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Introduction

Linux is truly amazing when you consider how it originated and how it
continues to evolve. From its modest beginning as the hobby of one
person — Linus Torvalds of Finland — Linux has grown into a full-fledged
operating system with features that rival those of any commercial UNIX
operating system. To top it off, Linux — with all of its source code — is
available free to anyone. All you have to do is download it from an Internet
site or get it on CDs or a DVD for a nominal fee from one of many Linux CD
vendors.

Linux certainly is an exception to the rule that “you get what you pay for.”
Even though Linux is free, it is no slouch when it comes to performance,
features, and reliability. The robustness of Linux has to do with the way

it is developed and updated. Developers around the world collaborate to
add features. Incremental versions are continually downloaded by users
and tested in a variety of system configurations. Linux revisions go through
much more rigorous beta testing than any commercial software does.

Since the release of Linux kernel 1.0 on March 14, 1994, the number of Linux
users around the world has grown exponentially. Many Linux distributions —
combinations of the operating system with applications and installation
tools — have been developed to simplify installation and use. Some Linux
distributions are commercially sold and supported, while many continue to
be freely available.

Linux, unlike many freely available software programs, comes with exten-
sive online information on topics such as installing and configuring the
operating system for a wide variety of PCs and peripherals. A small group

of hard-core Linux users are expert enough to productively use Linux with
the online documentation alone. A much larger number of users, however,
move to Linux with some specific purpose in mind (such as setting up a
Web server or learning Linux). Also, a large number of Linux users use their
systems at home. For these new users, the online documentation is not easy
to use and typically does not cover the specific uses of Linux that the user
may have in mind.

If you're beginning to use Linux, what you need is a practical guide that not
only gets you going with Linux installation and setup but also shows you
how to use Linux for a specific task. You may also want to try out different
Linux distributions before settling on one.

Accordingly, Linux All-in-One For Dummies, 4th Edition comes with a DVD
that includes five Linux distributions — Debian GNU/Linux, Fedora, open-
SUSE Linux, Ubuntu, and Xandros — and the instructions to install and use
any of these distributions.



2 About This Book

About This Book

Linux All-in-One For Dummies gives you eight quick-reference guides in a
single book. Taken together, these eight minibooks provide detailed informa-
tion on installing, configuring, and using Linux.

What you’ll like most about this book is that you don’t have to sequentially
read each chapter by chapter or even each section in a chapter. You can
pretty much turn to the topic you want and quickly get the answer to your
pressing questions about Linux, be it about using the OpenOffice.org word
processor or setting up the Apache Web server.

Here are some of the things you can do with this book:
4+ Install and configure Linux — Debian, Fedora, openSUSE, Ubuntu, or

Xandros — from the DVD-ROM included with the book

4 Connect the Linux PC to the Internet through a DSL or cable modem as
well as dial-up

4+ Add a wireless Ethernet to your existing network
4+ Get tips, techniques, and shortcuts for specific uses of Linux, such as

e Setting up and using Internet services: Web, Mail, News, FTP, NFS,
and DNS

¢ Setting up a Windows server using Samba
¢ Using Linux commands
¢ Using shell programming

¢ Using the OpenOffice.org office suite and other applications that
come with Linux

4 Understand the basics of system and network security

4+ Perform system administration tasks

Conventions Used in This Book

[ use a simple notational style in this book. All listings, filenames, function
names, variable names, and keywords are typeset in a monospace font for
ease of reading. I italicize the first occurrences of new terms and concepts
and then provide a definition right there. [ show typed commands in bold-
face. The output of commands and any listing of files are shown in a mono-
space font.
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What You Don’t Have to Read

Each minibook zeros in on a specific task area — such as using the Internet
or running Internet servers — and then provides hands-on instructions on
how to perform a series of related tasks. You can jump right to a section
and read about a specific task. You don’t have to read anything but the few
paragraphs or the list of steps that relate to your question. Use the Table of
Contents or the Index to locate the pages relevant to your question.

You can safely ignore text next to the Technical Stuff icons as well as text in
sidebars. However, if you're the kind of person who likes to know some of
the hidden details of how Linux works, by all means, dig into the Technical
Stuff icons and the sidebars.

Who Are Vou?

[ assume that you are familiar with a PC — you know how to turn it on and
off and you have dabbled with Windows. Considering that most new PCs
come preloaded with Windows, this assumption is safe, right? And you know
how to use some Windows applications, such as Microsoft Office.

When installing Linux on your PC, you may want to retain your Windows
installations. I assume that you don’t mind shrinking the Windows partition
to make room for Linux. For this you can invest in a good disk-partitioning
tool or use one of the partitioning tools included with most Linux distributions.

[ also assume that you're willing to accept the risk that when you try to
install Linux, some things may not quite work. Problems can happen if you
have some uncommon types of hardware. If you're afraid of ruining your
system, try finding a slightly older, spare Pentium PC that you can sacrifice
and then install Linux on that PC.

How This Book Is Organized

Linux All-in-One Desk Reference For Dummies has eight minibooks, each of
which focuses on a small set of related topics. If you're looking for informa-
tion on a specific topic, check the minibook names on the spine or consult
the Table of Contents.
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How This Book Is Organized

This desk reference starts with a minibook that explains the basics of Linux
and guides you through the installation process (a useful aspect of this book
because you typically do not purchase a PC with Linux pre-installed). The
second minibook serves as a user’s guide to Linux — it focuses on explor-
ing various aspects of a Linux workstation, including the GNOME and KDE
GUIs and many of the applications that come bundled with Linux. The third
minibook covers networking, and the fourth minibook goes into using the
Internet. The fifth minibook introduces system administration. The sixth
minibook turns to the important subject of securing a Linux system and its
associated network. The seventh minibook shows you how to run a variety
of Internet servers from mail to a Web server. The eighth and final minibook
introduces you to programming.

Here’s a quick overview of the eight books and what they contain:

4+ Book I, Linux Basics: What is Linux? Understanding what’s new in the
latest Linux kernel. Installing, configuring, and troubleshooting different
Linux distributions. Taking Linux for a test drive.

4+ Book II, Linux Desktops: Exploring GNOME and KDE. Using the shell
(what’s a shell anyway?). Navigating the Linux file system. Exploring the
applications such as multimedia software as well as the text editors (vi
and ed).

4+ Book III, Networking: Connecting the Linux PC to the Internet through
a dial-up connection or a high-speed, always-on connection such as DSL
or cable modem. Configuring and managing TCP/IP networks, including
wireless networks.

4+ Book IV, The Internet: Using various Internet services such as e-mail,
Web surfing, and reading newsgroups. Transferring files with FTP.

4+ Book V, Administration: Performing basic system administration.
Managing user accounts and the file system. Installing applications.
Working with devices and printers. Using USB devices. Upgrading and
customizing the Linux kernel.

4+ Book VI, Security: Understanding network and host security. Securing
the host and the network. Performing security audits.

4+ Book VII, Linux Servers: Managing Internet services. Configuring the
Apache Web server. Setting up the FTP server. Configuring the mail and
news servers. Providing DNS. File sharing with NFS. Using Samba to set
up a Windows server.

4+ Book VIII, Programming: Finding out the basics of programming.
Exploring the software development tools in Linux. Writing shell scripts.

vww . allitebooks.cond
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lcons Used in This Book 5

Sidebars

Sometimes, | use sidebars to highlight encountered before or give a little insight into a
interesting, but not critical, information. related topic. If you're in a hurry, you can safely
Sidebars explain concepts you may not have  skip the sidebars.

What's on the DUD?

The DVD contains five Linux distributions — dists folders contain ISO
image files for Debian, Fedora, openSUSE, Ubuntu, and Xandros, organized
into individual folders. You may use the DVD in accordance with the license
agreements accompanying the software.

Icons Used in This Book

Following the time-honored tradition of the All-in-One For Dummies series, |
use icons to help you quickly pinpoint useful information. The icons include
the following:

The Distribution Specific icon points out information that applies to specific
distributions that this book covers: Debian, Fedora, Knoppix, SUSE, Ubuntu,
and Xandros.

TRIBy.
Q\s 770
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»
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WMBER
¢ The Remember icon marks a general, interesting fact — something that you

want to know and remember. You might even find interesting trivia worth
bringing up at an evening dinner party.

‘%b

o When you see the Tip icon, you're about to read about something you can
do to make your job easier. Long after you've finished with the first reading
of this book, you can skim the book, looking for only the tips.

QUING/ [ use the Warning icon to highlight potential pitfalls. With this icon, I'm tell-

Ry ing you: “Watch out! Whatever is being discussed could hurt your system.”

They say that those who are forewarned are forearmed, so I hope these enti-
ties will save you some frustration.

The Technical Stuff icon marks technical information that could be of inter-
est to an advanced user (or those aspiring to be advanced users).

TEC#
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Where to Go from Here

It’s time to get started on your Linux adventure. Take out the DVD and install
Linux — choose a distribution, any distribution (as long as it’s Debian,
Fedora, openSUSE, Ubuntu, or Xandros). Then, turn to a relevant chapter
and let the fun begin. Use the Table of Contents and the Index to figure out
where you want to go. Before you know it, you’ll become an expert at Linux!

[ hope you enjoy consulting this book as much as I enjoyed writing it!
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Drive carefully, remember your lunch,
and always make abackup of gour
directory tree before modifying

gour hard disk partition file.”
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Chapter 1: Introducing Linux

In This Chapter

v+~ Explaining what Linux is
1 Going over what Linux distributions typically include
v+ Discovering what Linux helps you manage

v Getting started with Linux

By virtue of your holding this book in your hands, it’s a safe bet that
you've heard something about Linux. If you're wondering just exactly
what Linux is, whether it’s worth serious consideration, and what it can
help you do, this chapter is for you. Here, | provide a broad picture of Linux
and tell you how you can start using it right away.

Although Linux can run on many platforms, this book focuses on Linux
for Intel 80x86 and Pentium processors (basically any PC that can run any
flavor of Windows).

What Is Linux?

A PC can be thought of as a combination of hardware — things you can
touch, such as the system box, monitor, keyboard, and mouse. The system
box contains the most important hardware of all — the central processing
unit (CPU), the microchip that runs the soffware (any program that tells the
computer how to do your bidding), which you can’t actually touch. In a typi-
cal Pentium-based PC, the Pentium microprocessor is the CPU. Other impor-
tant hardware in the system box includes the memory (RAM chips) and the
hard drive.

The operating system is the program that has to interact with all the hard-
ware and get it to play nice. The operating system software manages all that
hardware and runs other software at your command. You, the user, provide
those commands by choosing menus, clicking icons, or typing cryptic text.
Linux is an operating system — as are UNIX, Windows XP, and Windows
Vista. The Linux operating system is modeled after UNIX; in its most basic,
no-frills form, the Linux operating system also goes by Linux kernel.
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Does Linux really run on any computer?

Linux has so many distributions that it does
seem able to run on nearly any type of computer.

Linus Torvalds and other programmers devel-
oped Linux for the Intel 80x86 (and compatible)
line of processors. This book covers Linux for
Intel 80x86 and Pentium processors. (These are
known as the IA32 architecture processors, or
i386, because they support the instruction set
of the 80386 processor.)

v+~ Alpha AXPs

v Sun SPARCs and UltraSPARCs

v~ Hewlett-Packard’s HP PA-RISC

v+ The PowerPC and PowerPC64 processors
v The MIPS R4x00 and R5x00

IBM has released its own version of Linux
for its S/390 and zSeries mainframes. And a

number of popular Linux distributions, includ-
ing Ubuntu and Fedora, can even be run on
Sony’'s Playstation 3 video game system.

Nowadays, Linux is also available for systems
based on other processors — such as the
following:

v AMD's 64-bit AMDG64 processors
v+ The Motorola 68000 family

The operating system is what gives a computer — any computer — its per-
sonality. For example, you can run Windows XP or Windows Vista on a PC —
and on that same PC, you can also install and run Linux. Then, depending on
which operating system is installed and running at any particular time, the
same PC can be a Windows XP system or a Linux system.

The primary job of an operating system is to load software (computer pro-
grams) from the hard drive (or other permanent storage) into the memory
and get the CPU to run those programs. Everything you do with your com-
puter is possible because of the operating system, so if the operating system
somehow messes up, the entire system freezes. You may know how infuriat-
ing it can be when your favorite operating system — maybe even the one
that came with your PC — suddenly calls it quits just as you were about to
click the Send button after composing that long e-mail to your friend. You try
a number of things frantically, but nothing happens. Then it’s time for the
Reset button (or pulling the cord from the back of the machine if your com-
puter’s builders weren’t wise enough to include a Reset). Luckily, that sort of
thing almost never happens with Linux — it has a reputation for being a very
reliable operating system.
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In technical mumbo jumbo, Linux is a multiuser, multitasking operating
system. Those terms just mean that Linux enables multiple users to log in,
and each of those users can run more than one program at the same time.
Nearly all operating systems are multiuser and multitasking these days, but
when Linux first started in 1993, multiuser and multitasking were big selling
points.

Linuyx distributions

A Linux distribution consists of the Linux kernel (the operating system) and a
collection of applications, together with an easy-to-use installation program.

Most people just say Linux to refer to a specific Linux distribution.

You will find many Linux distributions, and each includes the standard Linux
operating system and the following major packages:

4+ The X Window System: It’s the graphical user interface.

4 One or more graphical desktops: Among the most popular are GNOME
and KDE.

4+ A selection of applications: Linux programs come in the form of ready-
to-run software, but the source code (the commands we humans use
to tell the computer what to do) is included (or available), as is its
documentation.

Current Linux distributions include a huge selection of software — so
much that some distributions usually require multiple CD-ROMs or a
single DVD-ROM (which this book includes).

The development and maintenance of the Linux kernel, the software pack-
ages in a Linux distribution, and the Linux distributions themselves are
organized as open source projects. In a nutshell, open source means access
to the source code and the right to freely redistribute the software without
any restrictions. There’s a lot more to the definition than this succinct note.
To find out the details of what open source means and the acceptable open
source licenses, you can visit the Open Source Initiative Web site at www .
opensource.org.

Table 1-1 lists a few major Linux distributions along with a brief description
of each. Note, however, that there are many more Linux distributions than
the ones shown in Table 1-1. To find out more about Linux distributions,
visit DistroWatch.com at http://distrowatch.com. At that Web site, you
can read up on specific distributions as well as find links for ordering CDs or
DVDs for specific distributions.
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12 WhatIs Linux?

Tabhle 1-1

Major Linux Distributions

Distribution

Description

Debian GNU/
Linux

This noncommercial distribution started in 1993 and continues to be
a popular distribution, with many volunteer developers around the
world contributing to the project. Debian is a huge distribution that
takes some time to install. After you have installed the base Debian
system, you can install and upgrade Debian packages easily with

a package installer called apt-get (where apt stands for the
Advanced Package Tool.) Debian is available free of charge from
www . debian. org. Debian is the basis for several other recent
distributions including Knoppix, MEPIS, Ubuntu, and Xandros.

Fedora

This distribution, once known as Fedora Core, is the successor to
Red Hat Linux, which is the Linux distribution from Red Hat. Fedora
Core 1, released in November 2003, was the successor to Red Hat
Linux 9. The alpha release of Fedora 13 was March 2010. Fedora

is freely available and uses the Red Hat Package Manager (RPM)
format for its software packages. You can download Fedora Core
fromhttp://fedoraproject.org.

Gentoo Linux

This is a noncommercial, source-based (all software is provided

in source code form) distribution that first appeared in 2002. The
installer provides some hinary packages to get the Linux going, but
the idea is to compile all source packages on the user’s computer.
The requirement to install so much makes it time-consuming to build
a full-fledged Gentoo system with the latest graphical desktops,
multimedia, and development tools because all the packages have to
be downloaded and compiled. Gentoo Linux is freely available from
www.gentoo.ord.

Knoppix

This Live CD distribution is based on Debian and named after its
developer, Klaus Knopper of Germany. Knoppix can be used as a
recovery tool (to fix problems with an already installed Linux system)
because you can run Knoppix directly from the CD without having

to first install it on the hard drive. (Although other distributions have
this capability, Knoppix is ideally suited for the task.) The Knoppix CD
stores software in compressed format, and Knoppix decompresses
the programs on-the-fly. With this approach, Knoppix can pack up to
2GB of software on a CD. Knoppix uses the Debian package manage-
ment. Knoppix 6.2 was released in November 2009. For information
on downloading Knoppix free of charge, visit the Knoppix Web site at
www . knopper .net/knoppix/index-en.html.

Linspire

This commercial distribution was first released in 2002 under

the name Lindows0S. Linspire uses the Debian package format
and offers software downloads for a fee through what it calls the
Click-N-Run Web-based interface. You can download a Live CD
version called LindowsLive! via BitTorrent. In 2008, Linspire was
acquired by Xandros. For more information about Linspire, visit
www.linspire.com.




What Is Linux? 73

Distribution

Description

Mandriva
Linux One

This popular distribution began life as a 1998 release of Red Hat Linux
with an easy-to-use installer and with KDE as the default desktop.
Until recently, this distribution was called Mandrakelinux. Mandriva
Linux One uses the Red Hat Package Manager (RPM) format for its
software packages. You can download the latest version at www .
mandriva.com. Click the Download link for more information.
Mandriva also offers Mandriva Flash — an 8GB bootable flash drive
that contains everything you need to get the operating system up and
running without installing it on the hard drive.

MEPIS Linux

This Debian-based Live CD distribution was first released in July 2003.

Itincludes a graphical installer that can be launched from the Live CD
to install MEPIS on the hard drive. MEPIS has good hardware detec-
tion and comes with Java and multimedia software, which makes it
popular. MEPIS uses the Debian package format. You can download
the SimplyMEPIS Live CD free of charge from www.mepis.org.

Slackware
Linux

This distribution is one of the oldest, having been first released in
1992. Slackware uses compressed tar files for its packages and
provides a text-based installer with limited automatic detection of
hardware. You do all software configurations by editing text files.
Slackware is freely available from www . slackware. com.

SUSE Linux

This commercial distribution switched to a community development
project called openSUSE in August 2005. SUSE Linux Open Source
Software (0SS) is now freely available, and the retail SUSE Linux

is based on the open source version. SUSE comes with the YaST
installation and configuration tool, which is one of the best adminis-
tration tools available. SUSE Linux uses RPM packages. The open-
SUSE project provides the ISO image files from various mirror sites
(see http://en.opensuse.org/Download). Visit www.
opensuse. org for more information.

Ubuntu Linux

This Debian-based, noncommercial Linux distribution has become
very popular since its initial release in 2004. Ubuntu is available as
both an install CD and a Live CD. Because it's Debian based, you
can install the basic desktop system from the install CD and then
use the apt-get tool to install other packages as well as keep the
system up-to-date. You can download Ubuntu free of charge from
www . ubuntulinux.com.

Xandros
Desktop 0S

This distribution is the successor to Corel Linux and is based on
Debian. Xandros is aimed at first-time Linux users, with an installer
that can repartition the hard drive. The versatile Xandros File
Manager is a key selling point of this distribution. However, Xandros
includes some proprietary components that prevent redistribution. A
trial version of both Xandros Desktop and Server can be downloaded
for evaluation. In 2008, Xandros acquired Linspire, developer of the
Linspire and Freespire Linux desktop operating systems. Visit

www . xandros . com for more information about Xandros.
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As you can see from the brief descriptions in Table 1-1, some Linux distribu-
tions, such as Knoppix and MEPIS, are in the form of Live CDs. A Live CD (or
Live DVD) includes a Linux kernel that you can boot and run directly from
the CD or DVD without having to first install it on your hard drive. Such Live
CD distributions can be handy if you want to try out a distribution before
you decide whether to install it.

Many Linux distributions, such as SUSE Linux and Xandros Desktop, are
commercial products that you can buy online or in computer stores and
bookstores. If you have heard about open source and the GNU (which stands
for GNU’s Not UNIX) license, you may think that no one can sell Linux for
profit. Luckily for companies that sell Linux distributions, the GNU license —
also called the GNU General Public License (GPL) — does allow commer-
cial, for-profit distribution (but requires that the software be distributed in
source-code form) and stipulates that anyone may copy and distribute the
software in source-code form to anyone else. Several Linux distributions are
available free of charge under the GPL, which means that the publisher may
include these distributions on a DVD-ROM with this book and that you may
make as many copies of the DVD as you like.

Making sense of version numbers

The Linux kernel and each Linux distribution have their own version
number. Additional software programs (such as GNOME and KDE) that come
with the Linux distribution have their own version numbers as well. The ver-
sion numbers for the Linux kernel and the Linux distributions are unrelated,
but each has particular significance.

Linux kernel version numbers

After Linux kernel version 1.0 was released on March 14, 1994, the loosely
knit Linux development community adopted a version-numbering scheme.
Version numbers such as 1.x.y and 2.x.y, where x is an even number, are
considered the stable versions. The last number, y, is the patch level, which
is incremented as problems are fixed. For example, 2.6.14 is a typical, stable
version of the Linux kernel. Notice that these version numbers are in the
form of three integers separated by periods — major.minor.patch — where
major and minor are numbers denoting the major and minor version num-
bers, and patch is another number representing the patch level.

Version numbers of the form 2.x.y with an odd x number are beta releases
for developers only; they may be unstable, so you shouldn’t adopt such ver-
sions for day-to-day use. For example, if you were to find version 2.7.5 of the
Linux kernel, the 7 in the minor version number tells you it’s a beta release.
Developers add new features to these odd-numbered versions of Linux.

You can find out about the latest version of the Linux kernel online at www .
kernel.org.

vww . allitebooks.cond
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Distribution-specific version numbers

Each Linux distribution has a version number as well. These version num-
bers usually follow the format x.y, where x is the major version, and y is the
minor version.

Unlike with the Linux kernel version numbers, no special meaning is associ-
ated with odd- and even-numbered minor versions. Each version of a Linux
distribution includes specific versions of the Linux kernel and other major
components, such as GNOME, KDE, and various applications.

The developers of active Linux distributions usually release new versions
of their distribution on a regular basis — about every six to nine months.
For example, Ubuntu 9.10 was released in October 2009; 10.04 was released
in April 2010. Typically, each new major version of a Linux distribution pro-
vides significant new features.

Debian always has at least three releases at any time — stable, unstable, and
testing.

4+ Stable: Most users prefer this type of release because it’s the latest offi-
cially released distribution.

4+ Unstable: The developers are working on this release.

4+ Testing: The release contains packages that have gone through some
testing but aren’t ready for inclusion in the stable release yet.

Linux Standard Base (LSB)

Linux has become important enough that there’s a standard for Linux called
the Linux Standard Base (or LSB, for short). LSB is a set of binary standards
that should help reduce variations among the Linux distributions and pro-
mote portability of applications. The idea behind LSB is to provide an appli-
cation binary interface (ABI) so that software applications can run on any
Linux (or other UNIX) systems that conform to the LSB standard. The LSB
specification references POSIX (Portable Operating System Interface) stan-
dards as well as many other standards, such as the C and C++ programming
language standards, the X Window System version 11 release 6 (X11R6),
and the Filesystem Hierarchy Standard (FHS). LSB version 1.2 (commonly
referred to as LSB 1.2) was released on June 28, 2002. LSB 2.0 was released
on August 30, 2004, and LSB 4.0, on November 11, 2008.

The LSB specification is organized into two parts — a common specification
that remains the same across all types of processors and a set of hardware-
specific specifications, one for each type of processor architecture. For
example, LSB 1.2 has architecture-specific specifications for Intel 32-bit
(TA32) and PowerPC 32-bit (PPC32) processors. LSB 1.3 adds a specification
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for the Intel 64-bit (IA64) architecture and IBM zSeries 31-bit (5S390) and
64-bit (5390X) processors, in addition to the ones for IA32 and PPC32. LSB
2.0 added specification for the AMD 64-bit (AMD64 or X86_64) processors.
The current LSB specification — LSB 4.0 — supports seven processor
architectures: 1A32, IA64, PPC32, PPC64 (64-bit PowerPC), S390, S390X, and
X86_64.

An LSB certification program exists. By now, several Linux distributions are

certified to be LSB 1.3 compliant, IA32 runtime environments. Several others
are certified as LSB 2.0 compliant, IA32 runtime environments. Distributions
currently LSB 3.1 certified include Red Hat Enterprise Linux Version 5, open-

SUSE 10.2, and Xandros Server 1.0. LSB 4.0 certified distributions include
Mandriva Enterprise Server 5, SUSE Linux Enterprise 11, and Ubuntu 9.04.

To discover more about LSB, visit www. 1inuxbase.org. The latest list of
LSB-certified systems is available at www.1linux-foundation.org/en/

LSB_Distribution_Status.

Contents of a Linux Distribution

A Linux distribution comes with the Linux kernel and a lot more software.
These software packages include everything from graphical desktops to
Internet servers to programming tools for creating new software. In this sec-
tion, I briefly describe some major software packages that are bundled with
typical Linux distributions. Without this bundled software, Linux wouldn’t

be as popular as it is today.

What is the GNU Project?

GNU is a recursive acronym that stands
for GNU’s Not UNIX. The GNU Project was
launched in 1984 by Richard Stallman to develop
a complete UNIX-like operating system. The
GNU Project developed nearly everything
needed for a complete operating system except
for the operating system kernel.

All GNU software was distributed under the
GNU General Public License (GPL). GPL essen-
tially requires that the software is distributed in
source-code form and stipulates that any user
may copy, modify, and distribute the software

to anyone else in source-code form. Users may,
however, have to pay for their individual copies
of GNU software. (The GPL is printed in the
back of this book.)

The Free Software Foundation (FSF) is a tax-
exempt charity that raises funds for work on the
GNU Project. To find out more about the GNU
Project, visit its home page atwww . gnu. org.
The home page is also where you can find infor-
mation about how to contact the Free Software
Foundation and how to help the GNU Project.
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GNU software

At the heart of a Linux distribution is a collection of software that came from
the GNU Project. You get to know these GNU utilities only if you use your
Linux system through a text terminal — a basic command-line interface that
doesn’t use on-screen visuals but a prompt at which you type your com-
mands. (Or you could use a graphical window that mimics a text terminal
and still have use of GNU utilities.) The GNU software is one of the basic
parts of any Linux distribution.

As a Linux user, you may not realize the extent to which all Linux distribu-
tions rely on GNU software. Nearly all the tasks you perform in a Linux
system involve one or more GNU software packages. For example, the
GNOME graphical user interface (GUI) and the command interpreter (that is,
the bash) are both GNU software programs. By the way, the shell is the
command-interpreter application that accepts the commands you type

and then runs programs in response to those commands. If you rebuild the
kernel or develop software, you do so with the GNU C and C++ compiler
(which is part of the GNU software that accompanies Linux). If you edit text
files with the ed or emacs editor, you're again using a GNU software pack-
age. The list goes on and on.

Table 1-2 lists some well-known GNU software packages that come with most
Linux distributions. Depending on your interests, you may never need to use
many of these packages, but knowing what they are there in case you ever
do need them is a good idea.

Table 1-2 Well-Known GNU Software Packages

Software Package Description

autocont Generates shell scripts that automatically configure
source-code packages

automake Generates Makefile. in files for use with autoconf

bash The default shell (command interpreter) in Linux

bc An interactive calculator with arbitrary precision numbers

Binutils A package that includes several utilities for working with

binaryfiles: ar, as, gasp, gprof, 14, nm,
objcopy, objdump, ranlib, readelf, size,
strings, and strip

(continued)
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Table 1-2 (continued)

Software Package

Description

Coreutils

A package that combines three individual packages called
Fileutils, Shellutils, and Textutils and implements utilities
such as chgrp, chmod, chown, cp, dd, df, dir
dircolors,du,install, 1n, 1s, mkdir, mkfifo,
mknod, mv, rm, rmdir, sync, touch, vdir,
basename, chroot, date, dirname, echo, env,
expr, factor, false, groups, hostname, id,
logname, nice, nohup, pathchk, printenv,
printf, pwd, seq, sleep, stty, su, tee, test,
true, tty, uname, uptime, users, who, whoami,
yes, cut, join,nl, split, tail, andwc

cpio

Copies file archives to and from disk or to another part of
the file system

diff

Compares files, showing line-by-line changes in several
different formats

ed

A line-oriented text editor

emacs

An extensible, customizable, full-screen text editor and
computing environment

Findutils

A package thatincludes the £ind, locate, and xargs
utilities

finger

A utility program designed to enable users on the Internet
to get information about one another

gawk

The GNU Project’s implementation of the awk program-
ming language

gcc

Compilers for C, C++, Objective C, and other languages

gdb

Source-level debugger for C, C++, and Fortran

gdbm

A replacement for the traditional dbm and ndbm database
libraries

gettext

A set of utilities that enables software maintainers to inter-
nationalize (make the software work with different lan-
guages such as English, French, and Spanish) a software
package’s user messages

ghostscript

An interpreter for the PostScript and Portable Document
Format (PDF) languages

ghostview

An X Window System application that makes ghostscript
accessible from the GUI, enabling users to view PostScript
or PDF files in a window

The GIMP

The GNU Image Manipulation Program, an Adobe
Photoshop-like image processing program
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Software Package

Description

GNOME

Provides a graphical user interface (GUI) for a wide variety
of tasks that a Linux user may perform

GNUchess A chess game
GNU C Library For use with all Linux programs
Gnumeric A graphical spreadsheet (similar to Microsoft Excel) that

works in GNOME

grep package

Includes the grep, egrep, and £grep commands,
which are used to find lines that match a specified text
pattern

groff A document formatting system similar to trof £

gtk+ A GUI toolkit for the X Window System (used to develop
GNOME applications)

gzip A GNU utility for compressing and decompressing files

indent Formats C source code by indenting it in one of several dif-
ferent styles

less A page-by-page display program similar to more but with
additional capabilities

libpng Alibrary for image files in the Portable Network Graphics
(PNG) format

mé An implementation of the traditional UNIX macro processor

make A utility that determines which files of a large software
package need to be recompiled, and issues the commands
to recompile them

mtools A set of programs that enables users to read, write, and
manipulate files on a DOS file system (typically a floppy
disk)

ncurses A package for displaying and updating text on text-only
terminals

patch A GNU version of Larry Wall's program to take the output
of di £ £ and apply those differences to an original file to
generate the modified version

rcs Revision Control System; used for version control and
management of source files in software projects

sed A stream-oriented version of the ed text editor

Sharutils A package thatincludes shar (used to make shell

archives out of many files) and unshar (to unpack these
shell archives)

(continued)

Book |
Chapter 1

xnuiq fuianponu|



20  contents of a Linux Distribution

Table 1-2 (continued)

Software Package Description

tar Atape archiving program that includes multivolume
support — the capability to archive sparse files (files with
big chunks of data that are all zeros), handle compression
and decompression, and create remote archives — and
other special features for incremental and full backups

texinfo A set of utilities that generates printed manuals, plain ASCII
text, and online hypertext documentation (called info), and
enables users to view and read online info documents

time A utility that reports the user, system, and actual time that
a process uses

GUIs and applications

Face it — typing cryptic Linux commands on a terminal is boring. For average
users, using the system through a graphical user interface (GUI, pronounced
“GO0-ee”) — one that gives you icons to click and windows to open — is
much easier. This is where the X Window System, or X, comes to the rescue.

X is kind of like Microsoft Windows, but the underlying details of how X
works are different from Windows. X provides the basic features of display-
ing windows on-screen, but (unlike Microsoft Windows) it doesn’t come with
any specific look or feel for graphical applications. That look and feel comes
from GUIs, such as GNOME and KDE, which make use of the X Window System.

Most Linux distributions come with the X Window System in the form of
XFree86 or X.0rg X11 — implementations of the X Window System for 80x86
systems. XFree86 and X.Org X11 work with a wide variety of video cards
available for today’s PCs.

Until early 2004, XFree86 from the XFree86 Project (www.xfree86.org)

was the most commonly used X Window System implementation for x86
systems. However, around version 4.4, some changes to the XFree86 licens-
ing terms caused concerns to many Linux and UNIX vendors — they felt

that the licensing terms were no longer compatible with the GNU General
Public License (GPL). In January 2004, several vendors formed the X.Org
Foundation (www.x.org) to promote continued development of an open
source X Window System and graphical desktop. The first release of X.Org
X11 uses the same code that was used by XFree86 4.4, up until the time when
the XFree86 license changes precipitated the creation of X.Org Foundation.

As for the GUI, Linux distributions include one or both of two powerful GUI
desktops: KDE (K Desktop Environment) and GNOME (GNU Object Model
Environment). If both GNOME and KDE are installed on a PC, you can choose
which desktop you want as the default — or switch between the two. KDE
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and GNOME provide desktops similar to those of Microsoft Windows and the
Mac OS. GNOME also comes with the Nautilus graphical shell, which makes
finding files, running applications, and configuring your Linux system easy.
With GNOME or KDE, you can begin using your Linux workstation without
having to know cryptic Linux commands. However, if you ever need to use
those commands directly, all you have to do is open a terminal window and
type the commands at the prompt.

Linux also comes with many graphical applications. One of the most note-
worthy programs is The GIMP (The GNU Image Manipulation Program), a
program for working with photos and other images. The GIMP’s capabilities
are on a par with Adobe Photoshop.

Although Linux used to lack in providing common productivity software —
such as word processing, spreadsheet, and database applications — this
situation has changed. Linux comes with the OpenOffice.org office produc-
tivity applications. In addition, you may want to check out the following
prominent, commercially available office productivity applications for Linux
that are not included on this book’s companion DVD-ROM:

4+ Applixware: This office package is a good example of productivity soft-
ware for Linux. You can find it at www.vistasource. com.

4 Open Office: From Oracle (www.oracle.com/us/products/
applications/open-office/index.html), Open Office is another
well-known productivity software package.

4+ CrossOver Office: From CodeWeavers (www . codeweavers.com/
products/cxlinux), CrossOver Office can be used to install your
Microsoft Office applications (Office 2000 and Office XP, for example)
as well as several other Windows applications in Linux.

As you can see, there’s no shortage of Linux office applications that are
compatible with Microsoft Office.

Networks

Linux comes with everything you need to use the system in networks to
exchange data with other systems. On networks, computers that exchange
data must follow well-defined rules, or protocols. A network protocol is a
method that the sender and receiver agree upon for exchanging data across
a network. Such a protocol is similar to the rules you might follow when
you're having a polite conversation with someone at a party. You typically
start by saying hello, exchanging names, and then taking turns talking.
That’s about the same way network protocols work. The two computers use
the same protocol to send bits and bytes back and forth across the network.

One of the most well-known and popular network protocols is Transmission
Control Protocol/Internet Protocol (TCP/IP). TCP/IP is the protocol of choice on
the Internet — the “network of networks” that now spans the globe. Linux sup-
ports the TCP/IP protocol and any network applications that make use of TCP/IP.

Book |
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Internet servers

Some popular network applications are designed to deliver information from
one system to another. When you send electronic mail (e-mail) or visit Web
sites using a Web browser, you use these network applications (also called
Internet services). Here are some common Internet services:

4+ Electronic mail (e-mail) that you use to send messages to any other
person on the Internet using addresses like joe@someplace. com
4+ World Wide Web (or simply, Web) that you browse using a Web browser

4+ News services, where you can read newsgroups and post news items
to newsgroups with names such as comp.os.linux.networking or
comp.os.linux.setup

+

File transfer utilities that you can use to upload and download files

4+ Remote login that you can use to connect to and work with another
computer (the remote computer) on the Internet — assuming you have
the required username and password to access that remote computer

Any Linux PC can offer these Internet services. To do so, the PC must be
connected to the Internet, and it must run special server software called
Internet servers. Each of the servers uses a specific protocol for transferring
information. For example, here are some common Internet servers that you
find in Linux:

4+ sendmail is the mail server for exchanging e-mail messages between
systems using SMTP (Simple Mail Transfer Protocol).

4 Apache httpd is the Web server for sending documents from one
system to another using HTTP (HyperText Transfer Protocol).

4+ vsftpd is the server for transferring files between computers on the
Internet using FTP (File Transfer Protocol).

4+ innd is the news server for distribution of news articles in a store-and-
forward fashion across the Internet using NNTP (Network News Transfer
Protocol).

4 in.telnetd allows a user on one system to log in to another system on
the Internet using the TELNET protocol.

4+ sshd allows a user on one system to securely log in to another system
on the Internet using the SSH (Secure Shell) protocol.

Software development

Linux is particularly well suited to software development. Straight out the
box, it’s chock-full of software-development tools, such as the compiler and
libraries of code needed to build programs. If you happen to know UNIX and
the C programming language, you'll feel right at home programming in Linux.
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As far as the development environment goes, Linux has the same basic tools
(such as an editor, a compiler, and a debugger) that you might use on other
UNIX workstations, such as those from IBM, Sun Microsystems, and Hewlett-
Packard (HP).

If you work by day on one of these UNIX workstations, you can use a Linux
PC in the evening at home to duplicate that development environment at a
fraction of the cost. Then you can either complete work projects at home or
devote your time to software you write for fun and to share on the Internet.

Online documentation

As you become more adept at using Linux, you may want to look up infor-
mation quickly — without having to turn the pages of (ahem) this great
book, for example. Luckily, Linux comes with enough online information to
jog your memory in those situations when you vaguely recall a command’s
name but can’t remember the exact syntax of what you're supposed to type.

If you use Linux commands, you can view the manual page — commonly
referred to as the man page — for a command by using the man command.
(You do have to remember that command to access online help.)

You can also get help from the GUI desktops. Both GNOME and KDE desk-
tops come with help viewers to view online help information. Most distri-
butions include a help option in the desktop menu or a help icon on the
desktop that you can use to get online help. You can then browse the help
information by clicking the links on the initial help window. Figure 1-1 shows
a typical help window — this one from Ubuntu’s desktop.
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p Welcome to the Ubuntu Help Center
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New to Ubuntu? To find help, insert a keyword in the search bar
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Networks
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The following features make Linux a productive
software-development environment:

v+ GNU C compiler (gcc): Compiles ANSI-
standard C programs.

+* GNU C++ compiler (g++): Supports ANSI-
standard C++ features.

v+ GNU compiler for Java (gcj): Compiles
programs written in the Java programming
language.

+* GNU make utility: Enables you to compile
and link large programs.

+* GNU debugger (gdb): Enables you to step
through your program to find problems and
to determine where and how a program
failed. (The failed program’s memory image
is saved in the core file; gdb can examine
this file.)

v GNU profiling utility (gpro£): Enables you
to determine the degree to which a piece
of software uses your computer’s proces-
sor time.

v+~ Subversion, Concurrent Versions System
(CVS), and Revision Control System (RCS):

”

Managing Your PC with Linux

As an operating system, Linux acts as the intermediary through which you — as
the “lord of the system” — manage all the hardware. The hardware includes
the system box, the monitor, the keyboard, the mouse, and anything else
connected to the system box. The catchall term peripheral refers to any
equipment attached to the system. If you use a laptop computer, all your
hardware is packaged into the laptop.

Stuff programmers want to know about Linux

Maintains version information and controls
access to the source files so that two pro-
grammers don't inadvertently modify the
same source file at the same time.

GNU emacs editor: Prepares source files
and even launches a compile-link process
to build the program.

Perl: Enables you to write scripts to accom-
plish a specific task, tying together many
smaller programs with Linux commands.

Tool Command Language and its graphi-
cal toolkit (Tc1/Tk): Enables you to build
graphical applications rapidly.

Python: Enables you to write code in an
interpreted programming language com-
parable to Perl and Tcl. (For example, the
Fedora Core installation program, called
anaconda, is written in Python.)

Dynamically linked, shared librar-
ies: Allows your actual program files to
be much smaller because all the library
code that several programs may need is
shared — with only one copy loaded in the
system’s memory.

Inside that system box is the system’s brain — the microprocessor (Intel
Pentium 4, for example) or the CPU — that performs the instructions con-
tained in a computer program. When the microprocessor runs a computer
program, that program’s instructions are stored in the memory, or RAM

vww . allitebooks.cond
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(random access memory). This means that any part of the memory can be
accessed randomly — in arbitrary order.

The system box has another crucial component — the hard drive (or hard
disk, as it is sometimes called). The hard drive is the permanent storage
space for computer programs and data. It’s permanent in the sense that

the contents don’t disappear when you power off the PC. The hard drive is
organized into files, which are in turn organized in a hierarchical fashion into
directories and subdirectories (somewhat like organizing papers in folders
in the drawers of a file cabinet).

To keep a Linux system running properly, you or someone else has to make
sure that the hardware is working properly and that the files are backed up
regularly. There’s also the matter of security — making sure that only legiti-
mate people can access and use the system. These tasks are called system
administration.

If you use Linux at a big facility with many computers, a full-time system
administrator probably takes care of all system administration tasks. On the
other hand, if you run Linux on a home PC, you're the system administrator.
Don’t let the thought frighten you. You don’t have to know any magic incan-
tations or prepare cryptic configuration files to be a system administrator.
Most Linux distributions include many graphical tools that make system
administration a point-and-click job, just like running any other application.

Disks, CD-ROMs, and DUD-ROMs

Some Linux distributions come on a single DVD-ROM. After installation, the
Linux kernel and all the applications are stored on your hard drive — which
is where your PC looks first when you tell it to do something.

Typically, the hard drive is prepared to use Linux during the installation pro-
cess. After that, you usually leave the hard drive alone except to back up the
data stored there or (occasionally) to install and update applications.

Using CD-ROMs or DVD-ROMs in Linux is easy. While you're logged in at

the GNOME or KDE desktop, just pop a CD or DVD in to the drive, and the
system should automatically detect the DVD/CD-ROM. Depending on the
Linux distribution, either a DVD/CD-ROM icon appears on the desktop or

a file manager automatically opens and displays the contents of the DVD/
CD-ROM. If all else fails, you can type a simple mount command to associate
the DVD/CD-ROM with a directory on your system. This process of accessing
the files on a CD or a DVD from Linux is called mounting the CD or the DVD.

Besides the hard drive and DVD/CD-ROM drive, of course, your PC may have
other drives, such as a floppy disk drive, a Zip drive, or a USB flash drive.
Using those disks in Linux is also simple: You insert a disk and double-click
the icon that represents the disk drive on the GUI desktop. Doing so mounts
the disk so that you can begin using it.

Book |
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Peripheral devices

Anything connected to your PC is a peripheral device, as are some compo-
nents (such as sound cards) that are installed inside the system box. You
can configure and manage these peripheral devices in Linux.

One of the common peripherals is a printer, typically hooked up to the USB
(Universal Serial Bus) or parallel port of your PC. (Many distributions come
with a graphical printer configuration tool that you can use to configure the
printer.)

Another peripheral device that needs configuration is the sound card. Most
Linux distributions detect and configure sound cards, just as Windows does.
However, if Linux can’t detect the sound card correctly, you may have to run
a text mode or graphical tool to configure the sound card.

Linux configures other peripheral devices, such as the mouse and keyboard,
at the time of installation. You can pretty much leave them alone after
installation.

Nowadays, PCs come with the USB interface; many devices, including print-
ers and scanners, plug into a PC’s USB port.

One nice feature of USB devices is that you can plug them into the USB port
and unplug them at any time — the device doesn’t have to be connected
when you power up the system. These devices are called hot plug because
you can plug in a device when the system is hot, meaning while it’s running.
Linux supports many hot plug USB devices. When you plug a device into the
USB port, Linux loads the correct driver and makes the device available to
applications.

File systems and sharing

The entire organization of directories and files is the file system. You can, of
course, manage the file system using Linux. When you browse the files from
the GNOME or KDE graphical desktop, you work with the familiar folder icons.

A key task in caring for a file system is to back up important files. In Linux,
you can use the tar program to archive one or more directories on a floppy
disk or a Zip drive. You can even back up files on a tape (if you have a tape
drive). If you have a CD or DVD burner, you can also burn a CD or DVD with
the files you want to back up or save for posterity.

Linux can also share parts of the file system with other systems on a net-
work. For example, you can use the Network File System (NFS) to share
files across the network. To a user on the system, the remote system’s files
appear to be in a directory on the local system.
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Linux also comes with the Samba package, which supports file sharing with Book |
Microsoft Windows systems. Samba makes a Linux system work just like a Chapter 1
Windows file or print server. You can also access shared folders on other
Windows systems on your network.

Network

Now that most PCs are either in a local area network (LAN) or connected to
the Internet, you need to manage the network as well. Linux comes with a
network configuration tool to set up the LAN. For connecting to the Internet
with a modem, there’s usually a GUI Internet dial-up tool.

xnuiq fuianponu|

If, like many users, you connect to the Internet with DSL or cable modem,
you need a PC with an Ethernet card that connects to the cable or DSL
modem. It also means that you have to set up a local area network and
configure the Ethernet card. Fortunately, these steps are typically a part
of Linux installation. If you want to do the configurations later, you can by
using a GUI network configuration tool.

Linux also includes tools for configuring a firewall, which is a protective
buffer that helps keep your system relatively secure from anyone trying to
snoop over your Internet connection. You can configure the firewall by using
iptables commands or by running a GUI firewall configuration tool.

Getting Started

Based on personal experience in exploring new subjects, I prescribe a four-
step process to get started with Linux (and Linux All-in-One Desk Reference
For Dummies):

1. Install Linux on your PC (as shown in Book I).

2. Configure Linux so that everything works to your liking (as shown in
Book ).

3. Explore the GUI desktops and the applications (as shown in Book II).
4. Find out the details of specific subjects, such as Internet servers (as
shown in Book V).

In the rest of this chapter, | explain this prescription a bit more.

Step 1: Install
Microsoft Windows usually comes installed on your new PC, but Linux usu-

ally doesn’t. So your first hurdle is to get Linux onto your PC. Although some
vendors are now offering Linux pre-installed, this is still a rarity.
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Getting Started

After you overcome that initial human fear of the unknown, I'll bet you find
Linux fairly easy to install — but where do you get it in the first place? Well,
the good news is that it’s included on the DVD for this book. After you drop
the DVD into your PC, Book I shows how to install Linux, step by step.

Because a typical complete Linux distribution is huge — it takes several CDs
or at least a single DVD — your best bet is to buy or borrow a book (such

as this one) that includes Linux on a CD or DVD. However, if you have a lot
of patience and bandwidth, Linux is also free to download. For example,
you can visit the Linux Online Web site at www. 1inux.org and click the
Download button.

Step 2: Configure

When you finish installing Linux, the next step is to configure individual
system components (for example, the sound card and the printer) and tweak
any needed settings. Book I shows how to configure the nooks and crannies
of Linux.

If you aren’t getting a graphical login screen, the X Window System may not
have been configured correctly during installation. You have to fix the X con-
figuration file for the GUI to work.

You may want to configure your GUI desktop of choice — GNOME or KDE (or
both). Each has configuration tools. You can use these tools to adjust the
look and feel of the desktop (background, title fonts, or even the entire color
scheme). Book Il shows how to make your desktop even more your own.

After you're through with configuration, all the hardware on your system
and the applications should run to your liking.

Step 3: Explore

With a properly configured Linux PC at your disposal, you're ready to
explore Linux itself. You can begin the process from the GUI desktop —
GNOME or KDE — that you see after logging in. Look at the GUI desktops and
the folders and files that make up the Linux file system, as discussed in Book
II. You can also try out the applications from the desktop. You find office and
multimedia applications and Internet applications to explore.

Also try out the shell: Open a terminal window and type some Linux com-
mands in that window. You can also explore the text editors that work in
text mode, as covered in Book II. Knowing how to edit text files without the
GUI, just in case the GUI isn’t available, is a good idea. At least you won’t be
helpless.
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Step 4: Find out more ookt
After you explore the Linux landscape and know what is what, you can dig T
deeper and find out more about specific subject areas. For example, you may -
be interested in setting up Internet servers. You can then learn the details Z—:
of setting up individual servers, such as sendmail for e-mail, Apache for a =
Web server, and the INN server for news, as covered in Book IV. g
«
You can find out about many more areas, such as security, programming, g
x

and system administration, as discussed in Books V, VI, VII, and VIIIL

Of course, you can expect this step to go on and on, even after you have
your system running the way you want it — for now. After all, learning is a
lifelong journey.

Bon voyage!
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Chapter 2: Installing Linux

In This Chapter

+ Understanding the installation steps

1 Making a list of your PC’s hardware

v+ Checking out the Ubuntu Live CD

+ Burning CDs or DVDs for your distribution
1 Setting aside hard drive space for Linux

v~ Installing Ubuntu

M ost PCs come with Microsoft Windows pre-installed; if you want to
use Linux, you usually have to install it.

This book comes with a DVD-ROM that contains several Linux distributions —
Ubuntu, Debian, Fedora, openSUSE, and Xandros. Some are full distribu-
tions, and a few are Live CDs that you can try without installing on the hard
drive. (Full distributions include everything you need to install those distri-
butions; Live CDs are CDs from which you can directly boot Linux.) All you
have to do to install or try any of these distributions is follow the steps in
this chapter.

You may feel a tad worried about installing a new operating system on your
PC because it’s a bit like brain surgery — or, rather, more like grafting a new
brain because you can install Linux in addition to Microsoft Windows. When
you install two operating systems like that, you can choose to start one or
the other as you power up the PC. The biggest headache in adding Linux to
a PC with Windows is creating a new disk partition — basically setting aside
a part of the hard drive for Linux. The rest of the installation is routine —
just a matter of following the instructions. If you want to try any of the Live
CDs, you don’t have to do any disk partitioning; just boot your PC from the
Live CD. But first, take a deep breath and exhale slooowwwly. You have
nothing to worry about.

Following the Installation Steps

Installing any Linux distribution involves a number of steps, and I will walk
through them briefly, without the details. Then you can follow the detailed
steps for the specific distributions and install what you want from this
book’s companion DVD-ROM.
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Some Linux distributions require that you have quite a bit of information
about your PC’s hardware on hand before installation. If you plan to install
Debian, go ahead and gather information about your PC and its peripheral
components before starting the installation. Luckily, most Linux installation
programs can detect and work with most PC peripherals. Nevertheless, it’s a
good idea to figure out your PC’s hardware so that you can troubleshoot in
case something goes wrong with the installation.

The very first step is to burn the CD or DVD for your distribution. You can
burn the CDs on any system that has a CD/DVD burner. (You must have

a DVD burner if you want to burn a DVD, but a DVD burner can burn both
CDs and DVDs.) Typically, if you already have a Windows PC with a CD/DVD
burner, you can simply use that system to burn the CDs. Remember that
you must have a DVD drive as well because you have to burn the CDs from
this book’s companion DVD-ROM. A PC with a DVD burner or a combination
DVD-ROM and CD burner is adequate for this task.

The second step is to make sure that your PC can boot from the DVD/CD
drive. Most new PCs can boot directly from the DVD/CD drive, but some PCs
may require your intervention. Typically, the PC may be set to boot from
the hard drive before the DVD/CD drive, and you have to get into Setup to
change the order of boot devices.

To set up a PC to boot from the DVD drive, you have to go into Setup as

the PC powers up. The exact steps for entering Setup and setting the boot
device vary from one PC to the next, but typically they involve pressing a
key, such as F2. When the PC powers up, a brief message tells you what key
to press to enter Setup. When you're in Setup, you can designate the DVD/
CD drive as the boot device. After your PC is set up to boot from the DVD/CD
drive, simply put the DVD or CD in the DVD/CD drive and restart your PC.

If you plan to try a Live CD distribution, the third step is to boot your PC
from the Live CD or DVD. Otherwise, the third step is to make room for Linux
on your PC’s hard drive. If you're running Microsoft Windows, this step can
be easy or hard, depending on whether you want to replace Windows with
Linux or keep both Windows and a Linux distribution.

If you want to install Linux without removing (or disturbing) Windows,
remember that your existing operating system uses the entire hard drive.
That means you have to partition (divide) the hard drive so that Windows
can live in one part of it, and Linux can live in the other. Doing so can be a
scary step because you run the risk of clearing the hard drive and wiping out
whatever is on the drive. Therefore, always make a backup of your system
before undertaking any significant changes.

To set aside space on your hard drive that the Linux installation program
can use, you should use a partitioning program to help you create the par-
tition. If your PC runs Windows 7, Vista, or XP (as well as the much older
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NT or 2000), you might want to invest in a commercial hard drive partition- Book |
ing product. On the other hand, you can repartition your PC’s hard drive Chapter 2
by using a GUI (graphical user interface) tool called QTParted, which comes
with Knoppix and a number of other distributions.
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NSPEC,,  Note that the installers for some Linux distributions, such as openSUSE and ::’
¢ Xandros Desktop, can automatically create partitions for Linux by reducing =

the size of a Windows partition. In that case, you don’t need to use a tool c

such as QTParted to shrink the size of the existing Windows partition on =
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your hard drive.

After you set aside a hard drive partition for Linux, you can boot the PC
from the selected distribution’s CD and start the Linux installation. Quite
a few steps occur during installation, and they vary from one distribution
to another. When you’ve come this far, it should be smooth sailing. Just go
through the installation screens, and you’ll be finished in an hour or two.
Most installers, such as the openSUSE interface in Figure 2-1, display a GUI
and guide you through all the steps.

@ openSUSE Installer

openSUSE Live (KDE)

Check Installation Media
Boot from Hard Disk

Memory Test

Figure 2-1:
The GUI
walks you Boot Options
through the

|nsta"at|0n F1 Help F2 Language F3 Video Mode F4 Kernel
English (US) 800 x 600 Default

One key step during installation involves partitioning the hard drive again,
but this time you simply use the extra partition you created previously.
Figure 2-2 shows the actions recommended for this step by the openSUSE
installation interface.
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After a few configuration steps, such as setting up the network and the time
zone, select the software packages to install and then let the installer com-
plete the remaining installation chores. Some distributions make it even
easier and do away with the software selection step and instead install a
default set of software packages.
At the end of the installation, reboot the PC. Rebooting is sometimes
required as a part of the installation process, as shown in Figure 2-3.

Figure 2-3:

A reboot

is needed

during this ED Lo e i the malaon, s VEST ean reboet

OpenSUSE now oryou can reboot any time later.

installation e e e et

bef()re the inthe boot menu of the Live CD

automatic

configuration

can run.

When Linux runs for the first time, you get a chance to perform some more
configuration steps and install additional software packages.
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Checking Your PC’s Hardware

If you're concerned that your PC may not be able to run Linux, here are
some of the key components of your PC that you need to consider before
you start the Linux installation:

+

+

DVD drive: You must have a DVD drive (either DVD-ROM or DVD
burner), and the PC must be able to boot from that drive.

The exact model doesn’t matter. What does matters is how the DVD
drive connects to the PC. Most new PCs have DVD drives that connect to
the hard drive controller (IDE, for Integrated Drive Electronics, or ATA,
for AT Attachment). If you add an external DVD drive, it most likely con-
nects to the USB port. Any IDE/ATA or USB DVD drive works in Linux.

Hard drives: Any IDE disk drive works in Linux. Another type of hard
drive controller is SCSI (Small Computer System Interface), which Linux
also supports. To comfortably install and play with Linux, you need
about 5GB of hard drive space. On the other hand, to try the Live CD
versions of Linux, you don’t need any space on the hard drive.

Keyboard: All keyboards work with Linux and the X Window System.

Modem: If you plan to dial out to the Internet, you need a modem that
Linux supports. For software-based modems, called softmodems or
Winmodems, you may have to download a driver from the manufacturer
or the Linux modem sites (such as www.linmoderm.org). A download
may or may not be freely available.

Monitor: The kind of monitor isn’t particularly critical except that it
must be capable of displaying the screen resolutions that the video card
uses. The screen resolution is expressed in terms of the number of picture
elements (pixels), horizontally and vertically (for example, 1024 x 768).
The installer can detect most modern monitors. If it doesn’t detect your
monitor, you can select a generic monitor type with a specific resolution
(such as 1024 x 768). You can also specify the monitor by its make and
model (which you can find on the back of the monitor).

Mouse: The installation program can detect the mouse. All types of
mouse (such as PS/2 or USB) work with Linux and the X Window System.

Network card: Not all PCs have network cards, but if yours does, the
installer can probably detect and use it. If you have problems, try to find
the make and model (such as Linksys LNE100TX Fast Ethernet Adapter) so
that you can search for information on whether Linux supports that card.

Processor: A 400 MHz Pentium II or better is best. The processor speed,
expressed in MHz (megahertz) or GHz (gigahertz), isn’t that important
as long as it’s over 400 MHz. But the faster the better. Linux can run on
other Intel-compatible processors, such as AMD and VIA processors.
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Trying the Ubuntu Live CD

4+ RAM: RAM is the amount of memory your system has. As with process-
ing speed, the more RAM, the better. You need a minimum of 256MB to
install both Linux and the X Window System. With some distributions,
the minimum amount has climbed to 384MB, and you’ll want still more
memory to be able to comfortably run a GUI desktop.

4+ SCSI controller: Some high-performance PCs have SCSI controllers that
connect disk drives and other peripherals to a PC. If your PC happens to
have a SCSI controller, you might want to find out the make and model
of the controller.

4+ Sound card: If your PC has a sound card and you want to have sound
in Linux, you have to make sure it’'s compatible. You can configure the
sound card after successfully installing Linux.

4 Video card: Linux works fine with all video cards (also known as dis-
play adapters) in text mode, but if you want the GUI, you need a video
card that works with the X Window System. The installer can detect a
supported video card and configure the X Window System correctly.
However, if the installer can’t detect the video card, it helps if you know
the make and model of your video card.

4+ Printer: In addition to this hardware, you also need to find out the make
and model of any printer you plan to use in Linux.

Many distributions, such as Debian GNU/Linux, work on any hardware that’s
compatible with the Linux kernel. For information on Linux-compatible hard-
ware, see www . t1dp.org/HOWTO/Hardware-HOWTO.

To check whether your PC’s hardware is compatible with individual distribu-
tions, visit that vendor’s site and find their hardware compatibility list.

Trying the Ubuntu Live CD

Before you install anything, you’ll find it worthwhile to try out Ubuntu from
the companion DVD. In addition to getting a feel for a Linux desktop, you can
perform a few additional pre-installation chores from Ubuntu.

To start Ubuntu, boot your PC from this book’s companion DVD. A menu
will appear from which you can enter various options to control the boot
process or check your system to see if it meets hardware requirements. You
should choose the default option of booting Ubuntu (this option is automati-
cally performed if you don’t make a selection before the menu times out in 30
seconds).

A few minutes later, you see the GNOME GUI desktop, which Ubuntu uses.
You can now start exploring Ubuntu. If you click the Examples folder,
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you'll find a number of things that Ubuntu can do. You can also choose Book |

GParted (the partition editor) from the System, Administration menu Chapter 2

(System=>Administrationm>GParted) to reconfigure the hard drive.

When you finish using Ubuntu, choose System=>Quit. After Ubuntu shuts 2

down, remove the DVD and press Enter. Should you decide you want to °_=’

install Ubuntu, click the Install icon on the desktop to begin the process. a
5
=
x

Burning CDs or DUDs from 1SO Images

This book’s companion DVD has Debian, openSUSE, and Xandros distribu-
tions in the form of ISO images, organized into separate folders in the dists
folder of the DVD. To install any of these distributions, you must first burn the
selected distribution’s ISO images onto CD or DVD. You can typically perform
this step on a PC with a CD/DVD burner, most likely while using Microsoft
Windows because most new PCs come with Windows pre-installed.

Using a Windows CD burner application

In Microsoft Windows, you can use a CD
burner application, such as Nero, to burn
ISO images onto recordable CDs. If you don’t
have a CD burner application for Microsoft
Windows, boot Ubuntu from the DVD and
choose Places=>CD/DVD Creator from the GUI
desktop to start the CD/DVD burning applica-
tion. The exact steps for burning a CD from an
ISO image depend on the CD burner application
that you use. The general steps follow. (Use the
same instructions to burn a DVD, provided you
have a DVD burner.)

1. Place the companion DVD-ROM into the
PC’s DVD drive.

If your DVD drive is a combination DVD/
CD burner, you have to first copy the ISO
image files of the Linux distribution from
the DVD to the PC’s hard drive so that you
can use the same drive to burn the CDs.

2. Start the CD burner application.

3. From the CD burner application, open the
image file.

The exact steps depend on the CD burner
application.

4. Place a blank, recordable CD in the CD
burner.

5. Burn the IS0 image to the recordable CD.

Typically, the CD burner application has a
toolbar button that you can click to start
burning the IS0 image onto the blank CD.

6. If the distribution has more I1SO images,
repeat Steps 3-5 for the remaining 1SO
images.

Live CD distributions come in a single ISO
image that you can burn on a single CD.
Other distributions typically come in multi-
ple ISO images, and you have to burn each
image file onto a separate CD.
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Setting Aside Space for Linux

In a typical Windows PC, Windows is sitting on one big partition, taking over
the entire hard drive. You want to shrink that partition and create room for
Linux. During Linux installation, the installation program uses the free space
for the Linux partitions.

To try out any of the Live CD distributions — such as Ubuntu — you don’t
have to repartition your hard drive. Just boot your PC from the Live CD. The
installers can nondestructively shrink a Windows partition, so you don’t
need to perform the repartitioning step beforehand. If you plan to install
Fedora, Debian, or any other Linux distribution on the hard drive, you have
to repartition your hard drive. If you want to resize the disk partition under
Windows, you can use a commercial product, or boot Ubuntu from this
book’s companion DVD and then use GParted, the partition editor, to resize
the Windows partitions. GParted can resize NTFS (NT File System) parti-
tions, which are used by most newer versions of Windows.

When you resize the disk partition, you always risk losing all the data on the
hard drive. Therefore, before you resize hard drive partitions with a disk
partitioning tool, back up your hard drive. After making your backup — and
before you do anything to the partitions — please make sure that you can
restore your files from the backup.

After Ubuntu boots and the GUI desktop appears, follow these steps to
reduce the size of the Windows partition:

1. Choose Systemr>Administration>GParted from the Ubuntu desktop.

The GParted window appears, and the tool displays the drives it finds
on your PC. The first hard drive appears with a device name /dev/sda,
the second one as /dev/sdb, and so on.

2. Click the hard drive from the list of devices on the right side of the
GParted window.

3. From the list of partitions, click the partition you want to resize.

This partition would normally be the largest partition. For Windows 7,
Vista, or XP, the partition type is ntfs, as shown in the Type column in
the list of partitions. In a typical new PC, you might see two partitions —
a smaller fatl16 partition and a large nt £s partition.

4. Choose Resize/Move from the GParted menu.
The Resize partition dialog box appears.

5. Set the setting for the new size for the partition and then click
Resize/Move.
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You should choose a size such that you get 4GB or more free space after
the partition. You'll see the size of the free space in the Free Space After
field in the dialog box.

6. Click Apply to begin the operation after you have specified all
changes you want to make. When the warning appears, click Apply
and all pending operations will be performed.

The partition is changed, and you have free space after the Windows
partition.

After you create free space on the hard drive for Linux, you can proceed
to install the Linux distribution of your choice using the CDs or DVD that
you've burned from the ISO image files provided on the companion DVD.

Installing Ubuntu

The companion DVD includes a single-CD ISO image for installing Ubuntu.
First, burn that ISO image onto a CD-R by following the steps outlined in the
“Burning CDs or DVDs from ISO Images” section, previously in this chapter.
Ubuntu is based on Debian, so the installation steps are similar to those

for Debian.

To install Ubuntu on your PC, follow these steps:

1. Boot your PC from the Ubuntu installation CD.

The initial boot screen prompts you to press Enter to start installation
or press F1 for more help. You can press F1 and then look at help infor-
mation by pressing the specified function key. These options are similar
to what you see on the Debian installer’s boot screen because Ubuntu is
based on Debian.

2. Press Enter or type a boot command followed by any options and then
press Enter.

For example, on a PC that doesn’t support ACPI (Advanced Configuration
and Power Interface), type 1inux acpi=off to start the Ubuntu instal-
lation. The installer prompts you to select the language. For most instal-
lations, just choose Install Ubuntu.

3. Select the language and click Forward.

For most installations, just choose Install Ubuntu. The installer displays
the location based on your language choice. If release notes are avail-
able, you see them here and can also choose to update the installer
should a new one be available.

4. Select the location, and then click Forward.
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10.

The installer shows a map and attempts to guess your time zone loca-
tion based on the current clock’s time. You can also change the default
time zone to the one correct for your location if the installer did not
guess correctly.

Select the keyboard layout, and then click Forward.
The installer detects hardware, including the hard drive configuration.
(Optional) Choose how to prepare the disk space.

You can remove the existing operating system, install in another parti-
tion, and so on. If you've created space for Ubuntu on your hard drive
(see the “Setting Aside Space for Linux” section), select that space.

Click Forward.

Create your user account, type a host name for your system, and then
click Forward.

Enter the primary user account information for this system (the supe-
ruser) and assign a computer name that you want this system to be
known as across the network.

Confirm the Installation, and then click Install.

All the variables you've entered or choices you've selected are displayed
one last time. You can Quit, go back to change something, or Install (you
can also click the Advanced button to configure less common settings).
After you click Install, the installer installs the Ubuntu base system.

Remove the CD and press Enter to reboot the PC.

After the PC reboots, Ubuntu downloads and installs many more pack-
ages from online repositories. (Your PC needs to be connected to the
Internet for everything to work.)

The X Window System and the GNOME GUI are among the packages Ubuntu
downloads and installs. After these packages are installed and configured,
Ubuntu starts a GUI login screen, where you can log in using the user
account that you defined previously.

Congratulations! You can now start using Ubuntu!



Chapter 3: Installing Linux
on a Flash Drive

In This Chapter

v Creating a drive
v+ Troubleshooting the workstation

v+ Using the flash drive on a daily basis

was a fan of Live CD versions of Linux distributions for a while — but no

more. [ liked Live CDs because I could create cheap media that I could
distribute to students and users so they could enjoy the Linux experience
on their own machines without installing the operating system, changing
what they were comfortable with, or risking doing harm. In addition, this
same user group could quickly change from Fedora to Ubuntu to openSUSE
and more. My biggest dislikes of the Live CD were their incredibly slow
speed and the inability to save configuration changes easily. Given these
substantial issues, I've been seeking a better solution. Thankfully, I've found
it: bootable USB distributions.

Bootable USB distributions have been around for some time but have all

had weaknesses that prevented me from embracing them. Fedora’s Live USB
implementation, however, is the best I've encountered. It provides a simple
method for creation that most users can walk through unescorted, the instal-
lation process is nondestructive — allowing you to keep existing files on the
USB drive — and retaining changes (data persistence) is straightforward.

In this chapter, I show you how to create a bootable flash drive and use it in
your own setting.

Creating the Bootable Flash Drive

Although you can create a bootable flash drive using a number of command
line methods in Linux, the simplest technique uses Windows. (I realize that
it might sound like heresy to suggest making a Linux boot from Windows,
but most users interested in a Live USB implementation of Linux probably
run Windows.) Follow these steps to create a bootable flash drive:
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Creating the Bootable Flash Drive

1. Gotohttp://fedorahosted.org/liveusb-creator and download

the 1liveusb-creator program.
2. Install the liveusb-creator program.
3. Open the folder where 1liveusb-creator was installed.
4. Double-click the 1iveusb-creator program to run it.

You see the program shown in Figure 3-1.

"1 Fedora LiveUSB Creator

fedora® Do
Live USB Creator e .
Use existing Live CD Dowrload Fedora

— or  |Fedorad(ies6) v

Figure 3-1: Target Device Persistent Storage (0 M)

The Fedora E: (TravelDive) EN=NA

Live USB

Creator

simplifies

the creation

of the

bootable 0%

flash drive.

Create Live USE

. Under Target Device, select the flash drive.

For example, the flash drive in Figure 3-1 appears as TravelDrive.

. Choose where the image (the ISO file) will come from.

If you have a slow Internet connection, you can have one Live CD from
which you pull the ISO file. If you have a faster Internet connection, use
the download option to access a current ISO file.

. Set the Persistent Storage amount.

This is the amount of storage space allocated to the installation that will
always be available. | suggest a value of at least 300MB for the average
user. (I don’t know why this defaults to 0OMB.)

. Click the Create Live USB button and sit back.

You can watch the progress, as shown in Figure 3-2. Be prepared to wait
ten minutes for the process to complete. Two folders are created on the
drive: syslinux (less than 7MB and responsible for the booting) and
LiveOS (the size depends on your storage setting).

. Close the application and test the newly created bootable drive.



Figure 3-2:
The creation
process
takes about
ten minutes.
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"I Fedora LiveUSB Creator

fedora® -

Live USB Creator

Use existing Live CD Download Fedora

Target Device Persistent Storage (300 Mb)

E: (TravelDrive) [v] @ J

z‘é’%

Fedora-9-i686-Live. iso selected
erifying filesystem..,

Verifying SHAT of LiveCD image...
Extracting live image to U3E device. ..
Creating 300 Mb persistent averlay...
‘Configuring and installing bootloader...
Complete! (0:09:46)

100%

Create Live USE

Troubleshooting the Workstation

I experimented with a number of flash drives and failed to encounter a prob-
lem with any as long as 1GB of free space remained after the installation.
Smaller drives (2GB or less) are often factory formatted with FAT (file alloca-
tion table) and larger ones are formatted with FAT32; this did not make any
difference in installation or usability that I could ascertain.

You must be sure that the workstation settings will allow the machine to
boot from USB, which typically requires reconfiguring the BIOS. To begin,
reboot the workstation and press the key that takes you to the BIOS con-
figuration (usually F12 or DEL or sometimes F1 or F2). Choose the Boot
menu and enable the setting that reads Boot USB Devices First or some-
thing similar. On some computers, the flash drive is hidden under the hard
drive section of the boot BIOS. In this case, you need to choose Boot~>Hard
Drives, change the primary hard drive to the storage media, and then make
sure that the USB is the first choice listed under Boot Device. If the option
to boot from USB is Enable/Disable, select Enable and then go to the order
of boot devices and move the USB selection above the hard drive selection.
Save your changes and exit the BIOS configuration. At this point, the work-
station will continue with the reboot and — if your USB drive is plugged

in — should boot Fedora. Note: If you get the single line entry Boot Error
and nothing else happens, update the system BIOS per the manufacturer’s
instructions.
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Working Daily with the New Drive

Figure 3-3:
Working
within the
Live USB

environment.

When your system boots, the Fedora environment will load much more
quickly than it does with Live CDs. As shown in Figure 3-3, the USB drive
displays the new folders created on it, and other devices can be accessed as
usual. The Install to Hard Drive icon remains on the desktop, allowing for a
quick permanent transition to Fedora should you decide to do so.

To use the operating system, an Internet connection is not required on but
is strongly recommended because most users will want to download addi-
tional programs that allow them to test the operating system’s functionality
further.

£) Applications Places System Q@ % Fedora Live Fri Aug 8, 3:21 PM Eﬂ")

File Edit View Places Help
fedora@localhost:~

File Edit View Terminal Tabs Help
[fedora@localhost ~]$ df -h
Filesystem Size
/dev/mapper/live-rw 4.0G6
tmpfs 248M
gvfs-fuse-daemon 4.0G
/dev/sdbl 3.9G6
/dev/sdcl 497M
[fedora@localhost ~1$ i

Used Avail Use% Mounted on
2.26 1.96 54% /
48K 248M 1% /dev/shm
2.26 1.9G 54% /home/fedora/.gvfs
1006M 2.9G 26% /media/TravelDrive
25M  473M 5% /media/disk

| B fedora@localhost:~

E\ | TravelDrive
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Chapter 4: Troubleshooting
and Configuring Linux

In This Chapter

+ Troubleshooting the installation

v+~ Configuring the X Window System
+ Resolving installation problems

v~ Setting up your printers

» Managing your DVDs and CD-ROMs

v~ Installing additional software packages

During the installation of Linux, the installer attempts to detect key
hardware components, such as the SCSI controller and network card.
According to what it detects, the installer takes you through a sequence of
installation steps. For example, if the installer can’t detect the network card,
it skips the network configuration step. This is okay if you don’t in fact have
a network card, but if you do have one and the installer mistakenly insists
that you don’t, you have an installation problem on your hands.

Another installation problem occurs when you restart the PC and see not
the graphical login screen but a text terminal. This error means that some-
thing is wrong with the X Window System configuration.

In addition, the Linux installation typically doesn’t include configuration
procedures for every piece of hardware on your PC system. For example,
most installations don’t set up printers during installation.

In this chapter, | show you some ways to troubleshoot installation prob-
lems. You find out how to configure X Window System to start with a GUI
screen and how to configure a printer.

You may also have to install additional software packages from the compan-
ion DVD-ROM. [ show you how to install packages in different formats, such
as the Red Hat Package Manager (RPM) and Debian package — the two
formats in which most Linux software is distributed.
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Using Text Mode Installation

Using Text Mode Installation

Most Linux installers attempt to use the X Window System (X) to display the
graphical installation screens. If, for instance, the installer fails to detect a
video card, X does not start. If — for this reason or any other reason — the
installer fails to start X, you can always fall back on a text mode installation.
Then you can specify the video card manually or configure X later by using a
separate configuration program. You can also configure X by editing its text
configuration file.

Table 4-1 lists how you can get to the text mode installation from the initial
installer screen for the Linux distributions included on this book’s DVD.
Typically, the text mode installation sequence is similar to that of the graphi-
cal installation that I outline in Chapter 2 of this minibook. You respond to
the prompts and perform the installation.

Table4-1 Text Mode Installation in Some Linux Distributions

Distribution How to Get to the Text Mode Installer

Debian Runs in text mode by default.

Fedora Type text atthe boot : prompt after you start the PC from
the Fedora CD or DVD.

Knoppix Start Knoppix in text mode by typing knoppix 2 atthe

boot : prompt (because Knoppix is a Live CD distribution, you
don’t have to install it).

SUSE At the first installation screen, press F3, use the arrow keys to
select the text mode option, and then press Enter.

Ubuntu Runs in text mode by default.

Xandros Hold down the Shift key while booting the CD and select Rescue

Console. When the bash-3 . 00# prompt appears, type
quick_install and follow the instructions.

Troubleshooting X

Every time I installed Linux on an older PC, the GUI installation worked fine
during installation, but then the graphical login screen didn’t appear when I
rebooted the PC for the first time after installation. Instead, | ended up with
a text login screen or a black screen with a small X in the middle, or the boot
process seemed to hang with a gray screen. If this problem happens to you,
here’s how you can troubleshoot it:
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Troubleshooting X 4 /

Press Ctrl+Alt+Delete to reboot the PC.

The PC starts to boot. You get to a screen where GRUB (GRand Unified
Bootloader) prompts you for the operating system to boot. (If the distri-
bution uses LILO as the boot loader, you get a text prompt.)

For GRUB, press the A key to add an option that tells the Linux kernel
to boot to a prompt. For LILO, skip this step.

The GRUB boot loader then displays a command line for the Linux
kernel and prompts you to add what you want.

For GRUB, type a space followed by the word single and press Enter.
For LILO, type linux single and press Enter.

The Linux kernel boots in a single-user mode and displays a prompt that
looks like the following:

sh-3.00#

Now you’re ready to configure X.

X uses a configuration file (XF86Config-4 or xorg.conf, depending on the
distribution) to figure out your display card, your monitor, and the kind of
screen resolution you want. The Linux installer prepares the configuration
file, but sometimes the configuration isn’t correct.

To quickly create a working configuration file, follow these steps:

1.

Type the following command:
X -configure

The X server runs and creates a configuration file. The screen goes blank
and then the X server exits after displaying some messages. In Fedora,
the last line of the message says the following:

To test the server, run 'X -config ///etc/xorg.conf.new'

Use a text editor, such as vi, to edit the ///etc/xorg.conf .new file
and insert the following line after the line Section "Files":

FontPath "unix/:7100"
In Fedora, you must also change /dev/mouse to /dev/input/mice.
Type xfs & to start the X font server.
Try the new configuration file by typing X -config ///etc/xorg.conf.new.

If you see a blank screen with an X-shaped cursor, the configuration file
is working fine.

Press Ctrl+Alt+Backspace to kill the X server.

Copy the new configuration file to the /etc/X11 directory with the
following command:

cp ///etc/xorg.conf.new /etc/X1ll/xorg.conf
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Resolving Other Installation Problems

7. Reboot the PC by pressing Ctrl+Alt+Delete or typing reboot.

If all goes well, you should get the graphical login screen.

The X configuration file created by using the -configure option of the X
server does not display at the best resolution. To fine-tune the configuration
file, you have to run a utility to adjust the display settings after you reboot
the system. Which utility you use depends on the Linux distribution, but
most distributions include a utility that enables you to configure the video
card, monitor, and display settings through a graphical user interface.

Resolving Other Installation Problems

3

I'm sure | haven’t exhausted all the installation problems lurking out there.
No one can. So many components in Intel x86 PCs exist that Murphy’s Law
practically requires that there be some combination of hardware that the
installation program can’t handle. In this section, I list a few known prob-
lems. For others, I advise you to go to Google Groups (http://groups.
google.com) and type some of the symptoms of the trouble. Assuming that
others are running into similar problems, you can get some indication of
how to troubleshoot your way out of your particular predicament.

Using Knoppix boot commands

The Knoppix Live CD can be a great troubleshooting tool because Knoppix is
good at detecting hardware and can be run directly from the CD.

If you have trouble starting Knoppix, try entering Knoppix boot commands
at the boot : prompt. For example, if Knoppix seems to hang when trying to
detect a SCSI card, you can disable SCSI probing by typing knoppix noscsi
at the boot : prompt. Or, if you want the X server to load the nv module

(for graphics cards based on the NVIDIA chipset), you can type knoppix
smodule=nv at the boot: prompt.

Table 4-2 lists some commonly used Knoppix boot commands.

Table 4-2 Some Common Knoppix Boot Commands
Boot Command What It Does
expert Starts in expert mode, which enables the user to

interactively set up and configure Knoppix.

failsafe Boots without attempting to detect hardware
(except for the bare minimum needed to start Linux).
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Boot Command

What It Does

fb1280x1024 Uses fixed framebuffer graphics at the specified
resolution (specify the resolution you want, such as
1024 x 768 or 800 x 600).

knoppix 1 Starts Knoppix in run level 1 (single-user mode),
which you can use to perform rescue operations.

knoppix 2 Starts at run level 2, which provides a text mode

shell prompt only.

knoppix acpi=off

Disables ACPI (Advanced Configuration and Power
Interface) completely.

knoppix atapicd

Uses the ATAPI CD-ROM interface instead of
emulating a SCSI interface for IDE CD-ROM drives.

knoppix
desktop=wmname

Uses the specified Window Manager instead of the
default KDE desktop=wmname (where wmname
is f luxbox, icewm, kde, larswm, twm,
wmaker, or xfce).

knoppix dma

Enables direct memory access (DMA) for all
IDE drives.

knoppix
floppyconfig

Runs the shell script named knoppix. sh from a
floppy. (The shell script contains Linux commands
that you want to run.)

knoppix fromhd=/
dev/hdal

Boots from a previously copied image of Live CD
that's in the specified hard drive partition.

knoppix hsync=80

Uses an 80 kHz horizontal refresh rate for X (enter
the horizontal refresh rate you want X to use).

knoppix lang=xx

Sets the keyboard language as specified by the
two-letter code xx (where xxis cn = Simplified
Chinese, de = German, da = Danish, es = Spanish,
fr =French, it = ltalian, n1 = Dutch, p1 = Polish,
ru = Russian, sk = Slovak, tr = Turkish, tw =
Traditional Chinese, or us = U.S. English).

knoppix mem=256M

Specifies that the PC has the stated amount of
memory (in megabytes).

knoppix myconf=/
dev/hdal

Runs the shell script knoppix. sh fromthe /
dev/hdal partition (enter the partition name
where you have the knoppix. sh file).

knoppix
myconf=scan

Causes Knoppix to search for the file named
knoppix. sh, scan, and execute the commands in
thatfile, if it exists.

knoppix noeject

Does not eject the Live CD after you halt Knoppix.

(continued)
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Table 4-2 (continued)

Boot Command

What It Does

knoppix noprompt

Does not prompt to remove the Live CD after you
halt Knoppix.

knoppix nowheel

Forces the PS/2 protocol for a PS/2 mouse or
touchpad (as opposed to the mouse being detected
automatically).

knoppix noxxx

Causes Knoppix to skip specific parts of the hard-
ware detection (where xxx identifies the hardware
or server that should not be probed: apic =
Advanced Programmable Interrupt Controller, agp =
Accelerated Graphics Port, apm = Advanced Power
Management, audio = sound card, ddc = Display
Data Channel, dhcp = Dynamic Host Configuration
Protocol, £stab =file system table, firewire =
IEEE 1394 high-speed serial bus, pcmcia = PC
Card, scsi = Small Computer System Interface,
swap = hard drive space used for virtual memory,
usb = Universal Serial Bus).

knoppix pci=bios

Uses BIOS directly for bad PCI controllers.

knoppix
pnpbios=off

Skips the Plug and Play (PnP) BIOS initialization.

knoppix
screen=resolution

Sets the screen resolution in pixels (where
resolutionisthe resolution you want, such as
1024x768,800x600, 640x480, and so on).

knoppix testcd

Checks the data integrity of the Live CD by using the
MD5 sum.

knoppix tohd=/
dev/hdal

Copies the Live CD to the specified hard drive parti-
tion and runs from there (requires 1GB of RAM).

knoppix toram

Copies the Live CD to RAM (memory) and runs from
there (requires 1GB of RAM).

knoppix vga=ext

Uses a 50-line text mode display.

knoppix vsync=60

Uses a vertical refresh rate of 60 Hz for X (enter the
vertical refresh rate you want X to use).

knoppix Enables the IMPS/2 protocol for wheel mice.
wheelmouse
knoppix Causes the X server to load the module specified

xmodule=modname

by modname so that X works on your video card
(where modnameis ati, fbdev, 1810, mga, nv,
radeon, savage, svga, 0r s3).

knoppix
Xserver=progname

Starts the X server specified by progname (where
progname is XFree86 or XF86_SVGA).
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When you want to issue multiple Knoppix boot commands, simply combine
them in a single line. For example, to specify that you want to skip the SCSI
auto detection, turn off ACPI, use the U.S. keyboard, use a wheel mouse, and
require the X server to load the nv module, enter the following at the boot :
prompt:

knoppix noscsi acpi=off lang=us wheelmouse xmodule=nv

The fatal signal 11 error

During installation, some people get a fatal signal 11 error message, which
stops the process cold. This error usually happens past the initial boot
screen as the installer is starting its GUI or text interface. The most likely
cause of a signal 11 error during installation is a hardware error related to
memory or the cache associated with the CPU (microprocessor).

A signal 11, or SIGSEGV (short for Segment Violation Signal), error can occur
in Linux applications. A segment violation occurs when a process tries to
access a memory location that it’s not supposed to access. The operat-

ing system catches the problem before it happens and stops the offending
process by sending it a signal 11. When that happens during installation, it
means the installer made an error while accessing memory, and the most
likely reason is a hardware problem. A commonly suggested cure for the
signal 11 problem is to turn off the CPU cache in the BIOS. To do so, you
have to enter Setup while the PC boots (by pressing a function key, such

as F2) and turn off the CPU cache from the BIOS Setup menu.

If the problem is due to a hardware error in memory (in other words, the
result of bad memory chips), you can try swapping the memory modules
around in their slots. You may also consider replacing an existing memory
module with another memory module if you have one handy.

You can read more about the signal 11 problem at www.bitwizard.nl/
sigll.

Getting around the PC reboot problem

On some PCs, when you press Enter at the boot prompt, the initial Linux
kernel loads and immediately reboots the PC. This could be due to a bad
implementation of ACPI in the PC’s BIOS. To bypass the problem, type
linux acpi=off at the boot prompt to turn off ACPI. If that doesn’t work,
consult Table 4-3 for other boot options that you might want to try.

Using Linux kernel boot options

When you boot the PC for Linux installation, either from the DVD or the first
CD-ROM, you get a text screen with the boot : prompt. Typically, you press
Enter at that prompt or do nothing, and the installation begins shortly. You
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can, however, specify a variety of options at the boot : prompt. The options
control various aspects of the Linux kernel startup, such as disabling sup-
port for troublesome hardware or starting the X server using a specific X
driver module. Some of these boot options can be helpful in bypassing prob-
lems that you may encounter during installation.

To use these boot options, typically you type 1inux followed by the boot
options. For example, to perform text mode installation and tell the kernel
that your PC has 512MB of memory, you type the following at the boot :
prompt:

linux text mem=512M

Consult Table 4-3 for a brief summary of some of the Linux boot options. You
can use these commands to turn certain features on or off.

Although I mention these Linux kernel boot commands in the context of
troubleshooting installation problems, you can use many of these com-
mands anytime you boot a PC with any Linux distribution and you want to
turn specific features on or off.

Table 4-3 Some Linux Boot Options

Boot Option What It Does

allowcddma Enables DMA for CD/DVD drive.

apic Works around a bug commonly encountered in the

Intel 440GX chipset BIOS and only executes with
the installation program kernel.

acpi=off Disables ACPIl in case there are problems with it.

dd Prompts for a driver disk during the installation of
Red Hat Linux.

display=IP_ Causes the installer GUI to appear on the remote

address: 0 system identified by the IP address. (Make sure

that you run the command xhost +hostname
on the remote system where hostname is the
host where you run the installer.)

driverdisk Prompts for a driver disk during the installation of
Red Hat Linux.
enforcing=0 Turns off Security Enhanced Linux (SELinux) man-

datory access control.

expert Enables you to partition removable media and
prompts for a driver disk.
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Boot Option

What It Does

ide=nodma

Disables DMA on all IDE devices and can be useful
when you're having IDE-related problems.

ks

Configures the Ethernet card using DHCP and runs
a kickstart installation by using a kickstart file from
an NFS server identified by the boot server param-
eters provided by the DHCP server.

ks=kickstartfile

Runs a kickstart installation by using the kickstart
file, specified by kickstartfile.(Theidea
behind kickstart is to create a text file with all the
installation options and then kickstart the installa-
tion by booting and providing the kickstart file as
input.)

lowres Forces the installer GUI to run at a lower resolution
(640 x 480).
mediacheck Prompts you to check the integrity of the CD image

(also called the ISO image). The image is checked
by computing the MD5 checksum and compar-
ing that with the official Fedora value. Checking a
CD-ROM can take a few minutes.

mem=xxxM

Overrides the amount of memory that the kernel
detects on the PC. (Some older machines could
detect only 16MB of memory, and on some new
machines, the video card may use a portion of the
main memory.) Make sure you replace xxx with
the number representing the megabytes of memory
on your PC.

nmi_watchdog=1

Enables the built-in kernel deadlock detector that
makes use of Non-Maskable Interrupt (NMI).

noapic

Prevents the kernel from using the Advanced
Programmable Interrupt Controller (APIC) chip.
(You can use this command on motherboards
known to have a bad APIC.)

nofirewire

Does not load support for FireWire.

noht

Disables hyper-threading, which is a feature that
enables a single processor to act as multiple vir-
tual processors at the hardware level.

nomce

Disables self-diagnosis checks performed on the
CPU by using Machine Check Exception (MCE). On
some machines, these checks are performed too
often and need to be disabled.

nomount

Does not automatically mount any installed Linux
partitions in rescue mode.

(continued)
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Table 4-3 (continued)

Boot Option

What It Does

nopass

Does not pass the keyboard and mouse informa-
tion to stage 2 of the installation program.

nopcmcia

Ignores any PCMCIA controllers in system.

noprobe

Disables automatic hardware detection and
instead prompts the user for information about
SCSI and network hardware installed on the PC.
You can pass parameters to modules by using this
approach.

noshell

Disables shell access on virtual console 2 (the one
you get by pressing Ctrl+Alt+F2) during installation.

nousb

Disables the loading of USB support during the
installation. (Booting without USB support may be
useful if the installation program hangs early in the
process.)

nousbstorage

Disables the loading of the usbstorage module
in the installation program’s loader. This option
may help with device ordering on SCSI systems.

reboot=b

Changes the way the kernel tries to reboot the
PC so that it can reboot even if the kernel hangs
during system shutdown.

pci=noacpi

Causes the kernel to not use ACPI to route inter-
rupt requests.

pci=biosirg

Causes the kernel to use BIOS settings to route
interrupt requests (IRQs).

rescue

Starts the kernel in rescue mode, where you get a
shell prompt and can try to fix problems.

resolution=HHHXVVV

Causes the installer GUI to run in the specified
video mode (where HHH and VvV are stan-
dard resolution numbers, such as 640x480,
800x600,0r 1024x768).

selinux=0

Disables the SELinux kernel extensions.

serial Turns on serial console support during installation.

skipddc Skips the Display Data Channel (DDC) probe of
monitors. (This option is useful if probing causes
problems.)

vnc Starts a VNC (Virtual Network Computing) server

so that you can control the GUI installer from
another networked system that runs a VNC client.
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Setting Up Printers

Figure 4-1:
The primary
printer
configur-
ation
interface.

In most Linux distributions, you can set up printers only after you install the
distribution. The following sections outline the printer configuration steps
for Ubuntu and are similar for all distributions.

To set up a printer, follow these steps:

1. From the GNOME desktop, choose System=>Administration=>Printing.

If you're not logged in as root, the printer configuration tool prompts
you for the root password. The printer configuration tool, shown in
Figure 4-1, is called system-config-printer.

Server Printer Group View Help

dhadd v @ Filter: [Q 4]

Connected to localhost

2. Click the Add button to configure a new printer.

If the device can be identified, it will appear in the list. If it can’t be iden-
tified, you can still continue with the installation and manually add the
drivers and configuration data needed. Figure 4-2 shows that the Epson
Stylus printer has been identified as connected to the USB port.
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Select Device

Devices

Other
+ Network Printer

Description
A printer connected to a USB port.

Figure 4-2:
You can
install a
local printer
or a network
printer using
the same
interface. Cancel || Forward
3. Click Forward to continue.
The system will search for drivers and offer choices based on what it
thinks you’re installing.
In the following example, the host is connecting to a local printer.
4. Select the appropriate driver (see Figure 4-3), and then click Forward.
Choose Driver
© Select printer from database
) Provide PPD file
) Search for a printer driver to download
The foomatic printer database contains various manufacturer provided PostScript
Printer Description (PPD) files and also can generate PPD files for a large number of
(non PostScript) printers. But in general manufacturer provided PPD files provide better
access to the specific features of the printer.
Makes ~
Compaq
Dai
DEC D
Dell
—
Figure 4-3: Fujifilm
Choose the Fujitsu
: Genicom
appr
pp OPrIate Gestetner @
drivers to
install.

Back H Cancel || Forward
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5. Enter the printer name and description variables (see Figure 4-4), and
then click Apply.

Both the description and location variables are optional, but are helpful
if you are configuring this for access by others across the network.

Describe Printer

Printer Name
Short name for this printer such as "laserjet"

|EPSON-Epson-Stylus-NX510 |

Description (optional)
Human-readable description such as "HP Laserjet with Duplexer"

|EPSON Epson Stylus NX510 |

Location (optional)
Human-readable location such as "Lab 1"

Figure 4-4:
The only
required
configur-
ation value
is the printer
name.

‘ubuntu ‘

Back Cancel Apply

Figure 4-5:
Edit the
configur-
ation with
the printer
configur-
ation tool.

6. Print a test page to make sure all is working as it should.

Make any modifications to the settings as needed using the configura-
tion options, which are shown in Figure 4-5.

7. When the printer is configured as it should be, exit the printer
configuration tool.

Settings Settings

Policies Description: |EPSON Epson Stylus NX510 |
Access Control

Printer Options Location: ‘ ubuntu ‘
Job Options Device URI: |usb:/EPSON/Stylus%20NX510 | | Change...

Ink/Toner Levels
Make and Model: Epson Stylus NX515 - CUPS+Gut... | Change...

Printer State: Idle - Finished page 1...
Tests and Maintenance

Print Test Page Print Self-Test Page| | Clean Print Heads

Apply Cancel OK
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Managing DUDs and CD-ROMs
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The GUI desktop makes using DVDs and CD-ROMs in Linux easy. Just place a
DVD or a CD-ROM in the drive, and an icon appears on the desktop.

You can then access the CD or DVD by double-clicking the icon on the desk-
top. In some Linux distributions, the GUI automatically opens the contents of
a CD or DVD in a file manager window soon after you insert the CD or DVD in
the drive. To access the files and folders, you simply double-click the icons
that appear in the GUI file manager window.

If you see a DVD/CD-ROM icon, right-click that icon for a context menu. From
that menu, you can eject the CD or DVD when you're finished.

The Knoppix desktop displays icons for each detected drive. To open a CD
or DVD, simply click the icon for that drive. In SUSE, click the My Computer
icon and click the icon for the DVD/CD drive. Ubuntu and Fedora open

the CD/DVD in a Nautilus window and also place an icon on the desktop.
Xandros Desktop opens the CD/DVD in a Xandros File Manager window.

Installing Other Software

NBER
@&
&

The exact steps for installing software depend on the type of package in
which the software is distributed. Most Linux software comes in either an
RPM file or a Debian package file. The RPM files have an . rpm extension, and
the Debian packages have a . deb extension.

Most distributions provide GUI installers to ease the process of installing
new software packages. In this section, I provide a quick overview of adding
software in Debian, Fedora, SUSE, and Xandros. You typically do not add
software to Knoppix (or any other Live CD distribution) because Live CD dis-
tributions run from CD-ROM.

Fedora and SUSE use RPM packages. Debian, Ubuntu, and Xandros are all
Debian-based distributions, and as expected, they typically use Debian pack-
ages (also called DEB files). However, both RPM and DEB packages can be
installed in any Linux distribution.

Installing software in Debian and Ubuntu

The best way to manage software packages in Debian and Debian-based dis-
tributions, such as Ubuntu, is to use APT — the Advanced Packaging Tool —
which you usually control through the apt-get command.
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When you install Debian, one of the last steps is to configure the sources for
APT. The APT sources are the Internet servers (both FTP and Web) where
APT looks for software packages to download and install on your system.
Assuming that APT is properly configured and that your system has a high-
speed Internet connection, you can begin installing any package by typing
the following command in a terminal window:

apt-get install pkgname

where pkgname is the name of the package that you want to install. If you
don’t know the package name, start by typing the following command in the
terminal window:

apt-cache search keyword

where keyword is related to the package you want to install. For example,
to search for a package that has the word screenshot in its description and
also contains the word KDE, I'd type the following. (I use grep to search the
output for occurrences of the text KDE.)

apt-cache search screenshot | grep KDE
This command then prints the following line as the result:
ksnapshot - Screenshot application for KDE

This shows that the ksnapshot package is what [ need. If this package was
not yet installed, I could then install it by typing the following command:

apt-get install ksnapshot

That, in a nutshell, is how you can use the command-line tools to look for
and install packages in Debian.

Debian and Ubuntu also come with a GUI package installer for APT called
Synaptic Package Manager, whose use is intuitive:

4+ Debian: Depending upon your version, you will either choose
Applications=>System Tools=>Synaptic Package Manager from the
GNOME desktop or Desktop=>Administration=>Synaptic Package
Manager.

4+ Ubuntu: Choose Select Systemr>Administration=>Synaptic Package
Manager. When prompted for a password in Ubuntu, enter your normal
user password because Ubuntu has no root user.
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After Synaptic Package Manager starts, it displays a Quick Introduction
dialog box that tells you, briefly, how to mark packages for installation,
upgrade, or removal, and how to get to the menu to perform these actions.
After reading the Introduction, click Close to get rid of that dialog box and
access the Synaptic Package Manager (see Figure 4-6).

File Edit Package Settings Help
Quick search

P
e
Reload

i)
Mark All Upgrades  ~pply

1)
m
m

Databases
Debug

043 abiword-plugin-grammar
[+ abiword-plugin-mathview

2.8
2.8,

~ (s Package Installed Version  Late _
Communication |_J [ 4 abiword : 2.8 U
Cross Platform [7) i abiword-common (28.

Development
Documentation

e — D

~ || No package is selected.

e ?
| Sections
Figure 4-6: Status
The Origin
Syn a ptl ¢ Custom Filters
Package
Manager Search Results

6761 packages listed, 1327 installed, 0 broken. 0 to install/upgrade, 0 to remove

If your package information is older than 48 hours, another dialog box
prompts you to update the package information. Click Reload in that dialog
box. Synaptic Package Manager then downloads the latest package informa-
tion, closes the dialog box, and displays information about the packages in
the main window.

By clicking the categories on the left side of the Synaptic Package Manager
window, you can view lists of various categories of packages on the right
side of the window. A box to the left of each package indicates whether the
package is installed or not. If you click the package name, Synaptic Package
Manager displays information about the selected package in the lower-right
part of the window.

To select a package for installation or removal, click the box to the left of its
name and choose Mark for Installation or Mark for Removal from the pop-up
menu that appears. If selecting a package for installation requires other
packages, Synaptic Package Manager displays a dialog box with that infor-
mation, and you can click Mark to install the required packages also. Mark
as many packages as you want and click Apply on the toolbar to perform all
marked actions.
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Installing software in Fedora

Most Fedora software comes in the form of RPM files. An RPM (Red Hat Package
Manager) file is basically a single package that contains everything — all the
files and configuration information — needed to install a software product.

From the GNOME desktop, you use the Add or Remove Software utility —
a graphical utility for installing and uninstalling RPMs. Follow these steps:

1. Choose System=>Administration=>Add/Remove Software.

If you're not logged in as root, a dialog box prompts you for the root
password. The Add or Remove Packages utility starts and gathers infor-
mation about the status of packages installed on your system. After it
sorts through the information about all the installed packages, the utility
displays the Package Manager dialog box, which contains a list of all the
packages, as shown in Figure 4-7.

(& BEE
System Filters Help
O Libraries for augeas 8
B augeas-libs-0.7.0-1.fc12 (i686) EI
& mckoge collectons ||| (T Audtlo mbxer based o ncurses
r:) Newest packages ’ ’

4 selecespcages || (1] 4,500 oL o svtomaticalyconfguring seurce code

Admin tools German autocorrection rules

‘€ GNOME desktop U autocorr-de-1:3.1.1-19.28.fc12 (noarch)
—— KDE desktop Polish autocorrection rules

. Other desktops o autocorr-pl-1:3.1.1-19.28.fc12 (noarch)

Flgure 4-7' P& XFCE desktop ul Slovak autocorrection rules ol
Package Eiiication R R U PR B e &

[ Fonts
Manager ﬂ Games
dlsplays the B Graphics (=]
packages @ querying
available. e e

2. To install an uninstalled package group, select the check box to the

left of that package group’s name.

3

For partially uninstalled package groups, click the Details link (or the
Optional Packages button) that appears in a column to the right of the
package name.

A dialog box appears with details of the packages in the package group.

3. In the dialog box, select the packages that you want to install or remove
by clicking the names, and then click Close to exit the dialog box.
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You return to the Package Management dialog box, and if you added or
removed any package, the Update (or Apply) button becomes active.

Click the Update (or Apply) button to update the packages based on
any additions or removals you made in the lists of packages.

Installing software in SUSE

In SUSE, follow these steps to install or remove software:

1.

From the main menu, choose YaST to start the YaST Control Center.

The YaST Control Center displays categories of tasks on the left side and
specific tasks for that category on the right side.

Click the Software category on the left side so that the right side
shows the options for software.

Click the Software Management icon on the right side.

YaST displays a new window where you can search for software
packages.

Search for a package by name or select a package by browsing
available packages.

To search for a package by name, type a keyword in the Search field in
the upper-left corner of the window and then click Search. YaST displays
the matching packages on the right side of the window. To browse for
packages, click Filter in the upper-left corner, select Package Groups
from the drop-down list, and click a group to see the list of individual
packages in that group.

Click the Accept button in the bottom-right corner to begin installing
selected packages.

YaST checks for dependencies — if a package requires other packages
to install correctly — before installing packages. If you want to view
what changes would occur when you click Accept, click Filter and select
Installation Summary.

Installing software in Xandros

Xandros Desktop OS comes with Xandros Networks, which enables you to
buy software online as well as install software from a CD or DVD. To start
Xandros Networks, double-click the Xandros Networks icon on the Xandros
desktop. Xandros Networks starts, connects to a Xandros server, and dis-
plays information about installed, updated, and new applications.
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To look at the list of new applications, click the plus sign to the left of the
New Applications label on the left side of the Xandros Networks window.
You get a further list of application categories. If you click a category, the
right side of the window displays the names of packages within that cat-
egory. You can then select a package or an entire category for installation.

To install any selected software packages, choose Filew>Enter Administrator
Mode. You're prompted for the administrator (root) password. After enter-
ing the root password, you can choose File=Install Selected Applications.
Xandros Networks checks for dependencies, prompts you if any further
information is needed, and downloads and installs the new software.

If you've downloaded a Debian package, you can install it by choosing Filer>
Install DEB File from the Xandros Networks menu. Similarly, the menu choice
Filew>Install RPM File installs an RPM package.
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Chapter 5: Trying Out Linux

In This Chapter

v~ Starting Linux and logging in
1 Getting familiar with the shell
v~ Shutting down the system

ou're sitting in front of your PC about to turn it on. You know that the

PC has Linux installed. (Maybe you did the installing yourself, but
who’s keeping track?) You're wondering what to expect when you turn it on
and what you do afterward. Not to worry. If you're using Linux for the first
time, this chapter shows you how to log in, check out the graphical desk-
tops, try out some cryptic Linux commands, and finally, shut down the PC.

If you try out the Ubuntu Live CD, all you have to do is boot from the Ubuntu
Live CD (as explained in Chapter 2 of this minibook), and you can try it just
like any other Linux distribution.

For those of you who already know something about Linux, flip through this
chapter to see if anything looks new. You never know what you may not
know!

Starting Linux

SPEc,
S =%

7,

STRBY,

When you turn on the PC, it goes through the normal power-up sequence
and loads the boot loader — GRUB or LILO, depending on your Linux distri-
bution and what you select during installation. The boot loader (once known
as the bootstrap loader) is a tiny computer program that loads the rest of
the operating system from the hard drive into the computer’s memory. The
entire process of starting a computer is called booting.

For Live CDs, the boot loader is typically ISOLINUX, a boot loader designed
to work from an ISO 9660 CD-ROM.

The LILO and GRUB boot loaders display a graphical screen with the names
of the operating systems that the boot loader can load. For example, if your
PC has Windows and Linux, you see both names listed. You can then use
the up- and down-arrow keys to select the operating system you want to
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use. If the PC is set up to load Linux by default, wait a few seconds, and the
boot loader starts Linux. To be more precise, the boot loader loads the Linux
kernel — the core of the Linux operating system — into the PC’s memory.

Other boot loaders, such as ISOLINUX, may display a text boot : prompt at
which you can type boot commands to load specific operating systems and
to pass options to that operating system.

While the Linux kernel starts, you see a long list of opening messages, often
referred to as the boot messages. (You can see these messages at any time
by typing the command dmesg in a terminal window.) These messages
include the names of the devices that Linux detects. One of the first lines in
the boot messages reads

Calibrating delay loop . . . 4997.12 BogoMIPS (1lpj=2498560)

BogoMIPS is Linux jargon (explained in this chapter in a handy sidebar) for
a measure of time. The number that precedes BogoMIPS depends on your

PC’s processor speed, whether it’s an old 200 MHz Pentium or a new 4 GHz
Pentium 4. The kernel uses the BogoMIPS measurement when it has to wait
a small amount of time for some event to occur (such as getting a response
back from a disk controller when it’s ready).

After the boot messages display, some Linux distributions, such as Fedora,
switch to a graphical boot screen that shows information about the progress
of system startup. When you boot some Linux distributions, such as Fedora
and Xandros Desktop OS, for the first time after installation, you get a con-
figuration program that guides you through some configuration steps, such
as setting the date and time and adding user accounts. To complete such
first-time configuration steps, all you have to do is enter the requested
information.

After Linux boots, you typically get a graphical login screen. For some distri-
butions, such as Knoppix, you get the desktop without having to log in as a
user. On other Live CDs, you have to log in.

Figure 5-1 shows the Ubuntu desktop after [ booted a PC from the Ubuntu Live
CD. For some distributions, you might be logged in automatically. For others,
a graphical login screen will appear asking you to authenticate with the user-
name and password given during (or at any time after) the installation.

Every distribution utilizes the root username, which happens to be the
superuser (the administrator account). Whether you install Linux yourself or
someone installs it for you, you need to know the root password. Without
that, you can’t do many of the tasks necessary to find out how Linux works.
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Live CD
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When Linux boots, you get a message that
saysCalibrating delay loop .
4997.12 BogoMIPS (1lpj=2498560),
with some number before the word BogoMIPS.
BogoMIPS is one of those words that con-
founds new Linux users, butit's just jargon with
a simple meaning.

BogoMIPS is Linus’s invention (yes, the same
Linus Torvalds who started Linux), and it means
bogus MIPS. As you may know, MIPSis an acro-
nym for millions of instructions per second —
a measure of how fast your computer runs pro-
grams. Unfortunately, MIPS isn't a very good
measure of performance; the MIPS measure-
ments of different types of computers are dif-
ficult to compare accurately. BogoMIPS is

What are BogoMIPS and LPJ?

basically a way to measure the computer’s
speed that's independent of the exact proces-
sor type. Linux uses the BogoMIPS number to
calibrate a delay loop, in which the computer
keeps running some useless instructions until a
specified amount of time passes. The reason for
killing valuable processor time like this is to wait
for some slowpoke device to get ready for work.

Oh . .. about LPJ — it's a recent term that
stands for loops per jiffy, and it's another mea-
sure of time delay used by the kernel. The Linux
kernel considers time in increments of jiffies,
and a jiffy is defined as the time period that is
equal to one second divided by the value of a
kernel variable named HZ. In other words, HZ
jiffies are in each second.
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Playing with the Shell

You shouldn’t normally log in as root. When you log in as root, you could
accidentally damage your system because you can do anything when you’re
root. Always log in as a normal user. When you need to perform any task
as root, type su - in a terminal window and enter the root password.

In Ubuntu, you define only a normal user account; Ubuntu doesn’t give you
the opportunity to define a root user account. Whenever you want to per-
form any tasks that require you to be root, you have to use the sudo com-
mand (an abbreviation for “superuser do”). The default password for root
is the one you gave during the installation of the operating system.

To log in as user spiderman, for example, type spiderman in the first text
field and press Enter. (Move the cursor to the login dialog box before you
begin typing.) Then type spiderman’s password and press Enter. You then
see the initial graphical user interface (GUI). What you get depends on your
choice of GUl — GNOME or KDE. If someone made the choice for you, don’t
worry — GNOME and KDE are both quite good and versatile.

Chapters 1 and 2 in Book II explore the GUI desktops — first GNOME and
then KDE. This section focuses on the command line — the only interface
you’ll have access to if you experience problems loading a graphical desktop.

Playing with the Shell

Linux is basically UNIX, and UNIX just doesn’t feel like UNIX unless you can
type cryptic commands in a text terminal. Although GNOME and KDE do

a lot to bring us into the world of windows, icons, mouse, and pointer —
affectionately known as WIMP — sometimes you're stuck with nothing but
a plain text screen with a prompt that looks something like this (when you
log in as edulaney):

edulaney@linux:/etc>

You see the text screen most often when something is wrong with the X
Window System, which is essentially the machinery that runs the windows
and menus that you normally see. In those cases, you have to work with the
shell and know some cryptic Linux commands.

You can prepare for unexpected encounters with the shell by trying some
Linux commands in a terminal window while you're in the GNOME or KDE
GUI. After you get the hang of using the terminal, you might even keep a ter-
minal window open so you can use one of those cryptic commands — simply
because it’s faster than pointing and clicking. Those two-letter commands do
pack some punch!



Figure 5-2:
The terminal
window
awaits your
input.
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Starting the bash shell

Simply put, the shell is the Linux command interpreter — a program that
reads what you type, interprets that text as a command, and does what the
command is supposed to do.

Before you start playing with the shell, open a terminal window. In either
GNOME or KDE, the panel typically includes an icon that looks like a moni-
tor. When you click that icon, what appears is a window with a prompt, like
the one shown in Figure 5-2. That’s a terminal window, and it works just like
an old-fashioned terminal. A shell program is running and ready to accept
any text that you type. You type text, press Enter, and something happens
(depending on what you typed).

ubuntu@ubuntu: ~ =[]
File Edit View Terminal Help
To run a command as administrator (user "roet"), use "sudo <command>".
See "man sudo root" for details.

ubuntu@ubuntu:~$ []

3

If the GNOME or KDE panel on your desktop doesn’t seem to have an icon

that starts a terminal or shell window, search through the Main menu hier-
archy and you should be able to find an item labeled Console or Terminal.

Choosing that item should then open a terminal window.

The prompt that you see depends on the shell that runs in that terminal
window. The default Linux shell is bash (which stands for Bourne-Again
SHell).

bash understands a host of standard Linux commands, which you can use
to look at files, go from one directory to another, see what programs are run-
ning (and who else is logged in), and a whole lot more.

In addition to the Linux commands, bash can run any program stored in an
executable file. bash can also execute shell scripts — text files that contain
Linux commands.
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Playing with the Shell

Understanding shell commands

Because a shell interprets what you type, knowing how the shell figures out
the text that you enter is important. All shell commands have this general
format:

command optionl option2 . . . optionN

Such a single line of commands is commonly called a command line. On

a command line, you enter a command followed by one or more optional
parameters (or arguments). Such command-line options (or command-line
arguments) help you specify what you want the command to do.

One basic rule is that you have to use a space or a tab to separate the com-
mand from the options. You also must separate options with a space or a
tab. If you want to use an option that contains embedded spaces, you have
to put that option within quotation marks. For example, to search for two
words of text in the password file, I enter the following grep command.
(grep is one of those cryptic commands used to search for text in files.)

grep "WWW daemon" /etc/passwd

When grep prints the line with those words, it looks like the following.
(What you see on your system may differ from what I show.)

wwwrun:x:30:8:WWW daemon apache:/var/lib/wwwrun:/bin/false

If you created a user account in your name, go ahead and type the grep
command with your name as an argument but remember to enclose the
name in quotes.

Trying a few Linux commands

While you have the terminal window open, try a few Linux commands just
for fun. I will guide you through some examples to give you a feel for what
you can do at the shell prompt.

To see how long the Linux PC has been up since you last powered it up, type
the following. (Note: I show the typed command in bold, followed by the
output from that command.)

uptime
12:06:34 up 59 days, 16:23, 4 users, load average: 0.56, 0.55, 0.37

The part up 59 days, 16:23 tells you that this particular PC has been up
for nearly two months. Hmmm . . . can Windows do that?

To see what version of Linux kernel your system is running, use the uname
command like this:

uname -srv
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This runs the uname command with three options: -s, -r, and -v (which
can be combined as -srv, as this example shows). The -s option causes
uname to print the name of the kernel, -r prints the kernel release number,
and -v prints the kernel version number. The command generates the fol-
lowing output on one of my Linux systems:

Linux 2.6.31.5-127.£c12.1686 #1 SMP Sat Nov 7 21:41:45 EST 2009
In this case, the system is running Linux kernel version 2.6.31.

To read a file, use the more command. For example, type more /etc/
passwd to read the /etc/passwd file. The resulting output looks similar to
the following:

root:x:0:0:root:/root:/bin/bash
bin:x:1:1:bin:/bin:/bin/bash
daemon:x:2:2:Daemon: /sbin: /bin/bash
lp:x:4:7:Printing daemon:/var/spool/lpd:/bin/bash
mail:x:8:12:Mailer daemon:/var/spool/clientmgueue:/bin/false
news:x:9:13:News system:/etc/news:/bin/bash
uucp:x:10:14:Unix-to-Unix Copy system:/etc/uucp:/bin/bash
lines deleted .

To see a list of all the programs currently running on the system, use the ps
command, like this:

ps ax

The ps command takes many options, and you can provide these options
without the usual dash prefix. This example uses the a and x options. The a
option lists all processes that you'’re running, and the x option displays the
rest of the processes. The result is that ps ax prints a list of all processes
running on the system, as shown in the following sample output of the ps
ax command:

PID TTY STAT TIME COMMAND
1 ? S 0:01 init [5]

2 ? SN 0:00 [ksoftirqgd/0]
3

4

? S< 0:00 [events/0]
? S< 0:00 [khelper]
9 ? S< 0:00 [kthread]
22 ? S< 0:00 [kblockd/0]
58 2 S 0:00 [kapmd]
79 ? S 0:00 [pdflush]
80 ? S 0:00 [pdflush]
82 ? S< 0:00 [aio/0]

.o lines deleted .
5325 ? Ss 0:00 /opt/kde3/bin/kdm
5502 ? S 0:12 /usr/X11R6/bin/X -br -nolisten tcp :0 vt7 -auth /var/lib/xdm/
authdir/authfiles/A:0-plAOrt
5503 2 S 0:00 -:0
? Ss 0:00 /sbin/portmap
? Ss 0:00 /bin/sh /usr/X11R6/bin/kde
6566 ? Ss 0:00 /usr/sbin/cupsd
? Ssl 0:00 /usr/sbin/nscd
lines deleted .
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Amazing how many programs can run on a system even when only you are
logged in as a user, isn’t it?

As you can guess, you can do everything from a shell prompt, but it does
take some getting used to.

Shutting Down

Figure 5-3:
The Log Out
dialog box.

When you’re ready to shut down Linux, you must do so in an orderly
manner. Even if you're the sole user of a Linux PC, several other programs
usually run in the background. Also, operating systems, such as Linux, try to
optimize the way that they write data to the hard drive. Because hard drive
access is relatively slow (compared with the time needed to access memory
locations), data generally is held in memory and written to the hard drive in
large chunks. Therefore, if you simply turn off the power, you run the risk
that some files aren’t updated properly.

Any user (you don’t even have to be logged in) can shut down the system
from the desktop or from the graphical login screen, although some dis-
tributions, such as Debian, prompt you for the root password. Choose
Main Menu=>Log Out (or look for a Log Out option in the menus). A Log Out
dialog box appears, such as the one shown in Figure 5-3, providing options
for rebooting, halting the system, or simply logging out. To shut down the
system, simply select Shutdown and click OK. The system then shuts down
in an orderly manner.

Lock Screen
Switch from ubuntu...

Log Out...
Suspend
Restart...
Shut Down...

If the logout menu doesn’t have an option to shut down, first log out and
then select Shutdown from the graphical login screen. You can also shut
down a Linux computer from a terminal with the command init 0. This
method is sometimes required if you are running the operating system
within a virtual software manager such as VMWare.

While the system shuts down, you see messages about processes shutting
down. You may be surprised at how many processes there are even when no
one is explicitly running any programs on the system. If your system doesn’t
automatically power off on shutdown, you can manually turn off the power.
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Shutting down or rebooting the system may not require root access. This is
why it’s important to make sure that physical access to the console is pro-
tected adequately so that anyone who wants to can’t simply walk up to the
console and shut down your system.

You don’t always need to shut down when you’re finished with a session;
instead, you may choose to simply log out. To log out of KDE, choose Main
Menu=Logout. You can also right-click an empty area of the desktop and
choose Logout from the context menu that appears. To log out from GNOME,
choose Systemr>Log Out. Click OK when a dialog box asks if you really want
to log out. (In some GNOME desktop distributions, the menu option to log
out is the second or third menu button from the left in the top panel.)
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Chapter 1: The GNOME Desktop

In This Chapter

v+ Discovering GNOME’s common features
v+~ Presenting the Main Menu

v Introducing the Places Menu

» Examining the System Menu

v+ Introducing the bottom panel

Linux distributions come with one or both of two popular graphical user
interfaces (GUIs): GNOME and KDE. GNOME and KDE are similar to
Microsoft Windows but unique in one respect. Unlike Microsoft Windows,
you can choose your GUI in Linux. If you don’t like GNOME, you can use
KDE; and if you don’t like KDE, you can use GNOME. With both installed,
you can switch between the two in a matter of seconds. Try doing that with
Microsoft Windows!

GNOME and KDE were developed independently of Linux and run on other
UNIX operating systems besides Linux. You also have the option to install
other GUIs, such as FVWM and Xfce, in Linux. Visit www . freedesktop.
org/wiki/Desktops to see a list of other X desktops (desktops that run
on X Window System).

This chapter explores the major features of GNOME, and Chapter 2 in this
minibook does a similar comparison of KDE. You can best figure out these
GUIs by simply starting to use them. No matter which GUI you decide to
use, all GUI applications — whether they’re based on GNOME or KDE — run
on all GUI desktops. In other words, you can run KDE applications under
GNOME and vice versa. The only hurdle is that sometimes both GNOME and
KDE applications may not be installed by default.

Each Linux distribution typically installs one of the GUIs by default. Each
distribution also customizes GNOME or KDE to create a desktop that’s
unique to the distribution. Because of this, there may be subtle, minor dif-
ferences between what you see in your distribution and what is described
here.
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Getting to Know the GNOME Desktop

The initial desktop for GNOME looks like any other popular GUI, such as
Microsoft Windows or the Mac OS X desktop. Figure 1-1, for example, shows
the typical GNOME desktop.

3 Applications Places System (@) By Tue Mar 23, 10:17 PM_ @ ubuntu ()

Figure 1-1:
A clean
GNOME
desktop in
Ubuntu.

Running the Live CD, a number of icons that would be present if the operat-
ing system were installed will not be there. When the system is installed, the
desktop initially shows icons for your computer, your home folder, and the
trash can for deleted files. (Unlike other distributions, Ubuntu strives for a
minimum of desktop icons and has a clean look. Some Ubuntu versions fea-
ture no desktop icons.)

Desktop context menus

The GNOME desktop displays a context menu when you right-click a clear
area on the desktop. The menu offers the following menu options:

4+ Create a new folder

4+ Create a shortcut to a command (Create Launcher)
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4 Create a new document
4 Clean up the desktop, or align icons
4+ Configure the desktop background
Figure 1-2 shows the desktop context menus in a typical GNOME desktop.

Desktop menu options with a right-pointing arrow have other menus that
appear when you put the mouse pointer over the arrow.

3% Applications Places tem & Tue Mar 23, 10:18 PM ubuntu ¢
2
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Create Folder
Create Launcher...
Create Document
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Clean Up by Name
[ keep Aligned

paste

Change Desktop Background

Figure 1-2:
Standard
menu
choices in
GNOME.

Icon context menus

Right-clicking any desktop icon in GNOME displays another menu, as shown
in Figure 1-3.

Many items on this context menu are the same no matter what icon you
click, but right-clicking certain icons (for example, the Trash icon) produces
a somewhat different menu. You can perform the following typical tasks
from icon context menus:

4 Open a folder in a file manager

4+ Open a file with an application that you choose
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Figure 1-3:
The menu
choices
for the
Examples
icon in
GNOME.

4 Rename the icon
4 Move theicon to trash

4+ View the properties of that icon

3 Applications Places System (@) B

Tue Mar 23, 10:19 PM @ ubuntu ()

Open
Browse Folder
Cut
Copy
Paste Into Folder

Make Link
Rename...
Copy to >
Move to

Move to Trash

Stretch Icon...
Restore Icon’s Original Size

Compress...
send To...

Properties

\\3

For the Trash icon, the icon context menu typically provides an option to
permanently delete the items in the trash. (You get a chance to say Yes
or No.)

[ bet you see a pattern here: the right-click. No matter where you are in a GUI
desktop, always right-click before you pick. You're bound to find something
useful when you right-click!

Understanding the GNOME Panels

The GNOME desktop has two panels — the top and bottom bars. (The KDE
desktop has only one panel.) Each panel is similar to the Windows taskbar.
The top panel has buttons on the left (shortcuts to various programs) and a
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Figure 1-4:
The GNOME
top panel.
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time display to the right. The middle part of the panel shows buttons for any
applications you’ve started (or that were automatically started for you).

Move the mouse over any icon on the panel, and a small pop-up window dis-
plays the name of that icon. The pop-up window also gives a hint about what
you can do with that icon.

The top panel

The top panel is the long bar that stretches across the top of the GNOME
desktop. Figure 1-4 shows a typical view of the GNOME top panel.

] E-mail 0S indicator
Main System
menu menu  Help Network Talk
|,::; Applications Places System Qé N d Tue Mar 23, 10:19PM @ ubuntu (',\‘
Places menu Firefox Web browser Volume Date and time Logout

The panel is a parking place for icons. Some icons start programs when you
click them. Some show status (for example, what programs are currently
running) as well as information such as date and time.

The Main Menu button

The leftmost icon on the GNOME top panel is the Main Menu button. The
Main Menu button, like the Start button in Microsoft Windows, is where you
typically find all your applications, organized into submenus. The term Main
Menu is generic; in GNOME, the button is typically labeled Applications.

Click the Main Menu button to bring up the first-level menu. Then mouse
over any menu item containing an arrow to bring up the next-level menu,
and so on. You can go through a menu hierarchy and make selections from
the final menu. Figure 1-5 shows the main menu hierarchy in the typical
GNOME desktop.

[ use the notation Applications=>Internet>Firefox Web Browser to refer to
the menu sequence highlighted in Figure 1-5. This style of notation is used
throughout this book.
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JIHEel Places  System ] Tue Mar 23,1020 PM @ ubuntu ()

ﬁo Accessories o
Games >

‘ﬁ Graphics >
® Internet bl @@ Empathy IM Client

ﬁ Office b3 ) Firefox Web Browser

3 sound & video >| (@ Gwibber social Client

e Universal Access > @ Remote Desktop Viewer
@ Terminal Server Client

ﬁ Ubuntu Software Center

@ Transmission BitTorrent Client

Figure 1-5:
The standard
menu
hierarchy on
the GNOME
desktop.

In most desktops, the top-level main menu has the following types of menu
categories:

4+ Accessories: Lots of utility programs, such as a scientific calculator, a
character selector, a floppy formatter, a dictionary, and a Palm Pilot or
Handspring syncing software

4 Games: A menu of games (and a whole lot of them at that), such as
Solitaire, Mahjongg, Mines, and Reversi

4+ Graphics: Programs such as The GIMP (an Adobe Photoshop-like pro-
gram), a digital camera interface, a scanner interface, a screen-capture
program, and an Adobe Acrobat viewer

4 Internet: Internet applications, such as a Web browser, e-mail reader,
and instant messenger

4+ Office: Office applications such as the OpenOffice.org office suite (which
includes the Writer word processor, Calc spreadsheet, Impress slide
presentation program, and Draw drawing program)

4+ Sound & Video: Multimedia applications such as a CD player, a sound
mixer, a sound recorder, and volume control



Figure 1-6:
The GNOME
Places
menu
choices.
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The main menu typically also has a few submenu items for some commonly
performed tasks, such as Add/Remove Applications.

In each distribution, the main menu has different categories but a similar
organization, so you can usually find what you need.

The Places Menu button

The second menu choice from the left on the GNOME top panel is the Places
Menu. That’s where you typically find an easy way to get to all the locations
you may need to visit, as well as access the network, search for files, and
perform other common functions. Figure 1-6 shows an example of this menu.

B E Tue Mar 23, 10:20 PM @ ubuntu ()

Bl Desktop

”E' Documents

|l Music

| Pictures
Iﬁ Videos

|[.£i| Downloads

M| computer

() Ubuntu 10.04 1386
&

ﬂ 80 GB Filesystem
__| 210 MB Filesystem
GRAHAMBROWN

__\‘ Floppy Drive

Network
Connect to Server...

Search for Files...

Recent Documents

Of particular help is the Search for Files option, which displays the dialog
box shown in Figure 1-7. You can use this option to find files based on
almost any criteria — date created, changed, name, containing certain
phrases, and so on. It’s worth your time to experiment with this tool and get
to know it well.
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Figure 1-7:
The default
search
options can
be changed
through the
dialog box.

Search for Files =[Enr=

Name contains: | [v]

Look in folder: Iuhuntu v |
|~ Select more options

Contains the text: | } \ Remove |

Available options: I Date modified less than ~ ‘ \ Add I

Search results:

Figure 1-8:
The
standard
System
menuin
GNOME.

The System Menu button

The third menu choice from the left on the GNOME top panel is the System
Menu. This is where you typically turn to for administrative tasks. Figure 1-8
shows an example of this menu.

43 Applications Places [Bal® @ =X 4l Wed Mar 31, 1:21PM @ubuntu (%
o A\

Preferences >

[ERTECS Y computer janitor
S pisk utility

& Grarted

[ Hardware Drivers

Help and Support

About GNOME

About Ubuntu

> Install Ubuntu 10.04
=

[ Language Support
| Log File Viewer

) Login Screen

|88 Network Tools

) Printing

Software Sources
L_’_‘ Startup Disk Creator

Synaptic Package Manager

[E® system Monitor
[ system Testing
&) Time and Date
@ Update Manager

Qf’_‘.‘ Users and Groups

@) -| ) [3400 - File Browser]
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The Preferences options allow you to perform such tasks as choosing your
default printer, configuring power management on a laptop, and tweaking
sound settings. The Administration options let you run the administrative
utilities needed to see what’s going on with the system and make changes
(administration is covered in detail in Book V).

Other options on this menu allow you to get information about the distribu-
tion, as well as access help and support.

Top panel icons

In addition to the menu choices in the top panel, a number of icons are com-
monly present (refer to Figure 1-4). You can identify each of these icons

by moving the cursor over them and reading the pop-up descriptions that
appear. The most common ones (in the order they typically appear from left
to right) are

4+ Firefox Web browser: Start the popular browser and access the
Internet.

+

Evolution Mail: Start the Evolution e-mail and calendar software.

4+ Help: Display online help information in a documentation viewer for
GNOME.

Network: Display information about current wired or wireless connections.

<+

4+ Volume: Display a volume control bar that you can use to change the
sound’s volume by dragging a slider.

+

E-mail: Open your preferred e-mail reader.

4+ Date and time: Display the current date and time; clicking displays a cal-
endar showing the current date.

4+ Talk: Allow instant messaging with fellow workers.
4+ OS indicator: Signify which operating system you are running.

4+ Logout: Change users, lock the desktop, or shut down the system.

The bottom panel

In addition to the top panel, GNOME also includes a bottom panel. Figure 1-9
shows an example of this menu. The items that appear here are

Figure 1-9: Show Desktop Active window Workspace Switcher
The bottom L ~
panel in @E D Crestor -l [0 Movee Prferences RS T
GNOME. |

Open windows Trash can
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+

+

Show Desktop: Hide (but do not close) all windows and display the
desktop.

Open windows: Display all currently open windows.
Active window: Switch to another running application or window.

Workspace Switcher: Display a different workspace by clicking a
square. This has the same function as the Desktop Pager in KDE desk-
tops. Explore the three menus (Applications, Places, and System) to
see the categories of tasks you can perform from the selections in
these menus.

Trash can: View or empty the contents of the trash can.
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Chapter 2: The KDE Desktop

In This Chapter

v+ Discovering KDE’s common features

v~ Introducing the Main Menu

v~ Configuring the panel and the desktop

A s mentioned in Chapter 1 of this minibook, Linux distributions come
with one (or both) of two popular graphical user interfaces (GUIs) —
GNOME and KDE. With both installed, you can switch between the two in a
matter of seconds. If you don’t like GNOME, you can use KDE; or if you don’t
like KDE, you can use GNOME.

This chapter explores the major features of KDE, just as Chapter 1 of this
minibook examined GNOME. I strongly encourage you to try both GUIs
before you decide which one you’re most comfortable using. Remember,
you can run KDE applications under GNOME and vice versa. Several installa-
tions, including Fedora and openSUSE, allow you to choose to install KDE or
GNOME. Installing only one by default allows for a quicker and easier setup
and installation; you can always go back and install the other interface later.

Each distribution customizes the desktop, so there may be subtle, minor differ-
ences between what you see in your distribution and what’s described here.

Getting to Know the KDE Desktop

The initial desktop for KDE looks like any other popular GUI, such as
Microsoft Windows desktop or the Mac OS X desktop. Figure 2-1 shows a
typical KDE desktop.

KDE stands for the K Desktop Environment. The KDE project started in
October 1996 with the intent to develop a common GUI for UNIX systems
that use the X Window System. The first beta version of KDE was released a
year later, in October 1997. KDE version 1.0 was released in July 1998.

Figure 2-1 is from Fedora 12, which strives for a minimum of desktop icons.
Along the bottom of the desktop is the panel — which is similar to the top
and bottom bars in GNOME and the Windows taskbar. The panel has but-
tons on the left (shortcuts to various programs), a set of buttons to the
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Figure 2-1:
A clean KDE
desktop.

available desktops, a task area, and a time display and icons for volume con-
trol and access to the KDE’s Clipboard manager, Klipper, to the right. In the
middle part of the panel are buttons for any applications that you started (or
that were automatically started for you).

Desktop context menus

The KDE desktop displays a context menu when you right-click a clear area
on the desktop. The context menu offers a menu that includes the following
options (with slight variations between distributions):

4+ Konsole (access to a terminal window)

4+ Run Command

4 Lock Screen

4+ Leave (exit the desktop)

4+ Desktop Activity Settings (set such things as the wallpaper)

Figure 2-2 shows the desktop context menu in a typical KDE desktop.



Figure 2-2:
The context
menu in
KDE.
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| Konsole

o' Run Command...

== Add Widgets... Alt+D, A
== Add Panel

3 Remove this Desktop Activity AlE+D, Alt+R
|7l Lock Widgets Alt+D, L
[=] Lock Screen

[@ Leave...

»* Desktop Activity Settings Alt+D, Alt+5

Icon context menus

89

Right-clicking any desktop icon in KDE displays another menu, as shown in
Figure 2-3. Many items on this context menu are the same no matter what

icon you click, but right-clicking certain icons (for example, the CD-ROM

device icon) produces a somewhat different menu. Desktop menu options
with a right-pointing arrow have other menus that appear when you put the
mouse pointer over the arrow. You can perform the following typical tasks

from icon context menus:

4 Cut Ctri+x
) Copy Ctri+C
I Paste Crl+v

Figure 2-3:

The pop-up
menu for an
icon in KDE.

J Rename... F2

7. Move to Trash Del
Open With >
Actions >
Compress >

| Properties Alt+Return

A\

Cut or copy
Rename the icon

Move the icon to the trash

R IR R R

Open a folder in a file manager

Open a file with an application that you choose

View the properties of that icon

For the CD-ROM device icon and similar devices, the icon context menu typi-

cally provides an option to eject the media.

No matter where you are in a GUI desktop, always right-click before you pick.

You're bound to find something useful when you right-click!
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Understanding the KDE Panel

Figure 2-4:
The KDE
panel.
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The panel is the long bar that stretches across the bottom of the desktop.
KDE, as opposed to GNOME, has only one panel by default. Figure 2-4 shows
a typical view of the KDE panel.

Main menu  Active window Network connection— Volume Time

£ GRAHAMBRGWN - Dolphin

Desktop Select Klipper Clipboard

Notifications

The panel is a parking place for icons. Some icons start programs when you
click them. Some show status (for example, what programs are currently
running) as well as information such as the date and time.

If you move the mouse pointer on top of an icon, a Help balloon pops up and
gives you a helpful hint about the icon.

The Main Menu button

The leftmost icon on the KDE panel is the Main Menu button. (KDE docu-
mentation calls the Main Menu button the Application Starter). Like the Start
button in Microsoft Windows, the Main Menu button is where you typically
find all your applications, organized into submenus. The Main Menu button
is often labeled K, although the letter can be changed by the distribution.

Click the Main Menu button to see the first-level menu. Then mouse over
any menu item with an arrow to bring up the next-level menu and so on. You
can go through a menu hierarchy and make selections from the final menu.
Figure 2-5 shows the Main Menu hierarchy in a typical KDE desktop.

[ use the notation Applications=>Internet to refer to the menu sequence high-
lighted in Figure 2-5. This style of notation is used throughout this book.

The most recent versions of KDE feature the KickOff application launcher as
their main menu. KickOff allows you to access frequently used applications
more quickly than navigating through the traditional menu hierarchy. In
most desktops, clicking the Main Menu button to open KickOff presents the
following top-level categories:

4+ Favorites: Easy access to frequently used applications and documents.
To quickly add a file to your Favorites, right-click it and choose Add to
Favorites.



Figure 2-5:
The KDE
menu
hierarchy.
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Graham Brown (glbrown) on anderso

a Search: )|

m Education >
L Games >
&g? Graphics »
e Internet >
j Multimedia >
a Office »
X Settings >
"n!.' System

! Utilities

VoA |-

Favorites  Applications  Computer  Recently Used

4+ Applications: The applications and tools installed on your system. Click
a subcategory with a right-pointing arrow to open more options.

4+ Computer: Access to hard drives and removable memory devices, as
well as the trash.

4+ Recently Used: A chronological display of recently opened documents
and applications.

4+ Leave: Options to log out, restart, shut down the computer, and more.

In the Applications tab, you will find the following menu subcategories (and
probably a few more depending on which distribution you are using):

4+ Administration: Access to the utility programs you need to manage the
system, such as managing the firewall and adding users and groups.
Figure 2-6 shows an example of the Administration menu.

4 Games: A menu of games (and a lot of them at that) such as arcade
games, board games, and card games.

4 Graphics: Programs such as Flickr, KolourPaint, and KSnapshot (used to
take the screenshots in this chapter).

4+ Internet: Internet applications, such as a Web browser, an e-mail reader,
and instant messenger.
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Graham Brown (glbrown) on anderso [EEEEEEE

ﬁ search: | ]

Administration
m Authentication

B | Date &Time

S

}{v Firewall

=t Printing
4

4L
=
- Users and Groups

Figure 2-6:
The Admin-
istration
e
menu / i ol
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Fawvorites Applications Computer Recently Used ,L’;uq_lg

4+ Multimedia: Multimedia applications such as a CD player, a sound
mixer, a sound recorder, and volume control.

4+ Office: Office applications such as the OpenOffice.org Office suite
(includes the Writer word processor, the Calc spreadsheet, the Impress
slide presentation program, and the Draw drawing program).

4+ Settings: Access to configuration settings and the utilities needed to
make changes. An example of the Settings menu is shown in Figure 2-7.

Graham Brown (glbrown) on anderso [DEAEEED

a Search: (| ]

Settings
Default Printer

.
L
o | Desktop Switching Tool
°§i Input Method
D Menu Updating Tool
N

Palmos Devices
=

e Preferred Applications

Figure 2.7: m Screensaver
The Settings >{v System Settings
menu

choices. vy & llg F

Favorites  Applications  Computer  RecentiylUsed  Leave
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4+ System: The utilities needed for system configuration. An example of the
System menu is shown in Figure 2-8.

Graham Brown (glbrown) on anderson.¢ [EGEED|
“ Search: [ ]
ystem M)
u Automatic Bug Reporting Tool
% Desktop Sharing
~ | Disk Utility
ﬁ File Manager
i Info Center
9 KDE Bluetooth
\‘}% Removable Media Utility
: Screen Resize & Rotate
i‘z SELinux Troubleshooter
E Seftware Management
-" System Monitor
) = System Monitor
Figure 2-8: s
- Terminal
The System = "
menu Bl Terminal v
choices. + W e Q9
Favorites  Applications | Computer  Recaly Used Leave
4+ Utilities: Additional miscellaneous utilities that can be utilized by KDE,
including text-to-speech tools, a personal alarm scheduler, and a screen
magnifier.
QMBER g
O
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Three KDE menu choices — Administration, Settings, and System — will
help you configure almost anything you need.

In each distribution, the main menu and KickOff have different categories
but the same menu organization, so you should usually be able to find what
you need.

Panel icons

In addition to the Main Menu button, the KDE panel has several icons
(labeled in Figure 2-4). You can identify any icon by moving your cursor over
it and reading the pop-up description that appears. The most common ones
(in the order they typically appear from left to right) are as follows:

4+ Desktop Pager: Navigate between workspaces or “virtual desktops.”

4 Open windows: Display all currently open windows.
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<+

Active window: Switch to another running application or window.

4+ Network connection: Display information about current wired or wire-
less connections.

+

Klipper Clipboard: Configure and edit contents of your clipboard.

4+ Volume: Display a volume control bar that you can use to change the
sound’s volume by dragging a slider.

4+ Notifications and Jobs: Mouse over to see the progress of current jobs
such as file transfers or printing documents.

4+ Time: Display the time; clicking displays a calendar showing the current
date.

4+ Panel toolbox: Adjust size, location, and controls for the panel.

Configuring the KDE Bottom Panel

For all the power inherent in the KDE panel, it also has a great deal of flex-
ibility. If you right-click a blank spot on the panel, the menu shown in Figure
2-9 appears. You use this menu to add and remove items from the panel and
even create an additional panel (allowing you to configure your desktop as
much like GNOME as you want it to be).

Figure 2-9:

You have

a lot of

flexibility

when 4 Add widgets... Alt+D, A
configuring bt e i e Ao,
the panel' ®x ;emave this Task Manager Alt+D, R Skanel e o

% Remove this Panel Alt+D, Alt+R
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The most powerful menu choice is Panel Settings. Choosing Panel Settings=>
More Settings displays the utility shown in Figure 2-10. From here, you can
place the panel in a location other than its default location along the bottom,
adjust the alignment of the panel, automatically hide the panel, select
whether windows will appear in front of or behind the panel, and more.

Panel Alignment
= Left

= Center

= Right
Visibility

& Always visible
I Auto-hide

— - 2 Windows can cover

Figure 2-10:
Configuring
the KDE
panel is
easy.

:: Windows go below

~= Maximize Panel

% Remove this Panel {

- Screen Edge | Height < Add Widgets...  Add Spacer |7 Lock Widgets % More Settings | €

Configuring the KDE Desktop

After right-clicking an empty spot on the desktop, you can choose Configure
Desktop from the pop-up menu. Doing so displays the configuration tool
shown in Figure 2-11. You can configure such items as the background and
special mouse controls to perform helpful functions on the desktop.

For more thorough desktop configurations, choose Desktop from the System
Settings menu (which I discuss more in a few moments) to display the con-
figuration options shown in Figure 2-12. You can set the screen size, adjust
settings for multiple desktops, change the screen saver, and play around
with desktop effects (a new addition to KDE version 4).
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If you're using an older version of KDE, you have the choice to set a desk-
top menu bar at the top of the screen — an example of which is shown in

Figure 2-13. However, the ability to add a desktop menu is no longer avail-
able in KDE 4.



Figure 2-13:
A desktop
menu

adds more
flexibility.
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Another tool to experiment with is System Settings, KDE’s control center
interface (shown in Figure 2-14). To get to System Settings, choose
Applications=Settings>System Settings. The System Settings menu is
organized into categories, such as Look and Feel, Personal, Network
Connectivity, and Computer Administration. Click an item to view the sub-
categories for that item. Click one of the subcategory items to change it.
After making any changes you want, click the Apply button to enact the
change. If you don’t like the result, you can often click Reset to go back to
the original setting.
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Configuring the KDE Desktop

Depending upon your distribution, you may also want to use downloadable
programs such as SAX2 or YAST (in openSUSE) for desktop configuration.
SAX2 is an open source program that simplifies configuration.



Chapter 3: Commanding the Shell

In This Chapter

v Opening a terminal window or a virtual console
v+~ Discovering the bash shell
v+~ Using Linux commands

1+ Writing a shell script

S)metimes, things just don’t work. What do you do if the GUI desktop
stops responding to your mouse clicks? What if the GUI doesn’t start at
all? You can still tell your Linux system what to do, but you have to do it by
typing commands into a text screen. In these situations, you work with the
shell — the Linux command interpreter. This chapter introduces the bash
shell, the default shell in most Linux distributions.

After you figure out how to work with the shell, you may even begin to like
the simplicity and power of the Linux commands. And then, even if you're
a GUI aficionado, someday soon you may find yourself firing up a terminal
window and making the system sing and dance with two- or three-letter
commands strung together by strange punctuation characters. (Hey, I can
dream, can’t I?)

Opening Terminal Windows and Virtual Consoles

First things first. If you're working in a GUI desktop, such as GNOME or KDE,
where do you type commands for the shell? Good question.

The easiest way to get to the shell is to open a ferminal (also called console)
window. The GNOME and KDE GUIs in most distributions include an icon (or
a Main Menu option) to open a terminal window. Click that icon or choose
the menu option to get a terminal window. If you don’t see such an icon in
GNOME, choose Applications=>Accessories=>Terminal. Now you can type
commands to your heart’s content.

If, for some reason, the GUI seems to be hung (you click and type but noth-
ing happens), you can turn to the virtual consoles. (The physical console is
the monitor-and-keyboard combination.) The idea of virtual consoles is to
give you the ability to switch between several text consoles even though
you have only one physical console. Whether you’re running a GUI or not,
you can then use different text consoles to type different commands.
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To get to the first virtual console from the GNOME or KDE desktop, press
Ctrl+Alt+F1. Press Ctrl+Alt+F2 for the second virtual console, and so on. Each
of these virtual consoles is a text screen where you can log in and type Linux
commands to perform various tasks. When you’re finished, type exit to

log out.

You can use up to six virtual consoles. In most distributions, the seventh
one is used for the GUI desktop. To get back to the GUI desktop, press
Ctrl+Alt+F7.

Using the bash Shell

If you've used MS-DOS, you may be familiar with COMMAND . coM, the DOS
command interpreter. That program displays the infamous C: \> prompt.
In Windows, you can see this prompt if you open a command window. (To
open a command window in Microsoft Windows, choose Start>Run, type
command in the text box, and then click OK.)

Linux comes with a command interpreter that resembles COMMAND . COM
in DOS, but it can do a whole lot more. The Linux command interpreter is
called a shell.

The default shell in many Linux distributions is bash. When you open a ter-
minal window or log in at a text console, the bash shell is what prompts you
for commands. Then, when you type a command, the shell executes your
command.

Just as there are multiple GUIs (GNOME or KDE) for Linux, you have a choice
of shells besides bash. For example, some people prefer the C shell. You can
easily change your default shell by using the chsh command.

In addition to the standard Linux commands, bash can execute any com-
puter program. So you can type the name of an application (the name is usu-
ally more cryptic than what you see in GNOME or KDE menus) at the shell
prompt, and the shell starts that application.

Understanding the syntax of shell commands

Because a shell interprets what you type, knowing how the shell processes
the text you enter is important. All shell commands have the following gen-
eral format. (Some commands have no options.)

command [optionl] [option2] . . . [optionN]

Issuing such a command is commonly referred to as a command line. On
a command line, you enter a command, followed by zero or more options
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(or arguments). These strings of options — the command-line options (or
command-line arguments) — modify the way the command works so that
you can get it to do specific tasks.

The shell uses a blank space or a tab to distinguish between the command
and options. This means you must use a space or a tab to separate the com-
mand from the options and the options from one another.

If an option contains spaces, you put that option inside quotation marks. For
example, to search for my name in the password file, I enter the following
grep command (grep is used for searching for text in files):

grep "Emmett Dulaney" /etc/passwd
When grep prints the line with my name, it looks like this:
edulaney:x:1000:100:Emmett Dulaney:/home/edulaney: /bin/bash

If you create a user account with your username, type the grep command
with your username as an argument to look for that username in the /etc/
passwd file.

In the output from the grep command, you can see the name of the shell
(/bin/bash) following the last colon (:). Because the bash shell is an
executable file, it resides in the /bin directory; you must provide the full
path to it.

The number of command-line options and their format depend on the actual
command. Typically, these options look like -X, where X is a single charac-
ter. For example, you can use the -1 option with the 1s command. The com-
mand lists the contents of a directory, and the option provides additional
details. Here is a result of typing 1s -1 in a user’s home directory:

total O

drwxr-xr-x 2 edulaney users 48 2010-09-08 21:11 bin

drwx------ 2 edulaney users 320 2010-09-08 21:16 Desktop

drwx------ 2 edulaney users 80 2010-09-08 21:11 Documents

drwxr-xr-x 2 edulaney users 80 2010-09-08 21:11 public_
html

drwxr-xr-x 2 edulaney users 464 2010-09-17 18:21 sdump

If a command is too long to fit on a single line, you can press the backslash
key (\) followed by Enter. Then, continue typing the command on the next
line. For example, type the following command. (Press Enter after each line.)

cat \
/etc/passwd

The cat command then displays the contents of the /etc/passwd file.
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You can concatenate (that is, string together) several shorter commands on
a single line by separating the commands by semicolons (;). For example,
the following command

cd; 1ls -1; pwd

changes the current directory to your home directory, lists the contents of
that directory, and then shows the name of that directory.

Combining shell commands

You can combine simple shell commands to create a more sophisticated
command. For example, suppose that you want to find out whether a device
file named sbpcd resides in your system’s /dev directory because some
documentation says you need that device file for your CD-ROM drive. You
can use the 1s /dev command to get a directory listing of the /dev direc-
tory and then browse through it to see whether that listing contains sbpcd.

Unfortunately, the /dev directory has a great many entries, so you may

find it hard to find any item that has sbpcd in its name. You can, however,
combine the 1s command with grep and come up with a command line that
does exactly what you want. Here’s that command line:

ls /dev | grep sbpcd

The shell sends the output of the 1s command (the directory listing) to the
grep command, which searches for the string sbpcd. That vertical bar (]) is
known as a pipe because it acts as a conduit (think of a water pipe) between
the two programs — the output of the first command is fed into the input of
the second one.

Controlling command input and output

Most Linux commands have a common feature — they always read from
the standard input (usually, the keyboard) and write to the standard output
(usually, the screen). Error messages are sent to the standard error (usually
to the screen as well). These three devices often are referred to as stdin,
stdout, and stderr.

You can make a command get its input from a file and then send its output
to another file. Just so you know, the highfalutin term for this feature is input
and output redirection or I/0 redirection.

Table 3-1 shows the syntax of common I/O redirection commands, and the
next few sections explain how to use some of these commands.
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Table 3-1 Common Standard I/0 Redirections

Task Command Syntax

Send stdout to afile command > file

Send stderr tofile command 2> file

Send stdout and stderr tofile command > file 2>&l

Read stdin from a file command < file

Read stdinfrom file.in and command < file.in > file.
send stdoutto file.out out

Append stdout to the end of a file command >> file

Append stderr to the end of a file command 2>> file

Append stdout and stderr to command >> file 2>&1

the end of a file

Read stdin from the keyboard command <<c

until the character ¢

Pipe stdout to command?2 command | command?2

Pipe stdout and stderr to command 2>&1 | command2
command2

Getting command input from a file

If you want a command to read from a file, you can redirect the standard
input to come from that file instead of from the keyboard. For example, type
the following command:

sort < /etc/passwd

This command displays a sorted list of the lines in the /etc/passwd file. In
this case, the less-than sign (<) redirects stdin so that the sort command
reads its input from the /etc/passwd file.

Saving command output in a file

To save the output of a command in a file, redirect the standard output to a
file. For example, type cd to change to your home directory and then type
the following command:

grep typedef /usr/include/* > typedef.out
This command searches through all files in the /usr/include directory

for the occurrence of the text typedef — and then saves the output in a
file called typedef . out. The greater-than sign (>) redirects stdout to a

Book Il
Chapter 3

lI3ys ay}
Buipuewwon



’04 Using the bash Shell

3

3

A\

file. This command also illustrates another feature of bash: When you use
an asterisk (*), bash replaces the asterisk with a list of all filenames in the
specified directory. Thus, /usr/include/* means all the files in the /usr/
include directory.

If you want to append a command’s output to the end of an existing file
instead of saving the output in a new file, use two greater-than signs (>>)
like this:

command >> filename

Another interesting use of sending stdout to a file is the use of the cat
command to quickly prepare small text files. For example, suppose that you
want to create a new text file to store lines of text you type until you type 22z
and press Enter. Here is how you can accomplish that task:

cat <<ZZ > input.txt

After you type this command, you can keep typing lines and then type zz
on a line when you are finished. Everything you type is saved in the file
input. txt.

Saving error messages in a file

Sometimes you type a command, and it generates a lot of error messages
that scroll by so fast you can’t tell what’s going on. One way to see all the
error messages is to save them in a file so that you can see what the heck
happened. You can do that by redirecting stderr to a file.

For example, type the following command:

find / -name COPYING -print 2> finderr

This command looks through the file system for files named COPYING and
saves all the error messages (if there are any) in the finderr file. The

number 2 followed by the greater-than sign (2>) redirects stderr to afile.

If you want to simply discard the error messages instead of saving them in a
file, use /dev/null as the filename, like this:

find / -name COPYING -print 2> /dev/null

That /dev/null is a special file — often called the bit bucket and some-
times glorified as the Great Bit Bucket in the Sky — that simply discards
whatever it receives. So now you know what they mean when you hear
phrases, such as “Your mail probably ended up in the bit bucket.”
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Typing less with automatic command completion

Many commands take a filename as an argument. To view the contents of the
/etc/modprobe. conf text file, for example, type the following command:

cat /etc/modprobe.conf

The cat command displays the /etc/modprobe. conf file. For any com-
mand that takes a filename as an argument, you can use a bash feature to
avoid having to type the entire filename. All you have to type enough charac-
ters to uniquely identify the file in its directory.

To see an example, type cat /etc/mod but don’t press Enter; press Tab
instead. bash automatically completes the filename, so the command
becomes cat /etc/modprobe.conf. Now press Enter to run the
command.

Whenever you type a filename, press Tab after the first few characters of the
filename. bash probably can complete the filename so that you don’t have
to type the entire name. If you don’t enter enough characters to uniquely
identify the file, bash beeps. Just type a few more characters and press Tab
again.

Going wild with asterisks and question marks

You can avoid typing long filenames another way. (After all, making less
work for users is why we use computers, isn’t it?)

This particular trick involves using the asterisk (*) and question mark (?).
These special characters are wildcards because they match zero or more
characters in a line of text.

If you know MS-DOS, you may have used commands such as COPY *.* A:
to copy all files from the current directory to the A: drive. bash accepts sim-
ilar wildcards in filenames. As you expect, bash provides many more wild-
card options than the MS-DOS command interpreter does. Of course, newer
computers (particularly notebook computers and especially netbooks) don’t
have A and B drives anymore. That deprives an entire generation of the fun
of trying to copy a large file onto floppy disks!

You can use three types of wildcards in bash:

4+ Asterisk (*): Matches zero or more characters in a filename. That means
* denotes all files in a directory.

4+ Question mark (?): Matches any single character. If you type test?,
that matches any five-character text that begins with fest.
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4+ Set of characters in brackets: Matches any single character from that
set. The string [aB], for example, matches only files named a or B, The
string [aB] *, though, matches any filename that starts with a or B.

Wildcards are handy when you want to do something to many files. For
example, to copy all the files from the /media/cdrom directory to the cur-
rent directory, type the following:

cp /media/cdrom/*

bash replaces the wildcard character * with the names of all the files in the
/media/cdrom directory. The period at the end of the command represents
the current directory.

You can use the asterisk with other parts of a filename to select a more spe-
cific group of files. Suppose you want to use the grep command to search
for the text typedef struct in all files of the /usr/include directory
that meet the following criteria:

4 The filename starts with s

4 The filename ends with .h

The wildcard specification s* . h denotes all filenames that meet these crite-
ria. Thus you can perform the search with the following command:

grep "typedef struct" /usr/include/s*.h

The string contains a space that you want the grep command to find, so you
have to enclose that string in quotation marks. That way, bash doesn’t try to
interpret each word in that text as a separate command-line argument.

The question mark (?) matches a single character. Suppose that you have
four files — imagel .pcx, image2 .pcx, image3 . pcx, and image4 .pcx —
in the current directory. To copy these files to the /media/floppy direc-
tory, use the following command:

cp image?.pcx /media/floppy

bash replaces the single question mark with any single character and copies
the four files to /media.

The third wildcard format — [ . . . ] — matches a single character from
a specific set of characters enclosed in square brackets. You may want to
combine this format with other wildcards to narrow the matching filenames
to a smaller set. To see a list of all filenames in the /etc/X11/xdm directory
that start with x or X, type the following command:

1ls /etc/X11l/xdm/ [xX]*
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Repeating previously typed commands

To make repeating long commands easy for you, bash stores up to 500 old
commands as part of a command history (basically just a list of old com-
mands). To see the command history, type history. bash displays a num-
bered list of the old commands, including those that you entered during
previous logins.

If the command list is too long, you can limit the number of old commands
that you want to see. For example, to see only the 10 most recent com-
mands, type this command:

history 10

To repeat a command from the list that the history command shows,
simply type an exclamation point (!), followed by that command’s number.
To repeat command number 3, type !3.

You can repeat a command without knowing its command number. Suppose
you typed more /usr/lib/X11/xdm/xdm-config a few minutes ago and
now you want to look at that file again. To repeat the previous more com-
mand, type the following:

'more

Often, you may want to repeat the last command that you just typed,
perhaps with a slight change. For example, you may have displayed the
contents of the directory by using the 1s -1 command. To repeat that com-
mand, type two exclamation points as follows:

Sometimes, you may want to repeat the previous command but add extra
arguments to it. Suppose that 1s -1 shows too many files. Simply repeat
that command but pipe the output through the more command as follows:

11 | more

bash replaces the two exclamation points with the previous command and
then appends | more to that command.

Here’s the easiest way to recall previous commands: Just press the up-arrow
key, and bash keeps going backward through the history of commands you
previously typed. To move forward in the command history, press the down-
arrow key.
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Discovering and Using Linux Commands

You type Linux commands at the shell prompt. By Linux commands, ] mean
some of the commands that the bash shell understands as well as the
command-line utilities that come with Linux. In this section, I introduce
you to a few major categories of Linux commands.

I can’t cover every single Linux command in this chapter, but [ want to give
you a feel for the breadth of the commands by showing you common Linux
commands. Table 3-2 lists common Linux commands by category. Before
you start memorizing any Linux commands, browse this table.

Table 3-2 Essential Linux Commands

Command Name Action

Help and Abbreviations

apropos Find online manual pages for a specified keyword

info Display online help information about a specified command

man Display online help information

whatis Search for complete words only and find the online
manual pages

alias Define an abbreviation for a long command

type Show the type and location of a command

unalias Delete an abbreviation defined using alias

Managing Files and Directories

cd Change the current directory

chmod Change file permissions

chown Change the file owner and group

cp Copy files

1n Create symbolic links to files and directories

1s Display the contents of a directory

mkdir Create a directory

mv Rename a file and move the file from one directory to
another

rm Delete files

rmdir Delete directories

pwd Display the current directory

touch Update a file's timestamp




Discovering and Using Linux Commands 109

Command Name Action

Finding Files

find Find files based on specified criteria, such as name
and size

locate Find files using a periodically updated filename database
(the database is created by the updatedb program.)

whereis Finds files based in the typical directories where execut-
able (also known as binary) files are located

which Find files in the directories listed in the PATH environment

variable

Processing Files

cat Display a file on standard output (can be used to concat-
enate several files into one big file)

cut Extract specified sections from each line of text in a file

ad Copy blocks of data from one file to another (used to copy
data from devices)

diff Compare two text files and find any differences

expand Convert all tabs to spaces

file Display the type of data in a file

fold Wrap each line of text to fit a specified width

grep Search for regular expressions in a text file

less Display a text file one page at a time (go backward by
pressing b)

lpr Print files

more Display a text file, one page at a time (goes forward only)

nl Number all nonblank lines in a text file and print the lines
to standard output

paste Concatenate corresponding lines from several files

patch Update a text file using the differences between the origi-
nal and revised copy of the file

sed Copy a file to standard output while applying specified
editing commands

sort Sort lines in a text file

split Break up a file into several smaller files with specified size

tac Reverse a file (last line first and so on)

tail Display the last few lines of a file

tr Substitute one group of characters for another throughout

afile

(continued)
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Table 3-2 (continued)

Command Name

Action

Processing Files

uniqg Eliminate duplicate lines from a text file

wc Count the number of lines, words, and characters in a
text file

zcat Display a compressed file (after decompressing)

zless Display a compressed file one page at a time (go back-
ward by pressing b)

zmore Display a compressed file one page at a time

Archiving and Compressing Files

compress Compress files

cpio Copy files to and from an archive

gunzip Decompress files compressed with GNU Zip (gzip)

gzip Compress files using GNU Zip

tar Create an archive of files in one or more directories (origi-
nally meant for archiving on tape)

uncompress Decompress files compressed with compress

Managing Files

bg Run an interrupted process in the background

fg Run a process in the foreground

free Display the amount of free and used memory in the system

halt Shut down Linux and halt the computer

kill Send a signal to a process (usually used to terminate a
process)

ldad Display the shared libraries needed to run a program

nice Run a process with a lower priority (referred to as nice
mode)

ps Display a list of currently running processes

printenv Display the current environment variables

pstree Show parent-child process relationships

reboot Stop Linux and then restart the computer

shutdown Shut down Linux

top Display a list of most processor- and memory-intensive
processes

uname Display information about the system and the Linux kernel
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Command Name

Action

Managing Users

chsh Change the shell (command interpreter)

groups Print the list of groups that include a specified user

id Display the user and group ID for a specified username
passwd Change the password

su Start a new shell as another user (the other user is

assumed to be root when the command is invoked with-
out any argument)

Managing the File System

af Summarize free and available space in all mounted stor-
age devices

du Display disk usage information

fdformat Format a floppy disk

fdisk Partition a hard drive

fsck Check and repair a file system

mkfs Create a new file system

mknod Create a device file

mkswap Create a swap space for Linux in a file or a hard drive
partition

mount Mount a device (for example, the CD-ROM) on a directory
in the file system

swapoff Deactivate a swap space

swapon Activate a swap space

sync Writes buffered (saved in memory) data to files

tty Display the device name for the current terminal

umount Unmount a device from the file system

Dates and Times

cal

Display a calendar for a specified month or year

date

Display the current date and time or set a new date and
time

Becoming root (superuser)

When you want to do anything that requires a high privilege level (for exam-
ple, administering your system), you have to become root. Normally, you
log in as a regular user with your everyday username. When you need the
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privileges of the superuser, though, use the following command to become
root:

su -

That’s su followed by a space and the minus sign (or hyphen). The shell
then prompts you for the root password. Type the password and press
Enter.

After you've finished with whatever you want to do as root (and you have
the privilege to do anything as root), type exit to return to your normal
username.

Instead of becoming root by using the su - command, you can also type
sudo followed by the command that you want to run as root. In Ubuntuy,
you must use the sudo command because you don’t get to set up a root
user when you install Ubuntu. If you're listed as an authorized user in the /
etc/sudoers file, sudo executes the command as if you were logged in as
root. Typeman sudoers to read more about the /etc/sudoers file.

Managing processes

Every time the shell executes a command that you type, it starts a process.
The shell itself is a process as are any scripts or programs that the shell runs.

Use the ps ax command to see a list of processes. When you type ps ax,
bash shows you the current set of processes. Here are a few lines of output
when I type ps ax --cols 132. (Iincluded the --cols 132 option to
ensure that you can see each command in its entirety.)

ID TTY STAT TIME COMMAND
S 0:01 init [5]
SN 0:00 [ksoftirgd/0]
S< 0:00 [events/0]
S< 0:00 [khelper]
9 ? S< 0:00 [kthread]
19 ? S< 0:00 [kacpid]
75 ? S< 0:00 [kblockd/0]
115 ? S 0:00 [pdflush]
116 ? S 0:01 [pdflush]
118 ? S< 0:00 [aio/0]
?
?

O I N o]
N N N v

117 S 0:00 [kswapd0]

711 S 0:00 [kseriod]

1075 ? S< 0:00 [reiserfs/0]

2086 ? S 0:00 [kjournald]

2239 ? S<s 0:00 /sbin/udevd -d

. . lines deleted . . .

6374 ? S 1:51 /usr/X11R6/bin/X :0 -audit 0 -auth /var/lib/gdm/:0.Xauth
-nolisten tcp vt7

6460 ? Ss 0:02 /opt/gnome/bin/gdmgreeter

6671 ? Ss 0:00 sshd: edulaney [priv]

6675 ? S 0:00 sshd: edulaney@pts/0

6676 pts/0 Ss 0:00 -bash
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6712 pts/0 S 0:00 vsftpd
14702 ? S 0:00 pickup -1 -t fifo -u
14752 pts/0 R+ 0:00 ps ax --cols 132

In this listing, the first column has the heading PID and shows a number for
each process. PID stands for process ID (identification), which is a sequential
number assigned by the Linux kernel. If you look through the output of the
ps ax command, you see that the init command is the first process and
has a PID of 1. That’s why init is referred to as the mother of all processes.

The cOMMAND column shows the command that created each process, and
the TIME column shows the cumulative CPU time used by the process. The
STAT column shows the state of a process — S means the process is sleep-
ing, and R means it’s running. The symbols following the status letter have
further meanings; for example < indicates a high-priority process, and +
means that the process is running in the foreground. The TTY column shows
the terminal, if any, associated with the process.

The process ID, or process number, is useful when you have to forcibly stop
an errant process. Look at the output of the ps ax command and note the
P1ID of the offending process. Then, use the ki1l command with that pro-
cess number to stop the process. For example, to stop process number 8550,
start by typing the following command:

kill 8550

If the process doesn’t stop after five seconds, repeat the command. The next
step in stopping a stubborn process is to type kill -INT pid, where pid
is the process number. If that doesn’t work, try the following command as a
last resort:

kill -9 8550

The -9 option means send signal number 9 to the process. Signal number 9
is the KILL signal, which should cause the process to exit. You could also
type this command as kill -KILL pid, where pidis the process ID.

Working with date and time

You can use the date command to display the current date and time or set a
new date and time. Type date at the shell prompt and you get a result simi-
lar to the following:

Fri Mar 14 15:10:07 EST 2010

As you can see, the date command alone displays the current date and
time.
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To set the date, log in as root and then type date followed by the date and
time in the MMDDhhmmYYYY format, where each character is a digit. For
example, to set the date and time to December 31, 2010 and 9:30 p.m.,

you type

date 123121302010

The MMDDhhmmYYYY date and time format is similar to the 24-hour military
clock and has the following meaning:

4+ MM is a two-digit number for the month (01 through 12).

4+ DD is a two-digit number for the day of the month (01 through 31).

4 hhis a two-digit hour in 24-hour format (00 is midnight and 23 is 11 p.m.).
4+ mm is a two-digit number for the minute (00 through 59).

4+ YvYvYY is the four-digit year (such as 2010).

The other interesting date-related command is cal. If you type cal without
any options, it prints a calendar for the current month. If you type cal fol-
lowed by a number, cal treats the number as the year and prints the calen-
dar for that year. To view the calendar for a specific month in a specific year,
provide the month number (1 = January, 2 = February, and so on) followed
by the year. Thus, type cal 8 2010 and you get the calendar for August
2010, as follows:

August 2010

Su Mo Tu We Th Fr Sa
1 2 3 4 5 6 7
8 9 10 11 12 13 14
15 16 17 18 19 20 21

22 23 24 25 26 27 28

29 30 31

Processing files

You can search through a text file with grep and view a text file, a screen
at a time, with more. For example, to search for my username in the /etc/
passwd file, I use

grep edulaney /etc/passwd

To view the /etc/inittab file a screen at a time, I type

more /etc/inittab

As each screen pauses, I press the spacebar to go to the next page.
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Many more Linux commands work on files — mostly on text files, but some
commands also work on any file. The sections that follow describe a few of
the file-processing tools.

Counting words and lines in a text file

[ am always curious about the size of files. For text files, the number of char-
acters is basically the size of the file in bytes (because each character takes
up a byte of storage space). What about words and the number of lines,
though?

The Linux we command comes to the rescue. The we command displays the
total number of lines, words, and characters in a text file. For example, type
wc /etc/inittab and you see output similar to the following:

97 395 2926 /etc/inittab

In this case, wc reports that 97 lines, 395 words, and 2,926 characters are in
the /etc/inittab file. If you simply want to see the number of lines in a
file, use the -1 option and type we -1 /etc/inittab. The resulting output
should be similar to the following:

97 /etc/inittab
As you can see, with the -1 option, wc simply displays the line count.

If you don’t specify a filename, the wc command expects input from the stan-
dard input. You can use the pipe feature (|) of the shell to feed the output of
another command to wc, which can be handy sometimes.

Suppose you want a rough count of the processes running on your system.
You can get a list of all processes with the ps ax command, but instead of
counting lines manually, just pipe the output of ps to wc and you get a rough
count automatically:

ps ax | wc -1
86

Here the ps command produces 86 lines of output. Because the first line
simply shows the headings for the tabular columns, you can estimate that
about 85 processes are running on your system. (This count probably
includes the processes used to run the ps and wc commands as well.)

Sorting text files

You can sort the lines in a text file by using the sort command. To see how
the sort command works, first type more /etc/passwd to see the current
contents of the /etc/passwd file. Now type sort /etc/passwd to see
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the lines sorted alphabetically. If you want to sort a file and save the sorted
version in another file, you have to use the bash shell’s output redirection
feature, like this:

sort /etc/passwd > ~/sorted.text

This command sorts the lines in the /etc/passwd file and saves the output
in a file named sorted. text in your home directory.

Substituting or deleting characters from a file

Another interesting command is tr, which substitutes one group of charac-
ters for another (or deletes a selected character) throughout a file. Suppose
that you have to occasionally use MS-DOS text files on your Linux system.
Although you may expect to use a text file on any system without any prob-
lems, you find one catch: DOS uses a carriage return followed by a line feed
to mark the end of each line whereas Linux uses only a line feed.

<P On your Linux system, you can get rid of the extra carriage returns in the
DOS text file by using the tr command with the -d option. Essentially, to
convert the DOS text file named filename.dos to a Linux text file named
filename.linux, type the following:

tr -d '\015' < filename.dos > filename.linux

In this command, '\015' denotes the code for the carriage-return character
in octal notation.

Splitting a file into several smaller files

The split command is handy for those times when you want to copy a file
but the file is too large to fit on a single floppy or send as one e-mail attach-
ment. You can then use the split command to break up the file into mul-
tiple smaller files.

By default, split puts 1,000 lines into each file. The new, split files are
named by groups of letters such as aa, ab, ac, and so on. You can specify a
prefix for the filenames. For example, to split a large file called hugefile.
tar into smaller files, use split as follows:

split -b 1440k hugefile.tar part.

This command splits the hugefile. tar file into 1440K chunks. The com-
mand creates files named part.aa, part.ab, part.ac, and so on.

To combine the split files back into a single file, use the cat command as
follows:

cat part.?? > hugefile.tar
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In this case, the two question marks (??) match any two-character extension
in the filename. In other words, the filename part . ?? matches all filenames
such as part .12, part.aa, part.ab, and part.2b.

Writing Shell Scripts

If you've ever used MS-DOS, you may remember MS-DOS batch files, which
are text files with MS-DOS commands. Similarly, shell scripts are also text
files with a bunch of shell commands.

If you aren’t a programmer, you may feel apprehensive about programming, Book Il
but shell programming can be as simple as storing a few commands in a file. Chapter 3
Right now, you might not be up to writing complex shell scripts, but you can

certainly try out a simple shell script.

To try your hand at a little shell programming, type the following text at the
shell prompt exactly as shown and then press Ctrl+D when you’re finished:
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cd

cat > simple

#!/bin/sh

echo "This script's name is: $O0"
echo Argument 1: $1

echo Argument 2: $2

Press Ctrl+D. The cd command changes the current directory to your home
directory. Then the cat command displays the next line and any other lines
you type before pressing Ctrl+D. In this case, | use > simple to send the
output to a file named simple. After you press Ctrl+D, the cat command
ends, and you see the shell prompt again. You created a file named simple
that contains the following shell script:

#!/bin/sh

echo "This script's name is: $0"
echo Argument 1: $1

echo Argument 2: $2

The first line causes Linux to run the bash shell program (of the name /
bin/bash). The shell then reads the rest of the lines in the script.

Just as most Linux commands accept command line options, a bash script
also accepts command-line options. Inside the script, you can refer to the
options as $1, $2, and so on. The special name $0 refers to the name of the
script itself.

To run this shell script, first you have to make the file executable (that is,
turn it into a program) with the following command:

chmod +x simple
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Now type . /simple one two to run the script, and it displays the follow-
ing output:

This script's name is: ./simple
Argument 1: one
Argument 2: two

The . / prefix to the script’s name indicates that the simple file is in the
current directory.

This script simply prints the script’s name and the first two command-line
options that the user types after the script’s name.

Next, try running the script with a few arguments, as follows:

./simple "This is one argument" second-argument third
This script's name is: ./simple

Argument 1: This is one argument

Argument 2: second-argument

The shell treats the entire string in the double quotation marks as a single
argument. Otherwise, the shell uses spaces as separators between argu-
ments on the command line.

Most useful shell scripts are more complicated than this simple script, but
this easy exercise gives you a rough idea of how to write shell scripts.

Place Linux commands in a file and use the chmod command to make the file
executable. Voila! You created a shell script!



Chapter 4: Navigating the Linux
File System

In This Chapter

v~ Finding out about the Linux file system
+ Navigating the system with Linux commands
v+ Understanding file permissions

v+ Manipulating files and directories with Linux commands

To use files and directories well, you need to understand the concept

of a hierarchical file system. Even if you use the GUI file managers
(addressed in the next chapter) to access files and folders (folders are also
called directories), you can benefit from a lay of the land of the file system.

This chapter introduces the Linux file system and shows you how to work
with files and directories using several Linux commands.

Understanding the Linux File System

Like any other operating system, Linux organizes information in files and
directories. A directory is a special file that can contain other files and direc-
tories. Because a directory can contain other directories, this method of
organizing files gives rise to a hierarchical structure. This hierarchical orga-
nization of files is the file system.

The Linux file system gives you a unified view of all storage on your PC. The
file system has a single root directory, indicated by a forward slash (/).
Within the root directory is a hierarchy of files and directories. Parts of the
file system can reside in different physical media, such as a hard drive, a
floppy disk, and a CD-ROM. Figure 4-1 illustrates the concept of the Linux file
system (which is the same in any Linux system) and how it spans multiple
physical devices.

If you're familiar with MS-DOS or Windows, you may find something missing
in the Linux file system: You don’t find drive letters in Linux. All disk drives
and CD-ROM drives are part of a single file system.



120 Understanding the Linux File System
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In Linux, you can have long filenames (up to 256 characters), and filenames
are case-sensitive. Often these filenames have multiple extensions, such as
sample. tar.Z. UNIX filenames can take many forms, such as the follow-
ing: index.html, Makefile, binutils-2.15.92.0.2-5.1386.rpm,
vsftpd_2.0.3-1_1i386.deb, .bash_profile, and httpd_src.tar.gz.
To locate a file, you need more than just the filename. You also need infor-
mation about the directory hierarchy. The extended filename, showing the
full hierarchy of directories leading to the file, is the pathname. As the name
implies, it’s the path to the file through the maze of the file system. Figure
4-2 shows a typical pathname for a file in Linux.
. First-level Second-level Third-level Filename
Figure 4-2: directory directory directory
The path | | |
for the file
shows the Y Y . Y -
. ¢ |/ | home| /| edulaney |/ public_html|/|index.html
quence 0
. : A A A Al A A
directories :
leading up | ) ' .
to the file. Root Directory separator Name Extension

directory
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As Figure 4-2 shows, the pathname has the following parts:

4+ The root directory, indicated by a forward slash (/) character.

4+ The directory hierarchy, with each directory name separated from the
previous one by a forward slash (/) character. A / appears after the last

directory name.

4 The filename, with a name and one or more optional extensions. (A
period appears before each extension.)

The Linux file system has a well-defined set of top-level directories, and
some of these directories have specific purposes. Finding your way around
the file system is easier if you know the purpose of these directories. You
also become adept at guessing where to look for specific types of files when
you face a new situation. Table 4-1 briefly describes the top-level directories
in the Linux file system.

Table 4-1 Top-Level Directories in the Linux File System

Directory Contains

/ Base of the file system. All files and directories are con-
tained logically in the root, or /, directory, regardless of
their physical locations.

/bin Executable programs that are part of the Linux operating
system. Many Linux commands, such as cat, cp, 1s,
more, and tar, are located in /bin.

/boot Linux kernel and other files that the LILO and GRUB
boot managers need. (The kernel and other files can be
anywhere, but placing them in the /boot directory is
customary.)

/dev Special files that represent devices attached to the system.
/etc Most system configuration files and the initialization scripts
(inthe /etc/rc.dsubdirectory).

/home Home directories of all users. User edulaney’s home direc-
tory, for example, is /home/edulaney.

/1lib Library files for all programs stored in /sbin and /bin
directories (including the loadable driver modules) needed
to start Linux.

/lost+found Lost files. Every disk partition has a 1ost+found directory.

(continued)
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Table 4-1 (continued)

Directory Contains

/media The /media/floppy directory for mounting floppy disks
and the /media/cdromor /media/cdrom0 directory
for mounting the CD/DVD-ROM drive. If you have a CD/DVD
recorder, you find a /media/cdrecorder directory
instead of /media/cdrom and may also find /media/
DVD. Used for mounting file systems on removable media,
such as CD/DVD-ROM drives, flash drives, external drives,
floppy disks, and Zip drives.

/mnt Temporarily mounted file systems

/opt Storage for large application software packages. For exam-
ple, some distributions install the OpenOffice.org Office
suite inthe /opt directory.

/proc Various information about the processes running in the
Linux system.

/root Home directory for the root user.

/sbin Executable files representing commands typically used for

system administration tasks and used by the root user.
Commands such as halt and shutdown reside in the
/sbin directory.

/srv Data for services (such as Web and FTP) offered by this
system.

/sys Information about the devices, as seen by the Linux kernel.

/tmp Temporary directory that any user can use as a scratch

directory, meaning that the contents of this directory are
considered unimportant and usually are deleted every time
the system boots.

/usr Subdirectories for many important programs, such as the
X Window System (in the /usr/X11R6 directory) and the
online manual. (Table 4-2 shows some of the standard sub-
directories in /usr.)

/var Various system files (such as logs), as well as directories
for holding other information, such as files for the Web
server and anonymous FTP server.

The /usr and /var directories also contain a number of standard subdirec-
tories. Table 4-2 lists the important subdirectories in /usr. Table 4-3 shows
a similar breakdown for the /var directory.
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Table 4-2 Important /usr Subdirectories

Subdirectory Description

/usr/bin Executable files for many more Linux commands, including
utility programs that are commonly available in Linux but
aren't part of the core Linux operating system.

/usr/games Some old Linux games.

/usr/ Header files (filenames ending in . h) for the C and C++ pro-

include gramming languages and the X11 header files in the /usr/
include/X11 directory and the Linux kernel header files
inthe /usr/include/1inux directory.

/usr/lib Libraries for C and C++ programming languages and many
other libraries, such as database libraries and graphical tool-
kit libraries.

/usr/local Local files. The /usr/local/bin directory, for example,
is supposed to be the location for any executable program
developed on your system.

/usr/sbin Many administrative commands, such as commands for
e-mail and networking.

/usr/share Shared data, such as default configuration files and images for
many applications. For example, /usr/share/gnome con-
tains various shared files for the GNOME desktop, and /usr/
share/doc has the documentation files for many Linux
applications (such as the bash shell, the Sawfish window
manager, and The GIMP image processing program).

/usr/share/ Online manual (which you can read by using the man

man command).

/usr/src Source code for the Linux kernel (the core operating system).

Table 4-3 Important /var Subdirectories

Subdirectory Contains

/var/cache Storage area for cached data for applications.

/var/lib Information relating to the current state of applications.

/var/lock Locked files to ensure that a resource is used by one

application only.

(continued)
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Table 4-3 (continued)

Subdirectory Contains

/var/log Log files organized into subdirectories. The syslogd server
stores its log files in /var/1log, with the exact content of
the files depending on the sys1ogd configuration file /etc
/syslog.cont. Forexample, /var/log/messages
is the main system log file; /var/log/secure contains
log messages from secure services (such as sshd and
xinetd); and /var/log/maillog contains the log of
mail messages.

/var/mail User mailbox files.

/var/opt Variable data for packages stored in /opt directory.
/var/run Data describing the system since it was booted.
/var/spool Data that's waiting for some kind of processing.
/var/tmp Temporary files preserved between system reboots.
/var/yp Network Information Service (NIS) database files.

Navigating the File System with Linux Commands

Although GUI file managers such as Nautilus (in GNOME) or Konqueror (in
KDE) are easy to use, you can use them only if you have a working GUI desk-
top. Sometimes, you may not have a graphical environment to run a graphi-
cal file manager. For example, you may be logged in through a text terminal,
or X may not be working on your system. In those situations, you have to
rely on Linux commands to work with files and directories. You can always
use Linux commands, even in the graphical environment — all you have to
do is open a terminal window and type the Linux commands.

In this section, I briefly describe some Linux commands for moving around
the Linux file system.

Commands for directory navigation

In Linux, when you log in as root, your home directory is /root. For other
users, the home directory is usually in the /home directory. My home direc-
tory (when Ilog in as edulaney) is /home/edulaney. This information is
stored in the /etc/passwd file. By default, only you have permission to
save files in your home directory, and only you can create subdirectories in
your home directory to further organize your files.

Linux supports the concept of a current directory, which is the directory on
which all file and directory commands operate. After you log in, for example,
your current directory is the home directory. To see the current directory,
type the pwd command.
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To change the current directory, use the cd command. To change the cur-
rent directory to /usr/1ib, type the following:

cd /usr/lib

Then, to change the directory to the cups subdirectory in /usr/1ib, type
this command:

cd cups

Now, if you use the pwd command, that command shows /usr/1ib/cups
as the current directory.

These two examples show that you can refer to a directory’s name in two
ways:

4 Absolute pathname: An example is /usr/1ib, which is an exact direc-
tory in the directory tree. Think of the absolute pathname as the com-
plete mailing address for a package that the postal service will deliver to
your next-door neighbor.

4+ Relative directory name: An example is cups, which represents the
cups subdirectory of the current directory, whatever that may be. Think
of the relative directory name as giving the postal carrier directions
from your house to the one next door so the carrier can deliver the
package.

IfItype cd cupsin /usr/1lib, the current directory changes to /usr/1ib/
cups. However, if [ type the same command in /home/edulaney, the shell
tries to change the current directory to /home/edulaney/cups.

Use the cd command without any arguments to change the current direc-
tory back to your home directory. No matter where you are, typing ed at the
shell prompt brings you back home!

The tilde character (~) refers to your home directory. Thus, you can change
the current directory to your home directory also by using the command
cd ~. You can refer to another user’s home directory by appending that
user’s name to the tilde. Thus, cd ~superman changes the current direc-
tory to the home directory of superman.

Wait, there’s more. A single dot (.) and two dots (. .) — often cleverly
referred to as dot-dot — also have special meanings. A single dot (.) indi-
cates the current directory, whereas two dots (. .) indicate the parent
directory. For example, if the current directory is /usr/share, you go one
level up to /usr by typing the following:

cd .
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Commands for directory listings and permissions

You can get a directory listing by using the 1s command. By default, the 1s
command — without options — displays the contents of the current direc-
tory in a compact, multicolumn format. For example, type the next two com-
mands to see the contents of the /etc/X11 directory:

cd /etc/X11
1s

The output looks like this. (On the console, you see some items in different
colors.)

X Xsession.d cursors rgb.txt xkb

XF86Config-4 Xsession.options default-display-manager rstart xserver
Xresources Xwrapper.config fonts sysconfig xsm

Xsession app-defaults gdm xinit

From this listing (without the colors), you can’t tell whether an entry is a file
or a directory. To tell the directories and files apart, use the -F option with
1s, like this:

ls -F
This time, the output gives you some more clues about the file types:

X@ Xsession.d/ cursors/ rgb.txt xkb/

XF86Config-4 Xsession.options default-display-manager rstart/ xserver/
Xresources/ Xwrapper.config fonts/ sysconfig/ xsm/

Xsession* app-defaults/ gdm@ xinit/

The output from 1s -F shows the directory names with a slash (/)
appended to them. Plain filenames appear as is. The at sign (@) appended
to a filename (for example, notice the file named X) indicates that this

file is a link to another file. (In other words, this filename simply refers

to another file; it’s a shortcut.) An asterisk (*) is appended to executable
files. (Xsession, for example, is an executable file.) The shell can run any
executable file.

You can see even more detailed information about the files and directories
with the -1 option:

1ls -1

For the /etc/X11 directory, a typical output from 1s -1 looks like the
following:

total 84

lrwxrwxrwx 1 root root 20 Jul 15 20:32 X -> /usr/bin/X11/XFree86
-rw-r--r-- 1 root root 2878 Jul 16 14:50 XF86Config-4

drwxr-xr-x 2 root root 4096 Jul 15 20:32 Xresources
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-rwxr-xr-x 1 root root 3456 Jun 1 01:59 Xsession
drwxr-xr-x 2 root root 4096 Jul 15 20:34 Xsession.d
-rw-r--r-- 1 root root 217 Jun 1 01:59 Xsession.options
-Yw------- 1 root root 771 Jul 15 20:32 Xwrapper.config
drwxr-xr-x 2 root root 4096 Jul 15 20:35 app-defaults

. lines deleted . . .

This listing shows considerable information about every directory entry —
each of which can be a file or another directory. Looking at a line from the
right column to the left, you see that the rightmost column shows the name
of the directory entry. The date and time before the name show when the
last modifications to that file were made. To the left of the date and time is
the size of the file in bytes.

The file’s group and owner appear to the left of the column that shows the
file size. The next number to the left indicates the number of links to the file.
(A link is like a shortcut in Windows.) Finally, the leftmost column shows the
file’'s permission settings, which determine who can read, write, or execute
the file.

The first letter has a special meaning, as the following list shows:

4+ 1: The file is a symbolic link to another file. In other words, it’s a short-
cut to something else.

4+ a: The file is a directory. It will appear as a folder in a GUL

4 - (hyphen): The file is normal. By normal, ] mean that it isn’t a directory,
a link, or anything else odd. Most of the items on your system are just
normal files.

4+ b: The file represents a block device, such as a disk drive.

4+ c: The file represents a character device, such as a serial port or a terminal.

After that first letter, the leftmost column shows a sequence of nine charac-
ters, which appear as rwxrwxrwx when each letter is present. Each letter
indicates a specific permission. A hyphen (-) in place of a letter indicates no
permission for a specific operation on the file. Think of these nine letters as
three groups of three letters (rwx), interpreted as follows:

4 Leftmost rwx group: Controls the read, write, and execute permission
of the file’s owner. In other words, if you see rwx in this position, the
file’s owner can read (r), write (w), and execute (x) the file. A hyphen in
the place of a letter indicates no permission. Thus, the string rw- means
the owner has read and write permission but not execute permission.
Although executable programs (including shell programs) typically have
execute permission, directories treat execute permission as equivalent
to use permission: A user must have execute permission on a directory
before he or she can open and read the contents of the directory.

Book Il
Chapter 4

wa)sAg a4 xnury
ay) bunebiney



128 Navigating the File System with Linux Commands

3

4+ Middle rwx group: Controls the read, write, and execute permission of
any user belonging to that file’s group.

4+ Rightmost rwx group: Controls the read, write, and execute permission
of all other users (collectively thought of as the world).

Thus, a file with the permission setting rwx------ is accessible only to the
file’s owner, whereas the permission setting rwxr--r-- makes the file read-
able by the world.

An interesting feature of the 1s command is that it doesn’t list any file whose
name begins with a period. To see these files, you must use the 1s command
with the -a option, as follows:

ls -a

Try this command in your home directory and then compare the result with
what you see when you don’t use the -a option:

1. Type cd to change to your home directory.
2. Type 1s -F to see the files and directories in your home directory.

3. Type 1s -aF to see everything, including hidden files.

Most Linux commands take single-character options, each with a hyphen as
a prefix. When you want to use several options, type a hyphen and concat-
enate (string together) the option letters, one after another. Thus, 1s -al is
equivalentto 1s -a -laswellasls -1 -a.

Commands for changing permissions and ownerships
You may need to change a file’s permission settings to protect it from
others. Use the chmod command to change the permission settings of a file
or a directory.

To use chmod effectively, you have to specify the permission settings. A
good way is to concatenate letters from the columns of Table 4-4 in the
order shown (Who/Action/Permission).

Table 4-4 Letter Codes for File Permissions
Who Action Permission
u (user) + (add) r (read)
g (group) - (remove) w (write)
o (others) = (assign) x (execute)

a (all) s (set user ID)
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You use only the single character from each column — the text in parenthe-
ses is for explanation only.

For example, to give everyone read access to all files in a directory, pick
a (for all) from the first column, + (for add) from the second column, and
r (for read) from the third column to come up with the permission setting
a+r. Then use the set of options with chmod, like this:

chmod a+r *.
On the other hand, to permit everyone to execute one specific file, type
chmod a+x filename

Suppose you have a file named mystuff that you want to protect. You can
make it accessible to no one but you if you type the following commands, in
this order:

chmod a-rwx mystuff
chmod u+rw mystuff

The first command turns off all permissions for everyone, and the second
command turns on the read and write permissions for the owner (you). Type
1s -1 to verify that the change took place. (You see a permission setting of

Sometimes you have to change a file’s user or group ownership for every-
thing to work correctly. For example, suppose you're instructed (by a
manual, what else?) to create a directory named cups and give it the owner-
ship of user ID 1p and group ID sys. How do you it?

Well, you can log in as root and create the cups directory with the com-
mand mkdir:

mkdir cups

If you check the file’s details with the 1s -1 command, you see that the user
and group ownership is root root.

To change the owner, use the chown command. For example, to change the
ownership of the cups directory to user ID 1p and group ID sys, type

chown 1lp.sys cups

Commands for working with files

To copy files from one directory to another, use the cp command. If you
want to copy a file to the current directory but retain the original name, use
a period (.) as the second argument of the cp command. Thus, the following
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command copies the Xresources file from the /etc/X11 directory to the
current directory (denoted by a single period):

cp /etc/X1l/Xresources
The cp command makes a new copy of a file and leaves the original intact.

If you want to copy the entire contents of a directory — including all sub-
directories and their contents — to another directory, use the command
cp -ar sourcedir destdir. (This command copies everything in the
sourcedir directory to destdir.) For example, to copy all files from the
/etc/X11 directory to the current directory, type the following command:

cp -ar /etc/X1ll

To move a file to a new location, use the mv command. The original copy is
gone, and a new copy appears at the destination. You can use mv to rename
a file. If you want to change the name of today.list to old.1list, use the
mv command, as follows:

mv today.list old.list

On the other hand, if you want to move the today.1ist file to a subdirec-
tory named saved, use this command:

mv today.list saved

An interesting feature of mv is that you can use it to move entire directories
(with all their subdirectories and files) to a new location. If you have a direc-
tory named data that contains many files and subdirectories, you can move
that entire directory structure to o1d_data by using the following command:

mv data old_data

To delete files, use the rm command. For example, to delete a file named
o0ld.list, type the following command:

rm old.list

Be careful with the rm command — especially when you log in as root. You
can inadvertently delete important files with rm.

Commands for working with directories

To organize files in your home directory, you have to create new directories.
Use the mkdir command to create a directory. For example, to create a
directory named images in the current directory, type the following:

mkdir images
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After you create the directory, you can use the cd images command to
change to that directory.

You can create an entire directory tree by using the -p option with the
mkdir command. For example, suppose your system has a /usr/src direc-
tory and you want to create the directory tree /usr/src/book/java/
examples/applets. To create this directory hierarchy, type the following
command:

mkdir -p /usr/src/book/java/examples/applets

When you no longer need a directory, use the rmdir command to delete it.
You can delete a directory only when the directory is empty.

To remove an empty directory tree, you can use the -p option, like this:
rmdir -p /usr/src/book/java/examples/applets

This command removes the empty parent directories of applets. The com-
mand stops when it encounters a directory that’s not empty.

Commands for finding files

The find command is useful for locating files (and directories) that meet
your search criteria.

When I began using UNIX many years ago (Berkeley UNIX in the early 1980s),
[ was confounded by the find command. I stayed with one basic syntax of
find for a long time before graduating to more complex forms. The basic
syntax that I discovered first was for finding a file anywhere in the file
system. Here’s how it goes: Suppose you want to find any file or directory
with a name that starts with gnome. Type the following find command to
find these files:

find / -name "gnome*" -print

If you're not logged in as root, you may get a bunch of error messages. If
these error messages annoy you, just modify the command as follows and
the error messages are history. (Or, as Unix aficionados say, “Send ’em to
the bit bucket.”)

find / -name "gnome*" -print 2> /dev/null

This command tells £ind to start looking at the root directory (/) to look
for filenames that match gnome* and to display the full pathname of any
matching file. The last part (2> /dev/null) simply sends the error mes-
sages to a special file that’s the equivalent of simply ignoring them.
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You can use variations of this simple form of £ind to locate a file in any
directory (as well as any subdirectories contained in the directory). If you
forget where in your home directory you've stored all files named report*
(names that start with reporf), you can search for the files by using the fol-
lowing command:

find ~ -name "report*" -print

When you become comfortable with this syntax of £ind, you can use other
options of £ind. For example, to find only specific types of files (such as
directories), use the type option. The following command displays all top-
level directory names in your Linux system:

find / -type d -maxdepth 1 -print

You probably don’t have to use the complex forms of £ind in a typical Linux
system. But if you ever need to, you can look up the rest of the find options
by using the following command:

man find

<P An easy way to find all files that match a name is to use the 1ocate com-
mand, which searches a periodically updated database of files on your
system. For example, here’s a typical output I get when [ type 1locate
Xresources on a Debian system (the output may differ based on your
distribution):

/etc/X11l/Xresources
/etc/X11l/Xresources/xbase-clients
/etc/X11l/Xresources/xfree86-common

The locate command isn’t installed by default in some Linux distributions.
To install it, open the Add/Remove Software application for your distribution
and search for locate. Then select the package from the search results and
click Accept to install it.

Commands for mounting and unmounting

Suppose you want to access the files on this book’s companion DVD-ROM
when you're logged in at a text console (with no GUI to help you). To do so,
you have to first mount the DVD-ROM drive’s file system on a specific direc-
tory in the Linux file system.

‘\SPEC/&O Start by looking at the /etc/£fstab file for clues to the name of the CD-ROM

device. For example, some Linux distributions use the device name /dev/
cdrom to refer to CD/DVD-ROM drives, whereas others may use device
names such as /dev/hdc, /dev/cdroms/cdrom0, or /dev/cdrecorder
(for a DVD/CD-R drive). The entry in /etc/fstab file also tells you the
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directory where that distribution expects the CD/DVD to be mounted. Some
distributions use /media/cdrom as the mount point, whereas others use /
media/cdrom0, or /media/cdrecorder.

It is customary to use the cdrom term to mean both CD-ROM and DVD-ROM.

Log in as root (or type su - to become root), insert the DVD-ROM in the
DVD drive, and then type the following command:

mount /dev/hdc /media/cdromO

This command mounts the file system on the device named /dev/hdc (an
IDE DVD/CD-ROM drive) on the /media/cdrom0 directory (which is also
called the mount poinf) in the Linux file system.

After the mount command successfully completes its task, you can access
the files on the DVD-ROM by referring to the /media/cdrom0 directory as
the top-level directory of the disc. In other words, to see the contents of the
DVD-ROM, type

ls -F /media/cdromO

When you've finished using the DVD-ROM — and before you eject it from
the drive — you have to unmount the disc drive with the following umount
command:

umount /dev/hdc

You can mount devices on any empty directory on the file system. However,
each distribution has customary locations with directories meant for
mounting devices. For example, some distributions use directories in /mnt
whereas others use the /media directory for the mount points.

Commands for checking disk-space usage

You can use two simple commands — df and du — to check the disk-space
usage on your system. The df command shows you a summary of disk-space
usage for all mounted devices. For example, when [ type df on a PC with
many mounted storage devices, here’s what I get as output:

Filesystem 1K-blocks Used Available Use% Mounted on
/dev/hdb6 28249372 2377292 25872080 9% /

tmpfs 383968 12 383956 1% /dev/shm

/dev/hda5 5766924 1422232 4051744 26% /ubuntu/boot
/dev/hda7 6258100 2989200 2951004 51% /debian/boot
/dev/hda9 5766924 1422232 4051744 26% /ubuntu
/dev/hdal0 5766924 1872992 3600984 35% /mepis
/dev/hdall 6258100 2989200 2951004 51% /debian
/dev/hdb3 19558500 1370172 18188328 8% /xandros
/dev/hda2 16087676 10593364 5494312 66% /windows/C
/dev/hdbl 107426620 9613028 97813592 9% /windows/D
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This table lists the device, the total kilobytes of storage, how much of that
memory is in use, how much is available, the percentage being used, and the
mount point.

To see the output of Af in a more readable format, type df -h. The output
follows:

Filesystem Size Used Avail Use$% Mounted on
/dev/hdb6 27G 2.3G 25G 9% /

tmpfs 375M 12K 375M 1% /dev/shm

/dev/hda5 5.5G 1.4G 3.9G 26% /ubuntu/boot
/dev/hda7 6.0G 2.9G 2.9G 51% /debian/boot
/dev/hda9 5.5G 1.4G 3.9G 26% /ubuntu
/dev/hdal0 5.5G 1.8G 3.5G 35% /mepis
/dev/hdall 6.0G 2.9G 2.9G 51% /debian
/dev/hdb3 19G 1.4G 18G 8% /xandros
/dev/hda2 16G 11G 5.3G 66% /windows/C
/dev/hdbl 103G 9.2G 94G 9% /windows/D

If you compare this output with the output of the plain df (the preceding
listing), you see that df -h prints the sizes with terms like M for megabytes
and G for gigabytes. These are easier to understand than 1K-blocks.

The other command, du, is useful for finding out how much space a direc-
tory takes up. For example, type du /etc/X11 to view the contents of

all the directories in the /etc/X11 directory. (This directory contains X
Window System configuration files.) You see the following:

12 /etc/X1ll/Xresources
36 /etc/X1l/Xsession.d
272 /etc/X1ll/app-defaults
20 /etc/X1ll/cursors

12 /etc/X11l/xinit

. lines deleted .
12 /etc/X11l/fonts/misc
8 /etc/X1l/fonts/100dpi
8 /etc/X1l/fonts/75dpi
8 /etc/X1ll/fonts/Speedo
8 /etc/X1l/fonts/Typel
48 /etc/X11l/fonts

2896 /etc/X11l

Each directory name is preceded by a number — which tells you the number
of kilobytes of disk space used by that directory. Thus, the /etc/x11 direc-
tory uses 2896KB (or about 2.9MB) disk space. If you simply want the total
disk space used by a directory (including all the files and subdirectories con-
tained in that directory), use the -s option, as follows:

du -s /etc/X11
2896 /etc/X11l
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The -s option causes du to print just the summary information for the entire
directory.

Just as df -h prints the disk-space information in megabytes and gigabytes,
you can use the du -h command to view the output of du in more readable
form. For example, here’s how I combine it with the -s option to see the
space that I'm using in my home directory (/home/edulaney):

du -sh /home/edulaney
645M /home/edulaney
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Chapter 5: Introducing Linux
Applications

In This Chapter

v~ Taking stock of typical Linux applications
v+ Trying out the office applications

v Playing with multimedia

v Working with images

v+ Trying out GUI file managers

Each Linux distribution comes with plenty of applications for all your
diverse computing needs, as you can see by simply looking at the
menus in the GUI desktops. Often, more than one application of the same
type exists. Most distributions come with the OpenOffice.org office applica-
tion suite with a word processor, spreadsheet, presentation software, and
more. You'll find many choices for CD players and multimedia players, plus
games, utility programs, and other useful tools, such as a scanner and digi-
tal camera applications. Some commercial distributions come with commer-
cial office suites such as StarOffice from Sun Microsystems.

When it comes to playing multimedia (audio and video in various formats,
such as MP3, MPEG, and QuickTime), freely available Linux distributions
rarely come with the appropriate decoders because of licensing restric-
tions; the multimedia application runs but cannot play the MP3 file or the
DVD movie because it lacks a decoder. Commercial distributions, such as
Xandros and SUSE, usually come with some of these decoders.

This chapter offers an overview of some Linux applications. After you read
about these applications, you can explore them further and have them at
your disposal when needed. This chapter also provides an introduction to the
GUI file managers, which allow you to browse and manipulate individual files.

Taking Stock of Linux Applications

Table 5-1 shows a sampling of major Linux applications, organized by cate-
gory. For the major applications, there is also a relevant Web site where you
can get more information about that application. This list is by no means



138 Taking Stock of Linux Applications

comprehensive. Each Linux distribution comes with many more applica-
tions and utilities than the ones shown in this table. If your system has both
GNOME and KDE installed, most of these applications are already available
from either GUI desktop.

Table 5-1 A Sampling of Linux Applications

Application Description

Office Applications

OpenOffice.org Free open source office suite (compatible with Microsoft
Office) that includes the Writer word processor, Calc
spreadsheet, Impress presentation application, Draw
drawing program, and Math equation editor (www . open
office.org)

StarOffice Commercial office suite from which OpenOffice.org was
derived (www . sun.com/staroffice)

CrossOver Office Commercial office suite that enables you to install and run
Microsoft Office software on Linux (www . codeweavers .
com/products/office)

AbiWord Free word processing program similar to Microsoft Word
(www . abisource.com)

Dia Diagram drawing program, designed to be like Visio,
the Windows application (http://1live.gnome.
org/dia)

Office Tools

GNOME Calculator Simple calculator for GNOME

KCalc Calculator for KDE

KOrganizer Calendar and scheduling program for KDE (http: //

userbase.kde.org/KOrganizer)

Kontact Personal information management suite for KDE, includes
applications for e-mail, scheduling, contacts, and time
tracking (http://userbase.kde.org/Kontact)

Aspell Text mode spell checker (http://aspell .net)

Dictionary Provides definitions through a graphical client for the dict.
org dictionary server

Text Editors

emacs Well-known text editor with both text and graphical inter-
faces (www.gnu.org/software/emacs)

gedit Text editor for GNOME (http://projects.gnome.
org/gedit/)




Taking Stock of Linux Applications

139

Application Description
Office Applications
KWrite Text editor for KDE

Kate Advanced text editor for KDE (http: //kate-
editor.org)

vim Text editor with text mode interface and compatible with
the well-known UNIX editor vi (www.vim. org)

Database

PostgreSQL Sophisticated object-relational database-management
system (www.postgresqgl . org) that supports
Structured Query Language (SQL)

MySQL Popular relational database-management system that
supports SAL (www . mysgl . com)

Multimedia

GNOME CD Player

Audio CD player (needs a working sound card)

KsCD

Audio CD player from KDE (needs a working sound card)

amaroK

Multimedia audio player (http: //amarok.kde.org)
that can play several sound formats, including MP3 files if
the MP3 decoders are installed

Rhythmbox

Multimedia audio player (http: //projects.

gnome . org/rhythmbox) designed for the GNOME
desktop that can play several sound formats, including
MP23 files if the proper plug-ins have been downloaded

XMMS

X Multimedia System: a multimedia audio player (www .
xmms . org) that can play many different sound formats,
including MP3 files. (For some distributions, you have to
download a plug-in to play MP3.)

xine

Free multimedia player (http://xine-project.
org) that can play CDs, DVDs, and video CDs (VCDs) and
also decode multimedia files such as AVIl, MOV, WMV,
and MP3, provided you have the appropriate decoders

Kaffeine

KDE media player based on xine; Kaffeine's capabilities
are similar to those of xine (http://kaffeine.kde.
org)

Totem

GNOME movie player that is based on xine; Totem’s capa-
bilities are similar to those of xine (http://
projects.gnome.org/ totem)

Pitivi

Video editor for GNOME that allows for video clip manipu-
lation, audio editing, and more (www.pitivi.org)

(continued)
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Table 5-1 (continued)

Application Description

Multimedia

cdrdao Command-line application that can burn audio or
data CD-Rs in disk-at-once (DAQ) mode based on the
descriptions of the CD’s content in a text file (http: //
cdrdao.sourceforge.net)

cdrecord Command-line application that can burn audio and data
CD-Rs as well as DVD-Rs (http: //cdrecord.
berlios.de/old/private/cdrecord.html)

growisofs Command-line application that uses the mkisofs com-
mand to append data to an IS0 9660 file system used
in CD-Rs and DVD-Rs (http://fy.chalmers.
se/~appro/linux/DVD+RW)

X-CD-Roast GUI front-end for cdrecord and cdrdao that makes burning
data and audio CD-Rs easy (www .xcdroast .org)

K3b KDE-based GUI front-end for cdrecord, cdrdao, and grow-
isofs for burning CD-Rs and DVD-Rs (www . k3b . org)

digiKam Digital camera and photo management application that

supports all the digital cameras supported by gPhoto2
(www . digikam.org)

Graphics and Imaging

The GIMP The GNU Image Manipulation Program: an application
suitable for tasks such as photo retouching, image com-
position, and image authoring (www . gimp.org)

GQview Powerful image viewer (http://ggview.source
forge.net)

KFax Fax viewer for KDE

KView Simple image viewer for KDE

GGv Gnome Ghostview (GGv): a PostScript document viewer
(www.directory.fsf.org/project/ggv/)

Xpdf Adobe PDF document viewer (www. foolabs.com/
xpdf/)

XSane Graphical front-end for accessing scanners with the SANE
(Scanner Access Now Easy) library (www . xsane . org)

KSnapshot Screen-capture program

Kooka Scanner program for KDE that uses the SANE library

(http://kooka.kde.org)

Xscanimage

Graphical front-end for controlling a scanner
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Application Description

Internet

Evolution Personal information management application that inte-
grates e-mail, calendar, contact management, and online
task lists (http://projects.gnome.org/
evolution/)

gFTP Graphical FTP client for downloading files from the
Internet

Pidgin Instant messenger client compatible with multiple GUls
(www.pidgin. im)

Kopete KDE instant messenger client (http: / /kopete.kde.
org)

Empathy Instant-messaging program that supports text, voice, and
video chat over multiple protocols (http://1live.
gnome . org/Empathy)

Gwibber Microblogging client for GNOME (http: //launch
pad.net/gwibber)

Mozilla Well-known open source Web browser that started with
source code from Netscape (www.mozilla.org)

Firefox New and improved Web browser from the Mozilla Project
(www.mozilla.org/products/firefox)

Thunderbird E-mail client from the Mozilla Project (www.mozilla
messaging.com)

Epiphany Mozilla-based open source Web browser for GNOME
(http://projects.gnome.org/epiphany/)

Lynx Text mode Web browser (http://lynx.browser.
org)

KNode GUI newsreader for KDE (http: //userbase.kde.
org/KNode)

Pan GUI newsreader for GNOME (http://pan.rebel
base.com)

Akregator RSS feed aggregator and reader for KDE (http://
akregator.kde.org)

KPhone Internet telephony application that supports the Session
Initiation Protocol (SIP) (http: //sourceforge.
net/projects/kphone)

Linphone Internet telephony application that supports the Session

Initiation Protocol (SIP) and Real-time Transport Protocol
(RTP) (www . 1inphone. org)

(continued)
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Table 5-1 (continued)

Application Description

Internet

Skype Internet telephony application for using voice over IP
(VOIP) to make voice phone calls (www . skype . com)

XChat Internet Relay Chat (IRC) client (www . xchat . org)

Konqueror Web browser and file manager in KDE (www .
kongqueror.org)

KMail E-mail client for KDE (http://userbase.kde.org/
Kmail)

Games

Kapman New version of an old classic; eat delicious pills while
avoiding pesky ghosts

Kolf Virtual minigolf game

Konquest Battle Game of intergalactic takeover

Mines Safer than crossing a real minefield but still nerve wracking

Solitaire Classic prescription for chronic boredom

Sudoku Puzzles with different levels

Later sections of this chapter include some of the applications from Table 5-1,
selecting one or two from each category. Internet applications are discussed
in Book IV.

Not all Linux distributions come with all the applications shown in Table 5-1,
although you can often download and install all these applications in any
distribution.

You typically must select specific groups of applications to install as you
install a Linux distribution. The exact list of applications on your Linux
system depends on the choices you make during the installation.

It’s easy to install missing applications in Debian (and Debian-based distribu-
tions, such as Ubuntu) as long as you have a broadband (cable or DSL) con-
nection to the Internet. For example, to see whether the K3b CD/DVD burner
exists for Debian, type apt-cache search k3b. You get output similar to
the following:

k3b - A sophisticated KDE cd burning application

k3b-1i18n - Internationalized (il8n) files for k3b

k3blibs - The KDE cd burning application library - runtime files
k3blibs-dev - The KDE cd burning application library - development files
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Next, type apt-get install k3b and a few moments later you’ll have K3b
installed on your Debian system. This ease of installing (or upgrading) soft-
ware is why Debian users swear by apt-get (even though it's a command-
line tool).

Introducing Office Applications and Tools

Word processor, spreadsheet, presentation software, calendar, calculator —
these are some office staples. Most Linux distributions come with the
OpenOffice.org (often shortened as OO.o or Oo0) suite of office applications
and tools. You can try all of them one by one and see which one takes your Book Il
fancy. Each application is fairly intuitive to use. Although some nuances of Chapter 5
the user interface may be new to you, you’ll become comfortable with the
interface after using it a few times. This section briefly introduces the follow-
ing applications, as well as some other commercially available office applica-
tions for Linux:

4+ OpenOffice.org Office Suite: A Microsoft Office-like office suite with the
Writer word processor, the Calc spreadsheet program, the Impress pre-
sentation program, the Draw drawing and illustration application, and
Math, a mathematical formula editor

suoneaiddy
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Kontact: A personal information management application in KDE
4+ Calculators: A GNOME calculator and KDE calculator
4+ Aspell: A spelling checker

OpenOffice.org office suite

OpenOffice.org is an office suite developed by the OpenOffice.org project
(www .openoffice.org). OpenOffice.org is similar to major office suites
such as Microsoft Office. Its main components are the Writer word proces-
sor, the Calc spreadsheet, and the Impress presentation program.

You can easily start OpenOffice.org — either the overall suite or an indi-
vidual application — from most GUI desktops by clicking a panel icon or by
making a choice from the main menu. For example, in SUSE, you can click a
desktop icon to open the initial window of the OpenOffice.org suite. You can
create new Open Office documents or open existing documents (which can
be Microsoft Office files as well) from the main window of the OpenOffice.org.

Writer

Choosing File®>New=>Text Document from any OpenOffice.org window starts
OpenOffice.org Writer with a blank document in its main window. Using
Writer is simple — if you're familiar with Microsoft Word, you should have
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no trouble finding your way around Writer. You can type text into the blank
document, format text, and save text.

You can also open documents that you have prepared with Microsoft Word
on a Windows machine. Figure 5-1 shows a Microsoft Word document
opened in OpenOffice.org Writer.

L document.doc - OpenOffice.org Writer =[x
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B-OdelH b % Q- 29 ¢ a@d5-P A ¥
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Professional wrestling, or pro wrestling, is a form of sporting theatre which contains strong elements of
mock combat and catch wrestling. Matches are preamanged by the promotion’s booking staff and contain
content and scripted outcomes. Its origins date to 19th-century camival sideshows and music halls, as part

of displays of athleticism and strength. Modem professional wrestling usually features striking an
‘arappling techniques, which are modeled after diverse sets of wrestling and pugilistic styles from around

\\3

When you save a document, by default, Writer saves it in OpenDocument
text format in a file with the . odt extension.

OpenOffice.org version 2.0 and later uses the standard OASIS
OpenDocument XML format as the default file format (the file extension

is . odt). The OASIS OpenDocument format is not tied to any vendor or
any specific office suite software. For more information on OpenDocument
format, see

http://www.oasis-open.org/committees/tc_home.php?wg_abbrev=office

If you need to share OpenOffice.org Writer documents with Microsoft Word,
you can save the documents in several formats, including Microsoft Word
97/2000/XP and Rich Text Format (.rtf). For exchanging files with users of
OpenOffice.org versions before 2.0, save the file in StarOffice text document
format with an . odt extension.

Writer is simple and intuitive to use. If you need help, online help is available
by choosing Help=>OpenOffice.org Help from the Writer menu (or pressing
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F1 in newer versions). This brings up the OpenOffice.org Help window with
help information on Writer. You can then click the links to view specific help
information.

Calc

Calc is the spreadsheet program in the OpenOffice.org application suite. To
start Calc, choose Spreadsheet from the Office category in the main menu or
choose File’Newr>Spreadsheet from any OpenOffice.org window. Calc dis-
plays its main window, which looks similar to Windows-based spreadsheets,
such as Microsoft Excel. (Calc can read and write Microsoft Excel format
spreadsheet files.)

Use Calc in the same way you use Microsoft Excel. You can type entries in
cells, use formulas, and format the cells. (For example, you can specify the
type of value and the number of digits after the decimal point.) Figure 5-2
shows a typical spreadsheet in Calc.
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When preparing the spreadsheet, use formulas in the same format that you
would in Microsoft Excel. For example, use the formula SUM(D2:D6) to add
the entries from cell D2 to D6. To set cell D2 as the product of the entries A2
and C2, type =a2*c2 in cell D2. To find out more about the functions avail-
able in OpenOffice.org Calc, choose Help=>OpenOffice.org Help from the
menu (or press F1 in newer versions). This opens the OpenOffice.org Help
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window, from which you can browse the functions by category and click a
function to read more about it.

To save the spreadsheet, choose Filem>Save As. A dialog box appears, from
which you can specify the file format, the directory location, and the name of
the file. When you save a document, Calc saves it in OpenDocument spread-
sheet format in a file with the . ods extension by default.

OpenOffice.org Calc can save the file in several other formats, including
Microsoft Excel 5.0/95/97/2000/XP, as well as text file with comma-separated
values (CSV).
o If you want to exchange files with Microsoft Excel, save the spreadsheet in
Microsoft Excel format (choose an appropriate version of Excel). Then you
can transfer that file to a Windows system and open it in Microsoft Excel.

Impress

Impress is similar to Microsoft PowerPoint, in that it allows you to create
unique and creative slide presentations for a variety of purposes. To run
Impress, choose Presentation from the Office category in the main menu or
choose File>’Newr>Presentation from any OpenOffice.org window.

When you first open Impress, the program prompts you for the presenta-
tion style and template. To begin working, select Empty presentation and
click Create. To open an existing document, select the appropriate option
from the Presentation Wizard and click Open. Then select the presentation
file you want to open. You can open Microsoft PowerPoint files in Impress.
Figure 5-3 shows a typical slide presentation in Impress.

The Impress window shows the first slide together with an outline view of
the slides along the left side. The exact appearance depends on the docu-
ment type and template you select. You can begin adding text and other
graphic objects such as images, text, and lines to the slide.

To insert a new slide, choose Insert=>Slide from the menu. A blank slide
appears. You can then add text and graphics to that new slide.

To save a presentation, choose Filem>Save. For new documents, you have to
provide a filename and select the directory where you want to save the file.
\3
P If you want to share the slides with someone who uses Microsoft
PowerPoint, save the presentation in Microsoft PowerPoint 97/2000/XP
format.
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Calendars

KDE comes with Kontact — an application that integrates existing KDE appli-
cations such as KMail mail reader and KOrganizer calendar program in a
single graphical personal information manager. You can start Kontact from
panel icons or the main menu. (The location of the menu entry depends on
the Linux distribution.)

When Kontact starts, it usually displays a summary window with information
about new e-mail messages, upcoming scheduled events, and more. You can
explore each application individually by clicking the icons in the left pane

of the Kontact window. For example, Figure 54 shows the Kontact window
after you click the Calendar icon. In this case, Kontact displays the output of
KOrganizer. The KOrganizer program displays a calendar view, in which you
can click a date to set or view that day’s schedule.

To add events or appointments for a specific date and time, select the date
from the calendar, double-click the time, and type a brief description of
the appointment in the New Event dialog box that appears. Click OK when
you're finished.
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calculator.

You have a choice of the GNOME calculator or the KDE calculator. Both are
scientific calculators, and you can do the typical scientific calculations, such
as square root and inverse, as well as trigonometric functions, such as sine,

cosine,

To use the calculator, look for it in the Utilities or Accessories category of

and tangent.

the main menu. Figure 5-5 shows the KDE calculator in SUSE.
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You can display additional buttons by selecting options from the Settings
menu. For example, choose Settings=Statistic Buttons to show buttons that
enable you to perform statistical calculations with the calculator.
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Checking out Multimedia Applications

Most Linux distributions include quite a few multimedia applications —
mostly multimedia audio players and CD players but also applications for
using digital cameras and burning CD-ROMs. To play some other multimedia
files (such as MPEG video), you may have to download and install additional
software on your Linux system. Here’s a quick sketch of a few typical multi-
media tasks and the applications you can use to perform these tasks:

4+ Using digital cameras: Use a digital camera tool to download photos

from your digital camera in Linux (or simply access the camera as a USB
mass storage device).

Playing audio CDs: Use one of many audio CD players that come with
Linux.

Playing sound files: Use Rhythmbox or XMMS multimedia audio play-

ers. (You have to download some additional software to play MP3 files
with Rhythmbox or XMMS.) You can also download other players from
the Internet.

4 Burning a CD: Use a CD burner, such as K3b, to burn audio and data CDs.

Using a digital camera

Most Linux distributions come with a digital camera application that you
can use to download pictures from digital cameras. For example, SUSE and
Xandros come with digiKam, which works with many makes and models of
digital cameras. Depending on the model, the cameras can connect to the
serial port or the Universal Serial Bus (USB) port.

To use digiKam with your digital camera, follow these steps:

1.

2.

Connect your digital camera to the serial port or USB port (whichever
interface the camera supports) and turn on the camera.

Start digiKam.

Look for digiKam in the main menu under the Graphics or Images sub-
menu. The first time you open digiKam, you will be asked to specify a
default location to store images and choose a number of other configu-
ration preferences.

From the digiKam menu, choose Settings=>Configure digiKam.
A configuration dialog box appears.
Click the Cameras tab in the dialog box, and then click Auto Detect.

If your camera is supported and the camera is configured to be in PTP
(Picture Transfer Protocol) mode, the camera is detected. If not, you
can get the photos from your camera by using an alternate method
described after these steps.
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5. Choose your camera model from the Camera menu.

A new window appears and, after a short while, displays the photos in
the camera.

6. Click the thumbnails to select the images you want to download; then
choose Camera~>Download to download the images.

digiKam downloads the images. You can save these files in a folder and
edit the photos in The GIMP or your favorite photo editor.

Don’t despair if digiKam doesn’t recognize your digital camera. You can still
access the digital camera’s storage media (compact flash card, for example)
as a USB mass storage device, provided your camera supports USB mass
storage. To access the images on your USB digital camera, use the following
steps.

1. Read the camera manual and use the menu options of the camera to
set the USB mode to Mass Storage.

If the camera doesn’t support USB mass storage, you can’t use this pro-
cedure to access the photos. If the camera supports the Picture Transfer
Protocol mode, you can use digiKam to download the pictures.

2. Connect your digital camera to the USB port by using the cable that
came with the camera. Then turn on the camera.

Linux detects the camera and opens the contents of the camera in a file
manager window.

3. Click to select photos and copy them to your hard drive by dragging
and dropping them into a selected folder.

4. Close the file manager window, disconnect the USB cable from the PC,
and turn off the camera.

Whether you are using a digital camera tool such as digiKam or accessing
your camera like any other storage device, Linux makes it easy to get your
pictures onto your computer!

Playing audio CDs

All Linux distributions come with either the GNOME or KDE CD player appli-
cations. To play an audio CD, you need a sound card, and that sound card
must be configured to work in Linux.

In some distributions, you can insert an audio CD into the drive, and a dialog
box appears and asks whether you want to play the CD with the CD player.

If this dialog box doesn’t appear, locate an audio CD player by choosing
Applications=>Sound and Video from the main menu.
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The KDE CD player displays the title of the CD and the name of the current
track. The CD player gets the song titles from http://freedb.org—a
free, open source CD database on the Internet (freedb.freedb.org at port
888). You need an active Internet connection for the CD player to download
song information from the CD database. After the CD player downloads infor-
mation about a particular CD, it caches that information in a local database
for future use. The CD player user interface is intuitive, and you can figure it
out easily. One nice feature is that you can select a track by title.

Playing sound files

You can use Rhythmbox or XMMS to open and play sound files (for example,
MP3 files). Users with large MP3 music libraries usually like Rhythmbox
because it can help organize their music files. You can start Rhythmbox by
choosing the music player application from the main menu in several dis-
tributions, including Debian and Fedora. When you first start Rhythmbox, it
displays an assistant that prompts you for the location of your music files so
that Rhythmbox can manage your music library.

After you identify the locations of music files, Rhythmbox starts and displays
the library in an organized manner. You can then select music and play it.

XMMS is another music player that can play many types of sound files,
including Ogg Vorbis, FLAC (Free Lossless Audio Codec, an audio file format
similar to MP3), and Windows WAV.

You can start XMMS by choosing the audio player application from the main
menu (look under Multimedia or Sound & Video). After XMMS starts, you
can open a sound file (such as an MP3 file) by choosing Window Menu=>Play
File or by pressing L. Then select one or more music files from the Load File
dialog box. Click the Play button, and XMMS starts playing the sound file.

In some free Linux distributions, you may not be able to play MP3 files
because the MP3 decoder is not included. However, MP3 playing works fine
in Debian, Knoppix, SUSE, and Xandros. Because of legal reasons, the ver-
sions of Rhythmbox and XMMS in Fedora don’t include the code needed to
play MP3 files, so you have to translate MP3s into a supported format, such
as WAV, before you can play them. You can, however, download the source
code for Rhythmbox and XMMS and build the applications with MP3 sup-
port. You can also use the Ogg Vorbis format for compressed audio files
because Ogg Vorbis is a patent- and royalty-free format.

Burning a CD

Nowadays, most GUI file managers have the capability to burn CDs. For
example, Nautilus File Manager and Xandros File Manager have built-in
features to burn CDs. Linux distributions also come with standalone GUI
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programs that enable you to easily burn CDs and DVDs. For example, K3b is
a popular CD/DVD burning application for KDE that’s available in Knoppix
and SUSE.

Most CD burning applications are simple to use. You basically gather the
files that you want to burn to the CD or DVD and then start the burning
process. Of course, for this to work, your PC must have a CD or DVD burner
installed.

The upper part of the K3b window is for browsing the file system to select
what you want to burn onto a CD or DVD. The upper-left corner shows the
CD writer device installed.

To burn a CD, you start with one of the projects shown in the lower part of
the K3b window — New Audio CD Project, for example, or New Data DVD
Project. Then you have to add files and, finally, burn the project to the CD or
DVD by choosing Project=>Burn or pressing Ctrl+B. For an audio CD, you can
drag and drop MP3 files as well as audio tracks.

K3b needs the external command-line programs cdrecord and cdrdao to
burn CDs. K3b also needs the growisofs program to burn DVDs.

If you get an error about missing cdrdao in Debian, make sure that your
Debian system is connected to the Internet and then type apt-get
install cdrdao to installit.

Using Graphics and Imaging Apps

You can use graphics and imaging applications to work with images and
graphics (line drawings and shapes). Two of the most popular of these appli-
cations are

4+ The GIMP (GNU Image Manipulation Program): A program for viewing
and performing image manipulation tasks, such as photo retouching,
image composition, and image creation.

4+ Gnome Ghostview (GGvV): A graphical application capable of displaying
PostScript files.

The GIMP

The GIMP is an image manipulation program written by Peter Mattis and
Spencer Kimball and released under the GNU General Public License (GPL).
Most Linux distributions come with this program, although you may have
to specifically select a package to install it. The GIMP is comparable to
other image manipulation programs, such as Adobe Photoshop and Corel
PHOTO-PAINT.
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To try out The GIMP, look for it under the Graphics category in the main
menu. When you start The GIMP, it displays a window with copyright and
license information. Click the Continue button to proceed with the installa-
tion. The next screen shows the directories to be created when you proceed
with a personal installation of The GIMP.

If you can’t find The GIMP under the Graphics category, choose Add/Remove
Software from the System Settings menu and install it from there.

The GIMP installation involves creating a directory in your home directory
and placing a number of files there. This directory essentially holds infor-
mation about any changes to user preferences you may make to The GIMP.
Go ahead and click the Continue button at the bottom of the window. The
GIMP creates the necessary directories, copies the necessary files to those
directories, and guides you through a series of dialog boxes to complete the
installation.

When the installation is finished, click the Continue button. The GIMP then
loads any plug-ins — external modules that enhance its functionality. It dis-
plays a startup window that shows a message about each plug-in as it loads.
After finishing the startup, The GIMP displays a tip of the day in a window.
You can browse the tips and click the Close button to close the Tip window.
At the same time, The GIMP displays a number of other windows, including a
main navigation window titled The GIMP, a Toolbox window (usually on the
left side), a Brush Selection window, and a Layers, Channels, Paths window.
The center navigation window gives you access to new images to work with,
image editing functions, and a number of effect filters that you can apply to
the image. The Toolbox window lets you quickly select a number of impor-
tant image manipulation tools.

To open an image file in The GIMP, choose Filec>Open. The Load Image
dialog box appears. You can change directories and select the image file that
you want to open. The GIMP can read all common image file formats, such as
GIF, JPEG, TIFF, PCX, BMP, PNG, and PostScript. After you select the file and
click OK, The GIMP loads the image into a new window.

The Toolbox window has many buttons that represent the tools you use to
edit the image and apply special effects. You can get pop-up help on each
tool button by placing the mouse pointer over the button. You can select a
tool by clicking the tool button, and you can apply that tool’s effects to the
image to see what it does.

When you right-click the image window, The GIMP displays a pop-up menu
that has most of the options from the GIMP’s top toolbar.

You can do much more than just load and view images with The GIMP, but
a complete discussion of all its features is beyond the scope of this book.
If you want to try the other features of The GIMP, consult The GIMP User
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Manual (GUM), available online at http: //manual.gimp.org. You can
also choose Help>GIMP Online=>User Manual Website to access the online
documentation for The GIMP. (You need an Internet connection for this com-
mand to work.)

Visit The GIMP home page at www.gimp.org to find the latest news about
The GIMP as well as links to other resources.

GNOME Ghostview

GNOME Ghostview is a graphical application ideal for viewing and printing
PostScript or PDF documents. For a long document, you can view and print
selected pages. You can also view the document at various levels of magnifi-
cation by zooming in or out.

To run GNOME Ghostview in Fedora, choose Graphics=>PostScript Viewer
from GUI desktop. The GNOME Ghostview application window appears. In
addition to the menu bar and toolbar along the top edge, a vertical divide
splits the main display area of the window into two parts.

To load and view a PostScript document in GNOME Ghostview, choose
Filec>Open, or click the Open icon on the toolbar. GNOME Ghostview dis-
plays a File-Selection dialog box. Use this dialog box to navigate the file
system and select a PostScript file. For example, select the file tiger.ps in
the /usr/share/ghostscript-8.64/examples directory. (Use your sys-
tem’s version number of Ghostscript in place of 8. 64).

To open the selected file, click the Open File button in the File-Selection
dialog box. GNOME Ghostview opens the selected file, processes its con-
tents, and displays the output in its window.

SMBER GNOME Ghostview is useful for viewing various kinds of documents that
come in PostScript format. (These files typically have the .ps extension.)
You can also open PDF files — which typically have .pdf extensions — in
GNOME Ghostview.

Using GUI File Managers

Both GNOME and KDE desktops come with GUI file managers that enable
you to easily browse the file system and perform tasks such as copying or
moving files. The GNOME file manager is Nautilus, and the KDE file manager
is Dolphin. I briefly describe these GUI file managers in this section.

Using the Nautilus shell

The Nautilus file manager (more accurately called a graphical shell) comes
with GNOME. Nautilus is intuitive to use; it’s similar to the Windows Active
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Desktop. You can manage files and folders as well as your system with
Nautilus. When you double-click any object on the desktop, Nautilus opens
an object window that shows that object’s contents.

Viewing files and folders in object windows

When you double-click a file or a folder, Nautilus opens that object in what it
calls an object window. If you then double-click an object inside that window,
Nautilus opens another object window where that object’s contents appear.
You can use the Back button to return to the original folder. Alternatively,
you can right-click a folder and choose to open it in a new window from the
pop-up menu. Figure 5-6 shows the contents of a folder in Nautilus.
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Burning data CDs and DUDs

If you have a CD or DVD recorder attached to your system (it can be a
built-in recorder or an external one attached to the USB port), you can use
Nautilus to burn data CDs and DVDs. Just follow these simple steps:

1. In any Nautilus object window, choose Go->CD/DVD Creator.

Nautilus opens the CD/DVD Creator object window. You can open the
Nautilus CD/DVD Creator also from the menu that appears automatically
when you insert a blank disc.
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Figure 5-7:
The Nautilus
navigation
window
with a

list of the
directory
contents.

If you don’t have a Nautilus object window open, just double-click the
Computer icon on the desktop.

2. From other Nautilus windows, drag and drop into the CD/DVD Creator

window the files and folders you want to put on the media.

To get to files on your computer, double-click the Computer icon to
open the Nautilus window and find the files you want. Then drag and
drop those file or folder icons into the CD/DVD Creator window.

3. From the CD/DVD Creator window, choose File->Write to Disc.

Nautilus displays a dialog box where you can select the CD or DVD
recorder, the write speed, and several other options, such as whether to
eject the media when you are finished. You can also specify the title.

4. (Optional) Make your selections in the dialog box that appears.

5. Click the Write button.

Nautilus burns the CD/DVD.

Changing the view
If you prefer to view the contents of a folder in a tree view instead of as
icons, you can change what you're seeing simply enough:

1

. Choose View from the Nautilus menu.

2. Click List (as opposed to Icons).

Nautilus displays the contents of the selected directory by using smaller
icons in a list format, along with detailed information, such as the size
of each file or directory and the time when each was last modified, as
shown in Figure 5-7.
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If you click a column heading along the top of the list view (such as Name,
Size, Type, or Date Modified), Nautilus sorts the list according to that
column. For example, go ahead and click the Date Modified column heading.
Nautilus now displays the list of files and directories sorted according to the
time they were last modified. Clicking the Name column heading sorts the
files and folders alphabetically.

Not only can you move around different folders by using the Nautilus navi-
gation window, you can also move a file from one folder to another, delete
a file, and more, as in the following. (I don’t outline each step because the
steps are intuitive and similar to what you do in any GUI, such as Windows
or Mac.)

4+ To move a file to a different folder: Drag and drop the file’s icon on the
folder where you want the file.

4+ To copy a file to a new location: Select the file’s icon and choose Edit=>
Copy from the Nautilus menu. (Or you can right-click the file’s icon and
choose Copy from the context menu.) Then move to the folder where
you want to copy the file and choose Edit=>Paste.

4+ To delete a file or directory: Right-click the icon and choose Move to
Trash from the context menu. (You can do this only if you have permis-
sion to delete the file.) To permanently delete the file, right-click the
Trash icon on the desktop and choose Empty Trash from the context
menu. Do this only if you really want to delete the file because you won’t
see the file again after you empty the trash. If you haven’t emptied the
trash and want to retrieve a file, double-click the Trash icon and then
drag the file’s icon back to the folder where you want to save it.

4+ To rename a file or a directory: Right-click the icon for the file or direc-
tory and choose Rename from the context menu. Then type the new
name (or edit the name) in the text box that appears.

4+ To create a new folder: Right-click an empty area of the window on the
right and choose Create Folder from the context menu. After the new
folder icon appears, you can rename it by right-clicking the icon and
choosing Rename from the context menu. If you don’t have permission
to create a folder, that menu item appears dimmed.

Using Dolphin

Dolphin is one of the most popular file managers that come with KDE. It’s
intuitive to use — somewhat similar to the Windows Active Desktop. You
can manage files and folders with Dolphin (use F9 to toggle the Navigational
bar on the left side).
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When you double-click a folder icon on the KDE desktop, Dolphin starts
automatically and opens that folder. Click the Home Folder icon on the verti-
cal toolbar on the left side of the Dolphin window. Dolphin now displays the
contents of your home directory in its main window. From here you can navi-
gate to other directories, folders, and files. Figure 5-8 shows a typical folder

display in Dolphin.
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You can use Dolphin in a similar manner to using Windows Explorer. The
Dolphin window is vertically divided into three parts:

4+ A narrow left pane: Displays icons for various places on your system
(including Home, Trash, and any removable hard drives).

4+ The main middle pane: Uses icons to show the files and folders in the
current folder.

4+ The right pane: Displays additional information about the selected file or
folder, as well as providing a thumbnail preview of image files.

Dolphin uses different types of icons for different files and shows a preview
of each file’s contents. Each directory appears as a folder, with the name

of the directory below the folder icon. Ordinary files appear as a sheet of
paper. For image files, the preview is a thumbnail version of the image.

The Dolphin window’s title bar shows the name of the currently selected
directory. The Location text box (along the top of the window) shows
the full name of the directory — Figure 5-9 shows the contents of the
user’s /home directory. If you don’t see the Location text box, choose
Vieww>Location Bar=>Editable Location to toggle its display on or off.
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The Dolphin window has the usual menu bar and a toolbar. You can view the
files and folders in other formats as well. For example, choose Viewr>View
Moder>Details to see the folder’s contents with smaller icons in a list format
(see Figure 5-10). To view more detailed information (such as the size of
each file or directory and at what time each was last modified), choose Viewr>
Additional Information and select which information you would like to display.
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If you click a column heading along the top of the list view (such as Name,
Size, Type, or Date), Dolphin sorts the list according to that column. For
example, if you click the Date column heading, Dolphin displays a list of files
and folders sorted according to the time they were last modified. Clicking the
Name column heading sorts the files and directories alphabetically by name.
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You can do several other tasks in Dolphin, such as the following. (I don’t out-
line each step because the steps are intuitive and similar to what you do in
any GUI, such as Windows or the Mac interface.)

+

+

View a text file: Click the filename, and Dolphin runs the default word
processor, displaying the file in a new window.

Copy or move a file to a different folder: Drag and drop the file’s icon
on the folder where you want the file to go. A menu pops up and asks
you whether you want to copy, move, or link the file to that directory.

Delete a file or directory: Right-click the icon for the file or directory
and choose Move to Trash from the context menu. To permanently
delete the file, right-click the Trash icon on the desktop and choose
Empty Trash from the context menu. Do this only if you want to delete
the file, because after you empty the trash, any deleted files are gone
forever. If you haven’t emptied the trash and want to recover a file from
the trash, double-click the Trash icon on the desktop; from the window
that appears, drag and drop the file icon into the folder where you want
to save the file. On some distributions, you will be asked whether you
want to copy or move; select Move.

Rename a file or a directory: Right-click the corresponding icon and
choose Rename from the context menu. Then you can type the new
name (or edit the old name) in the text box that appears.

Create a new folder: Choose Views>View Mode=Icons. Then right-click
an empty area of the middle pane and choose Create Newr>Folder from

the context menu. Finally, type the name of the new directory and click

OK. (If you don’t have permission to create a directory, you get an error
message.)



Chapter 6: Using Text Editors

In This Chapter

v Checking out different GUI text editors
v~ Working with the ed text editor

v~ Getting to know the vi text editor

A Ithough the desktop provides a beautiful graphical interface that’s a
pleasure to work in, much goes on outside that interface. Most Linux
system configuration files are text files. Additionally, Linux gives you the
ability to create shell scripts and interact with the operation of a number of
programs — all by using text files.

When all is working as it should, you can edit (and even create) those files
with graphical tools, but it’s highly recommended that you also know how
to edit them outside that interface, should a problem exist that keeps the
X Window System from loading. Whether in the interface or not, you’ll be
using text editors, programs designed to interact with text files.

In this chapter, you're introduced to a few text editors — both GUI editors
and text mode editors.

Using GUI Text Editors

Each of the GUI desktops — GNOME and KDE — comes with GUI text editors
(text editors that have graphical user interfaces).

To use a GUI text editor, look in the main menu and search for text editors
in an appropriate category. For example, in the GNOME desktop, choose
Applicationst>Accessoriest>gedit Text Editor. After you have a text editor
up and running, you can open a file by clicking the Open button on the tool-
bar to display the Open File dialog box. You can change directories and then
select the file to edit by clicking the OK button.

The GNOME text editor loads the file in its window. You can open more
than one file at a time and move among them as you edit the files. Figure 6-1
shows a typical editing session with the editor.
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Figure 6-1:
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files.
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In this case, the editor has two files — a new file being written, and motd
(from the /etc directory) — open for editing. The filenames appear as tabs
below the toolbar of the editor’s window. You can switch between the files
by clicking the tabs. The current filename appears in the last line of the
window.

If you open a file for which you have only read permission, the text [Read
Only] is appended to the filename shown in the window title to indicate
that the file is read-only and the location of the file is displayed at the top
(such as /etc). The indication that the file is read-only often appears when
aregular user is opening system files that only the root can modify.

The rest of the text editing steps are intuitive. To enter new text, click to
position the cursor and begin typing. You can select text, copy, cut, and
paste by using the buttons on the toolbar above the text editing area.

From the KDE desktop, you can start the KDE text editor (KWrite) by choos-
ing Applications=>Accessoriesw>Text Editor. To open a text file, choose Filew>
Open to display a dialog box. From this dialog box, you can go to the direc-
tory of your choice, select the file to open, and click OK. KWrite opens the
file and displays its contents in the window, and you can then edit the file as
shown in Figure 6-2.
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Text Editing with ed and vi

GUI text editors enable you to edit text files using the mouse and keyboard
much the same way as you use any word processor. Text mode editors are
a different beast — you work using only the keyboard and you have to type
cryptic commands to perform editing tasks, such as cutting and pasting text
or entering and deleting text. Linux comes with two text mode text editors:

4 ed: Aline-oriented text editor

4+ vi: Afull-screen text editor that supports the command set of an earlier
editor named ex

The ed and vi editors are cryptic compared to the graphical text editors.
However, you should still get to know the basic editing commands of ed
and vi because sometimes these two may be the only editors available. For
example, if Linux refuses to boot from the hard drive, you may have to boot
from a CD, DVD, or flash drive. In that case, you have to edit system files
with the ed editor because that editor is small enough to fit on the floppy. |
walk you through the basic text editing commands of ed and vi — they'’re
not that hard.

Using ed

Typically, you have to use ed only when you boot a minimal version of Linux
(for example, from a floppy you’ve set up as a boot disk), and the system
doesn’t support full-screen mode. In all other situations, you can use the vi
editor, which works in full-screen text mode.
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When you use ed, you work in command mode or text input mode:

4+ Command mode: This mode is the default. In this mode, anything
that you type is interpreted as a command. The ed text editor has a
simple command set in which each command consists of one or more
characters.

4+ Text input mode: This mode is for typing text. You can enter text input
mode with the commands a (append), c (change), or i (insert). After
entering lines of text, you can leave text input mode by entering a period
() on a line by itself.

To practice editing a file, copy the /etc/fstab file to your home directory
by issuing the following commands:

cd
cp /etc/fstab .

Now you have a file named fstab in your home directory. Type ed -p:
fstab to begin editing a file in ed. The editor responds:

878

This example uses the -p option to set the prompt to the colon character
(:) and opens the f£stab file (in the current directory, which is your home
directory) for editing. The ed editor opens the file, reports the number

of characters in the file (878), displays the prompt (:), and waits for a
command.

When you’re editing with ed, make sure that you always turn on a prompt
character (use the -p option). Without the prompt, distinguishing whether
ed is in text input mode or command mode is difficult.

After ed opens a file for editing, the current line is the last line of the file. To
see the current line number (the current line is the line to which ed applies
your command), use the . = command, like this:

9

This output tells you that the £stab file has nine lines. (Your system’s /
etc/fstab file may have a different number of lines, in which case ed
shows a different number.)

You can use the 1, $p command to see all lines in a file, as the following
example shows:
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:1,$p

# This file is edited by fstab-sync - see 'man fstab-sync' for details
/dev/VolGroup00/LogVol00 / ext3 defaults 1 1

LABEL=/boot /boot ext3 defaults 1 2

/dev/devpts /dev/pts devpts gid=5,mode=620 0 0

/dev/shm /dev/shm tmpfs defaults 0 0

/dev/proc /proc proc defaults 0 0

/dev/sys /sys sysfs defaults 0 0

/dev/VolGroup00/LogVol0l swap swap defaults 0 0

/dev/scd0 /media/cdrecorder auto pamconsole,exec,noauto,managed 0 0
/dev/£fd0 /media/floppy auto pamconsole, exec,noauto,managed 0 0
/dev/hdc /media/cdrom auto pamconsole, exec,noauto,managed 0 0

To go to a specific line, type the line number:

The editor responds by displaying that line:

/dev/VolGroup00/LogVol00 / ext3 defaults 1 1

Suppose you want to delete the line that contains cdrom. To search for a
string, type a slash (/) followed by the string that you want to locate:

:/cdrom
/dev/hdc /media/cdrom auto pamconsole, exec,noauto,managed 0 0

The editor locates the line that contains the string and then displays it. That
line becomes the current line.

To delete the current line, use the d command as follows:

:d

To replace a string with another, use the s command. To replace cdrom with
the string cd, for example, use this command:

:s/cdrom/cd/

To insert a line in front of the current line, use the i command:

:i
(type the line you want to insert)
(type a single period to indicate you're done)
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You can enter as many lines as you want. After the last line, enter a period
(.) on aline by itself. That period marks the end of text input mode, and
the editor switches to command mode. In this case, you can tell that ed
switches to command mode because you see the prompt (:).

When you’re happy with the changes, you can write them to the file with the
w command. If you want to save the changes and exit, type wg to perform
both steps at the same time:

‘wWq
857

The ed editor saves the changes in the file, displays the number of saved
characters, and exits. If you want to quit the editor without saving any
changes, use the Q command.

These examples give you an idea of how to use ed commands to perform the
basic tasks of editing a text file. Table 6-1 lists some of the commonly used
ed commands.

Table 6-1 Common ed Commands

Command Does the Following

! command Executes a shell command. (For example, ! pwd displays the cur-
rent directory.)

$ Goes to the last line in the buffer.

oe

Applies a command that follows to all lines in the buffer. (For
example, %p prints all lines.)

+ Goes to the next line

+n Goes to the nth next line (where nis a number you designate).

, Applies a command that follows to all lines in the buffer. (For
example, , p prints all lines.) This command is similar to %.

- Goes to the preceding line.

-n Goes to the nth previous line (where n is a number you designate).

Refers to the current line in the buffer.

/text/ Searches forward for the specified text.

; Refers to a range of lines — the current line through the last line
in the buffer.

= Prints the line number.

?text? Searches backward for the specified text.
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Command Does the Following
~ Goes to the preceding line. (See also the - command.)
~n Goes to the nth previous line (where nis a number you desig-

nate). (See also the -n command.)

a Appends the current line.

c Changes the specified lines.

el Deletes the specified lines.

i Inserts text before the current line.

n Goes to line number nn (where nis a number you designate).

Press Enter Displays the next line and makes that line current.

a Quits the editor.

0 Quits the editor without saving changes.

r file Reads and inserts the contents of the file after the current line.

s/old/ Replaces an old string with a new one.

new/

u Undoes the last command.

W file Appends the contents of the buffer to the end of the specified file.

w file Saves the buffer in the specified file. (If no file is named, it saves in

the default file — the file whose contents ed is currently editing.)

Using vi

After you dabble with ed, you'll find vi is a dream come true, even though
it’s still a command-line editor. The vi editor is a full-screen text editor, so
you can view several lines at the same time. Most UNIX systems, including
Linux, come with vi. Therefore, if you know the basic features of vi, you
can edit text files on almost any UNIX-based system.

When vi edits a file, it reads the file into a buffer — a block of memory — so
you can change the text in the buffer. The vi editor also uses temporary
files during editing, but the original file isn’t altered until you save the
changes.

To start the editor, type vi and follow it with the name of the file you want
to edit, like this:

vi /etc/fstab

The vi editor then loads the file into memory and displays the first few
lines in a text screen and positions the cursor on the first line, as shown in
Figure 6-3.
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Figure 6-3:
You can edit
files with
the vi full-
screen text
editor.

File Edit View Terminal Tabs Help

unionfs / unionfs rw @ @
tmpfs /tmp tmpfs nosuid,nodev © @

T T 1T T T T T T T T T T T T T T 1171

"/etc/fstab" [readonly] 2 lines, 59 characters

The last line shows the pathname of the file as well as the number of lines
(2) and the number of characters (59) in the file. In this case, the text
[readonly] appears after the filename because I'm opening the /etc/
fstab file while I'm logged in as a normal user (which means [ don’t have
permission to modify the file). Later, the last line in the vi display functions
as a command entry area. The rest of the lines display the file. If the file con-
tains fewer lines than the screen, vi displays the empty lines with a tilde (~)
in the first column.

The current line is marked by the cursor, which appears as a small black
rectangle. The cursor appears on top of a character.

When using vi, you work in one of three modes:

4 Visual command mode: This mode is the default. In this mode, anything
that you type is interpreted as a command that applies to the line con-
taining the cursor. The vi commands are similar to the ed commands.

4+ Colon command mode: You use this mode for reading or writing files,
setting vi options, and quitting vi. All colon commands start with a
colon (:). When you type the colon, vi positions the cursor on the last
line and waits for you to type a command. The command takes effect
when you press Enter.

4+ Text input mode: This mode is for typing text. You can enter text input
mode with the command a (insert after cursor), A (append at end of
line), or i (insert after cursor). After entering lines of text, you have to
press Esc to leave text input mode and re-enter visual command mode.

One problem with all these modes is that you can’t easily tell the current
mode that vi is in. You may begin typing only to realize that vi isn’t in text
input mode, which can be frustrating.
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If you want to make sure that vi is in command mode, just press Esc a few
times. (Pressing Esc more than once doesn’t hurt.)

To view online help in vi, type :help while in colon command mode. When
you're finished with help, type :q to exit the Help screen and return to the
file you're editing.

The vi editor initially positions the cursor on the first character of the first
line, and one of the handiest things you can know is how to move the cursor
around. To get a bit of practice, try the commands shown in Table 6-2.

Table 6-2 Cursor Movement Commands in vi
Key Moves the Cursor

l One line down

T One line up

«— One character to the left

- One character to the right

W One word forward

B One word backward

Ctrl+D Half a screen down

Ctrl+U Half a screen up

You can go to a specific line number at any time by using the handy colon
command. To go to line 6, for example, type the following and then press
Enter:

:6

When you type the colon, vi displays the colon on the last line of the
screen. From then on, vi uses any text you type as a command. You have
to press Enter to submit the command to vi. In colon command mode, vi
accepts all commands that the ed editor accepts — and then some.

To search for a string, first type a slash (/). The vi editor displays the slash
on the last line of the screen. Type the search string and then press Enter.
The vi editor locates the string and positions the cursor at the beginning of
that string. Thus, to locate the string cdrom in the file /etc/fstab, type

/cdrom
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To delete the line that contains the cursor, type dd. The vi editor deletes
that line of text and makes the next line the current one.

To begin entering text in front of the cursor, type i. The vi editor switches
to text input mode. Now you can enter text. When you finish entering text,
press Esc to return to visual command mode.

After you finish editing the file, you can save the changes in the file with the
:w command. To quit the editor without saving any changes, use the : g!
command. If you want to save the changes and exit, you can use the :wg
command to perform both steps at the same time. The vi editor saves the
changes in the file and exits. You can also save the changes and exit the
editor by pressing Shift+ZZ (hold Shift down and press Z twice).

vi accepts a large number of commands in addition to the commands I just
mentioned. Table 6-3 lists some commonly used vi commands, organized

by task.
Table 6-3 Common vi Commands
Command Does the Following
Insert Text
a Inserts text after the cursor
A Inserts text at the end of the current line
I Inserts text at the beginning of the current line
i Inserts text before the cursor
Delete Text
D Deletes up to the end of the current line
dd Deletes the current line
fele} Deletes from the current line to the end of the file
dw Deletes from the cursor to the end of the following word
x Deletes the character on which the cursor rests
Change Text
c Changes up to the end of the current line
cc Changes the current line
J Joins the current line with the next one
rx Replaces the character under the cursor with x (where xis

any character)
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Command

Does the Following

Move Cursor

hor« Moves one character to the left

jord Moves one line down

korT Moves one line up

L Moves to the end of the screen

lor— Moves one character to the right

w Moves to the beginning of the following word
b Moves to the beginning of the previous word
Scroll Text

Ctrl+D Scrolls forward by half a screen

Ctrl+U Scrolls backward by half a screen

Refresh Screen

Ctrl+L Redraws screen

Cut and Paste Text

vy Yanks (copies) current line to an unnamed buffer
P Puts the yanked line above the current line
o) Puts the yanked line below the current line

Colon Commands

: | command Executes a shell command
el Quits the editor
:q! Quits without saving changes

:r filename

Reads the file and inserts it after the current line

:w filename

Writes a buffer to the file

:wg

Saves changes and exits

Search Text

/string

Searches forward for a string

?string

Searches backward for a string

Miscellaneous

Undoes the last command

u
Esc Ends input mode and enters visual command mode
U Undoes recent changes to the current line
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Chapter 1: Connecting to
the Internet

In This Chapter

v+~ Understanding the Internet

+ Deciding how to connect to the Internet

1 Connecting to the Internet with DSL

v~ Connecting to the Internet with a cable modem

v Setting up a dial-up PPP link

Given the prevalence and popularity of the Internet, it’s a safe bet to
assume that you want to connect your Linux system to the Internet.
In this chapter, I show you how to connect to the Internet in several ways —
depending on whether you have a DSL, cable modem, or dial-up network
connection.

Two of the options for connecting to the Internet — DSL and cable modem —
involve attaching a special modem to an Ethernet card on your Linux
system. In these cases, you have to set up Ethernet networking on your
Linux system. (I explain networking in Chapter 2 of this minibook.)

The other option — dial-up networking — involves dialing up an Internet
service provider (ISP) from your Linux system.

Understanding the Internet

How you view the Internet depends on your perspective. Most people see
the Internet in terms of the services they use. For example, as a user, you
might think of the Internet as an information-exchange medium with fea-
tures such as

4+ E-mail: Send e-mail to any other user on the Internet, using addresses
such as mom@home . net.

4+ Web: Download and view documents from millions of servers through-
out the Internet.
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4+ Newsgroups: Read newsgroups and post news items to newsgroups with
names such as comp.os.linux.networking or comp.os.linux.
setup.

4+ Information sharing: Download software, music files, videos, and so
on. Reciprocally, you may provide files that users on other systems can
download.

4+ Remote access: Log in to another computer on the Internet, assuming
that you have access to that remote computer.

The techies say that the Internet is a worldwide network of networks. The
term internet (without capitalization) is a shortened form of internetworking —
the interconnection of networks. The Internet Protocol (IP) was designed
with the idea of connecting many separate networks.

In terms of physical connections, the Internet is similar to a network of
highways and roads. This similarity is what has prompted the popular press
to dub the Internet “the Information Superhighway.” Just as the network of
highways and roads includes some interstate highways, many state roads,
and many more residential streets, the Internet has some very high-capacity
networks (for example, a 10 Gbps backbone can handle 10 billion bits per
second) and a large number of lower-capacity networks ranging from 56
Kbps dial-up connections to 45 Mbps T3 links. (Kbps is thousand-bits-per-
second, and Mbps is million-bits-per-second.) The high-capacity network is
the backbone of the Internet.

In terms of management, the Internet isn’t run by a single organization, nor
is it managed by any central computer. You can view the physical Internet
as a network of networks managed collectively by thousands of cooperating
organizations. Yes, a collection of networks managed by thousands of organi-
zations — sounds amazing, but it works!

Deciding How to Connect to the Internet

So you want to connect your Linux workstation to the Internet, but you
don’t know how? Let me count the ways. Nowadays you have three popular
options for connecting homes and small offices to the Internet (huge corpo-
rations and governments have many other ways to connect):

4+ Digital Subscriber Line (DSL): Your local telephone company as well
as other telecommunications companies may offer DSL. DSL provides a
way to send high-speed digital data over a regular phone line. Typically,
DSL offers data transfer rates of between 128 Kbps and 3.0 Mbps (usu-
ally, the higher the speed, the more you pay). You can often download
from the Internet at much higher rates than when you send data from
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your PC to the Internet (upload). One caveat with DSL is that your home
must be between 15,000 and 20,000 feet from your local central office
(the DSL provider’s facility where your phone lines end up). The dis-
tance limitation varies from provider to provider. In the United States,
you can check out the distance limits for many providers at www.ds1
reports.com/distance.

4+ Cable modem: If the cable television company in your area offers
Internet access over cable, you can use that service to hook up your
Linux system to the Internet. Typically, cable modems offer higher data-
transfer rates than DSL — for about the same cost. Downloading data
from the Internet via cable modem is much faster than sending data
from your PC to the Internet. You can expect routine download speeds
of 12 Mbps and upload speeds of around 2 Mbps, but sometimes you
may get even higher speeds than these.

4+ Dial-up networking: Although its popularity is certainly waning, a
dial-up connection is what most folks were using before DSL and cable
modems came along. You hook up your PC to a modem that’s connected
to the phone line. Then you dial up an ISP to connect to the Internet.
That’s why it’s called dial-up networking — establishing a network con-
nection between your Linux PC and another network (the Internet)
through a dial-up modem. In this case, the maximum data-transfer rate
is 56 Kbps.

DSL and cable modem services connect you to the Internet and also act as
your Internet service provider (ISP); in addition to improved speed, what
you're paying for is an IP address and your e-mail accounts. If you use a dial-
up modem to connect to the Internet, first you have to connect to the phone
line (for which you pay the phone company) and then select and pay a sepa-
rate ISP — which gives you a phone number to dial and all the other neces-
sary goodies (such as an IP address and e-mail accounts).

Table 1-1 summarizes these options. You can consult that table and select
the type of connection that’s available to you and that best suits your needs.

Besides the three options shown in Table 1-1, a few other less common
options may be available to you. These include fiber-to-the-home (FTTH),
broadband over power lines (BPL), fixed wireless broadband (called FWB
or WiMAX), and satellite Internet access (for example, DIRECWAY and
StarBand). If one or more of these options are available in your geographic
area and you want to use one of them for Internet access, follow the spe-
cific service provider’s instructions on setting up the Internet connection.
Typically, satellite Internet access is available across large geographical
regions (even places that don’t have phone or cable), but the initial equip-
ment cost and monthly fees are higher than DSL and cable.
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Table 1-1 Comparison of Dial-up, DSL, and Cable
Feature Dial-up DSL Cable
Equipment Modem DSL modem, Cable modem,
Ethernet card Ethernet card
Also requires Phone service Phone service Cable TV
and an Internet and location connection
service provider within 15,000 to
(ISP) 20,000 feet of
central office
Connection Dial to connect Always on, Always on,
type dedicated shared
Typical 56 Kbps maximum 12 Mbps down- 1.5 Mbps down-
speed load, 2 Mbps load, 128 Kbps
upload (higher upload
speeds cost
more)
One-time None Installation is Installation is
costs $100-200 (none $100-200 (none

(estimate)*

for self install);
equipment costs
$50-100 (may be
leased and may
require activation
cost)

for self install);
equipment costs
$50-100 (may be
leased)

Typical
monthly
cost (2010)*

Phone charges
are $20 per
month; ISP
charges are
$15-30 per month

$40-50 per month;
may require
monthly modem
lease

$40-50 per
month; may
require monthly
modem lease

*Costs vary by region and provider. Costs shown are typical for U.S. metropolitan areas.

Connecting with DSL

DSL stands for Digital Subscriber Line. DSL uses your existing phone line to
send digital data in addition to the normal analog voice signals (analog means
continuously varying, whereas digital data is represented by 1s and 0s). The
phone line goes from your home to a central office, where the line connects
to the DSL provider’s network. By the way, the connection from your home to
the central office is called the local loop.
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When you sign up for DSL service, the DSL provider hooks up your phone
line to some special equipment at the central office. That equipment can
separate the digital data from voice. From then on, your phone line can carry
digital data that is then directly sent to an Internet connection at the central
office.

How DSL works

A special box called a DSL modem takes care of sending digital data from
your PC to the DSL provider’s central office over your phone line. Your PC
can connect to the Internet with the same phone line that you use for your
normal telephone calls — you can make voice calls even as the line is being
used for DSL. Figure 1-1 shows a typical DSL connection to the Internet.

To Internet
backbone

DSL provider's
central office (CO)

Other customers

Ethernet card in PC

Telephone Network
Interface Device
(NID) where your
phone wires come

into your home DSL modem Your PC

Your PC talks to the DSL modem through an Ethernet connection, which
means that you need an Ethernet card in your Linux system.

Your PC sends digital data over the Ethernet connection to the DSL modem.
The DSL modem sends the digital data at different frequencies than those
used by the analog voice signals. The voice signals occupy a small portion
of all the frequencies that the phone line can carry. DSL uses the higher fre-
quencies to transfer digital data, so both voice and data can travel on the
same phone line.
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W DSL alphabet soup: ADSL, IDSL, SDSL

S

I have been using the term DSL as if there were only one kind of DSL, but DSL
has three variants of DSL, each with different features. Take a look:

4+ ADSL: Asymmetric DSL is the most common form of DSL and has much
higher download speeds (from the Internet to your PC) than upload
speeds (from your PC to the Internet). ADSL can have download speeds
of up to 8 Mbps and upload speeds of up to 1 Mbps. ADSL works best
when your location is within about two to two-and-a-half miles (12,000
feet) of the central office. ADSL service is priced according to the down-
load and upload speeds you want. A popular form of ADSL, called G.lite,
has a maximum download speed of 1.5 Mbps and a maximum upload
speed of 512 Kbps.

4+ IDSL: ISDN DSL (ISDN is an older technology called Integrated Services
Digital Network) is a special type of DSL that works at distances of up
to five miles between your phone and the central office. The downside
is that IDSL averages downstream (from the Internet to your PC) and
upstream (from your PC to the Internet) speeds of around 144 Kbps.

4+ SDSL: Symmetric DSL provides equal download and upload speeds of up
to 2.0 Mbps. SDSL is priced according to the speed you want, with the
higher speeds costing more. The closer your location is to the central
office, the faster the connection you can get.

DSL (and cable modem) speeds are typically specified by two numbers
separated by a slash, such as 1500/384. The numbers refer to data-transfer
speeds in kilobits per second (that is, thousands of bits per second, abbrevi-
ated Kbps). The first number is the download speed; the second, the upload.
Thus, 1500/384 means you can expect to download from the Internet at a
maximum rate of 1,500 Kbps (or 1.5 Mbps) and upload to the Internet at

384 Kbps. If your phone line’s condition isn’t perfect, you may not get these
maximum rates — both ADSL and SDSL adjust the speeds to suit existing line
conditions.

The price of DSL service depends on which variant — ADSL, IDSL, or SDSL —
you select. For most home users, the primary choice is ADSL (or, more accu-
rately, the G.lite form of ADSL) with transfer speed ratings of up to 9000/640.

Typical DSL setup

To get DSL for your home or business, you have to contact a DSL provider.
You can find many other DSL providers in addition to your phone company.
No matter who provides the DSL service, some work has to be done at the
central office — the place where your phone lines connect to the rest of the
phone network. The work involves connecting your phone line to equipment
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that can work with the DSL. modem at your home or office. The central office
equipment and the DSL modem at your location can then do whatever magic
is needed to send and receive digital data over your phone line.

The distance between your home and the central office — the loop length —
is a factor in DSL’s performance. Unfortunately, the phone line can reliably
carry the DSL signals over only a limited distance — typically three miles or
less, which means that you can get DSL service only if your home (or office)
is located within about three miles of the central office. Contact your DSL
provider to verify. You may be able to check this availability on the Web. Try
typing into Google (www.google.com) the words DSL availability and then
your provider’s name. The search results will probably include a Web site
where you can type in your phone number to find out if DSL is available for
your home or office.

If DSL is available, you can look for the types of service — ADSL versus

SDSL — and the pricing. The price depends on what download and upload
speeds you want. Sometimes, phone companies offer a simple residential
DSL (basically the G.lite form of ADSL) with a 1500/128 speed rating — mean-
ing you can download at up to 1,500 Kbps and upload at 128 Kbps. Of course,
these are the maximums, and your mileage may vary.

After selecting the type of DSL service and provider you want, you can place
an order and have the provider install the necessary equipment at your
home or office. Figure 1-2 shows a sample connection diagram for typical
residential DSL service.

DSL modem
_— Ethernet card
in your PC
Wallplate f ===
@ @@@@
Microfilter

N F gL

(o]
g == =

Your phone
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Here are some key points to note in Figure 1-2:

4+ Connect your DSL modem’s data connection to the phone jack on a wall
plate.

4 Connect the DSL modem'’s Ethernet connection to the Ethernet card on
your PC.

4 When you connect other telephones or fax machines on the same
phone line, install a microfilter between the wall plate and each of these
devices.

Because the same phone line carries both voice signals and DSL data, you
need the microfilter to protect the DSL data from possible interference. You
can buy them at electronics stores or from the DSL provider.

When you connect your Linux PC to the Internet using DSL, the connection
is always on, which means a greater potential for outsiders to break into
the PC.

You can protect your Linux system from intruders and, as a bonus, share
the high-speed connection with other PCs in a local area network (LAN) by
using a router that can perform Network Address Translation (NAT). A NAT
router translates multiple private Internet Protocol (IP) addresses from an
internal LAN into a single public IP address, which allows all the internal PCs
to access the Internet. The NAT router acts as a gateway between your LAN
and the Internet, and it isolates your LAN from the Internet — this makes it
harder for intruders to reach the systems on your LAN.

If you also want to set up a local area network, you need an Ethernet hub or
switch to connect the other PCs to the network. Figure 1-3 shows a typical
setup that connects a LAN to the Internet through a NAT router and a DSL
modem.

Here are the points to note when setting up a connection like the one shown
in Figure 1-3:

4 You need a NAT router with two 100BaseT or 10BaseT Ethernet ports
(the 100BaseT and 10BaseT ports look like a large phone jack, also
known as an RJ45 jack). Typically, one Ethernet port is labeled Internet
(or External or WAN, for wide area network), and the other one is
labeled Local or LAN (for local area network).

4+ You also need an Ethernet hub/switch. For a small home network, you
can buy a 4- or 8-port Ethernet hub. Basically, you want a hub with as
many ports as the number of PCs you intend to connect to your local
area network. For a business, you'll want to replace the hub with a
switch.
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4+ Connect the Ethernet port of the DSL modem to the Internet port of the
NAT router, using a 100BaseT Ethernet cable. (These look like phone
wires with bigger RJ-45 jacks and are often labeled Category 5 or Cat 5
wire.)

4+ Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub/switch, using a 100BaseT Ethernet cable.

4+ Now connect each of the PCs to the Ethernet hub/switch. (To do so, you
must first have an Ethernet card installed and configured in each PC.)

You can also buy a NAT router with a built-in 4-port or 8-port Ethernet hub.
With such a combined router and hub, you need only one box to set up a
LAN and connect it to the Internet via a DSL modem. These boxes are typi-
cally sold under the name Cable/DSL router because they work with both
DSL and a cable modem.

Consult Chapter 2 of this minibook for information on how to configure net-
working on the Linux system so that your system can access the Internet.

DSL providers typically use a protocol known as PPP over Ethernet (PPPoE)
to establish a connection between your PC and the equipment at the provid-
er’s central office. PPPoE requires you to provide a username and password
to establish the network connection over Ethernet. To set up your system
for a PPPoE DSL connection, all you have to do is run a utility program that
configures the system for PPPoE. You can find the utility by searching in the
Main menu in the GUI desktop.
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In Ubuntu, you can set up a PPPoE DSL connection by choosing System=>
Administration>Network Tools, clicking the modem connection, and choos-
ing Properties. Then go through the successive screens and provide the
requested account information, such as username and password.

Connecting with a Cable Modem

Cable TV companies also offer high-speed Internet access over the same
coaxial cable that carries television signals to your home. After the cable
company installs the necessary equipment at its facility to send and receive
digital data over the coaxial cables, customers can sign up for cable Internet
service. You can then get high-speed Internet access over the same line that
delivers cable TV signals to your home.

How a cable modem works

A box called a cable modem is at the heart of Internet access over the cable
TV network. (See Figure 1-4.) The cable modem takes digital data from your
PC’s Ethernet card and puts it in an unused block of frequency. (Think of
this frequency as another TV channel, but instead of pictures and sound,
this channel carries digital data.)

The cable modem places upstream data — data that’s being sent from your
PC to the Internet — in a different channel than the downstream data that’s
coming from the Internet to your PC. By design, the speed of downstream
data transfers is much higher than that of upstream transfers. The assump-
tion is that people download far more stuff from the Internet than they
upload (which is probably true for most of us).

The coaxial cable that carries all those hundreds of cable TV channels to
your home is a very capable signal carrier. In particular, the coaxial cable
can carry signals covering a huge range of frequencies — hundreds of mega-
hertz (MHz). Each TV channel requires 6 MHz — and the coaxial cable can
carry hundreds of such channels. The cable modem places the upstream
data in a small frequency band and expects to receive the downstream data
in another frequency band.
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At the other end of your cable connection to the Internet is the Cable Modem
Termination System (CMTS) — also known as the head end — that your cable
company installs at its central facility. (Refer to Figure 1-4.) The CMTS con-
nects the cable TV network to the Internet. It also extracts the upstream
digital data sent by your cable modem (and by those of your neighbors as
well) and sends it to the Internet. The CMTS also puts digital data into the
upstream channels so that your cable modem can extract that data and pro-
vide it to your PC via the Ethernet card.

Cable modems can receive downstream data at the rate of about 50 Mbps
and send data upstream at around 10 Mbps. However, all the cable modems
in a neighborhood share the same downstream capacity. Each cable modem
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filters out — separates — the data it needs from the stream of data that the
CMTS sends out. Cable modems follow a modem standard called DOCSIS,
which stands for Data Over Cable Service Interface. You can buy any
DOCSIS-compliant modem and use it with your cable Internet service; all you
have to do is call the cable company and give them the modem’s identifying
information so that the CMTS can recognize and initialize the modem.

In practice, with a cable modem, you will most likely get downstream transfer
rates of around 12 Mbps and upstream rates of 2 Mbps. These are maximum
rates, and your transfer rate is typically lower, depending on how many
people in your neighborhood are using cable modems at the same time.

If you want to check your downstream transfer speed, go to http: //band
widthplace.com/speedtest and click the link to start the test. For my
cable modem connection, for example, a recent test reported a downstream
transfer rate of about 2.2 Mbps, but at other times the rate has been as high
as 5.2 Mbps.

Typical cable modem setup

To set up cable modem access, your cable TV provider must offer high-
speed Internet access. If the service is available, you can call to sign up. The
cable companies often have promotional offers, such as no installation fee or
a reduced rate for three months. If you're lucky, a local cable company may
have a promotion going on just when you want to sign up.

The installation is typically performed by a technician, who splits your
incoming cable into two — one side goes to the TV and the other to the
cable modem. The technician provides information about the cable modem
to the cable company’s head end for setup at its end. When that work is
completed, you can plug in your PC’s Ethernet card to the cable modem, and
you'll be all set to enjoy high-speed Internet access. Figure 1-5 shows a typi-
cal cable modem hookup.

The cable modem connects to an Ethernet card in your PC. If you don’t
have an Ethernet card in your PC, the cable company technician often
provides one.

Here are some key points to note about the cable modem setup in Figure 1-5:
4+ Split the incoming cable TV signal into two parts by using a two-way

splitter. (The cable company technician installs the splitter.)

The two-way splitter needs to be rated for 1 GHz; otherwise, it may not
let the frequencies that contain the downstream data from the Internet
pass through.
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4+ Connect one of the video outputs from the splitter to your cable
modem’s F-type video connector using a coaxial cable.

4 Connect the cable modem’s 100BaseT Ethernet connection to the
Ethernet card on your PC.

4+ Connect your TV to the other video output from the two-way splitter.

When you use cable modem to directly connect your Linux PC to the
Internet, the connection is always on, so you have more of a chance that
someone may try to break into the PC. Linux includes the iptables packet
filtering capability, which you may want to use to protect your PC from
unwanted Internet connections.

In Ubuntu, you can install the firestarter package (from the Universe
repository). After installed, configure settings by choosing Systemc>
Administration=Firestarter. This kicks off the Firewall Wizard and walks
you through the steps of configuration.

To isolate your Linux PC or local area network from the public Internet,

you may want to add a NAT router between your PC and the cable modem.
One of the NAT router’s network interfaces connects to the Internet, and
the other connects to your LAN; the router then acts as a gateway between
your LAN and the Internet. As a bonus, you can even share a cable modem
connection with all the PCs in your own local area network (LAN) by adding
an Ethernet hub. Better yet, buy a combination NAT router and hub so you
have only box to do the entire job.

Book IlI
Chapter 1

JouId)u| ay}
0} hunoauuo)



188 Connecting with a Cable Modem

A\

Figure 1-6:
A NAT
router
isolates
your PC
from the
Internet and
also lets
you share
the cable
modem
connection
with other
PCsina
LAN.

The NAT router and hubs are typically sold under the name cable/DSL router
because they work with both DSL and cable modem.

The NAT router translates private IP addresses into a public IP address.
When connected through a NAT router, any PC in the internal LAN can
access the Internet as if it had its own unique IP address. As a result, you can
share a single Internet connection among many PCs — an ideal solution for a
family of Net surfers!

Figure 1-6 shows a typical setup with a cable modem connection being
shared by a number of PCs in a LAN.
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Here are the points to note when setting up a connection like the one shown
in Figure 1-6:
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4+ You need a cable/DSL NAT router with two 100BaseT Ethernet ports (the
100BaseT port — also known as an RJ/<45 jack, which looks like a large
phone jack). Typically, one Ethernet port is labeled Internet (or External
or WAN, for wide area network), and the other one is labeled Local.

4+ If you plan to set up a LAN, you also need an Ethernet hub/switch. For a
small home network, you can buy a 4- or 8-port Ethernet hub. Basically,
you want a hub with as many ports as the number of PCs you intend to
connect to your local area network.

4+ Consider buying a single box that acts as both a NAT router and a hub
with a number of Ethernet ports.

<+

Connect the video cable to the video input port of the cable modem.

4+ Connect the Ethernet port of the cable modem to the Internet port of
the NAT router using a 100BaseT Ethernet cable. (The cable looks like a
phone wire except that the Ethernet cable has bigger RJ-45 jacks and is
often labeled Category 5 or Cat 5 wire.)

4+ Connect the Local Ethernet port of the NAT router to one of the ports on
the Ethernet hub using a 100BaseT Ethernet cable.

4 Now connect each of the PCs to the Ethernet hub. Each PC must have an
Ethernet card.

In Chapter 2 of this minibook, I explain how to configure the PCs in a LAN so Book Il
that they can all access the Internet through the router. Chapter 1

Setting Up Dial-up Networking

With the rise in popularity of both DSL and cable networks, dial-up net-
working is becoming a thing of the past. That said, this section outlines the
important features to know about dial-up for those who live in areas where
DSL or cable are not available.
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Dial-up networking refers to connecting a PC to a remote network through a
dial-up modem. If you're ancient enough to remember the days of dialing up
with Procomm or some serial communications software, realize that there’s
a significant difference between dial-up networking and the old days of serial
communication. Both approaches use a modem to dial up a remote com-
puter and to establish a communication path, but the serial communication
software makes your computer behave like a dumb terminal connected to
the remote computer. The serial communication software exclusively uses a
dial-up connection. You can’t run another copy of the communication soft-
ware and use the same modem connection, for example.

In dial-up networking, both your PC and the remote system run network pro-
tocol (called TCP/IP) software. When your PC dials up and sets up a
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communication path, the network protocols exchange data packets over
that dial-up connection. The neat part is that any number of applications can
use the same dial-up connection to send and receive data packets. So your
PC becomes a part of the network to which the remote computer belongs.

(If the remote computer isn’t on a network, dial-up networking creates a net-
work that consists of the remote computer and your PC.)

In Chapter 2 of this minibook, I describe TCP/IP protocol some more, but I
have to use the term as well as a few concepts such as Internet Protocol (IP)
address and Domain Name System (DNS) when describing how to set up dial-
up networking.

Setting up a TCP/IP network over a dial-up link involves specifying the
protocol — the convention — for packaging a data packet over the com-
munication link. Point-to-Point Protocol (PPP) is such a protocol for estab-
lishing a TCP/IP connection over any point-to-point link, including dial-up
phone lines. Linux supports PPP, and it comes with the configuration tools
you can use to set up PPP so that your system can establish a PPP connec-
tion with your ISP.

Here’s what you have to do to set up dial-up networking in Linux:

1. Install an internal or external modem in your PC. If your PC didn’t
already come with an internal modem, you can buy an external modem
and connect it to the PC’s serial or USB port.

2. Connect the modem to the phone line and power up the modem and the
computer.

3. Get an account with an ISP. Every ISP provides you a phone number to
dial, a username, and a password. Additionally, the ISP gives you the full
names of servers for e-mail and news. Typically, your system automati-
cally gets an IP address.

4. Run a GUI tool (if available) to set up a PPP connection. If you can’t find
a GUI tool, type wvdialconf /etc/wvdial.conf at the shell prompt.
(If this program isn’t installed yet, use your distribution’s installation
tools or type apt-get install wvdial in the shell prompt of Ubuntu,
Debian, or Xandros.) The wwdialconf program automatically detects the
modem and sets up the configuration file /etc/wvdial.conf. Now use a
text editor to edit the file /etc/wvdial.conf and enter the ISP’s phone
number as well as the username and password of your Internet account
with the ISP. (Look for fields labeled Username, Password, and Phone.)

5. Use a GUI tool (if available) to activate the PPP connection to connect to
the Internet. If no GUI tool is available, log in as root and type wvdial
to establish the PPP connection.

[ briefly go over these steps in the following sections.
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Connecting the modem

The word modem is a contraction of modulator/demodulator — a device
that converts digital signals (strings of 1s and 0s) into continuously varying
analog signals that transmit over telephone lines and radio waves. Thus,
the modem is the intermediary between the digital world of the PC and the
analog world of telephones. Figure 1-7 illustrates the concept of a modem.

Inside the PC, 1s and 0s are represented with voltage levels, but signals
carried over telephone lines are usually tones of different frequencies. The
modem sits between the PC and the telephone lines and makes data com-
munication possible over the phone lines. The modem converts information
back and forth between the voltage/no voltage representation of digital
circuits and different frequency tones that are appropriate for transmission
over phone lines.

Before you can dial out using an external modem, you have to make sure
that the modem is properly connected to one of the serial or USB ports of
your PC.

Winmodems: They do only Windows

A quick word of caution about the Winmodems  work only with special driver software (which in
that come with many new PCs and laptops: turn works only with Microsoft Windows). With
Winmodems are software-based internal Winmodems and Linux, you're pretty much on
modems — different from the traditional hard-  your own, but you can find some useful guidance
ware modems. Also known as Windows modems  online at the Linux Winmodem Support home
or software modems (softmodemfor short), they  page atwww.1inmodems . org.
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If you have an external modem, make sure that your modem is properly
connected to the power supply and that the modem is connected to the tele-
phone line. Buy the right type of cable to connect the modem to the PC. You
need a straight-through serial cable to connect the modem to the PC. The
connectors at the ends of the cable depend on the type of serial connector
on your PC. The modem end of the cable needs a male 25-pin connector. The
PC end of the cable often is a female 9-pin connector. You can buy modem
cables at most computer stores. Often, you can find 9-pin-female-to-25-pin-
male modem cables sold under the label AT modem cable. Connect USB
modems by using a USB cable.

If your PC has an internal modem, all you have to do is connect the phone
line to the phone jack at the back of the internal modem card. If your PC
has a Winmodem, you still connect the phone line, but you also have to

do a bit of research on the Internet and download a driver that makes the
Winmodem work in Linux. After you install a working Linux driver for a
Winmodem, it works just like the older serial port modems. See the sidebar,
“Winmodems: They do only Windows,” for more information.

Setting up and activating a PPP connection

Most ISPs provide PPP dial-up access to the Internet through one or more
systems that the ISP maintains. If you sign up for such a service, the ISP pro-
vides you the information that you need to make a PPP connection to the
ISP’s system. Typically, this information includes the following:

4 The phone number to dial to connect to the remote system.

4+ The username and password that you must use to log in to the remote
system.

+

The names of the ISP’s mail and news servers.

4 The IP address for your PPP connection. Your ISP doesn’t provide this
address if the IP address is assigned dynamically (which means the
IP address may change every time that your system establishes a
connection).

4 [P addresses of the ISP’s DNS. The ISP doesn’t provide these addresses if
it assigns the IP address dynamically.

Of this information, the first two items are what you need to set up a PPP
connection. The exact steps for setting up and using a PPP connection
depend on the distribution. For distributions with a GUI Internet connection
tool, you can easily figure out where to enter your ISP account information —
the phone number, username, and password. I point out a few distribution-
specific approaches for configuring PPP next.
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Debian has a GUI tool to set up a PPP connection, and the tool uses wvdial,
which isn’t installed by default. Type apt-get install wvdial to install
it. Then you can use the GUI tool to configure and activate the dial-up PPP
connection.

The most recent versions of Ubuntu do not support dial-up modems, but
drivers can be installed that can enable the use of these modems. For more
information, consult Ubuntu’s Help menu.

Configuring CHAP and PAP authentication

The PPP server on your system has to authenticate itself to the ISP’s

PPP server before the PPP connection can get fully up and running.
Authentication requires proving that you have a valid account with the ISP,
essentially providing a username and a secret (that is, a password). PPP
specifies two ways of exchanging the authentication information between
the two ends of the connection:

4+ Challenge Handshake Authentication Protocol (CHAP) requires the
remote end to send a randomly generated challenge string along with
the remote server’s name. The local system looks up the secret, using
the server’s name; then it sends back a response that includes its name
and a value that combines the secret and the challenge, using a one-way
hash function. The remote system then checks that value against its own
calculation of the expected hash value. If the values match, the authen-
tication succeeds; otherwise, the remote system terminates the con-
nection. In this case, the name and secret are stored in the /etc/ppp/
chap-secrets file.

The remote system can repeat the CHAP authentication any time while
the PPP link is up.

4+ Password Authentication Protocol (PAP) is like the normal login pro-
cess. When using PAP, the local system repeatedly sends a username
(name) and password (secret) until the remote system acknowledges
the authentication or ends the connection. The name and secret are
stored in the /etc/ppp/pap-secrets file.

The username and password are sent in the clear (unencrypted).

The Linux PPP server supports both types of authentication. For PAP and
CHAP, the information that the PPP server needs is a name and a secret — a
username and password pair. This authentication information is stored in
the following configuration files:

4 /etc/ppp/chap-secrets stores the information for CHAP. Here’s
what a typical chap-secrets file looks like:
# Secrets for authentication using CHAP

# client server secret IP addresses
"edulaney" * "mypassword"
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/etc/ppp/pap-secrets stores the information for PAP. Here’s a typi-
cal pap-secrets file:
# Secrets for authentication using PAP

# client server secret IP addresses
"edulaney" * "mypassword"

As you can see, the formats of the entries are the same for both chap-
secrets and pap-secrets. Four fields are in each line, in the following
order:

+

+

client: This field contains the name that’s used during authentication.
You get this name from the ISP.

server: This field contains the name of the remote system to which
you'’re authenticating the local system. If you don’t know the server’s
name, type an asterisk to indicate any server.

secret: This field is the secret that your system’s PPP server has to
send to the remote system to authenticate itself. You receive this pass-
word from the ISP.

IP addresses: This optional field can contain a list of the IP addresses
that the local system may use when connecting to the specified server.
Typically, this field is left blank because the local system usually gets a
dynamic IP address from the server and (therefore) doesn’t know what
IP address it uses.



Chapter 2: Setting Up a Local
Area Network

In This Chapter

v+ Understanding TCP/IP networks

v+~ Setting up an Ethernet local area network

1~ Discovering how to configure TCP/IP networking

+~ Connecting a LAN for the Internet

Linux comes with built-in support for Transmission Control Protocol/
Internet Protocol (TCP/IP) networking, as do most modern operating
systems from Windows to Mac OS. You can have TCP/IP networking over
many different physical interfaces, such as Ethernet cards, serial ports, and
parallel ports.

Typically, you use an Ethernet network for your local area network (LAN) —
at your office or even your home (if you happen to have two or more sys-
tems at home) — with wireless (the subject of the next chapter) gaining in
popularity.

This chapter describes how to set up an Ethernet network. Even if you have a
single PC, you may need to set up an Ethernet network interface so that you
can connect your PC to high-speed Internet access that uses a DSL or cable
modem. (I cover DSL and cable modems in Chapter 1 of this minibook.)

Understanding TCP/1P

You can understand TCP/IP networking best if you think in terms of a four-
layer model, with each layer responsible for performing a particular task.
The layered model describes the flow of data between the physical connec-
tion to the network and the end-user application. Figure 2-1 shows the four-
layer network model for TCP/IP.

In this four-layer model, information always moves from one layer to the
next. For example, when an application sends data to another application,
the data goes through the layers in this order: application=>transport=
network=>physical. At the receiving end, the data goes up from physical=
network=>transportoapplication.
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Figure 2-1:
You can
understand
TCP/IP
using the
four-layer
network
model.
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Each layer has its own set of protocols — conventions — for handling and
formatting the data. If you think of sending data as something akin to send-
ing letters through the postal service, a typical protocol is a preferred
sequence of actions for a task, such as addressing an envelope (first the
name, then the street address, and then the city, state, and zip or other
postal code).

These four layers, depending on what reference you look at, might have dif-
ferent names. For example, if you look at the old DOD model, the transport is
called host-to-host, network is called internetwork or Internet, application is
process/application, and physical is network access.

Here’s what each of the four layers does, top to bottom:

4+ Application: Runs the applications that users use, such as e-mail read-
ers, file transfers, and Web browsers. Application-level protocols are
Simple Mail Transfer Protocol (SMTP) and Post Office Protocol (POP)
for e-mail, HyperText Transfer Protocol (HTTP) for the Web, and File
Transfer Protocol (FTP) for file transfers. Application-level protocols
also have a port number that you can think of as an identifier for a spe-
cific application. For example, port 80 is associated with HTTP or the
Web server.

4+ Transport: Sends data from one application to another. The two most
important protocols in this layer are Transmission Control Protocol
(TCP) and User Datagram Protocol (UDP). TCP guarantees delivery of
data; UDP just sends the data without ensuring that it actually reaches
the destination.

4+ Network: This layer is responsible for getting data packets from one
network to another. If the networks are far apart, the data packets are
routed from one network to the next until they reach their destination.
The primary protocol in this layer is the Internet Protocol (IP).

4+ Physical: Refers to the physical networking hardware (such as an
Ethernet card or token ring card) that carries the data packets in a
network.
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TCP/IP and the Internet

TCP/IP has become the protocol of choice on
the Internet — the network of networks that
evolved from ARPANET. The U.S. Government's
Advanced Research Projects Agency (ARPA)
initiated research in the 1970s on a new way
of sending information, using packets of data
sent over a network. The result was ARPANET:
a national network of linked computers.
Subsequently, ARPA acquired a Defense prefix

and became DARPA. Under the auspices of
DARPA, the TCP/IP protocols emerged as a
popular collection of protocols for internet-
working— communication among networks.

TCP/IP has flourished because the protocol is
open. That means the technical descriptions
of the protocol appear in public documents, so
anyone can implement TCP/IP on specific hard-

ware and software.

The beauty of the layered model is that each layer takes care of only its
specific task, leaving the rest to the other layers. The layers can mix and
match — you can have TCP/IP network over any type of physical network
medium, from Ethernet to radio waves (in a wireless network). The software is
modular as well because each layer can be implemented in different modules.
For example, typically the transport and network layers already exist as part
of the operating system, and any application can make use of these layers.

TCP/IP also made great inroads because stable, working software was avail-
able. Instead of a paper description of network architecture and protocols, the
TCP/IP protocols started out as working software — and who can argue with
what’s already working? These days, as a result, TCP/IP rules the Internet.

1P addresses

When you have many computers on a network, you need a way to identify
each one uniquely. In TCP/IP networking, the address of a computer is the
[P address. Because TCP/IP deals with internetworking, the address is based
on the concepts of a network address and a host address. You may think of
the idea of a network address and a host address as having to provide two
addresses to identify a computer uniquely:

4+ Network address indicates the network on which the computer is
located.

4 Host address indicates a specific computer on that network.

The network and host addresses together constitute an IP address, and it’s a
4-byte (32-bit) value. The convention is to write each byte as a decimal value
and to put a dot (.) after each number. Thus, you see network addresses
such as 132.250.112.52. This way of writing IP addresses is known as dotted-
decimal or dotted-quad notation.
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Next-generation IP (IPv6)

When the 4-byte IP address was created, the
number of available addresses seemed ade-
quate. Now, however, the 4-byte addresses
are running out. The Internet Engineering Task
Force (IETF) recognized the potential for run-
ning out of IP addresses in 1991 and began work
on the next-generation |IP addressing scheme.
They called it IPng (for Internet Protocol Next
Generation) and intended for it to eventually
replace the old 4-byte addressing scheme
(called IPv4, for IP version 4).

Several alternative addressing schemes for
IPng were proposed and debated. The final
contender, with a 128-bit (16-byte) address,
was dubbed IPv6 (for IP version 6). On
September 18, 1995, the IETF declared the core
set of IPv6 addressing protocols to be an IETF
Proposed Standard. By now, there are many
RFCs (Request for Comments) dealing with vari-
ous aspects of IPv6, from IPv6 over PPP for the
transmission of IPv6 packets over Ethernet.

IPv6 is designed to be an evolutionary step from
IPv4. The proposed standard provides direct
interoperability between hosts using the older
IPv4 addresses and any new IPv6 hosts. The
idea is that users can upgrade their systems
to use IPv6 when they want and that network
operators are free to upgrade their network
hardware to use IPv6 without affecting cur-
rent users of IPv4. Sample implementations
of IPv6 are being developed for many operat-
ing systems, including Linux. For more infor-
mation about IPv6 in Linux, consult the Linux
IPv6 HOWTO at www. t1dp.org/HOWTO/
Linux+IPv6-HOWTO. For information about
IPv6 in general, visit the IPv6 home page at
www.1ipvb6 .ord.

The IPv6 128-bit addressing scheme allows for
a total of 2'% or 340,282,366,920,938,463,463,37
4,607,431,768,211,456 theoretically assignable
addresses. That should last us for a while!
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In decimal notation, a byte (which has 8 bits) can have a value between 0
and 255. Thus, a valid IP address can use only the numbers between 0 and
255 in the dotted-decimal notation.

Internet services and port numbers

The TCP/IP protocol suite has become the lingua franca of the Internet

because many standard services are available on any system that supports
TCP/IP. These services make the Internet tick by facilitating the transfer of
mail, news, and Web pages. These services go by well-known names such as
the following:

4+ DHCP (Dynamic Host Configuration Protocol) is for dynamically con-
figuring TCP/IP network parameters on a computer. DHCP is primarily
used to assign dynamic IP addresses and other networking information
(such as name server, default gateway, and domain names) needed to
configure TCP/IP networks. The DHCP server listens on port 67.



Setting Up an Ethernet LAN 199

4+ FTP (File Transfer Protocol) is used to transfer files between computers
on the Internet. FTP uses two ports — data is transferred on port 20, and
control information is exchanged on port 21.

4+ HTTP (HyperText Transfer Protocol) is a protocol for sending docu-
ments from one system to another. HTTP is the underlying protocol of
the Web. By default, the Web server and client communicate on port 80.

4 SMTP (Simple Mail Transfer Protocol) is for exchanging e-mail messages
between systems. SMTP uses port 25 for information exchange.

4+ NNTP (Network News Transfer Protocol) is for distribution of news articles
in a store-and-forward fashion across the Internet. NNTP uses port 119.

4 SSH (Secure Shell) is a protocol for secure remote login and other
secure network services over an insecure network. SSH uses port 22.

4+ TELNET is used when a user on one system logs in to another system
on the Internet. (The user must provide a valid user ID and password to
log in to the remote system.) TELNET uses port 23 by default, but the
TELNET client can connect to any port.

4+ SNMP (Simple Network Management Protocol) is for managing all types
of network devices on the Internet. Like FTP, SNMP uses two ports: 161
and 162.

4+ TFTP (Trivial File Transfer Protocol) is for transferring files from one
system to another. (It’s typically used by X terminals and diskless work-
stations to download boot files from another host on the network.) TFTP
data transfer takes place on port 69.

4+ NFS (Network File System) is for sharing files among computers. NFS
uses Sun’s Remote Procedure Call (RPC) facility, which exchanges infor-
mation through port 111.

A well-known port is associated with each of these services. The TCP protocol
uses each such port to locate a service on any system. (A server process — a
special computer program running on a system — provides each service.)

Setting Up an Ethernet LAN

Ethernet is a standard way to move packets of data between two or more
computers connected to a single hub, router, or switch. (You can create
larger networks by connecting multiple Ethernet segments with gateways.)
To set up an Ethernet LAN, you need an Ethernet card for each PC. Linux
supports a wide variety of Ethernet cards for the PC.

Ethernet is a good choice for the physical data-transport mechanism for the
following reasons:
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4+ Ethernet is a proven technology that has been in use since the early
1980s.

4+ Ethernet provides good data-transfer rates: typically 10 million bits per
second (10 Mbps), although 100-Mbps Ethernet and Gigabit Ethernet
(1,000 Mbps) are now common.

4 Ethernet hardware is often built into the PC or can be installed at a rela-
tively low cost. (PC Ethernet cards cost about $10-20.)

4+ With wireless Ethernet, you can easily connect laptop PCs to your
Ethernet LAN without having to run wires all over the place. (Go to
Chapter 3 of this minibook for more information on wireless Ethernet.)

How Ethernet works

So what makes Ethernet tick? In essence, it’s the same thing that makes any
conversation work: listening and taking turns.

In an Ethernet network, all systems in a segment are connected to the same
wire. A protocol is used for sending and receiving data because only one
data packet can exist on the single wire at any time. An Ethernet LAN uses a
data-transmission protocol known as Carrier-Sense Multiple Access/Collision
Detection (CSMA/CD) to share the single transmission cable among all the
computers. Ethernet cards in the computers follow the CSMA/CD protocol to
transmit and receive Ethernet packets.

The idea behind the CSMA/CD protocol is similar to the way in which you
have a conversation at a party. You listen for a pause (that’s sensing the car-
rier) and talk when no one else is speaking. If you and another person begin
talking at the same time, both of you realize the problem (that’s collision
detection) and pause for a moment; then one of you starts speaking again.
As you know from experience, everything works out.

In an Ethernet LAN, each Ethernet card checks the cable for signals — that’s
the carrier-sense part. If the signal level is low, the Ethernet card sends its
packets on the cable; the packet contains information about the sender and
the intended recipient. All Ethernet cards on the LAN listen to the signal, and
the recipient receives the packet. If two cards send out a packet simultane-
ously, the signal level in the cable rises above a threshold, and the cards
know a collision has occurred. (Two packets have been sent out at the same
time.) Both cards wait for a random amount of time before sending their
packets again.

Ethernet was invented in the early 1970s at the Xerox Palo Alto Research
Center (PARC) by Robert M. Metcalfe. In the 1980s, Ethernet was stan-
dardized by the cooperative effort of three companies: Digital Equipment
Corporation (DEC), Intel, and Xerox. Using the first initials of the company
names, that Ethernet standard became known as the DIX standard. Later,
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the DIX standard was included in the 802-series standards developed by the
Institute of Electrical and Electronics Engineers (IEEE). The final Ethernet
specification is formally known as IEEE 802.3 CSMA/CD, but people continue
to call it Ethernet.

Ethernet sends data in packets (discrete chunks also known as frames). You
don’t have to hassle much with the innards of Ethernet packets, except to
note the 6-byte source and destination addresses. Each Ethernet controller
has a unique 6-byte (48-bit) address at the physical layer; every packet must
have one.

Ethernet cables

Any time you hear experts talking about Ethernet, you’ll also hear some
bewildering terms used for the cables that carry the data. Here’s a quick
rundown.

The original Ethernet standard used a thick coaxial cable, nearly half an inch
in diameter. This wiring is called thicknet, thickwire, or just thick Ethernet
although the IEEE 802.3 standard calls it /0Base5. That designation means
several things: The data-transmission rate is 10 megabits per second (10
Mbps); the transmission is baseband (which simply means that the cable’s
signal-carrying capacity is devoted to transmitting Ethernet packets only),
and the total length of the cable can be no more than 500 meters. Thickwire
was expensive, and the cable was rather unwieldy. Unless you're a technol-
ogy history buff, you don’t have to care one whit about 10Base5 cables.

Nowadays, several other forms of Ethernet cabling are more popular. An
alternative to thick Ethernet cable is thinwire, or 10Base2, which uses a thin,
flexible coaxial cable. A thinwire Ethernet segment can be, at most, 185 meters
long. The other, more recent, alternative is Ethernet over unshielded twisted-
pair cable (UTP), known as 10BaseT. More recent Ethernet cabling options
that support higher transmission rates include 100BaseT4, 100BaseT2, and
100BaseTX for 100 Mbps Ethernet and 1000BaseT for Gigabit Ethernet. The
Electronic Industries Association/Telecommunications Industries Association
(EIA/TIA) defines the following five categories of shielded and unshielded
twisted-pair cables:

4+ Category 1 (Cat 1): Traditional telephone cable.

4+ Category 2 (Cat 2): Cable certified for data transmissions up to 4 Mbps.

4+ Category 3 (Cat 3): Cable that can carry signals up to a frequency of 16
MHz. Cat 3 is the most common type of wiring in old corporate networks,
and it normally contains four pairs of wire. Now considered obsolete.

4+ Category 4 (Cat 4): Cable that can carry signals up to a frequency of 20
MHz. Cat 4 wires aren’t common. Now considered obsolete.
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Figure 2-2:
You can use
an Ethernet
hub to
setupa
10BaseT or
100BaseT
Ethernet
LAN.

4+ Category 5 (Cat 5): Cable that can carry signals up to a frequency of 100

MHz. Cat 5 cables normally have four pairs of copper wire. Cat 5 UTP is
the most popular cable used in new installations today. This category of
cable is being superseded by Category 5e (enhanced Cat 5).

Category 5e (Cat 5€): Similar to Cat 5 but with improved technical
parameters, such as near-end cross talk and attenuation. Cat 5e cables
support 10BaseT, 100BaseT4, 100BaseT2, and 100BaseTX and 1000BaseT
Ethernet. Nowadays, Cat 5e is the minimum acceptable wiring.

Category 6 (Cat 6): Similar to Cat 5e but capable of carrying signals up
to a frequency of 250 MHz. Cat 6 cables can support all existing Ethernet
standards and also support Gigabit Ethernet standard 1000BaseTX,
which uses two pairs of wires in each direction as opposed to all four
pairs for 1000BaseT Ethernet over Cat 5e cables.

To set up a 10BaseT or 100BaseT Ethernet network, you need an Ethernet
hub — a hardware box with RJ-45 jacks. (This type of jack looks like a big
telephone jack.) You build the network by running twisted-pair wires (usu-
ally Category 5 cables) from each PC’s Ethernet card to this hub. You can
get a 4-port 10BaseT/100BaseT hub for about $40. Figure 2-2 shows a typical
small 10BaseT/100BaseT Ethernet LAN that you may set up at a small office
or your home.

[

Ethernet hub
[
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Category 5
cables
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PCs with Ethernet cards
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When you install any of the Linux distributions from this book’s companion
DVD-ROM on a PC connected with an Ethernet card, the Linux kernel auto-
matically detects the Ethernet card and installs the appropriate drivers. The
installer also lets you set up TCP/IP networking.

The Linux kernel loads the driver for the Ethernet card every time it boots.
To verify that the Ethernet driver is loaded, type the following command in a
terminal window:

dmesg | grep ethO

On one of my Linux PCs, I get the following output when I type that command:

eth0: RealTek RTL8139 at 0xf£0e20000, 00:0c:76:£4:38:b3, IRQ 161
eth0: Identified 8139 chip type 'RTL-8101"'

eth0: link up, 100Mbps, full-duplex, lpa 0x45E1

eth0: no IPv6 routers present

You should see something similar, showing the name of your Ethernet card
and other related information.

Configuring TCP/IP Networking
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When you set up TCP/IP networking during Linux installation, the installa-
tion program prepares all appropriate configuration files using the infor-
mation you provide. This means that you typically never have to manually
configure the network. However, most Linux distributions come with GUI
tools to configure the network devices, just in case something needs chang-
ing. For all distributions, the steps are similar.

In Ubuntuy, for example, you can use the graphical network configuration tool.
To start the GUI network configuration tool, choose Systemr>Preferences~>
Network Connections. The network configuration tool displays a tabbed dialog
box, as shown in Figure 2-3. You can then configure your network through the
tabs that appear along the top of the dialog box. Clicking the Add button dis-
plays a dialog box similar to the one shown in Figure 2-4.

In most cases, you can set the network card so that it can automatically
obtain an IP address (which is the case when the Ethernet card is con-
nected to DSL or cable modem) by using DHCP. If your network doesn’t
have a DHCP server (which is typically built into routers), you have to
specify an IP address for the network card. If you are running a private net-
work, you may use IP addresses in the 192.168.0.0 to 192.168.255.255 range.
(Other ranges of addresses are reserved for private networks, but this
range suffices for most needs.)
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Figure 2-3:
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Connecting Your LAN to the Internet

If you have a LAN with several PCs, you can connect the entire LAN to the
Internet by using DSL or a cable modem. Basically, you can share the high-
speed DSL or cable modem connection with all the PCs in the LAN.

Chapter 1 of this minibook explains how to set up a DSL or cable modem. In
this section, I briefly explain how to connect a LAN to the Internet so that all
the PCs can access the Internet.

The most convenient way to connect a LAN to the Internet via DSL or a cable
modem is to buy a hardware device called DSL/cable modem NAT router with
a 4- or 8-port Ethernet hub. NAT stands for Network Address Translation,
and the NAT router can translate many private IP addresses into a single,
externally known IP address. The Ethernet hub part appears to you as a
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number of RJ-45 Ethernet ports where you can connect the PCs to set up a
LAN. In other words, you need only one extra box besides the DSL or cable
modem.

Figure 2-5 shows how you might connect your LAN to the Internet through
a NAT router with a built-in Ethernet hub. You need a DSL or cable modem
hookup for this scenario to work, and you have to sign up with a DSL pro-
vider (for DSL service) or with a cable provider for cable Internet service.

To Internet

Ethernet cable
(10BaseT)

Ethernet cables

NAT router and (10BaseT)

Ethernet hub
[==]
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Cable or
DSL modem

O
=

PCsin alocal area
network (LAN). Each
PC must have a
10BaseT
Ethernet card

When you connect a LAN to the Internet, the NAT router acts as a gateway
for your LAN. The NAT router also dynamically provides IP addresses to the
PCs in your LAN. Therefore, on each PC, you have to set up the networking
options to obtain the IP address dynamically.

If you are using DSL and incurring speeds slower than you should (2 Mbps
when it should be 5 Mbps, for example), try a different phone cord. Make
sure that the phone cord that runs from the modem to the wall jack is no
longer than 10 feet and does not go through a filter, surge protector, or split-
ter (which can attenuate the signal). All other phone devices (fax machines,
for example) should go through a filter or surge protector.
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Your LAN can mix and match all kinds of computers: Some may be running
Linux, and some may be running Microsoft Windows or any other operating
system that supports TCP/IP. When configuring the network settings,
remember to select the option that enables Linux to automatically obtain IP
address settings and DNS information with DHCP.



Chapter 3: Going Wireless

In This Chapter

v+ Understanding the wireless Ethernet network
1~ Setting up your wireless hardware
v+ Finding out how to configure a wireless access point

v~ Configuring a wireless network

f you have laptop computers on your LAN — or if you don’t want to run
arat’s nest of wires to connect a PC to the LAN — you have the option
of using a wireless Ethernet network. In a typical scenario, you have a cable
modem or DSL connection to the Internet, and you want to connect one or
more laptops with wireless network cards to access the Internet through
the cable or DSL. modem. This chapter shows you how to set up wireless
networking for connecting to an Ethernet LAN and accessing the Internet.

Understanding Wireless Ethernet Networks

You’ve probably heard about Wi-Fi. Wi-Fi stands for Wireless Fidelity — a
short-range wireless network similar to wired Ethernet networks. A number
of standards from an organization known as /EEE (the Institute of Electrical
and Electronics Engineers) define the technical details of how Wi-Fi net-
works work. Manufacturers use these standards to build the components
that you can buy to set up a wireless network, also known as WLAN for
short.

Until mid-2003, two popular IEEE standards — 802.11a and 802.11b — were
for wireless Ethernet networks. These two standards were finalized in 1999.
A third standard — 802.11g — was finalized by the IEEE in the summer of
2003, and the latest amendment, 802.11n, was published in October 2009.
All these standards specify how the wireless Ethernet network works at the
physical layer. You don’t have to fret all the details of all those standards
to set up a wireless network, but knowing some pertinent details is good so
that you can buy the right kind of equipment for your wireless network.

The three wireless Ethernet standards you’ll commonly encounter today
have the following key characteristics:
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4+ 802.11b: Operates in the 2.4 GHz radio band (2.4 GHz to 2.4835 GHz) in
up to three nonoverlapping frequency bands or channels. Supports a
maximum bit rate of 11 Mbps per channel. One disadvantage of 802.11b
is that the 2.4 GHz frequency band is crowded — many devices (such as
microwave ovens, cordless phones, medical and scientific equipment, as
well as Bluetooth devices), all work within the 2.4 GHz frequency band.
Nevertheless, 802.11b is popular in corporate and home networks.

4+ 802.11a: Operates in the 5 GHz radio band (5.725 GHz to 5.850 GHz) in
up to eight nonoverlapping channels. Supports a maximum bit rate of 54
Mbps per channel. The 5 GHz band isn’t as crowded as the 2.4 GHz band,
but the 5 GHz band isn’t approved for use in Europe. Products conform-
ing to 802.11a standard are on the market, and some wireless access
points are designed to handle both 802.11a and 802.11b connections.

4+ 802.11g: Supports up to 54 Mbps data rate in the 2.4 GHz band (the
same band that 802.11b uses). 802.11g achieves the higher bit rate by
using a technology called OFDM (orthogonal frequency-division multi-
plexing), which is also used by 802.11a. Equipment that complies with
802.11g is on the market. 802.11g has generated excitement by working
in the same band as 802.11b but promising much higher data rates and
by being backward compatible with 802.11b devices. Vendors currently
offer access points that can support both the 802.11b and 802.11g con-
nection standards.

In all cases, the maximum data throughput that a user sees is much less than
the channel’s total capacity because all users of that radio channel share
this capacity. Also, the data transfer rate decreases as the distance between
the user’s PC and the wireless access point increases.

The 802.11n standard is garnering increased usage and supports data rates
with five times the existing throughput and double the range of previous
standards.

An 802.11g access point can also communicate with older (and slower)
802.11b devices. You can also consider a MIMO (multiple input multiple
output) access point, which supports multiple 802.11 standards and imple-
ments techniques for getting higher throughputs and better range.

To find out more about wireless Ethernet, visit woew.wi-f1i.org, the home
page of the Wi-Fi Alliance, which is the nonprofit international association
formed in 1999 to certify interoperability of wireless LAN products based on
[EEE 802.11 standards.

Understanding infrastructure and ad hoc modes
The 802.11 standard defines two modes of operation for wireless Ethernet net-
works: ad hoc and infrastructure. Ad hoc mode is simply two or more wireless
Ethernet cards communicating with each other without an access point.
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Infrastructure mode refers to the approach in which all the wireless Ethernet
cards communicate with each other and with the wired LAN through an
access point. For the discussions in this chapter, | assume that you set your
wireless Ethernet card to infrastructure mode. In the configuration files, this
mode is referred to as managed mode.

Understanding Wired Equivalent Privacy (WEP)

The 802.11 standard includes Wired Equivalent Privacy (WEP) for protect-
ing wireless communications from eavesdropping. WEP relies on a 40-bit or
104-bit secret key that’s shared between a mobile station (such as a laptop
with a wireless Ethernet card) and an access point (also called a base sta-
tion). The secret key is used to encrypt data packets before they are trans-
mitted, and an integrity check is performed to ensure that packets aren’t
modified in transit. The 802.11 standard doesn’t explain how the shared key
is established. In practice, most wireless LANs use a single key that’s shared
between all mobile stations and access points. Such an approach, however,
doesn’t scale very well to an environment such as a college campus because
the keys are shared with all users — and you know how it is if you share

a secret with hundreds of people. That’s why WEP typically isn’t used on
large wireless networks, such as the ones at universities. In such wireless
networks, you have to use other security approaches, such as SSH (Secure
Shell), to log in to remote systems. WEP, however, is good to use on a home
wireless network.

WEP has its weaknesses, but it’s better than nothing. You can use it in
smaller wireless LANs where sharing the same key among all wireless sta-
tions isn’t an onerous task.

In 2003, the Wi-Fi Alliance published a specification called Wi-Fi Protected
Access (WPA) that replaced the existing WEP standard and improved
security by making some changes. For example, unlike WEP, which uses
fixed keys, the WPA standard uses Temporal Key Integrity Protocol (TKIP),
which generates new keys for every 10K of data transmitted over the net-
work. This makes WPA more difficult to break. In 2004, the Wi-Fi Alliance
introduced a follow-on to WPA called Wi-Fi Protected Access 2 (WPA2 —
the second generation of WPA security). WPA2 is based on the final IEEE
802.11i standard, which uses public key encryption with digital certificates
and an authentication, authorization, and accounting RADIUS (Remote
Authentication Dial-In User Service) server to provide better security for
wireless Ethernet networks. WPA2 uses the Advanced Encryption Standard
(AES) for data encryption.

Book IlI
Chapter 3

ssajalip bulog



210 Understanding Wireless Ethernet Networks

Is the WEP stream cipher good enough?

WEP uses the RC4 encryption algorithm, which
is known as a stream cipher. Such an algorithm
works by taking a short secret key and gener-
ating an infinite stream of pseudorandom bits.
Before sending the data, the sending station
performs an exclusive-OR operation between
the pseudorandom bits and the bits representing
the data packet, which results in a 7 when two
bits are different and 0if they are the same. The
receiver has a copy of the same secret key and
generates an identical stream of pseudorandom
bits — and performs an identical exclusive-OR
operation between this pseudorandom stream
and the received bits. Doing so regenerates the
original, unencrypted data packet.

This stream cipher method has a few problems.
If a bit is flipped (from a 0to 7 or vice versa) in
the encrypted data stream, the corresponding
bit is flipped in the decrypted output, which can
help an attacker derive the encryption key. Also,
an eavesdropper who intercepts two encoded
messages that were encoded with the same
stream can generate the exclusive-OR of the
original messages. That knowledge is enough
to mount attacks that can eventually break the
encryption.

To counter these weaknesses, WEP uses some
defenses:

v Integrity check (IC) field: To make sure
that data packets aren’t modified in transit,
WEP uses an integrity check field in each
packet.

v Initialization vector (IV): To avoid encrypt-
ing two messages with the same key
stream, WEP uses a 24-bit IV that aug-
ments the shared secret key to produce a

different RC4 key for each packet. The IV
itself is also included in the packet.

Experts say that both these defenses are poorly
implemented, making WEP ineffective. IC and
IV have two main problems:

v~ The integrity check field is implemented by
using a checksum algorithm called 32-bit
cyclic redundancy code (CRC-32); that
checksum is then included as part of the
data packet. Unfortunately, an attacker
can flip arbitrary bits in an encrypted mes-
sage and correctly adjust the checksum so
that the resulting message appears valid.

v The 24-bit IV is sent in the clear (unen-
crypted). There are only 2% possible ini-
tialization vectors (no big challenge for a
fast machine), and they have to be reused
after running through them all. In other
words, the IV is repeated after sending 2%,
or 16,777,216, packets. The number may
sound like a lot, but consider the case of
a busy access point that sends 1,500-byte
packets at a rate of 11 Mbps. Each packet
has 12,000 bits (8 x 1,500). That means
each second the access point sends 916
packets (11,000,000/12,000). At that rate,
the access point sends 16,777,216 pack-
ets in 5 hours (16,777,216/916 = 18,315
seconds = 5 hours). That means the IV is
reused after 5 hours or less because many
messages are smaller than 1,500 bytes.
Thus, an attacker has ample opportuni-
ties to collect two messages encrypted
with the same key stream — and perform
statistical attacks (which amount to trying
the possible combinations really fast) to
decrypt the message.
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Figure 3-1:
Typical
connection
of a mixed
wired and
wireless
Ethernet
LAN to the
Internet.
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To set up the wireless connection, you need a wireless access point and a
wireless network card in each PC. You can also set up an ad hoc wireless
network among two or more PCs with wireless network cards, but that is a
standalone wireless LAN among those PCs only. In this section, I focus on the
scenario in which you want to set up a wireless connection to an established
LAN that has a wired Internet connection through a cable modem or DSL.

In addition to the wireless access point, you also need a cable modem or DSL
connection to the Internet, along with a NAT router and hub, as described

in the Chapters 1 and 2 of this minibook. Figure 3-1 shows a typical setup for
wireless Internet access through an existing cable modem or DSL connection.
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3

As Figure 3-1 shows, the LAN has both wired and wireless PCs. In this exam-
ple, either a cable or DSL modem connects the LAN to the Internet through
a NAT router and hub. Laptops with wireless network cards connect to the
LAN through a wireless access point attached to one of the RJ-45 ports on
the hub. To connect desktop PCs to this wireless network, you can use a
USB wireless network card (which connects to a USB port).

If you haven’t yet purchased a NAT router and hub for your cable or DSL
connection, consider buying a router and hub that has a built-in wireless
access point.

Configuring the Wireless Access Point
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Configuring the wireless access point involves the following tasks:

4 Setting a name for the wireless network. (The technical term for this
name is the ESSID.)

4 Setting the frequency or channel on which the wireless access point
communicates with the wireless network cards. The access point and
the cards must use the same channel.

4+ Deciding whether to use encryption.

4+ If encryption is to be used, setting the number of bits in the encryp-
tion key and the value of the encryption key. For the encryption key,
24 bits are internal to the access point; you specify only the remaining
bits. Thus, for 64-bit encryption, you have to specify a 40-bit key, which
comes to 10 hexadecimal digits. (A hexadecimal digit is an integer from
0-9 or a letter from A-F.) For a 128-bit encryption key, you specify 104
bits, or 26 hexadecimal digits.

4 Setting the access method that wireless network cards must use when
connecting to the access point. You can opt for either open access
or shared key. The open-access method is typical (even when using
encryption).

4+ Setting the wireless access point to operate in infrastructure (man-
aged) mode You use this mode to connect wireless network cards to an
existing Ethernet LAN.

The exact method of configuring a wireless access point depends on the
device’s make and model; the vendor provides instructions to configure the
wireless access point. You typically work through a graphical client appli-
cation on a Windows PC to do the configuration. If you enable encryption,
make note of the encryption key; you have to specify that same key for each
wireless network card on your laptops or desktops.
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On your Linux laptop, the PCMCIA or PC Card manager recognizes the
wireless network card and loads the appropriate driver for the card. Linux
treats the wireless network card like another Ethernet device and assigns it
a device name such as eth0 or ethl. If you already have an Ethernet card
in the laptop, that card gets the eth0 device name and the wireless PC Card
becomes the ethl device.

You do have to configure certain parameters to enable the wireless network
card to communicate with the wireless access point. For example, you have
to specify the wireless network name assigned to the access point, and the
encryption settings must match those on the access point. You can usually
configure everything using a graphical network configuration tool that’s
available for your Linux distribution — just select the Wireless Network
option and fill in the requested information.

For example, in Fedora, choose Systemr>Preferences=>Network Connections
from the GNOME desktop. Then select the Wireless tab and click Add to add a
new wireless device (see Figure 3-2). You can then select the wireless device
and get to a window where you can configure the wireless connection. In
particular, set the Mode to Infrastructure, specify the name of the wireless net-
work (the one you want to connect to), and set the encryption key, if any. You
can set the option for getting the IP address to DHCP (a protocol for obtaining
network configuration parameters, including IP addresses from a server on the
network). When you're finished and return to the Network Configuration tool’s
main window, select the new wireless device and click the Activate button. If
all goes well, the wireless network will be up and running after a few moments.

= diting Wireless connection' 1 =

Connection pame: [Wireless connection 1 ]

Connect automatically

Wireless | wireless Security | IPv4 Settings | IPV6 Settings

SSID: [

]
Mode: ‘ Infrastructure = ‘

BSSID: | |

MAC address: [ ]

MTU: [autmmatic "‘| bytes

Cancel
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In Fedora, the Network Configuration tool saves your wireless network set-
tings in a text file. The name of the text file depends on the wireless network
device name. If the wireless network device name is eth0, the configuration
is stored in the text file /etc/sysconfig/network-scripts/ifcfg-etho.
If the wireless device name is ethl, the file is /etc/sysconfig/network-
scripts/ifcfg-ethl. This configuration file contains various settings for
the wireless network card. Table 3-1 explains the meaning of the settings.
Here is a slightly edited version of the /etc/sysconfig/network-scripts/
ifcfg-ethl file from my laptop PC running Fedora:

IPV6INIT=no
USERCTL=no
PEERDNS=yes
TYPE=Wireless
DEVICE=ethl
HWADDR=00:02:2d:8c:f9:c4
BOOTPROTO=dhcp
ONBOOT=no
DHCP_HOSTNAME=
NAME=
ESSID="'HOME'
CHANNEL=6
MODE=Managed
RATE=auto

Table 3-1 Settings in Configuration File for a Wireless
Ethernet Network Interface in Fedora

This Parameter Means the Following

BOOTPROTO The name of the protocol to use to get the IP address for the
interface. The protocol used is either dhcp or bootp for an
Ethernet interface.

CHANNEL Channel number (between 1 and 14 in United States and
Canada). Must be the same as that set for the wireless access
point. In managed mode, you don't need to specify the channel.

DEVICE The device name for the wireless Ethernet network interface
(etho for the first interface, ethl for the second, and so on).

ESSID Extended Service Set (ESS) Identifier (ID), also known as the
wireless network name. It is case-sensitive and must be the
same as the name specified for the wireless access point.
Provide the name within single quotes (for example, ' HOME ' ).

HWADDR The hardware address (also called the MAC address) of the wire-
less network card (six pairs of colon-separated hexadecimal num-
bers; for example, 00: 02 :2d: 8c: £9 : c4). The wireless card's
device driver automatically detects this address.
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This Parameter Means the Following

IPV6INIT When set to yes, this parameter initializes IPv6 configuration
for the wireless interface. Set it to no if you're not using IPv6.

MODE The mode of operation of the wireless network card. Set to
Managed for a typical network that connects through a wire-
less access point.

NAME A nickname for your wireless network. If you dont specify it,
the host name is used as the nickname.

ONBOOT Setto yes to activate the wireless interface at boot time; oth-
erwise, set to no.

PEERDNS Setto yes to enable the interface to modify your system’s /
etc/resolv. conf file to use the DNS servers obtained
from the DHCP server (the same server that provides the IP
address for the interface). If you set this parameter to no,
the /etc/resolv.conf fileis left unchanged.

RATE Bit rate for the wireless connection (set to one of the following
options: 1M, 2M, 5. 5M, 11M, or auto). The M means Mbps,
or a million bits per second. Set to auto to use the maximum
possible transmission rate.

TYPE SettoWireless for wireless network interface.

USERCTL When set to yes, a user who isn't logged in as root can
control the device. Setit to no so that only root can control
the device.

In Fedora, the encryption key is stored separately. For a wireless Ethernet
card whose device name is ethl, the encryption key is stored in the /etc/
sysconfig/network-scripts/keys-ethl file. For example, here is what
this file contains for my example:

KEY=1fdf3fdefe

The key has 10 hexadecimal digits for a 40-bit key (for example, 1fdf-
3fde-fe) or 26 hexadecimal digits for a 104-bit key. The keys are 64-bit and
128-bit, respectively, but the encryption algorithm automatically generates
24 bits of the key, so you need to specify only the remaining bits. The longer
the key, the more secure the encryption.

If you ever manually edit the parameters in the wireless Ethernet configura-
tion file in Fedora, type the following command to reactivate the wireless
network interface after editing the configuration file:

/etc/init.d/network restart
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\Q“SPECI‘}o In SUSE Linux, use YaST to configure the wireless network. SUSE stores

$ the wireless configuration parameters in a file whose name begins with
2 ifcfg-wlan, followed by a number such as 0 or 1, depending on the
‘5,0 sequence number of the wireless network interface. The configuration file is

stored in the /etc/sysconfig/network directory. Here’s a typical list of
wireless configuration parameters from a configuration file in SUSE Linux:

WIRELESS_MODE='Managed'
WIRELESS_ESSID='HOME'
WIRELESS_NICK=""
WIRELESS_RATE='auto'
WIRELESS_AUTH_MODE='open'
WIRELESS_KEY_ 0='0123-4567-89"'
A\
To check the status of the wireless network interface, type the following
command:

iwconfig

Here’s a typical output from a Fedora laptop with a wireless Ethernet PC
card. (The output should be similar in other Linux distributions.)

lo no wireless extensions.

eth0 no wireless extensions.

sit0 no wireless extensions.

ethl IEEE 802.11lb ESSID:"HOME" Nickname:"localhost.localdomain"
Mode:Managed Frequency:2.437 GHz Access Point: 00:30:AB:06:E2:5D
Bit Rate=11 Mb/s Sensitivity:1/3

Retry limit:4 RTS thr:off Fragment thr:off

Encryption key:1FDF-3FDE-FE Security mode:open

Power Management:off

Link Quality=51/92 Signal level=-40 dBm Noise level=-91 dBm

Rx invalid nwid:0 Rx invalid crypt:0 Rx invalid frag:27

Tx excessive retries:0 Invalid misc:0 Missed beacon:0

Here, the ethl interface refers to the wireless network card. I edited the

encryption key and some other parameters to hide those details, but the

sample output shows you what you’d typically see when the wireless link
is working.



Chapter 4: Managing the Network

In This Chapter

v Finding out about the TCP/IP configuration files
1 Checking TCP/IP networks

v+~ Configuring networks at boot time

Like almost everything else in Linux, TCP/IP setup is a matter of prepar-
ing numerous configuration files (text files you can edit with any text
editor). Most of these configuration files are in the /etc directory. The
Linux installer tries to be helpful by hiding the details of the TCP/IP configu-
ration files. Nevertheless, if you know the names of the files and their pur-
poses, editing the files manually, if necessary, is easier.

Discovering the TCP/IP Configuration Files

You can configure TCP/IP networking when you install Linux. However, if
you want to effectively manage the network, you need to become familiar
with the TCP/IP configuration files so that you can edit the files, if neces-
sary. (For example, if you want to check whether the name servers are spec-
ified correctly, you have to know about the /etc/resolv. conf file, which
stores the IP addresses of name servers.)

Table 4-1 summarizes the basic TCP/IP configuration files. [ describe these
configuration files in the next few sections.
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Table 4-1 Basic TCP/IP Network Configuration Files
This File Contains the Following
/etc/hosts IP addresses and host names for your local

network as well as any other systems that you
access often

/etc/networks Names and IP addresses of networks

/etc/host.conf Instructions on how to translate host names into
IP addresses

/etc/resolv.conft IP addresses of name servers

/etc/hosts.allow Instructions on which systems can access

Internet services on your system

/etc/hosts.deny Instructions on which systems must be denied
access to Internet services on your system

/etc/nsswitch.conf Instructions on how to translate host names into
IP addresses

A pound sign (#) in a text file indicates a comment.

letc/hosts

The /etc/hosts text file contains a list of I[P addresses and host names for
your local network. In the absence of a name server, any network program
on your system consults this file to determine the IP address that corre-
sponds to a host name. Think of /etc/hosts as the local phone directory
where you can look up the IP address (instead of a phone number) for a
local host.

Here is the /etc/hosts file from a system, showing the IP addresses and
names of other hosts on a typical LAN:

127.0.0.1 localhost localhost.localdomain
# Other hosts on the LAN
192.168.0.100 1nbp933

192.168.0.50 1nbp600
192.168.0.200 1nbp200
192.168.0.233 1nbp233
192.168.0.40 1nbp400

As the example shows, each line in the file starts with an IP address followed
by the host name for that IP address. (You can have more than one host
name for any given IP address.) In some distributions, such as openSUSE
10.3, the /etc/hosts file has the following: [P-Address, Fully-Qualified-
Hostname, Short-Hostname. In all cases, anything after the host name (such
as the Short-Hostname) is taken as an alias.
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letc/networks

/etc/networks is another text file that contains the names and IP
addresses of networks. These network names are commonly used in the
routing command (/sbin/route) to specify a network by name instead of
by its IP address.

Don’t be alarmed if your Linux PC doesn’t have the /etc/networks file.
Your TCP/IP network works fine without this file. In fact, the Linux installer
doesn’t create a /etc/networks file.

letc/host.conf

Linux uses a special library (that is, a collection of computer code) called
the resolver to obtain the IP address that corresponds to a host name. The
/etc/host . conf file specifies how names are resolved (that is, how the
name gets converted to a numeric IP address). A typical /etc/host.conf
file might contain the following lines:

order hosts, bind
multi on

The entries in the /etc/host. conf file tell the resolver what services to
use (and in which order) to resolve names.

The order option indicates the order of services (in recent distributions,
the nsswitch. conf file, discussed in a later section, performs this func-
tion). The sample entry tells the resolver to first consult the /etc/hosts
file and then check the name server to resolve a name.

Use the multi option to indicate whether a host in the /etc/hosts file can
have multiple IP addresses. Hosts that have more than one IP address are
called multihomed because the presence of multiple IP addresses implies
that the host has several network interfaces. (In effect, the host lives in sev-
eral networks simultaneously.)

letc/resolv.conf

The /etc/resolv.conf file is another text file used by the resolver — the
library that determines the IP address for a host name. Here is a sample
/etc/resolv.conf file:

nameserver 192.168.0.1 # dhcp: ethO
search nrockv0l.md.comcast.net

The nameserver line provides the IP addresses of name servers for your
domain. If you have multiple name servers, list them on separate lines.
They’re queried in the order in which they appear in the file.
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The search line tells the resolver how to search for a host name. For exam-
ple, when trying to locate a host name myhost, the search directive in the
example causes the resolver to try myhost .nrockv0l.md.comcast.net
first, then myhost .md.comcast .net, and finally myhost.comcast .net.

If you don’t have a name server for your network, you can safely ignore this
file. TCP/IP still works, even though you may not be able to refer to hosts by
name (other than those listed in the /etc/hosts file).

letc/hosts.allow

The /etc/hosts.allow file specifies which hosts are allowed to use the
Internet services (such as TELNET and FTP) running on your system. This
file is consulted before certain Internet services start. The services start
only if the entries in the hosts.allow file imply that the requesting host is
allowed to use the services.

The entries in /etc/hosts.allow are in the form of a server: IP
address format, where server refers to the name of the program provid-
ing a specific Internet service and TP address identifies the host allowed
to use that service. For example, if you want all hosts in your local network
(which has the network address 192.168.0.0) to access the TELNET service
(provided by the in. telnetd program), add the following line in the /etc/
hosts.allow file (the last octet is left off to signify all possibilities within
that range):

in.telnetd:192.168.0.

If you want to let all local hosts have access to all Internet services, you can
use the ALT keyword and rewrite the line as follows:

ALL:192.168.0.

Finally, to open all Internet services to all hosts, you can replace the IP
address with ALL, as follows:

ALL:ALL
You can also use host names in place of IP addresses.

To find out the detailed syntax of the entries in the /etc/hosts.allow file,
typeman hosts.allow at the shell prompt in a terminal window.

letc/hosts.deny

The /etc/hosts.deny file is just the opposite of /etc/hosts.allow.
Whereas hosts.allow specifies which hosts may access Internet services
(such as TELNET and TFTP) on your system, the hosts . deny file identifies
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the hosts that must be denied services. The /etc/hosts.deny file is
consulted if no rules are in the /etc/hosts.allow file that apply to the
requesting host. Service is denied if the hosts . deny file has a rule that
applies to the host.

The entries in /etc/hosts.deny file have the same format as those in the
/etc/hosts.allow file; they’re in the form of a server: IP address
format, where server refers to the name of the program providing a spe-
cific Internet service and IP address identifies the host that must not be
allowed to use that service.

If you already set up entries in the /etc/hosts.allow file to allow access
to specific hosts, you can place the following line in /etc/hosts.deny to
deny all other hosts access to any service on your system:

ALL:ALL
A\
To find out the detailed syntax of the entries in the /etc/hosts.deny file,
type man hosts.deny at the shell prompt in a terminal window.
letc/nsswitch.conf
The /etc/nsswitch. conf file, known as the name service switch (NSS) file,
specifies how services such as the resolver library, NIS, NIS+, and local con- Book Il
figuration files (such as /etc/hosts and /etc/shadow) interact. Chapter 4
NIS and NIS+ are network information systems — another type of name-lookup =
service. Newer versions of the Linux kernel use the /etc/nsswitch.conf =2
file to determine what takes precedence: a local configuration file, a service %g
such as DNS (Domain Name System), or NIS. s&
A -
-
As an example, the following hosts entry in the /etc/nsswitch. conf file ®
says that the resolver library first tries the /etc/hosts file, then tries NIS+,
and finally tries DNS:
hosts: files nisplus dns
A\\S

You can find out more about the /etc/nsswitch.conf file by typing man
nsswitch.conf in a terminal window.

Checking Out TCP/1P Networks

After you configure Ethernet and TCP/IP (whether during Linux installation
or by running a network configuration tool or command later), you can use
various networking applications without much problem. On the off chance
that you do run into trouble, Linux includes several tools to help you moni-
tor and diagnose problems.
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Checking the network interfaces

Use the /sbin/ifconfig command to view the currently configured net-
work interfaces. The ifconfig command is used to configure a network
interface (that is, to associate an IP address with a network device). If you
run ifconfig without any command-line arguments, the command displays
information about current network interfaces. The following is a typical
output when you type /sbin/ifconfig:

eth0 Link encap:Ethernet HWaddr 00:08:74:E5:C1:60

inet addr:192.168.0.7 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::208:74ff:fee5:c160/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:612851 errors:0 dropped:0 overruns:0 frame:0
TX packets:574187 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000

RX bytes:99834031 (95.2 MiB) TX bytes:76034821 (72.5 MiB)
Interrupt:10 Base address:0x3000

ethl Link encap:Ethernet HWaddr 00:02:2D:8C:F8:C5

inet addr:192.168.0.9 Bcast:192.168.0.255 Mask:255.255.255.0
inet6 addr: fe80::202:2dff:fe8c:£f8c5/64 Scope:Link

UP BROADCAST RUNNING MULTICAST MTU:1500 Metric:1

RX packets:3833 errors:0 dropped:0 overruns:0 frame:0

TX packets:1242 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txqueuelen:1000

RX bytes:560194 (547.0 KiB) TX bytes:250287 (244.4 KiB)
Interrupt:3 Base address:0x100

lo Link encap:Local Loopback

inet addr:127.0.0.1 Mask:255.0.0.0

inet6 addr: ::1/128 Scope:Host

UP LOOPBACK RUNNING MTU:16436 Metric:1

RX packets:2456 errors:0 dropped:0 overruns:0 frame:0

TX packets:2456 errors:0 dropped:0 overruns:0 carrier:0
collisions:0 txgueuelen:0

RX bytes:2891581 (2.7 MiB) TX bytes:2891581 (2.7 MiB)

This output shows that three network interfaces — the loopback interface
(10) and two Ethernet cards (eth0 and ethl) — are currently active on this
system. For each interface, you can see the IP address, as well as statistics
on packets delivered and sent. If the Linux system has a dial-up PPP link up
and running, you also see an item for the ppp0 interface in the output.

Checking the IP routing table

The other network configuration command, /sbin/route, also provides
status information when you run it without a command-line argument. If
you're having trouble checking a connection to another host (that you spec-
ify with an IP address), check the IP routing table to see whether a default
gateway is specified. Then check the gateway’s routing table to ensure that
paths to an outside network appear in that routing table.

A typical output from the /sbin/route command looks like the following:

Kernel IP routing table
Destination Gateway Genmask Flags Metric Ref Use Iface
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192.168.0.0 * 255.255.255.0 U 0 0 0 ethO
192.168.0.0 * 255.255.255.0 U 0 0 0 ethl
169.254.0.0 * 255.255.0.0 U 0 0 0 ethl

default 192.168.0.1 0.0.0.0 UG 0 0 0 ethO

As this routing table shows, the local network uses the eth0 and ethl
Ethernet interfaces, and the default gateway is the eth0 Ethernet interface.
The default gateway is a routing device that handles packets addressed to
any network other than the one in which the Linux system resides. In this
example, packets addressed to any network address other than those begin-
ning with 192.168.0 are sent to the gateway — 192.168.0. 1. The gate-
way forwards those packets to other networks (assuming, of course, that the
gateway is connected to another network, preferably the Internet).

Checking connectivity to a host

To check for a network connection to a specific host, use the ping com-
mand. ping is a widely used TCP/IP tool that uses a series of Internet
Control Message Protocol (ICMP, pronounced EYE-comp) messages. ICMP
provides for an echo message to which every host responds. Using the ICMP
messages and replies, ping can determine whether the other system is alive
and can compute the round-trip delay in communicating with that system.

The following example shows how [ run ping to see whether a system on my
network is alive:

ping 192.168.0.1

Here is what this command displays on my home network:

PING 192.168.0.1 (192.
64 bytes from 192.168.
64 bytes from 192.168.
64 bytes from 192.168.
64 bytes from 192.168.
64 bytes from 192.168. : icmp_seg=5 ttl=63 time=0.275 ms
---192.168.0.1 ping statistics ---

5 packets transmitted, 5 received, 0% packet loss, time 3999ms
rtt min/avg/max/mdev = 0.256/0.267/0.275/0.016 ms

68.0.1) 56(84) bytes of data.

1: icmp_seqg=1 ttl=63 time=0.256 ms
.1: icmp_seqg=2 ttl=63 time=0.267 ms
1: icmp_seq=3 ttl=63 time=0.272 ms
1: icmp_seqg=4 ttl=63 time=0.267 ms
1

NNl Nl =

In Linux, ping continues to run until you press Ctrl+C to stop it; then it dis-
plays summary statistics showing the typical time it takes to send a packet
between the two systems. On some systems, ping simply reports that a
remote host is alive. However, you can still get the timing information by
using appropriate command-line arguments.

The ping command relies on ICMP messages that many firewalls are configured
to block. Therefore, ping may not always work and is no longer a reliable way
to test network connectivity. If ping fails for a specific host, don’t assume that
the host is down or not connected to the network. You can typically use ping
to successfully check connectivity within your local area network.
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Checking network status

To check the status of the network, use the netstat command. This com-
mand displays the status of network connections of various types (such as
TCP and UDP connections). You can view the status of the interfaces quickly
by typing netstat -i, which results in an output similar to the following:

Kernel Interface table

Iface MTU Met RX-OK RX-ERR RX-DRP RX-OVR TX-OK TX-ERR TX-DRP TX-OVR Flg
eth0 1500 0 613175 0 0 1 574695 0 0 0 BMRU

ethl 1500 0 4298 0 0 0 1375 1 0 0 BMRU

lo 16436 0 3255 0 0 0 3255 0 0 0 LRU

In this case, the output shows the current status of the loopback and
Ethernet interfaces. Table 4-2 describes the meanings of the columns.

Table4-2  Meaning of Columns in the Kernel Interface Table

Column Meaning
Iface Name of the interface
MTU Maximum Transmission Unit — the maximum number of

bytes that a packet can contain

Met Metric value for the interface — a number indicating dis-
tance (in terms of number of hops) that routing software uses
when deciding which interface to send packets through

RX-OK, TX-0OK Number of error-free packets received (RX) or transmitted (TX)
RX-ERR, Number of packets with errors

TX-ERR

RX-DRP, Number of dropped packets

TX-DRP

RX-OVR, Number of packets lost due to overflow

TX-OVR

Flg A =receive multicast; B = broadcast allowed; D = debugging

turned on; L. = loopback interface (notice the flag on 10), M =
all packets received, N = trailers avoided; O = no ARP on this
interface; P = point-to-point interface; R = interface is run-
ning; and U = interface is up

Another useful form of netstat option is -t, which shows all active TCP
connections. Following is a typical result of typing netstat -t on one
Linux PC:



\\3

Checking Out TCP/IP Networks 225

Active Internet connections (w/o servers)

Proto Recv-Q Send-Q Local Address Foreign Address State

tcp 0 0 localhost:2654 localhost:1024 ESTABLISHED

tcp 0 0 localhost:1024 localhost:2654 ESTABLISHED

tcp 0 0 LNBNECXAN.nrockv0l.:ssh 192.168.0.6:1577 ESTABLISHED

In this case, the output columns show the protocol (Proto), the number of
bytes in the receive and transmit queues (Recv-Q, Send-Q), the local TCP
port in hostname: service format (Local Address), the remote port
(Foreign Address), and the state of the connection.

Type netstat -ta to see all TCP connections — both active and the ones
your Linux system is listening to (with no connection established yet). For
example, here’s a typical output from the netstat -ta command:

Active Internet connections (servers and established)
Proto Recv-Q Send-Q Local Address Foreign Address State

tcp 0 0 *:32769 *:* LISTEN

tcp 0 0 *:mysqgl *:* LISTEN

tcp 0 0 *:sunrpc *:* LISTEN

tcp 0 0 *:ftp *:* LISTEN

tcp 0 0 localhost.localdomain:ipp *:* LISTEN

tcp 0 0 *:telnet *:* LISTEN

tcp 0 0 localhost.localdomain:5335 *:* LISTEN

tecp 0 0 localhost.localdomain:smtp *:* LISTEN

tcp 0 0 192.168.0.9:45876 www.redhat.com:http ESTABLISHED
tcp 0 0 192.168.0.9:45877 www.redhat.com:http ESTABLISHED
tcp 0 0 192.168.0.9:45875 www.redhat.com:http ESTABLISHED
tcp 0 0 *:ssh *:* LISTEN

tcp 0 0 ::ffff:192.168.0.7:ssh ::£f£fff:192.168.0.3:4932 ESTABLISHED

Sniffing network packets

Sniffing network packets — sounds like something illegal, doesn’t it? Nothing
like that. Sniffing simply refers to viewing the TCP/IP network data packets.
The concept is to capture all the network packets so that you can examine
them later.

If you feel like sniffing TCP/IP packets, you can use tcpdump, a command-
line utility that comes with Linux. As its name implies, it dumps (prints) the
headers of TCP/IP network packets.

To use tcpdump, log in as root and type the tcpdump command in a termi-
nal window. Typically, you want to save the output in a file and examine that
file later. Otherwise, tcpdump starts spewing results that just flash by on the
window. For example, to capture 1,000 packets in a file named tdout and
attempt to convert the IP addresses to names, type the following command:

tcpdump -a -c 1000 > tdout
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After capturing 1,000 packets, tcpdump quits. Then you can examine the
output file, tdout. It’s a text file, so you can simply open it in a text editor or
type more tdout to view the captured packets.

Just to whet your curiosity, here are some lines from a typical output from
tcpdump:

20:05:57.723621 arp who-has 192.168.0.1 tell LNBNECXAN.nrockv(0l.md.comcast.net

20:05:57.723843 arp reply 192.168.0.1 is-at 0:9:5b:44:78:fc

20:06:01.733633 LNBNECXAN.nrockv0l.md.comcast.net.1038 > 192.168.0.6.auth:
S 536321100:536321100(0) win 5840 <mss 1460, sackOK, timestamp 7030060
0,nop,wscale 0> (DF)

20:06:02.737022 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: P 1:72
(71) ack 1 win 5840 (DF)

20:06:02.935335 192.168.0.6.1596 > LNBNECXAN.nrockv0l.md.comcast.net.ftp: . ack
72 win 65464 (DF)

20:06:05.462481 192.168.0.6.1596 > LNBNECXAN.nrockv0l.md.comcast.net.ftp: P 1:12
(11) ack 72 win 65464 (DF)

20:06:05.462595 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: . ack
12 win 5840 (DF)

20:06:05.465344 LNBNECXAN.nrockv0l.md.comcast.net.ftp > 192.168.0.6.1596: P
72:105(33) ack 12 win 5840 (DF)
. lines deleted .

The output offers some clues to what’s going on, with each line showing
information about one network packet. Every line starts with a timestamp
followed by details of the packet (information such as where it originates
and where it is going). [ don’t try to explain the details here, but you can
type man tcpdump to find out more about some of the details (and more
importantly, see what other ways you can use tcpdump).

If tcpdump isn’t installed in Debian, type apt-get install tcpdump to
install it.

You can use another packet sniffer called Ethereal in Linux. To find out more
about Ethereal, visit wow . ethereal . com.

Using GUI Tools

You can check the status of your network through the graphical interfaces

a number of ways. One of those is to use the System Monitor (in GNOME,
choose System=> Administration=>System Monitor), as shown in Figure 4-1.
In addition to seeing the network load, you can click the Processes tab to see
the status of various processes.
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Monitor Edit View Help
System Processes Resources File Systems

CPU History
100 % -
50%
0% : : : : : ]
60 seconds. 0 40 30 0 10 o
[ cpu 25.3%

Memory and Swap History
IR H H H
50% - ; ; ; —
0%

60 seconds 0 40 k) 20 10 o
Q Memory A Swap
193.1 MiB (39.5 %) of 489.1 MiB 184.0 KiB (0.1 %) of 122.3 MiB

Network History
2.0 KiBfs -:
L0 Klls
0.0 Kils

Figure 4-1: 60 seconds 50 40 30 0 10 ]
The System @, Receiving 0 bytes/s @ sending 0 bytes/s
Monitor Total Received 0 bytes Total Sent 0 bytes

Configuring Networks at Boot Time

It makes sense to start your network automatically every time you boot the Book Il
system. For that to happen, various startup scripts must contain appropri- Chapter 4
ate commands. You don’t have to do anything special other than configure
your network (either during installation or by using the network configura-

tion tool at a later time). If the network balks at startup, however, you can §
troubleshoot by checking the files I mention in this section. g §
-
q;;Sl’l:'c/,e/o In Debian, Ubuntu, and Xandros, the /etc/network/interfaces file gr‘;
describes the network interfaces available in your system, and the /sbin/ @
ifup command activates the interfaces when you boot the system. Here
is the content of a typical /etc/network/interfaces file from a Debian

SSTRIBY,,

system:

# This file describes the network interfaces available on your system
# and how to activate them. For more information, see interfaces(5).
# The loopback network interface

auto lo

iface lo inet loopback

# The primary network interface

auto eth0

iface eth0 inet dhcp
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The auto etho line indicates that you can bring up the Ethernet interface
at initialization by using the command i fup -a invoked by a system startup
script. The line i fup ethO inet dhcp identifies Ethernet as a TCP/IP net-
work interface that is configured by Dynamic Host Configuration Protocol
(DHCP).

In Fedora, the network-activation script uses a set of text files in the /etc/
sysconfig directory to activate the network interfaces. For example, the
script checks the variables defined in the /etc/sysconfig/network file to
decide whether to activate the network. In /etc/sysconfig/network, you
see a line with the NETWORKING variable as follows:

NETWORKING=yes

The network activates only if the NETWORKING variable is set to yes. A
number of scripts in the /etc/sysconfig/network-scripts directory
activate specific network interfaces. For example, the configuration file

for activating the Ethernet interface etho0 is the file /etc/sysconfig/
network-scripts/ifcfg-eth0. Here's what a typical /etc/sysconfig/
network-scripts/ifcfg-etho file contains:

DEVICE=ethO
BOOTPROTO=dhcp
HWADDR=00:08:74:E5:C1:06
ONBOOT=yes

TYPE=Ethernet

The DEVICE line provides the network device name. The BOOTPROTO vari-
able is set to dhcp, indicating that the IP address is obtained dynamically

by using DHCP. The ONBOOT variable states whether this network interface
activates when Linux boots. If your PC has an Ethernet card and you want

to activate the etho0 interface at boot time, ONBOOT must be set to yes.

The configuration file i fcfg-eth0 in the /etc/sysconfig/network-
scripts directory works only if your PC has an Ethernet card and the Linux
kernel has detected and loaded the specific driver for that card.

In SUSE, the network information is kept in the /etc/sysconfig/network
directory in files with names beginning with ifcfg. For Ethernet interfaces,
the configuration filename begins with i fcfg-eth-id- followed by the
unique hardware address of the Ethernet card. Here are the key lines in a
typical Ethernet configuration file:

BOOTPROTO="'dhcp'
STARTMODE="'auto'

The BOOTPROTO="dhcp" line indicates that the interface is set up using
DHCP, and STARTMODE="auto' means that the interface is initialized when
the system boots.
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Within KDE, you can start the Control Center by typing Session Manager
in the Search box and configuring the default operations for the system, as

shown in Figure 4-2.

Offer shutdown options

<

End current session
Turn off computer
_ Restart computer

Restore previous session
__ Restore manually saved session

4" Session Manager - KDE Control Module Y&
C gl the and logout settings P
General

v Confirm logout

Default Leave Option

On Login

—— _ Start with an empty session
Figure 4_2: Applications to be excluded from sessions:
The Session
Manager' i) Defaults ¥ OK ¥ Appl @ Cancel
Within KDE and GNOME, you can run the Login Manager utility to choose
the default operations for the system. Figure 4-3 shows an example of the
Login Manager dialog box as it appears in Fedora (based upon your version,
the Login Manager may not be installed by default). If a boot manager was
installed to handle multiple operating systems, the Boot Manager option in
Figure 4-3 would be enabled.
Bg Login Manager - KDE Control Module IRORENES
Configure the login manager (KDM) Gl
General Dialog Background Theme @ Shutdown Users Convenience
Allow shutdown
Local: |Everybod Remote: |Only Root
Commands
Halt: |/sbinjpoweroff (= Reboot: /shin/reboot =)
Miscellaneous
—— Boot manager:
Figure 4-3:
The Login
Manager
offers
several
Optlons' = Defaults ¥ OK 4 @ Cancel
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Chapter 1: E-Mailing and IMing
in Linux

In This Chapter

+ Understanding e-mail
v Looking at mail readers and IM (instant messaging) clients
v+ Introducing Evolution, Thunderbird, and KMail

v Instant messaging with Pidgin and Kopete

Eectronic mail (e-mail) is the killer app of the Internet. With e-mail, you
can exchange messages and documents with anyone on the Internet:
friends, acquaintances, loved ones, and complete strangers. Under normal
conditions, you can send messages anywhere in the world from any Internet
host, and that message typically makes its way to its destination within
minutes — something you can’t do with paper mail (also known as snail
mail, and appropriately so).

E-mail eliminates the hassles of trying to arrange schedules and availability
to communicate over the phone. When I send an e-mail message, it waits in
the recipient’s mailbox to be read at the recipient’s convenience. Likewise,
when people send me e-mail, I can read and reply at my convenience.

Linux comes with several mail clients — also called mail readers — that you
can use to download mail from your Internet service provider (ISP) or from
a number of Web sites. After installed, you can read and send e-mail using
these mail clients. In this chapter, | mention several mail clients available in
Linux and briefly introduce you to a few of them. Because of the similarities
among them, generally when you know one, you can easily use any of the
mail readers.

Yet another type of keeping in touch is more in line with today’s genera-
tion. I'm talking about /M — instant messaging. IM is basically one-to-one
chat, and most Linux implementations include IM clients for AOL Instant
Messenger (or AIM), as well as other instant messaging protocols such as
Jabber, ICQ, MSN Messenger, Yahoo!, Gadu-Gadu, IRC (Internet Relay Chat),
and SMS (Short Message Service, or text messaging). | briefly describe a few
IM clients in this chapter.
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Understanding Electronic Mail

E-mail messages are addressed to a username at an e-mail domain, with the
two values separated by an @ sign. That means if John Doe logs in with the
username jdoe, the first half of his e-mail address is jdoe. The only other
piece of information needed to identify the recipient uniquely is the e-mail
domain (also known as the fully qualified domain name of the recipient’s
system). Thus, if John Doe’s system is named someplace. com, his complete
e-mail address becomes jdoe@someplace.com. Given that address, anyone
on the Internet can send e-mail to John Doe.

How MUAs and MTAs work

The two types of mail software are as follows:

4 Mail user agent (MUA) is the fancy name for a mail reader — a client
that you use to read your mail messages, write replies, and compose
new messages. Typically, the mail user agent retrieves messages from
the mail server by using the POP3 or IMAP4 protocol. POP3 is the Post
Office Protocol version 3, and IMAP4 is the Internet Message Access
Protocol version 4. Most Linux implementations come with mail user
agents such as Balsa, Thunderbird, KMail, and Evolution.

4 Mail transport agent (MTA) is the fancy name for a mail server, which
sends and receives mail message text. The method used for mail trans-
port depends on the underlying network. In TCP/IP networks, the mail
transport agent delivers mail using the Simple Mail Transfer Protocol
(SMTP). Just about every Linux distribution includes sendmail, a pow-
erful and popular mail transport agent for TCP/IP networks.

Figure 1-1 shows how the MUAs and MTAs work with one another when
Alice sends an e-mail message to Bob. (Using Alice and Bob to explain e-mail
and cryptography is customary — just pick up any book on cryptography
and you’ll see what [ mean.) The Internet is always diagrammed as a cloud —
the boundaries of the Internet are so fuzzy that a cloud seems just right to
represent it. (Or is it because no one knows where the Internet starts and
where it ends?)

The scenario in Figure 1-1 is typical. Alice and Bob both connect to the
Internet through an ISP, which they use to get and send their e-mail. When
Alice types a message and sends it, her mail user agent (MUA) sends the
message to her ISP’s mail transfer agent (MTA) using the Simple Mail
Transfer Protocol (SMTP). The sending MTA then sends that message to the
receiving MTA — Bob’s ISP’s MTA — using SMTP. When Bob connects to
the Internet, his MUA downloads the message from his ISP’s MTA using the
POP3 (or IMAP4) protocol. That’s the way mail moves around the Internet —
from sending MUA to sending MTA to receiving MTA to receiving MUA.
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Alice’s ISP’s
Mail Transfer Agent (MTA)

Alice’s Mail User Agent (MUA)

Bob's ISP
SMTP
@
The
Internet
Alice POP3 or IMAP4
Bob’s MUA

Figure 1-1:
How Alice
sends
e-mail to
Bob (or all
about MUAs
and MTAs).

Mail message enhancements Book IV

Chapter 1
Mail messages used to be plain text (and most still are), but many messages P
today have much more than text. Two typical features of today’s mail are

=m

4+ Attachments: Many messages today include attached files, which can be E ,”5
anything from documents to images. The recipient can save the attach- = 5
ment on disk or open it directly from the mail reader. Unfortunately, one ce

of the ways hackers try to get viruses and worms into your PC is by plac- E =3

ing them in attachments. (If it’s any consolation, most Windows-based
viruses and worms don’t work in Linux.)

4+ HTML messages: Mail messages can be in HTML (HyperText Markup
Language), the language used to lay out Web pages. When you read an
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HTML message on a capable mail reader, the message appears in its full
glory with fancy fonts and embedded graphics.

Although HTML messages are nice, they don’t appear correctly when you
use a text-based mail reader. In a text mail reader, HTML messages appear
as a bunch of gobbledygook (which is just the HTML code).

If you have an ISP account, all you need is a mail client to access your e-mail.
In this case, your e-mail resides on your ISP’s server, and the mail reader
downloads mail when you run it. You have to do some setup before you can
start reading mail from your ISP’s mail server. The setup essentially requires
you to enter information that you get from your ISP — the mail server’s
name, server type (POP3, for example), your username, and your password.

Taking Stock of Mail Readers and IM Clients in Linux

There was a time when most mail readers were text programs, but those
times have changed. Now mail readers are graphical applications capable
of displaying HTML messages and handling attachments with ease. They're
easy to use; if you can work with one, it’s a pretty sure bet that you can use
any of the graphical mail readers out there. (As mentioned, most Linux dis-
tributions come with several mail readers; feel free to try a few out to see
which one fits your needs best.)

IM (instant messaging) is a more recent phenomenon, but Linux tries to stay
on top of things, so most implementations come with two IM clients that can
work with various IM protocols. Table 1-1 gives you an overview of the major
mail readers and IM clients in Linux.

Table 1-1 Linux Mail Readers and IM Clients
Software Description
KMail The KDE e-mail client that supports both POP3 and IMAP4.

Thunderbird A redesign of the Mozilla Mail client, which was a part of the
Mozilla Web browser (open source incarnation of Netscape
Communicator).

Evolution A personal information manager (PIM) that includes e-mail,
calendar, contact management, and an online task list.
Pidgin An IM client for GNOME that supports a number of instant-

messaging protocols such as AlM, ICQ, Yahoo!, MSN, Gadu-
Gadu, and Jabber. This software was formerly known as Gaim.

Kopete An IM client for KDE that supports a number of messaging protocols,
such as Jabber, ICQ, AIM, MSN, Yahoo!, IRC, Gadu-Gadu, and SMS.
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If you don’t see a specific mail or IM client in your distribution, chances are
that you can easily download and install it from the Internet.
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Each Linux distribution’s GUI desktop has one or two default e-mail clients.
GNOME desktops typically offer Evolution, whereas KDE desktops go with
KMail. Both GNOME and KDE desktops often come with Mozilla as the Web
browser, and Mozilla includes a mail client as well.

Debian and Fedora include KMail and Evolution (for the KDE and GNOME
interfaces, respectively). Ubuntu offers Evolution as the default mail client.
SUSE uses KMail as the default mail reader, and Xandros provides both
KMail and Thunderbird mail.

In the following sections, I briefly introduce you to Evolution, Thunderbird
mail, and KMail. All mail clients are intuitive, so you don’t need much more
than an introduction to start using them effectively.

Introducing Evolution

Evolution is one of Linux’s most popular e-mail clients, so [ want to start
with it. What better way than to just jump right in!

In Fedora, you can start Evolution by choosing
Application>Officer>Evolution Mail and Calendar from the GNOME desktop
or Applications=>Internet>Mail Client from the KDE desktop. With open-
SUSE, choose Main Menu=Internet=> E-mail=> Evolution Email. (In Debian, I
had to choose Applications=>Debian Menu=>Apps=Net=>Evolution.)

When you start Evolution for the first time, the Evolution Setup Assistant
window appears, as shown in Figure 1-2.

Click Forward in the Welcome screen, and the Setup Assistant guides you
through the following steps:

1. Enter your name and e-mail address in the Identity screen, and then
click the Forward button.

For example, if your e-mail address is jdoe@someplace. com, that’s
what you enter. You may also have the option of choosing to make this
your default account and adding additional information such as your
organization’s name.
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Figure 1-2:
Evolution
Setup
Assistant
guides you
through the
initial setup.

Evolution Setup Assistant =N

Welcome to Evolution. The next few screens will allow
Evolution to connect to your email accounts, and to import
files from other applications.

Please click the "Forward" button to continue.

2.

Set up the options for receiving e-mail, and then click Forward.

Select the type of mail download protocol — POP or IMAP. Then provide
the name of the mail server (for example, mail.comcast.net). You're
prompted for the password when Evolution connects to the mail server
for the first time.

Provide further information about receiving e-mail — how often to
check for mail, whether to leave messages on the server, and more —
and then click Forward.

Typically, you want to download the messages and delete them from the
server (otherwise the ISP complains when your mail piles up).

Set up the following options for sending e-mail and click Forward
when you’re finished:

a. Select the server type as SMTP.
b. Enter the name of the server, such as smtp.comcast.net.

c. If the server requires you to log in, select the Server Requires
Authentication check box.



Figure 1-3:
Evolution
takes care
of mail,
calendar,
contact
manage-
ment, and
to-do lists.
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d. Enter your username — the same username you use to log in to
your ISP’s mail server.

Often, you don’t have to log in to send mail; you only log in when
receiving — downloading — mail messages.

5. (Optional) Give this e-mail account a descriptive name, such as Work
or Personal.

6. Click Forward.
7. Click Apply to complete the Evolution setup.

After you complete the one-time setup, Evolution opens its main window, as
shown in Figure 1-3.

Inbox (0 total) - Evolution =S
File Edit View Folder Message Search Help
L=y New ~ L..*@Sendlﬁeceive Reply Reply to Al Forward 6
-/ Inbox ottal  Show: | All Messages < Search: in | Current Folder ¢
=/ on This Computer 4| @ | @ |From Subject Date 2l
|+ Drafts There are no messages in this folder.

Junk
&% Outbox
[0 Sent =l
[El Templates
3 Tash
+ grahambrownforeve...
= Search Folders
i@ Unmatched

| = mail
Contacts
Calendars
(% Tasks
& Memos

==

Evolution’s main display area is vertically divided into two windows: a
narrow pane on the left with a number of shortcut buttons — Mail, Contacts,
Calendars, Tasks, Memos — arranged in a column and a bigger right pane
where Evolution displays information relevant to the currently selected
shortcut icon. In Figure 1-3, Evolution displays the Inbox for mail.

You can click the shortcut buttons in the left window to switch to different
views. These buttons provide access to all the necessary components of a
PIM — e-mail, contacts, calendar, task list, and memos. You'll find all these
tasks intuitive to perform in Evolution.
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Figure 1-4:
Read your
e-mail in the
Evolution
Inbox.

To access your e-mail, click the Inbox icon. Evolution opens your Inbox, as
shown in Figure 1-4. If you turn on the feature to automatically check for mail
every so often, Evolution prompts you for your mail password, gives you

the option of having Evolution remember your password in the future, and
downloads your mail. The e-mail Inbox looks very much like any other mail
reader’s inbox, such as the Outlook Express Inbox.

Inbox (1 total) - Evolution ===
File Edit View Folder Message Search Help

\_-,E!New v L:(}Sendfﬁeceive L-:lRepIy LﬁiﬁeplytoAll I_—,#Forward LE‘J @ ) \_gj 6

- Inbox 1total Show: ‘ All Messages < Search: ‘ Q, Subject or Addresses cc ‘ in ‘ Current Folder ¢

=/ on This Computer ] 35’|ﬂ|2| From |5“hiECt |Date | Ml
a The Evolution Team <evolution@... Welcome to Evolution! 03/14/2007 12:00
|# Drafts

Junk
(£ Outbox
i Sent

[ Templates i )
From: The Evolution Team <evolution@novell.com> M

Smesh To: Evolution Users <evolution@novell.com>
& gr ject: Welcome to Evolution!
- Search Folders Date: 03/14/2007 12:00:00 PM

[i§ Unmatched

({,,\_ The Evolution Team is proud to welcome you to Evolution, a complete @
S

&

system for managing your communications and personal information.

Getting Started

=] Mail ‘ On the left of the Evolution window is the side bar, with shortcuts to all your mail folders. Below that, you will

find buttons for your calendars, contacts, tasks, mail and memos.
Contacts

For a complete guide to using Evolution, select Table of Contents in the Help menu, or press the F1 key.

‘@Calendars
- Bug Reporting
[ Tasks

\
L ‘ Bugs should be reported to http:/bugzilla.gnome.org.
‘ & Memos ‘

_More Information : z
== | ., Scanning folders in "IMAP server imap.gmail.com" (...) @ | - Reconnecting to IMAP server imap.gmail.com (...) Q

A\

To read a message, click the message in the upper window of the Inbox, and
the message text appears in the lower window. Figure 1-4 shows a welcome
e-mail message from the Evolution team.

To reply to the current message, click the Reply button on the toolbar. A
message composition window pops up. You can write your reply and then
click the Send button on the toolbar to send the reply. Simple, isn’t it?

To send a new e-mail, choose Newr=>Mail Message on the Evolution toolbar
or simply click the New icon. A new message composition window appears.
You can type your message in that window; when you're finished composing
the message, click the Send icon.

Evolution comes with extensive online help. Choose Help=>Contents from
the Evolution menu and your version of Evolution’s user’s guide appears in a
window. You can then read the user’s guide in that window.
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Introducing Thunderbird

Mozilla Thunderbird 3 is a redesign of Mozilla Mail, the mail and newsreader
that comes with the Mozilla Web browser — the open source successor

to Netscape Communicator. As this reader increases in popularity, more
and more distributions are including it and even making it the default pri-
mary reader. Thunderbird works well as a complement to the Firefox Web
browser and runs faster than Evolution and even Mozilla Mail. A bonus is
that it runs not only on Linux but also on a number of other operating sys-
tems, including Microsoft Windows and Mac OS X, making it a reader that
your organization can standardize on.

After installing Thunderbird, you can start it by choosing Applications=>
Debian Menu>Apps=>Net>Mozilla Thunderbird from the GNOME desktop in
Debian. When Thunderbird runs, it starts the Account Wizard (as shown in
Figure 1-5) and prompts you for information about your e-mail account.

Figure 1-5:

Enter your G Mail Account Setup
e-mail
_account_ Email address: | e
information e |
in Thunder- O Remember password

bird’s Cancel Continue
Account
Wizard.

Your pame: | First Last

The Account Wizard takes you through the following steps:

1. Enter your identity information — your name, your full e-mail
address, such as jdoe@someplace.com, and your e-mail password —
and click Next.

2. In most situations, Thunderbird will automatically locate information
about your ISP’s mail server — the protocol type (POP or IMAP) as
well as the incoming and outgoing server names. Click Next if they are
correct.

The incoming server is the POP or IMAP server, whereas the outgoing
server is the one through which you send mail out. If the information
Thunderbird automatically displays is not correct, choose Manual Setup
to enter the information yourself.

3. Verify all information. If it’s correct, click Create Account. Otherwise,
click Back and fix the errors.
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Figure 1-6:
You can
read and
send e-mail
messages
from
Thunderbird.

After you set up the e-mail account, Thunderbird’s main window appears
and displays the contents of your Inbox. Thunderbird downloads your
messages and displays them in a familiar format. To read a message, click
that message, and the full text appears in the lower window, as shown in
Figure 1-6.

e
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il Sent |
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subject Using Thunderbird for E-Mail! 05:16 PM
to glbrown@anderson.edu other actions v

<]

IMG_6915_5.jpg
EE [ | Unread: 0 Total: 1

Thunderbird’s intuitive to use. Most of the time, you can click the toolbar
buttons to do most anything you want with the e-mail messages. Here’s what
each toolbar button does:

4+ Get Mail: Downloads messages from your e-mail accounts. (You can set
up as many accounts as you want.)

+

Write: Opens a window where you can compose and send a message.

4 Address Book: Opens the Address Book window where you can main-
tain a list of your contacts.

4+ Tag: Assigns various tags to the selected e-mail message, such as
Important, Personal, and To-Do.

4+ Reply: Opens a window where you can send a reply to the person who
sent you the message you're reading now. You can also reply to all
recipients of the message.
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Forward: Displays the current message in a window so that you can for-
ward it to someone else.

Archive: Sends e-mail messages from the default folder to an archive
folder. To designate a location for archived messages to be sent, choose
Tools>Account Settings>Copies and Folders and select a location
under Keep Message Archives In.

Junk: Marks the selected messages as junk. (You can mark selected
messages as junk and choose Tools=>Junk Mail Controls to block similar
messages.)

Delete: Deletes the selected message.

If you use any GUI mail reader — from Microsoft Outlook Express to Novell
GroupWise — you find a similar set of toolbar buttons. In the following sec-
tions, I describe how to perform a few common e-mail-related tasks.

Managing your Inbox

Thunderbird downloads your incoming mail and stores it in the Inbox folder.
You can see the folders organized along the narrow window on the left side.
(Refer to Figure 1-6.) Each e-mail account you have set up has a set of fold-
ers. You have the following folders by default:

<+
<+

<+
+

Inbox: Holds all your incoming messages for this e-mail account.

Trash: Contains the messages you delete. (To empty the Trash folder,
choose File>)Empty Trash from the Thunderbird Mail menu.)

Outbox: Contains the messages that haven’t yet been sent to the mail
server.

Drafts: Contains the messages that you save as a draft. (Click the Save
button on the message composition window to save something as a draft.)

Sent: Holds all the messages you’ve successfully sent.

Spam: Contains any messages identified as spam.

You can create other folders to better organize your mail. To create a folder,
do the following:

1.

Right-click the Local Folder label on the left side of the Thunderbird
window and choose New Folder from the menu that appears.

The New Folder dialog box appears.

Fill in the folder name, select where you want to put the folder, and
click OK.

The new folder appears in the left window of Thunderbird. You can then
drag and drop messages into the folder.
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When you select a folder from the left window, Thunderbird displays the
contents of that folder in the upper window on the right side. The list is nor-
mally sorted by date, with the latest messages shown at the end of the list.
If you want to sort the list any other way — say, by sender or by subject —
simply click that column heading and Thunderbird sorts the list according
to that column.

Composing and sending messages

To send an e-mail message, you either write a new message or reply to a
message you're reading. The general steps for sending an e-mail message are
as follows:

1. To reply to a message, click the Reply or Reply All button on the
toolbar while you’re reading the message. To write a new message,
click the Write button on the toolbar. To forward a message, click the
Forward button.

A message composition window appears.

2. In the message composition window, fill in the subject line and type
your message.

The message can include images as well as links to Web sites. To insert
any of these items, choose Insert>Image or Inserte>Link from the menu.

3. If you're creating a new message or forwarding a message, type the
e-mail addresses of the recipients.

To select addressees from the Address Book, click the Address button
on the toolbar. Your Address Book opens, from which you can select the
addressees.

4. When you’ve finished composing the message, click the Send button.

If you want to complete a message later, click Save in the message composi-
tion window and then close the window. Thunderbird saves the message in
the Drafts folder. When you’re ready to work on that message again, go to
the Drafts folder and then double-click the saved message to open it.

Introducing KMail

KMail is a mail reader for KDE. When you first run KMail, you get its main
window (see Figure 1-7), but you can’t start using it to send and receive
e-mail until you’ve configured the mail accounts in KMail.
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To configure KMail, choose Settings=>Configure KMail. In the Configure
KMail window (see Figure 1-8), click Accounts on the left side of the window
and set up the information about your e-mail accounts. KMail uses this infor-
mation to send and receive mail.
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For outgoing mail, click the Add button on the Sending tab (see Figure 1-8)
and then select the mail transport agent. Typically, for an ISP-provided mail
account, you should select SMTP and enter the mail server’s name (for
example, smtp.comcast .net) that your ISP provided you.

To set up the incoming mail information, click Add on the Receiving tab and
select the mail protocol, such as POP3 or IMAP. Your ISP can tell you what
protocol to use. (Typically, it’s POP3 or IMAP.) Then enter the mail server’s
name (for example, mail.comcast.net) as well as the username and pass-
word of your ISP account.

After the e-mail account information is set up, you can start using KMail.
The user interface is intuitive and similar to other mail readers, such as
Thunderbird and Evolution. KMail periodically checks and downloads mes-
sages from your incoming mail accounts. You can view messages when they
arrive in your Inbox.

Instant Messaging in Linux

Two major IM clients are in Linux. In GNOME desktops, you can use Pidgin
(formerly known as Gaim), whereas Kopete is designed to work well on KDE
desktops. I briefly describe both IM clients in the following sections.

Using Pidgin

You can use Pidgin to keep in touch with all your contacts on many different
IM services, such as AIM, ICQ, Yahoo!, MSN, Gadu-Gadu, and Jabber. If you
use any of the IM services, you’ll be right at home with Pidgin.

In Fedora, start Pidgin by choosing Applications=>Internet=>Pidgin from the
GNOME desktop. You can start Pidgin in a similar manner from GNOME
desktops in other distributions.

Start by setting up your messaging accounts in the Accounts window. Click
the Add button and fill in the requested information in the Add Account
window. You have to select the protocol for your IM service. For example,
the protocol for AIM is AIM/ICQ. Other protocol choices include Gadu-Gadu,
Jabber, Yahoo!, and MSN.

After you enter account information, the Accounts window displays all cur-
rently defined accounts. You can then select an account from the Pidgin
main window and click Sign On.
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After Pidgin logs you in, it opens the standard Buddy List window. To add
buddies, choose Buddies=>Add Buddy. In the Add Buddy window that
appears, enter the screen name of the buddy and click Add. To create a new
group, choose Buddies=>Add Group. Type the name of the new group in the
Add Group window that appears, and then click Add.

If any of your buddies are online, their names show up in the Buddy List
window. To send a message to a buddy, double-click the name and a mes-
sage window pops up. If someone sends you a message, a message window
pops up with the message and you can begin conversing in that window.

Using Kopete
Kopete — the KDE IM client — enables you to connect to many messaging
services including AIM, IRC, MSN Messenger, Yahoo!, Gadu-Gadu, and SMS.

You can start Kopete by choosing Chat or Instant Messaging in the applica-
tions menu in Debian, SUSE, and Xandros.

When you first run Kopete, choose Settings=>Configure to get the Configure
Kopete window, where you can enter information about your IM and other
messaging service accounts.

For example, to add your AIM account information, click Add Account and
then answer and respond to the prompts from the Account Wizard. The first
step is to select your messaging service. Select the appropriate messaging
service, such as AIM if you use AOL’s instant messaging service. Then pro-
vide the AIM screen name and the password.

After you set up your messaging service accounts, the Account Wizard
closes and you get the regular Kopete window. To sign on with your messag-
ing services and begin using Kopete, choose File>Set Status=>Online.

Click the magnifying-glass icon to see your buddies. You see a solid smiley
face icon for buddies who are online. Right-click an online buddy and choose
Start Chat from the menu to start chatting. Choose Filec>Add Contact to add
more contacts.

Well, if you know AIM, you know what to do: Have fun IMing with Kopete!
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Chapter 2: Browsing the Web

In This Chapter

v+ Discovering the Web

1 Understanding a URL

+* Checking out Web servers and Web browsers
1~ Taking stock of Web browsers for Linux

+» Web browsing with Mozilla Firefox

suspect you already know about the Web or have been living under a

rock for a number of years. However, did you know that the Web (or
more formally, the World Wide Web) made the Internet what it is today?
The Internet’s been around for quite a while, but it didn’t reach the masses
until the Web came along in 1993.

Before the Web was created, you had to use arcane UNIX commands to
download and use files, which was simply too complicated for most of us.
With the Web, however, anyone can enjoy the benefits of the Internet by
using a Web browser — a graphical application that downloads and displays
Web documents. A click of the mouse is all you need to go from reading a
document from your company Web site to downloading a video clip from
across the country.

In this chapter, I briefly describe the Web and introduce Mozilla Firefox —
the primary Web browser (and, for that matter, mail and newsreader, too)
(MBER in most Linux distributions.

N
<
KDE desktops often use Konqueror as the Web browser, but after you've
used one Web browser, you can easily use any other Web browser.

Discovering the Web

If you've used a file server at work, you know the convenience of sharing
files. You can use the word processor on your desktop to get to any docu-
ment on the shared server.

Now imagine a word processor that enables you to open and view a docu-
ment that resides on any computer on the Internet. You can view the docu-
ment in its full glory, with formatted text and graphics. If the document
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Figure 2-1:
The Web is
like billions
of pages,
scattered
across the
network,
that you

can read
from your
computer by
using a Web
browser.

makes a reference to another document (possibly residing on yet another
computer), you can open that linked document simply by clicking the refer-
ence. That kind of easy access to distributed documents is essentially what
the Web provides.

Of course, the documents have to be in a standard format so that any com-
puter (with the appropriate Web browser software) can access and interpret
the document. And a standard protocol is necessary for transferring Web
documents from one system to another.

The standard Web document format is HyperText Markup Language (HTML),
and the standard protocol for exchanging Web documents is HyperText
Transfer Protocol (HTTP). HTML documents are text files and don’t depend
on any specific operating system, so they work on any system from Windows
and Mac to any type of UNIX and Linux.

A Web server is software that provides HTML documents to any client that
makes the appropriate HTTP requests. A Web browser is the client software
that actually downloads an HTML document from a Web server and displays
the contents graphically.

Like a giant spider’s web

The Web is the combination of the Web servers and the HTML documents
that the servers offer. When you look at the Web in this way, the Web is like
a giant book whose pages are scattered throughout the Internet. You use

a Web browser running on your computer to view the pages — the pages
are connected like a giant spider’s web, with the documents everywhere, as
illustrated in Figure 2-1.

oo

S
Bl

Web browser

Web pages



Figure 2-2:
The parts of
a Uniform
Resource
Locator
(URL).
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Imagine that the Web pages — HTML documents — are linked by network
connections that resemble a giant spider’s web, so you can see why the Web
is called the Web. The World Wide part comes from the fact that the Web
pages are scattered around the world.

Links and URLs

Like the pages of printed books, Web pages contain text and graphics. Unlike
printed books, however, Web pages can include multimedia, such as video
clips, sound, and links to other Web pages.

The links in a Web page are references to other Web pages that you can
follow to go from one page to another. The Web browser typically displays
these links as underlined text (in a different color) or as images. Each link
is like an instruction to you — something such as, “For more information,
please consult Chapter 4,” that you might find in a book. In a Web page, all
you have to do is click the link; the Web browser brings up the referenced
page, even though that document may actually reside on a far-away com-
puter somewhere on the Internet.

The links in a Web page are referred to as hypertext links because when you
click a link, the Web browser jumps to the Web page referenced by that link.

This arrangement brings up a question. In a printed book, you might ask the
reader to go to a specific chapter or page in the book. How does a hypertext
link indicate the location of the referenced Web page? In the Web, each Web
page has a special name, called a Uniform Resource Locator (URL). A URL
uniquely specifies the location of a file on a computer. Figure 2-2 shows the
parts of a URL.

Port
l HTML
Domain name Directory path Filename anchor
K-—k—\ —
| | [ ]
http://www.tldp.org:80/HOWTO/Wireless-HOWTO-2.html#ss2.1|

Protocol

As Figure 2-2 shows, a URL has the following parts:

4+ Protocol: Name of the protocol that the Web browser uses to access
the data from the file the URL specifies. In Figure 2-2, the protocol is
http://, which means that the URL specifies the location of a Web
page. Here are some of the common protocol types and their meanings:
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WING/

file:// means the URL points to a local file. You can use this URL
to view HTML files without having to connect to the Internet. For
example, file:///var/www/html/index.html opens the file /
var/www/html/index.html from your Linux system.

ftp:// means that you can download a file using the File Transfer
Protocol (FTP). For example, ftp://ftp.purdue.edu/pub/uns/
NASA/nasa.jpg refers to the image file nasa. jpg from the /pub/
uns/NASA directory of the FTP server ftp.purdue.edu. If you
want to access a specific user account via FTP, use a URL in the
following form:

ftp://username: password@ftp.somesite.com/
with username and password embedded in the URL.
The password is in plain text and not secure.

http:// means that you download the file using the HyperText
Transfer Protocol (HTTP). This protocol is the well-known format of
URLs for all Web sites, such as http://fedoraproject.org for
the Fedora Project’s home page. If the URL doesn’t have a filename,
the Web server sends a default HTML file named index.html.
(That’s the default filename for the popular UNIX-based Apache Web
servers; Microsoft Windows Web servers use a different default file-
name.)

https: // specifies that you access the file through a Secure
Sockets Layer (SSL) connection — a protocol designed by Netscape
Communications for encrypted data transfers across the Internet.
Typically, this form of URL is used when the Web browser sends
sensitive information (such as credit card number, username, and
password) to a Web server. For example, a URL such as

https://some.site.com/secure/takeorder.html

may display an HTML form that requests credit card information
and other personal information (such as name, address, and phone
number).

mailto: specifies an e-mail address that you can use to send an
e-mail message. This URL opens your e-mail program, from which you
can send the message. For example, mailto:webmaster@some
place.comrefers to the Webmaster at the host someplace.com.

news: // specifies a newsgroup that you can read by means of the
Network News Transfer Protocol (NNTP). For example:

news://news.md.comcast.giganews.com/comp.os.linux.
setup
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accesses the comp.os.linux.setup newsgroup at the news server
news.md.comcast.giganews.com. If you have a default news
server configured for the Web browser, you can omit the news serv-
er’s name and use the URL news : comp.os.linux.setup to access
the newsgroup.

4+ Domain name: Contains the fully qualified domain name of the com-
puter that has the file this URL specifies. You can also provide an IP
address in this field. The domain name is not case-sensitive.

4 Port: Port number that is used by the protocol listed in the first part
of the URL. This part of the URL is optional; all protocols have default
ports. The default port for HTTP, for example, is 80. If a site configures
the Web server to listen to a different port, the URL has to include the
port number.

4+ Directory path: Directory path of the file referred to in the URL. For Web
pages, this field is the directory path of the HTML file. The directory
path is case-sensitive.

4+ Filename: Name of the file. For Web pages, the filename typically ends
with .htmor .html. If you omit the filename, the Web server returns a
default file (often named index.html). The filename is case-sensitive.

4+ HTML anchor: Optional part of the URL that makes the Web browser
jump to a specific location in the file. If this part starts with a question
mark (?) instead of a pound sign(#), the browser takes the text following
the question mark to be a query. The Web server returns information
based on such queries.

Web servers and Web browsers

The Web server serves up the Web pages, and the Web browser downloads
them and displays them to the user. That’s pretty much the story with these
two cooperating software packages that make the Web work.

In a typical scenario, the user sits in front of a computer that’s connected to
the Internet and runs a Web browser. When the user clicks a link or types

a URL into the Web browser, the browser connects to the Web server and
requests a document from the server. The Web server sends the document
(usually in HTML format) and ends the connection. The Web browser inter-
prets and displays the HTML document with text, graphics, and multimedia
(if applicable). Figure 2-3 illustrates this typical scenario of a user browsing
the Web.
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Web server

== Web server sends back
the requested Web page

Internet
User
Web browser

Figure 2-3: HTTP

The Web

browser

requests

dogligwents Web browser connects to the

and the server and requests a \Web page

Web server

sends them.

User

The Web browser’s connection to the Web server ends after the server
sends the document. When the user browses through the downloaded docu-
ment and clicks another hypertext link, the Web browser again connects to
the Web server named in the hypertext link, downloads the document, ends
the connection, and displays the new document. That’s how the user can
move from one document to another with ease.

CMBER . P .

s“ A Web browser can do more than simply “talk” HTTP with the Web server;

Web browsers can also download documents and files using FTP, and many
have integrated mail and newsreaders as well.

Web Browsing in Linux

As Web pages become more interactive and complex, Web browsing turned
into a stimulating, engaging experience. Also, there’s always the element of
surprise: You can click a link and end up at unexpected Web pages. Links
are the most curious (and useful) aspect of the Web. You can start at a page
that shows today’s weather, and a click later, you can be reading this week’s
issue of Time magazine.
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To browse the Web, all you need is a Web browser and an Internet connec-
tion. I assume that you've already taken care of the Internet connection (see
Book IIl, Chapter 1 if you haven’t yet set up your Internet connection), so all
you need to know are the Web browsers in Linux.

Checking out Web browsers for Linux

Many Linux distributions come with the Mozilla Firefox Web browser.
Firefox is Mozilla’s improvement on their original browser, an open source
version of the venerable Netscape Communicator.

Several other Web browsers are available for Linux. [ briefly mention the
other browsers, but I focus on Firefox in the rest of the discussions. Here are
the major Web browsers for Linux:

4+ Mozilla Navigator: Mozilla’s first browser, a reincarnation of that old
workhorse Netscape Communicator — only better. Since 2005, however,
development of Navigator has stopped as Mozilla shifted focus to newer
Web applications such as Firefox and Thunderbird.

4+ Epiphany: The GNOME Web browser that uses parts of the Mozilla code
to draw the Web pages but has a simpler user interface than Mozilla.
If Epiphany isn’t installed, you can download it from www.projects.
gnome.org/epiphany.

4+ Firefox: Mozilla’s next-generation browser that blocks pop-up ads, pro-
vides tabs for easily viewing multiple Web pages in a single window, and
includes a set of privacy tools. You can download Firefox from www .
mozilla.com/firefox.

4+ Konqueror: The KDE Web browser that can also double as a file man-
ager and a universal viewer.

In addition to these, many other applications are capable of downloading
and displaying Web pages.

Nowadays most distributions include the Mozilla Firefox Web browser. I
briefly introduce the Firefox Web browser in the next section. All other Web
browsers have similarly intuitive user interfaces.

If your distribution doesn’t install Firefox by default, you can easily install
it by typing su - to become root and then typing apt-get install
mozilla-firefox.

Introducing Fivefox’s user interface

You can typically start Firefox by clicking an icon on the panel or by choos-
ing Firefox from the GUI desktop’s menu.
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Figure 2-4:
The Firefox
Web
browser in
action.

\\J

When Firefox starts, it displays a browser window with a default home page.
(The main Web page on a Web server is the home page.) You can configure
Firefox to use a different Web page as the default home page.

Figure 2-4 shows a Web page from a U.S. government Web site (www.irs.
gov), as well as the main elements of the Firefox browser window.
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Firefox supports tabbed browsing, which means that you can open a new tab
(by pressing Ctrl+T or clicking the plus sign to the right of the last open tab)
and view a Web page in that tab. That way, you can view multiple Web pages
in a single window.

The Firefox Web browser includes lots of features in its user interface, but
you can master it easily. You can start with just the basics to get going with
Firefox and then gradually expand to areas that you haven’t yet explored.

Firefox toolbars

Starting from the top of the window, you see a menu bar with the stan-
dard menus (File, Edit, and so forth) followed by the two toolbars — first
the Navigation toolbar and then the Bookmarks toolbar. The area below
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the Bookmarks toolbar is where any open tabs and the current Web page
appears.

Here’s what you can do with the buttons and text boxes on the Navigation
toolbar, from left to right:

4+ Back: Move to the previous Web page.
Forward: Move to the page from which you have gone backward.
Recent Pages: Open a drop-down list of recently visited Web pages.
Reload: Reload the current Web page.
Stop: Stop loading the current page.

Home: Go to the home page.

+ 4+ e

Location: Show the URL of the current Web page. (Type a URL in this
box and press Enter to view that Web page.)

<+

Bookmark: Bookmark the page you are currently viewing. (Click the star
icon at the end of the location bar.)

4+ Google Search: Search various Web sites such as Google, Yahoo!,
Amazon.com, Dictionary.com, and eBay. (Type text and press Enter to
search the currently selected Web site; the default is Google.)

Immediately below the Navigation toolbar comes the Bookmarks toolbar
with buttons that take you to specific Web pages.

Status bar

You can think of the bar along the bottom edge of the Firefox window as the
status bar because the middle part of that area displays status information
while Firefox loads a Web page.

In the right corner of Firefox’s status bar, a security padlock icon appears
when you access a secure Web site. Firefox supports a secure version of
HTTP that uses SSL to transfer encrypted data between the browser and the
Web server. When Firefox connects to a Web server that supports secure
HTTP, a locked security padlock icon appears on the right edge of the status
bar. Otherwise there’s no security padlock icon, signifying an insecure con-
nection. The URL for secure HTTP transfers begins with https: // instead
of the usual http:// (note the extra s in https). You can click the padlock
icon for more security information about the page.

Firefox displays status messages in the left part of the status bar. You can
watch the messages in this area to see what’s going on. If you mouse over a
link on the Web page, the status bar displays the URL for that link.
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Firefox menus

[ haven’t mentioned the Firefox menus much. That’s because you can usu-
ally get by without having to go to them. Nevertheless, taking a quick look
through the Firefox menus is worthwhile so you know what each one offers.
Table 2-1 gives you an overview of the Firefox menus.

Table 2-1 Firefox Menus
Menu Enables You to Do the Following
File Open a file or Web location, open or close a tab, send a Web

page or link by e-mail, edit a Web page, print the current page,
import settings and data, and quit Firefox.

Edit Copy and paste selections, find text in the current page, and edit
your preferences.

View Show or hide various toolbars, reload the current page, make
the text larger or smaller, and view the HTML code for the page.

History Go backward and forward in the list of pages you've visited, or
jump to other recently visited Web pages.

Bookmarks Bookmark a page, organize the bookmarks, and add links to the
Bookmarks toolbar folder. (These links appear in the Bookmarks
toolbar.)

Tools Search the Web and manage various aspects of the Web page,

such as themes; view information about the current page; and
clear browsing history

Help Get online help on Firefox.

Changing your home page

Your home page is the page that Firefox loads when you start it. The default
home page depends on the distribution. Often the home page is a file from
your system’s hard drive. Changing the home page is easy.

First, locate the page on the Web that you want to be the home page. You
can get to that page any way you want. You can search with a search engine
to find the page you want, you can type in the URL in the Location text box,
or you may even accidentally end up on a page that you want to make your
home page. It doesn’t matter.

When you’re viewing the Web page that you want to make your home page
in Firefox, choose Edit=>Preferences from the Firefox menu. The Preferences
dialog box appears, as shown in Figure 2-5.
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In Figure 2-5, notice the Home Page text box. Below the text box is a Use
Current Page button. Click that button to make the current page your home
page. If you select this option while multiple tabs are open, the browser will
open each tab with every new session.

QQ,N\BEB You can set a lot of other options using the Preferences dialog box. Although
& [ don’t explain all the options here, you can click around to explore every-
thing that you can do from this window. For example, you can click the Use
Bookmark button to select a saved URL bookmark as the home page. (You
have to select the bookmark from a dialog box.)

Surfing the Net with Firefox Book IV
Where you go from the home page depends on you. All you have to do is IS
click and see where you end up. Move your mouse around. You know when ®
you'’re on a link because the mouse pointer changes to a hand with an 3
extended index finger. Click the link, and Firefox downloads the Web page 5
referenced by that link. g

==
How you use the Web depends on what you want to do. When you first get %
started, you may explore a lot — browsing through Web sites and following o

links without any specific goal in mind (what you may call Web window-
shopping).
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The other, more purposeful, use of the Web is to find specific information
from the Net. For example, you might want to locate all the Web sites that
contain documents with a specified keyword. For such searches, you can
use one of many Web search tools available on the Net. Firefox’s Search text-
box takes you to the Google Web Search page (www.google.com).

A third type of use is a visit to a specific site with a known URL. For example,
when reading about a particular topic in this book, you may come across a
specific URL. In that case, you want to go directly to that Web page.

If you want to surf the Net with Firefox, all you need is a starting Web page —
then you can click whatever catches your fancy. For example, select the text
in the Location text box in Firefox’s Navigation toolbar, type www.yahoo.
com, and then press Enter. You get to the Yahoo! home page that shows the
Yahoo! Web directory — organized by subject. There’s your starting point.
All you have to do is click and you’re on your way.



Chapter 3: Reading Newsgroups
and RSS Feeds

In This Chapter

v+~ Finding out about newsgroups

+ Reading a newsgroup from your ISP
+ Reading and searching newsgroups

+* Reading an RSS feed

Newsgroups provide a distributed conferencing system that spans
the globe. You can post articles — essentially e-mail messages to an

entire group of people — and respond to articles others have posted.

Think of an Internet newsgroup as a gathering place — a virtual meeting
place where you can ask questions and discuss various issues. (And best of
all, everything you discuss is archived for posterity.) Internet newsgroups
are similar to the bulletin board systems (BBSs) of the pre-Web age or the
forums offered on online systems such as AOL and MSN.

To participate in newsgroups, you need access to a news server — your
Internet service provider (ISP) can give you this access. You also need a
newsreader. Luckily, Linux comes with software that you can use to read
newsgroups. In this chapter, | introduce you to newsgroups and show you
how to read newsgroups with a few of the newsreaders. I also briefly explain
how you can read and search newsgroups for free from a few Web sites.

Nowadays another popular way to read summaries of Web sites and
weblogs is to use a program that can accept RSS feeds. At the end of this
chapter, I briefly describe what an RSS feed is and how you can use a pro-
gram such as KDE Akregator to subscribe to RSS feeds and read them on
your Linux system.

Understanding Newsgroups

Newsgroups originated in Usenet — a store-and-forward messaging net-
work that was widely used for exchanging e-mail and news items. Usenet
works like a telegraph in that news and mail are relayed from one system to



262 Understanding Newsgroups

another. In Usenet, the systems aren’t on any network; the systems simply
dial up one another and use the UNIX-to-UNIX Copy Protocol (UUCP) to
transfer text messages.

Although it’s a loosely connected collection of computers, Usenet works well
and continues to be used because little expense is involved in connecting

to it. All you need is a modem and a site willing to store and forward your
mail and news. You have to set up UUCP on your system, but you don’t need
a sustained network connection; just a few phone calls are all you need to
keep the e-mail and news flowing. The downside of Usenet is that you can’t
use TCP/IP services such as the Web, TELNET, or FTP with UUCP.

From their Usenet origins, newsgroups have now migrated to the Internet
(even though the newsgroups are still called Usenet newsgroups). Instead of
UUCP, the Network News Transfer Protocol (NNTP) now transports the news.

Although (for most of the online world) the news transport protocol has
changed from UUCP to NNTP, the store-and-forward concept of news trans-
fer remains. Thus, if you want to get news on your Linux system, you have to
find a news server from which your system can download news. Typically,
you can use your ISP’s news server.

Newsgroup hierarchy

The Internet newsgroups are organized in a hierarchy for ease of mainte-
nance as well as ease of use. The newsgroup names help keep things straight
by displaying this hierarchy.

Admittedly, these newsgroup names are written in Internet-speak, which can
seem obscure at first. But the language is easy to pick up after a little bit of
explanation. For example, a typical newsgroup name looks like this:

comp.os.linux.announce

This is a newsgroup for announcements (announce) about the Linux operat-
ing system (os. linux), and these subjects fall under the broad category

of computers (comp). As you can see, the format of a newsgroup name is a
sequence of words separated by periods. These words denote the hierarchy
of the newsgroup. Figure 3-1 illustrates the concept of the hierarchical orga-
nization of newsgroups.

To understand the newsgroup hierarchy, compare the newsgroup name with
the pathname of a file (for example, /usr/1ib/X11/xinit/Xclients)

in Linux. Just as a file’s pathname shows the directory hierarchy of the file,
the newsgroup name shows the newsgroup hierarchy. In filenames, a slash
(/) separates the names of directories; in a newsgroup’s name, a period (.)
separates the different levels in the newsgroup hierarchy.
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In a newsgroup name, the first word represents the newsgroup category. The
comp.os.linux.announce newsgroup, as mentioned, is in the comp cat-
egory, whereas alt .books.technical is in the alt category.

Top-level newsgroup categories

Table 3-1 lists some of the major newsgroup categories. You find a wide vari-
ety of newsgroups covering subjects ranging from politics to computers. The
Linux-related newsgroups are in the comp . os.1inux hierarchy.

Table 3-1 Some Major Newsgroup Categories

Category Subject

alt Alternative newsgroups (not subject to any rules), ranging from the
mundane to the bizarre

bionet Biology newsgroups

bit Bitnet newsgroups

biz Business newsgroups

clari Clarinet news service (daily news)

comp Computer hardware and software newsgroups (includes operating

systems such as Linux and Microsoft Windows)

ieee Newsgroups for the Institute of Electrical and Electronics
Engineers (IEEE)

(continued)
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Table 3-1 (continued)
Category Subject

k12 Newsgroups devoted to elementary and secondary education
linux Newsgroups devoted to Linux (includes a 1inux.redhat hierarchy)
misc Miscellaneous newsgroups

news Newsgroups about Internet news administration

rec Recreational and art newsgroups

sci Science and engineering newsgroups

soc Newsgroups for discussing social issues and various cultures
talk Discussions of current issues (think talk radio)

This short list of categories is deceptive because it doesn’t tell you about the
wide-ranging variety of newsgroups available in each category. The top-level
categories alone number more than a thousand, but many top-level catego-
ries are distributed only in specific regions of the world. Because each news-
group category contains several levels of subcategories, the overall count of
newsgroups is close to 100,000! The comp category alone has close to 1,200
newsgroups.

Unfortunately, many newsgroups are flooded with spam, like your e-mail
Inbox only worse because anyone can post anything on a newsgroup.
Moderated newsgroups offer some relief. Anyone who wants to post on

a moderated newsgroup must first submit the article to a moderator — a
human being — who then decides whether to post or reject the article. You
can reduce the spam overload by browsing moderated newsgroups when-
ever possible.

To browse newsgroup categories and get a feel for the breadth of topics
covered by the newsgroups, visit the Google Groups Web site at http://
groups.google.com and click the Browse All of Usenet link. (You will need
to click the Browse Group Categories link on the first page.)

Linux-related newsgroups

Typically, you have to narrow your choice of newsgroups according to
your interests. If you want to know more about Linux, for example, you can
choose one or more of these newsgroups:

4 comp.os.linux.admin: Linux system administration (inactive).

4 comp.os.linux.advocacy: Linux promotion.
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comp.os.linux.announce: Important announcements about Linux.
This newsgroup is moderated, which means you must mail the article to
a moderator, who then posts it to the newsgroup if the article is appro-
priate for the newsgroup.

comp.os.linux.answers: Questions and answers about Linux. All the
Linux HOWTOs are posted in this moderated newsgroup.

comp.os.linux.development: Current Linux development work.
comp.os.linux.development.apps: Linux application development.

comp.os.linux.development.system: Linux operating system
development.

comp.os.linux.embedded: Running the Linux operating system on
embedded hardware.

comp.os.linux.hardware: Linux and various types of hardware.
comp.os.linux.help: Help with various aspects of Linux (inactive).
comp.os.linux.misc: Miscellaneous Linux-related topics.
comp.os.linux.networking: Networking under Linux.

comp.os.linux.portable: Running the Linux operating system on
laptop computers and portable PCs.

comp.os.linux.powerpc: Running the Linux operating system on
PowerPC microprocessors.

comp.os.linux.redhat: Red Hat Linux-related topics (inactive).
comp.os.linux.setup: Linux setup and installation.

comp.os.linux.x: Setting up and running the X Window System under
Linux.

comp.os. linux.xbox: Running Linux on the Xbox video game console.

linux.debian: Moderated newsgroup about Debian GNU/Linux
(inactive).

linux.debian.news: Moderated newsgroup for news items about
Debian GNU/Linux.

linux.redhat: Red Hat Linux discussions.

You have to be selective about what newsgroups you read because keep-
ing up with all the news is impossible, even in a specific area such as Linux.
When you first install and set up Linux, you might read newsgroups such as
comp.os.linux.answers, comp.os.linux.setup, comp.os.linux.
hardware, and comp . os . linux.x (especially if you have problems with
X). After you have Linux up and running, you may want to find out about
only new things happening in Linux. For such information, read the comp.

Oos.

linux.announce newsgroup.
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Although a number of newsgroups are currently inactive and not being
added to, these groups can still be referenced and searched for help with
specific questions.

Reading Newsgroups from Your ISP

“NG’
$

WMBER
@ﬁ
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If you sign up with an ISP for Internet access, it can provide you with access
to a news server. Such Internet news servers communicate by using the
Network News Transfer Protocol (NNTP). You can use an NNTP-capable
newsreader, such as KNode, to access the news server and read selected
newsgroups. You can also read news by using Thunderbird. Using a news-
reader is the easiest way to access news from your ISP’s news server.

My discussion of reading newsgroups assumes that you obtained access to a
news server from your ISP. The ISP provides you with the name of the news
server and any username and password needed to set up your news account
on the newsreader you use.

To read news, you need a newsreader — a program that enables you to
select a newsgroup and view the items in that newsgroup. You also have
to understand the newsgroup hierarchy and naming conventions (which I
describe in the “Newsgroup hierarchy” section, earlier in this chapter). In
this section, I show you how to read news from a news server.

If you don’t have access to newsgroups through your ISP, you can try using
one of the many public news servers that are out there. For a list of public
news servers, visit Newzbot at www . newzbot . com. At this Web site, you can
search for news servers that carry specific newsgroups.

Taking stock of newsreaders

You can use one of several software packages to download and read news-
groups in Linux. Here are a few major newsreaders:

4+ Thunderbird: Thunderbird includes the ability to download news from
an NNTP server. You can read newsgroups and post items to news-
groups. Xandros uses Thunderbird for mail and news.

4+ KNode: This is a newsreader for KDE that you can download from
knode.sourceforge.net. Debian and SUSE provide KNode as the
newsreader.

4+ Pan: Pan is a GUI newsreader that, according to the developer’s Web
site (http://pan.rebelbase.com), “attempts to be pleasing to both
new and experienced users.” You can download Pan for various Linux
distributions from http://pan.rebelbase.com/download.
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If you don’t find a newsreader in your Linux system, you can download and
install any of these newsreaders easily in any of the Linux distributions.
Often, you can locate the download site by a simple search at a search
engine — just search for the word download followed by the name of the
newsreader.

Reading newsgroups with Thunderbird

You can browse newsgroups and post articles from Thunderbird, a mail and
newsreader from the Mozilla project.

In many Linux distributions, the mail and news component of Thunderbird
may not be installed. In that case, you have to download and install the
Thunderbird mail and news component or use another newsreader. To
download Thunderbird, visit www.mozillamessaging.com/thunderbird/.

When you're starting to read newsgroups with Thunderbird for the first
time, follow these steps to set up the news account:
1. Choose Edit=>Account Settings from the Thunderbird menu.
A dialog box appears.
2. Select the Account Actions option and then click Add Other Account.

The Account Wizard appears, as shown in Figure 3-2.

& Wizard [z
New Account SEtup

In order to receive messages, you first need to set up a Mail or
Newsgroup account.

This Wizard will collect the information necessary to set up a
Mail or Newsgroup account. If you do not know the information
requested, please contact your System Administrator or
Internet Service Provider.

Select the type of account you would like to set up:

C Blogs & News Feeds

O Unix Mailspool (Movemail)

®|Newsgroup account

|0Cancel| ‘ B Next ‘
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3. Select the Newsgroup Account option and click Next.

4. In the new screen that appears, fill in your identity information —
name and e-mail address. Then click Next to move to the next screen.

5. Enter your news server name and click Next.
0. Enter a descriptive name of the newsgroup account and click Next.

7. Click Finish to complete the newsgroup account setup.

The new newsgroup account now appears in the list of accounts on the left
side of the Thunderbird window. Click the newsgroup account name, and
the right side of the window displays the options for the newsgroup account.

Click the Manage Newsgroup Subscriptions option. Thunderbird starts to
download the list of newsgroups from the news server. Don’t be surprised if
this process takes considerable time — the number of newsgroups is vast,
and the speed of your connection can slow the downloading of the list to a
point where you begin to get frustrated.

If your ISP’s news server requires a username and password, you're
prompted for that information. After that, Thunderbird downloads the list of
newsgroups and displays them in the Subscribe dialog box. (You can enter a
search string in a text box to narrow the list.) When you find the newsgroups
you want, click the check box to the right of their names and then click the
Subscribe button to subscribe to these newsgroups, as shown in Figure 3-3.
Then click OK to close the dialog box.

Account: | news = |

Show items that contain: [ linux f’]

Current Group List | New Groups

Select the newsgroups to subscribe to:
E3comp.os linux.advocacy
E4comp.os linux.alpha
EFcomp.os.linux.announce
Hcomp.os linux.development
E3comp.os linux.development.apps
E4comp.os.linux.development .system
E4comp.os linux.embedded

| 3>

| ubscr\be|
= | nsuhscrlhe|

| Refresh |

EHcomp.os linux.help

3 comp.os linux.mé8k
E4comp.os linux.misc
EFcomp.os.linux.networking

OoooRIOOO0FOR

<]

‘.Qcancel.‘
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After you subscribe to newsgroups, these newsgroups appear under the
newsgroup account name on the left side of the Thunderbird window. You
can then read a newsgroup using these steps:

1. Click a newsgroup name (for example, comp . os . linux.announce).

2.

If prompted, enter your username and password.

Some news servers require a username and password.

3.

load and click Download to proceed.

Specify the number of headers (for example, 500) you want to down-

Thunderbird downloads the headers from the newsgroup and displays a
list in the upper-right area of the window.

Figure 3-4.

From the list of headers, click an item to read that article, as shown in

B (=) (=)

File Edit View Go Message Tools Help

& G @ @ g

[ Get Mail v | Write @Address Book | '\ )Tagv @ ]

[P comp.os.linux.announce - ... | &
Smart Folders <4 > | @ | Subject “ | From Date =
EInbox (4) <+ MPlayerXP-0.7.95 has been released < Nickols_K 01/26/2010 12:0... |~
[El prafts < PLT Scheme v4.2.4 < Eli Barzilay 01/28/2010 O

b @ sent (3) <+ [SLUG] Suncoast LUG Meetings @ Paul M Foster,, 01/31/2010
(& all mail (a) <~ WWWOFFLE - Web proxy with featu... ¢ Andrew M. Bishop 01/31/2010 02:
( spam (8) * ©

b FTrash < libfishsound 1.0.0 Release < Conrad Parker 02/03/2010 08:4...
[E5Outbox <+ [SLUG] Suncoast LUG Meetings < Paul M Foster,, 02/07/2010 10:0...

b = Local Folders <+ [ADMIN] comp.os.linux.announce re... ¢ cola-admin@stump.alge... 02/08/2010 01:

b [~Igrahamle...mail.com “- ANNOUNCE: web2ldap release 1.1.0a... ¢ Michael Stroder 02/13/2010 06:5...

= & news

To select other subscribed newsgroups, simply click the newsgroup’s name
in the left side of the window.

Newsgroup subscriptions

Unlike magazines or newspapers, newsgroups don’t require that you sub-
scribe to them; you can read any available newsgroup on the news server.
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The news server’s administrator may decide to exclude certain newsgroups,
however; if they aren’t included, you can’t read them.

The only thing that can be called subscribing is indicating the newsgroups
you routinely want to read. The news server doesn’t receive any of this sub-
scription information — the information is used only by the newsreader to
determine what to download from the news server.

Posting new's

You can use any newsreader to post a news article (a new item or a reply
to an old posting) to one or more newsgroups. The command for posting

a news item depends on the newsreader. For example, in the Thunderbird
newsreader, you follow these steps to post an article:

1. Click the Reply button on the toolbar to post a follow-up to a news
item you’re reading. To post a new news article, click the Write
button.

A window appears where you can compose the message.

2. Type the names of the newsgroups, just as you’d type the addresses of
recipients when sending e-mail. Enter the subject and your message.

For this test posting, type ignore as the subject line and enter misc.
test as the name of the newsgroup. Otherwise, any site that receives
your article replies by mail to tell you the article has reached the site;
that’s in keeping with the purpose of the misc. test newsgroup.

3. After you finish composing the message, click Send on the toolbar.

Thunderbird sends the message to the news server, which in turn sends
it to other news servers, and soon it’s all over the world!

4. To verify that the test message reaches the newsgroup, choose
Filez>Subscribe. Then subscribe to misc.test newsgroup (that’s
where you recently posted the new article).

To subscribe, click the check box to the right of the group name and
then click the Subscribe button.

5. Look at the latest article or one of the most recent ones in misc.test
to find the article you recently posted.

If you post an article and read the newsgroup immediately, you see the new
article, but that doesn’t mean the article has reached other sites on the
Internet. After all, your posting shows up on your news server immediately
because that’s where you posted the article. Because of the store-and-for-
ward model of news distribution, the news article gradually propagates from
your news server to others around the world.
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The misc.test newsgroup provides a way to see whether your news post-
ing is getting around. If you post to that newsgroup and don’t include the
word ignore in the subject, news servers acknowledge receipt of the article
by sending an e-mail message to the address listed in the Reply To field of
the article’s header.

Using KNode

Debian and SUSE provide KNode as the default newsreader. Typically,

you can start KNode by selecting Newsreader from the menu (look in the
Internet applications); or choose Applications=Internet>KNode. If you don’t
see a choice for Newsreader or KNode in the menus, type knode in a termi-
nal window to start KNode.

When KNode runs for the first time, it displays the Configure KNode dialog
box, as shown in Figure 3-5, through which you can configure everything you
need to read newsgroups and post items to newsgroups.

= Configure - KNode T o o &

Personal Information
EEC R Name: Graham Brown

g_’_ QOrganization:
Accounts
Email address: [qlbruwn@luca\hust.Iuca\dumam ]

= J Reply-to address:
Appearance

’% Mail-copies-to:
=
Reading News

Signing key: a Change...

__ Use a signature from file

Signature file: Choose

Posting News
< __J The file is a program

Edit File

Signing/Verifying .+, Specify signature below

~

Cleanup

F Help 7 Defaults « OK o Apply @ Cancel

The left side of the dialog box displays all the items that you can configure,
and the right side is where you enter the information for the item that you've
selected on the left.

When the Configure KNode dialog box first opens, it prompts for your per-
sonal information. Enter your identification information, such as name,
e-mail address, and organization — this information is used when you post a
new item to a newsgroup.
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Figure 3-6:
Enter
information
about the
news server
in this dialog
box.

Then, click Accounts on the left side (refer to Figure 3-5) and then click the
Newsgroup Servers tab on the right side to set up information about the
news server from which you’ll be reading news. Click Add in the Newsgroup
Servers tab to display the dialog box shown in Figure 3-6, where you can
enter the information about the news server. Your ISP should have provided
you with the information needed to access the news server. If the news
server requires a login name and a password, you must enter that informa-
tion as well.

E & New Account - KNode &y

Server |dentity Cleanup

Name: News
Server: [netnews insightbb.com| |
Port: 119 )

| Fetch group descriptions

Server reguires authentication

User

Encryption

+ None
. SSL
U TLS

| Enable interval news checking

Check interval:

F Help W OK @ cancel

After you set up the news account, the KNode window shows the name

of the news server on the left. Right-click the server’s name and choose
Subscribe to Newsgroups from the pop-up menu. A dialog box appears
where you can subscribe to selected newsgroups (such as comp.
os.linux.announce). The first time you access this menu, the list of news-
groups must be fetched. The KNode user interface is similar to many other
mail and newsreaders, including Thunderbird.

Reading and Searching Newsgroups at Web Sites

If you don’t have access to newsgroups through your ISP, you can still read
newsgroups and post articles to newsgroups at a number of Web sites. Some
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of them archive old news articles and provide good search capabilities, so you
can search these sites for articles related to some question you may have.

The best parts about reading newsgroups through a Web site is that you
don’t even need access to a news server and you can read news from your
Web browser.

Table 3-2 lists Web sites that offer free access to Usenet newsgroups. To get
a list of all Web sites that offer newsgroup access (including the ones that
charge a fee), use Google (www.google.com) and type the search words
usenet newsgroup access.

Table 3-2 Web Sites with Free Access to Usenet Newsgroups
Web Site URL

Google Groups http://groups.google.com
mail2web http://usenet.mail2web.com
InterBulletin http://news.interbulletin.com
Usenet Replayer www .usenet-replayer.com

One of the best places to read newsgroups, post articles, and search old
newsgroup archives is Google Groups (Google’s Usenet discussion forums)
on the Web at http://groups.google.com. At that Web site, you can
select a newsgroup to browse and post replies to articles posted on various
newsgroups.

The best part of Google Groups is the search capability. You already know
how good Google’s Web search is; you get that same comprehensive search
capability to locate newsgroup postings that relate to your search words. To
search newsgroups, fill in the search form at http://groups.google.com
and press Enter.

To browse newsgroups in Google Groups, ignore the search box and look

at the list of high-level newsgroup categories such as alt, comp, and soc.
Click the category, and you can gradually drill down to specific newsgroups.
When viewing an article in Google Groups, you can click a link that enables
you to post a follow-up to that article.

Reading RSS Feeds

RSS stands for Really Simple Syndication. RSS is a format for syndicating —
gathering and making available — the content of Web sites, primarily news-
oriented sites and blogs. The term blog is short for weblog — a frequently
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updated journal with thoughts, comments, and opinions of the blog’s cre-
ator. RSS can be used to provide any kind of information that can be broken
down into discrete items and put into RSS format. Such RSS-formatted con-
tent is an RSS feed, and an RSS-aware program can check the feed periodi-
cally for changes, download new items, and make them available to the user.

The RSS format is a dialect of XML (eXtensible Markup Language). All RSS
files conform to XML 1.0 specification.

Many versions of RSS are available, but three versions — 0.91, 1.0, and 2.0 —
are in widespread use. Netscape designed RSS version 0.90 for gathering

and displaying headlines from news sites. A simpler version, (.91, was pro-
posed, and UserLand Software picked up that version for use in its blogging
product. At the same time, another noncommercial group had evolved RSS
0.90 into RSS 1.0, which is based on resource description format, or RDF (see
www.w3 .org/rdf). UserLand didn’t accept RSS 1.0 but instead continued
evolving RSS 0.91 through versions 0.92, 0.93, and 0.94 and finally settled

on RSS 2.0 (skipping 1.0 because that version number was already taken).
Currently, many blogs and Web sites use RSS 0.91 for basic syndication
(title, URL, and description), RSS 1.0 for readers that use RDF, and RSS 2.0 for
advanced syndication with more metadata. (Think of metadata as data about
data, which is what the RSS format provides: It provides data about other
information, such as blogs and news.) RSS 1.0 files have an .rdf extension,
whereas RSS 0.91 and 2.0 files have an .xml extension. However, all RSS files
are text files that use XML tags.

Examining an RSS Feed

An RSS feed is a text file with XML tags that describe a Web site’s content.
You typically use an automated program to periodically generate the RSS
feed file, but you can prepare the RSS feed file using a text editor. It’s good
to know what an RSS feed looks like, just so you can debug problems with
the feed.

The specific details of an RSS feed depend on the version of RSS. The sim-
plest feed is RSS 0.91, and here’s a typical RSS 0.91 feed:

<?xml version="1.0" ?>
<!-- A comment line --->
<rss version="0.91">

<channel> <!--- This tag specifies general information about
the feed--->

<title>Title of this feed</title>

<1ink>URL of this feed, for example, http://edulaney.typepad.
com/</1link>
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<description>Brief description of feed</description>
<language>en-us</language>

<item>

<title>Title of this item</title>

<1ink>URL for this item</link>
<description>Description of this item</description>
</item>

. . more items .

</channel>

</rss>

As you can see from that listing, an RSS feed includes a channel with a title,
link, description, and language followed by a series of items, each of which
has a title, link, and description.

The format is more verbose for RSS 1.0, which uses the RDF format. RSS 1.0
essentially provides the basic information that’s in RSS 0.91 and adds more
details such as item-level authors, subject, and publishing dates, which RSS
0.91 doesn’t support.

Reading RSS Feeds

Many GUI programs are available for subscribing to RSS feeds and reading
items from a feed. These programs are RSS aggregators because they can
gather information from many RSS feeds and make everything available in a
single place.

The two types of RSS aggregators are Web browser plug-ins and standalone
programs. Browser plug-ins, such as NewsMonster (www . newsmonster.
org), run in a Web browser so that the feeds appear in the Web browser.
Standalone programs such as GNOME Straw (http://projects.gnome.
org/straw) and KDE Akregator (http://akregator.kde.org) are com-
plete GUI applications and usually look similar to other mail and newsreader
programs.

Fedora and SUSE come equipped with the Akregator program, a standalone
RSS feed aggregator. To run it, look for a link in the GUI desktop’s applica-
tions menu (choose Application=>Internet~>Akregator). If you don’t see
Akregator listed, type akregator in a terminal window. In Debian, you can
install Akregator by typing apt-get install akregator (after typing su -
to become root).

When Akregator first runs, it displays its main window without any RSS
feeds. To subscribe to a feed, choose Feed=>Add Feed from the menu or
right-click All Feeds in the left pane of the window (see Figure 3-7) and select
Add Feed from the pop-up menu. Then type the URL for the feed in the Add
Feed dialog box and click OK. For example, to read Slashdot’s RSS feed, type

Spaaj §SY pue
sdnoifsmap
fuipeay



276 Reading RSS Feeds

Figure 3-7:
You can
organize
and read
RSS feeds in
Akregator.

http://slashdot.org/index.rss. The feed’s title appears in the left
pane of the window. Click the feed title to view the items in this feed. Then
you can click an item in the upper-right pane, and that item appears in the
lower-right pane, as shown in Figure 3-7. You can add many different RSS
feeds, organize them into folders, and browse them in Akregator.
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Search: Status: | All Articles v
Title ~ Feed Author Date

Mass. Data... Slashdot timothy Today 02:27 pm

[IEEE Introd... Slashdot — timothy — Yesterday 08:03pm |
How To Get... Slashdot timothy 04/25/10 04:36 pm

Don't Talk T... Slashdot Soulskill Today 09:13 am

Bridging th... Slashdot timothy Today 02:14 am

Best Altem... Slashdot timothy 04/25/10 06:43 pm

20 Years of ... Slashdot timothy 04/25/10 05:35 pm

IEEE Introduces Mario Level-Generation Competition

Date: Yesterday 08:03 pm
Author: timothy

bgweber writes "Last year, the IEEE conference on Computational Intelligence
and Games hosted a competition to determine who could write the best Al for

playing Mario levels (YouTube video). This year, the conference has expanded ||

the competition to include a track on level generation as well, where the goal is
to generate new levels online procedurally. Submitting an entry is as easy as
implementing a Java interface that performs procedural content generation. The
implications of this competition are techniques for greatly increasing the
replayability of games, since each gameplay session could present new levels to
the player.”

Read more of this story at Slashdot.
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Chapter 4: Using FTP

In This Chapter
v+~ Using the GNOME FTP client

1 Using any Web browser as an FTP client

v Getting to know the FTP commands

ust as the name implies, File Transfer Protocol (FTP) is used to transfer

files between computers. For example, if your Internet service provider
(ISP) gives you space for a personal Web site, you may have already used
FTP to upload the files making up the Web site. Using an FTP client on your
computer, you log in to your ISP account, provide your password, and then
copy the files from your home system to the ISP’s server.

You can also use FTP to download other files anonymously, such as open
source software from other computers on the Internet — in which case,

you don’t need an account on the remote system to download files. You can
simply log in using anonymous as the username and provide your e-mail
address as the password. (In fact, your Web browser can do this on your
behalf, so you may not even know this process is happening.) This type of
anonymous FTP is great for distributing files to anyone who wants them. For
example, a hardware vendor might use anonymous FTP to provide updated
device drivers to anyone who needs them.

Linux comes with several FTP clients, both command-line ones and GUI
(graphical user interface) ones. This chapter introduces you to a few GUI
FTP clients and a command-line FTP client. It also describes the commands

@ you use to work with remote directories.
‘

Based upon your distribution, and version, you may need to install the FTP
clients discussed in this chapter.

Using Graphical FTP Clients

You can use one of the following GUI FTP clients in Linux:

4+ gFTP: A graphical FTP client for GNOME at (http://gftp.seul.org)

4+ KFTPGrabber: A graphical FTP client for KDE (K Desktop Environment)
atwww.kftp.org

4+ Web browser: A browser such as Firefox, for anonymous FTP downloads
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For uploading files, you may want to use gFTP because you typically have to
provide a username and password for such transfers. Web browsers work
fine for anonymous downloads, which is how you typically download soft-

ware from the Internet.

All three GUI FTP clients are discussed in the next three sections.

Using gFTP

GNOME comes with gFTP, a graphical FTP client. gFTP isn’t installed by
default, but you can download it from http://gftp.seul.org and install
it easily. In some distributions, gFTP may be included in a package already,

and you just have to install that package.

SPE{,‘/
g\s“ B
@ In Debian, type su - in a terminal window, enter the root password, and
% then type apt-get install gftp.
°
\Q\\SPEC/,/ In Fedora, log in as root, choose Add/Remove Software from the System
§ Settings menu, and search for gFTP. Choose the package that appears in the
= search list (gftp-1:2.0.18-7. f£c8, as of this writing), click Apply, and the
L . .
d}o software will be installed.
In Fedora, start gFTP by choosing Applications=>Internet=>gFTP. (If you don’t
see gFTP, log in as root and type yum install gftp, and then look for
it in the menu again.) In other distributions, you can find gFTP in the main
menu. The gFTP window appears, as shown in Figure 4-1.
fel
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.fontconfig 4,096 glbrown [ fairall.htm 59 28139
The gFTP .geonf 4,096 glbrown [ hazen.htm 21,751 28139
window @ \ @ I
just after Filename Progress
opening a
connection | _ = o 2
to an FTP 227 Entering Passive Mode (209,237,150,20,85,135)
LIST -aL
server. [ e edor lins
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The gFTP window has a menu bar with menus for performing various tasks.
Just below the menu bar is a toolbar with a number of buttons and text
fields. Here you can type the name or IP address of the remote host, and

the username and password needed to log in to the remote host. Figure 4-1
shows the gFTP window after you fill in this information and establish a con-
nection with the remote host by clicking the button with the icon showing
two computers (the leftmost one on the toolbar).

To upload or download files with gFTP, follow these steps:

1. Fill in the hostname or the IP address of the remote system in the Host
field.

If you've used that host before, you can select it from the drop-down list
that appears when you click the downward-pointing arrow next to the
Host field.

2. Provide the username in the User field and the password in the Pass
field, and then click the button with the icon showing two computers
(to the left of the Host field).

This operation causes gFTP to connect to your chosen host and to log
in with the username and password you provided. The lower part of the
gFTP window shows the FTP protocol messages exchanged between the
two systems.

3. Observe the lower part of the screen for any indication of error
messages.

The directory listing of the remote system appears in the right half of
the gFTP window. The left half shows the current local directory.

4. To upload one or more files from the current system to the remote
system, select the files in the list on the left and then click the right-
pointing arrow button.

5. To download files from the remote system, select the filenames in the
list on the right and click the left-pointing arrow button.

Book IV

6. When you have finished transferring files, choose FTP->Quit. Chapter 4
As these steps show, transferring files with a GUI FTP client, such as gFTP, is

simple. -

o

Believe it or not, gFTP isn’t for FTP transfers alone. It can also transfer files &

using the HTTP (HyperText Transfer Protocol) and secure file transfers a

using the Secure Shell (SSH) protocol.
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Figure 4-2:
Enter
information
about the
remote FTP
server and
click OK.

Introducing KFTPGrabber

KFTPGrabber is a GUI FTP client for KDE. You find it in the main menu (in
the Internet category) on KDE desktops. In Debian, type apt-get install
kftpgrabber to install KFTPGrabber (after you type su - to become root).

In Fedora, log in as root, choose System Settingsw>Add/Remove Software,
and search for KFTPGrabber. Choose the package that appears in the search
list (kftpgrabber) and then click Apply. Click Continue at the prompt, and
the software will be installed.

When the main KFTPGrabber window appears, it displays your home folder
in a view similar to that in Windows Explorer. To connect to an FTP server,
choose File>Quick Connect. A dialog box like the one shown in Figure 4-2
prompts you for the hostname of the FTP server as well as the username and
password.

@ o KFTPGrabber <2> @ oo &
General | Advanced
~Recent connections
Select connection: [ftp:,f,ijbattelIe@au—anEwers.(om:Zl,f ‘vl

~Quick Connect

URL: [ftp:,,‘,h‘jbattelle@au-answers‘ccn"ﬂ:ZJ.,.i ]
Host: [au-answers.com| | Port: [21 I%]
Protocol: [FrP "l s

[_] Anonymous login

Username: [jbattelle ]

Password: [.......' ]
[ ] Add to bookmarks

After entering the requested information, click OK. KFTPGrabber establishes
a connection to the remote FTP server. In the KFTPGrabber main window,
shown in Figure 4-3, you see both the local and remote directories side by
side.

FTP transfers become just normal drag-and-drop file copying: Transfer files
by simply dragging them from one system’s folder and dropping them on the
other system’s folder.
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When you finish using KFTPGrabber, choose Filec>Quit.

Using a Web browser as an FTP client

Any Web browser can act as an FTP client, but such programs are best for
anonymous FTP downloads, where the Web browser can log in using the
anonymous username and any password.

For example, you can use the Firefox Web browser as an FTP client. All you
have to know is how to write the URL so that the Web browser can tell that
you want to download a file using FTP. The syntax of the FTP URL is

ftp://hostname/pathname

The first part (£tp: //) indicates that you want an FTP transfer. The host
name part is the name of the FTP server (the name often starts with ftp —
for example, ftp.wiley.com). The pathname is the full directory path and
filename of the file that you want to download.

If you simply provide the hostname for the FTP server, the Web browser
displays the contents of the anonymous FTP directory. If you want to access
anonymous FTP on your Linux system, start Firefox (click the Web browser
icon on the GNOME panel), type the FTP URL in the Location text box, and
press Enter.

Book IV
Chapter 4

d14 buisn



282 Using Graphical FTP Clients

Figure 4-4:
You can

use a Web
browser to
download
files from
FTP servers.

Figure 4-4 shows a typical appearance of an FTP directory in Firefox. You
can click folders to see their contents and download any files. You can
access your local system by using Firefox’s FTP capabilities; for example,
type ftp://localhost/pub/ to access the pub directory. (You won’t get a
response from your system if you’re not running an FTP server or if you've
set up your firewall so that no FTP connections are allowed.)
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In Debian and Fedora, log in as root and type /etc/init.d/vsftpd
start (in a terminal window) to start the FTP server. In SUSE, the xinetd
super server controls the FTP server vsftpd. The /etc/xinetd.d/
vsftpd configuration file specifies how vsftpd is started. See Book VII,
Chapter 1 for more information about xinetd configuration files.

The same approach of accessing anonymous FTP sites works if you type the
hostname of some other anonymous FTP server. For example, try typing the
following URL:

ftp://ftp.netscape.com/

You get the directory of the ftp.netscape.com server.
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Knowing how to use FTP from the command line is a good idea. For example,
if your GUI desktop isn’t working, you may need to download some files to
fix the problem; you can do so if you know how to use the command-line FTP
client. The command-line ftp client is available in all Linux distributions and
using it is not difficult.

The best way to figure out the command-line FTP client is to try it out. The
command is £tp, and you can try out the ftp commands from your Linux
system. You don’t even need an Internet connection because you can use
the ftp command to connect to your own system.

Note that the output from the ftp command might be different because
some distributions, such as Debian, use a text mode version of gFTP as the
command-line FTP client.

In the following sample FTP session, the command-line FTP client was used
to log in and browse the directories on a Linux system. Here’s the listing
illustrating interaction with a typical command-line FTP client:

ftp localhost

Connected to localhost.localdomain.
220 (vsFTPd 2.0.3)

Name (localhost:jdoe): (press Enter.)
331 Please specify the password.
Password: (enter the password for the user.)
230 Login successful.

Remote system type is UNIX.

Using binary mode to transfer files.
ftp> help

Commands may be abbreviated. Commands are:
! debug mdir gc send

$ dir mget sendport site

account disconnect mkdir put size
append exit mls pwd status

ascii form mode quit struct

bell get modtime quote system

binary glob mput recv sunique

bye hash newer reget tenex

case help nmap rstatus tick

cd idle nlist rhelp trace

cdup image ntrans rename type

chmod lcd open reset user

close 1ls prompt restart umask

cr macdef passive rmdir verbose
delete mdelete proxy runique °?

Book IV
Chapter 4
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ftp> help mget (to get help on a specific command.)

mget get multiple files

ftp> ed /var (This changes directory to /var.)

250 Directory successfully changed.

ftp> 1s (This command lists the contents of the directory.)
227 Entering Passive Mode (127,0,0,1,38,142)

150 Here comes the directory listing.

. lines deleted .

226 Directory send OK.

ftp> bye (This command ends the session.)

As the listing shows, you can start the command-line FTP client by typing
the command f£tp hostname, where hostname is the name of the system
you want to access. When the FTP client establishes a connection with

the FTP server at the remote system, the FTP server prompts you for a
username and password. After you supply the information, the FTP client
displays the ftp> prompt, and you can begin typing commands to perform
specific tasks. If you can’t remember a specific FTP command, type help to
view a list of them. You can get additional help for a specific command by
typing help command, where command is the command for which you
want help.

Many FTP commands are similar to the Linux commands for navigating the
file system. For example, cd changes directory, pwd prints the name of the
current working directory, and 1s lists the contents of the current directory.
Two other common commands are get and put: get is what downloads a
file from the remote system to your system, and put uploads (sends) a file
from your system to the remote host.

Table 4-1 describes some commonly used FTP commands. You don’t have
to type the entire FTP command. For a long command, you have to type only
the first few characters — enough to identify the command uniquely. For
example, to delete a file, you can type dele, and to change the file transfer
mode to binary, you can type bin.

Tabhle 4-1 Common FTP Commands

Command Description

! Executes a shell command on the local system. For example, ! 1s
lists the contents of the current directory on the local system.

? Displays a list of commands (same as help).

append Appends a local file to a remote file.
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Command Description

ascii Sets the file transfer type to ASCII (or plain text). This command is
the default file transfer type.

binary Sets the file transfer type to binary.

bye Ends the FTP session with the remote FTP server and quits the FTP
client.

cd Changes the directory on the remote system. For example, cd /

pub/Linux changes the remote directory to /pub/Linux.

chmod Changes the permission settings of a remote file. For example,
chmod 644 index.html changes the permission settings of
the index.html file on the remote system.

close Ends the FTP session with the FTP server and returns to the FTP
client’s prompt.

delete Deletes a remote file. For example, delete bigimage.jpg
deletes that file on the remote system.

dir Lists the contents of the current directory on the remote system.

discon- Ends the FTP session and returns to the FTP client’s prompt. (This

nect command is the same as close.)

get Downloads a remote file. For example, get junk.tar.gz

junk. tgz downloads the file junk. tar . gz from the remote
system and saves it as the file junk. tgz on the local system.

hash Turns on or off the hash mark (#) printing that shows the progress
of the file transfer. When this feature is turned on, a hash mark
prints on-screen for every 1,024 bytes transferred from the remote
system. (It's the command-line version of a progress bar.)

help Displays a list of commands.
image Same asbinary.
lcd Changes the current directory on the local system. For example,
lcd /var/ftp/pub changes the current local directory to Book IV
00
/var/ftp/pub. Chapter 4
1s Lists the contents of the current remote directory.
mdelete Deletes multiple files on a remote system. For example, mdelete
* _jpg deletes all remote files with names ending in . jpg in the =
current directory. g'
mdir Lists multiple remote files and saves the listing in a specified local |
)

file. For example, mdir /usr/share/doc/w* wlist saves
the listing in the local file named wlist.

(continued)
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Table 4-1 (continued)

Command Description

mget Downloads multiple files. For example, mget *.jpg downloads
all files with names ending in . jpg. If the prompt is turned on, the
FTP client asks for confirmation before downloading each file.

mkdir Creates a directory on the remote system. mkdir images
creates a directory named images in the current directory on the
remote system.

mls Same asmdir.

mput Uploads multiple files. For example, mput * . jpg sends all files
with names ending in . jpg to the remote system. If the prompt
is turned on, the FTP client asks for confirmation before sending
each file.

open Opens a connection to the FTP server on the specified host. For
example, open ftp.netscape.com connects tothe FTP
server on the host ftp.netscape. com.

prompt Turns the prompt on or off. When the prompt is on, the FTP client
prompts you for confirmation before downloading or uploading
each file during a multiple-file transfer.

put Sends a file to the remote system. For example, put index.
html sends the index.html file from the local system to the
remote system.

pwd Displays the full path name of the current directory on the remote
system. When you log in as a user, the initial current working
directory is your home directory.

quit Same as bye.

recv Same as get.

rename Renames a file on the remote system. For example, rename
old.html new.html renames the file 01d.html to new.
html onthe remote system.

rmdir Deletes a directory on the remote system. For example, rmdir
images deletes the images directory in the current directory of
the remote system.

send Same as put.

size Shows the size of a remote file. For example, size bigfile.
tar .gz shows the size of that remote file.

status Shows the current status of the FTP client.

user Sends new user information to the FTP server. For example, user

jdoe sends the username jdoe; the FTP server then prompts for
the password for that username.
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When downloading files from the Internet, you almost always want to trans-
fer the files in binary mode because the software is usually archived and
compressed in a binary form. (Its files aren’t plain text files.) So always use
the binary command to set the mode to binary. Then use the get com-
mand to download the files.

When transferring multiple files with similar names (such as imagel. jpg,
image?2 . jpg, and so on), type prompt to turn off prompting. (Otherwise the
FTP client will ask you after each file transfer whether you want to transfer
the next file.) Then type mget followed by the filename with a wildcard. For
example, to download all files with names starting with image and ending
with the . jpg extension, type mget image*.jpg.

Book IV
Chapter 4
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“ A centralized security management system
sounds fine, but then what would we do
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Chapter 1: Introducing Basic
System Administration

In This Chapter

v Introducing the GUI sysadmin tools

+* Becoming root

+ Understanding the system startup process

1~ Taking stock of the system configuration files

v Viewing system information through the /proc file system
+* Monitoring system performance

+* Managing devices

v+ Scheduling jobs

5/stem administration, or sysadmin, refers to whatever has to be done to
keep a computer system up and running. The system administrator (the
sysadmin) is whoever is in charge of taking care of these tasks.

If you're running Linux at home or in a small office, you’re most likely the
system administrator for your systems. Or maybe you're the system admin-
istrator for an entire LAN full of Linux systems. Regardless of your position
or title, this chapter will introduce you to basic system administration pro-
cedures and show you how to perform some common tasks.

Taking Stock of System Administration Tasks

So what are system administration tasks? An off-the-cuff reply is anything
you have to do to keep the system running well. More accurately, though, a
system administrator’s duties include

4+ Adding and removing user accounts: You have to add new user
accounts and remove unnecessary user accounts. If a user forgets the
password, you have to change the password.

4+ Managing the printing system: You have to turn the print queue on or
off, check the print queue’s status, and delete print jobs if necessary.
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4+ Installing, configuring, and upgrading the operating system and vari-
ous utilities: You have to install or upgrade parts of the Linux operating
system and other software that are part of the operating system.

4+ Installing new software: You have to install software that comes in vari-
ous package formats, such as RPM or DEB. You also have to download
and unpack software that comes in source-code form — and then build
executable programs from the source code.

4+ Managing hardware: Sometimes, you have to add new hardware and
install drivers so the devices work properly.

4+ Making backups: You have to back up files, to a DVD drive, a USB
memory stick, an external hard drive, or on tape.

4 Mounting and unmounting file systems: When you want to access the
files on a CD-ROM, for example, you have to mount that CD-ROM'’s file
system on one of the directories in your Linux file system. You may also
have to mount floppy disks, in both Linux format and DOS format.

4+ Automating tasks: You have to schedule Linux tasks to take place auto-
matically (at specific times) or periodically (at regular intervals).

4 Monitoring the system’s performance: You may want to keep an eye on
system performance to see where the processor is spending most of its
time and to see the amount of free and used memory in the system.

4+ Starting and shutting down the system: Although starting the system
typically involves nothing more than powering up the PC, you do have to
take some care when you shut down your Linux system. If your system
is set up for a graphical login screen, you can perform the shutdown
operation by choosing a menu item from the login screen. Otherwise,
use the shutdown command to stop all programs before turning off
your PC’s power switch.

4+ Monitoring network status: If you have a network presence (whether a
LAN, a DSL line, or a cable modem connection), you may want to check
the status of various network interfaces and make sure your network
connection is up and running.

4 Setting up host and network security: You have to make sure that
system files are protected and that your system can defend itself against
attacks over the network.

4+ Monitoring security: You have to keep an eye on any intrusions, usually
by checking the log files.

That’s a long list of tasks! Not all these items are covered in this chapter,

but the rest of this minibook describes most of these tasks. The focus in this
chapter is on some of the basics, such as using the GUI tools, explaining how
to become root (the superuser), describing the system configuration files,
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and showing you how to monitor system performance, manage devices, and Book V

set up periodic jobs. Chapter 1
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Each Linux distribution comes with GUI tools for performing system admin- 2 ~‘<: s

istration tasks. The GUI tools prompt you for input and then run the neces- §- g 2

=

sary Linux commands to perform the task. The following sections briefly
introduce the GUI sysadmin tools in Debian, Fedora, Knoppix, SUSE, Ubuntu,
and Xandros.

GUI sysadmin tools in Debian

Debian uses the GNOME desktop by default and provides some GUI tools
for performing sysadmin tasks. These tools are available by choosing
Applications=>System Tools. Table 1-1 lists some common tasks and the
menu choices you use to start the GUI tool that enables you to perform

that task.
Table 1-1 Performing Sysadmin Tasks with GUI Tools in Debian
To Do This Choose the Following from the Debian GNOME Desktop

Add or remove software
packages

Applicationsc>System Toolse>Synaptic Package
Manager

Change the date or time

Applicationsc>System Tools=>Time and Date

Change a password

Main Menu=>Settings=>Change Password

Configure a desktop

Applications=>Desktop Preferences

Configure a network

Applications=>Networking

Format a floppy

Applications=>System Tools=>Floppy Formatter

Manage printers

Applicationsc>System Tools=>Printers

Manage user accounts

Applicationse>System Toolse>Users and Groups

Monitor system
performance

Applicationse>System Toolse>System Monitor

View system logs

Applicationse>System Toolse>System Log

GUI sysadmin tools in Fedora

Fedora comes with a set of GUI system configuration tools that can ease the
burden of performing typical sysadmin chores. Table 1-2 briefly summarizes
the menu choices you use to start a GUI tool for a specific task.
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Table 1-2

Starting GUI Sysadmin Tools in Fedora

To Configure or Manage This

Start GUI Tool by Choosing This

Date and time

System=>Administrationc>Date & Time

Disks and DVD/CD-ROM

Applications=>System Tools=>Disk Utility

Display settings

Systemr>Preferencec>Display

Firewall settings

Systemc>Administration=>Firewall

Internet connection

System=>Preferences=>Network Connectivity

Network

System=>Preferences=>Network Connectivity

Preferences such as desktop
and password

Systemc>Preferences

Printer

System=>Administration=>Printing

Software

Systemc>Administration=>Add/Remove Software

System performance

Applicationsc>System Toolse>System Monitor

User accounts

System=>Administration=>Users and Groups

GUI sysadmin tools in Knoppix

Knoppix is a Live CD distribution that you can use either to try out Linux or
to fix problems in an existing Linux system. As such, Knoppix comes with
several GUI tools that you can use for system administration tasks. Table 1-3
summarizes some of the GUI tools in Knoppix.

Table 1-3

Using GUI tools for Sysadmin Tasks in Knoppix

To Do This

Choose This from the Knoppix GUI Desktop

Configure a desktop

Main Menuc>Preferences—>Appearances

Main Menu=>Preferences=>0penbook
Configuration Manager

Configure KDE

Main Menu=>System Tools=>Configuration
Editor

Configure a network

Main Menuc>Preferences=>ISDN Connection

Configure a printer

Main Menu=>Preferences=>KNOPPIX=>Printer
Configuration

Manage disk partitions (for
troubleshooting existing Linux
installations)

Main Menu=>Preferences=>GParted
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To Do This Choose This from the Knoppix GUI Desktop Book V

Chapter 1
Change the root password Main Menu=>PreferencescoKNOPPIX=>Set P
password for root

See disk usage Main Menu=>System Tools=>Disk usage § g 5
analyzer 5o §
Configure software Main Menu=>Preferencess> KNOPPIXc> %%E
Synaptic Package Manager = gcg

=

View log files Main Menu=>System Tools=>Log file viewer

GUI sysadmin tools in SUSE

In SUSE, from the main menu, choose YaST to start your system administra-
tion tasks in the YaST Control Center. Figure 1-1 shows the YaST Control
Center window.

&) YaST Control Center @ linux -5

Fle Edit Help

[k software ~

== Bluetooth {2 co-romDrives

i [ Hardware
Flgure 1-1: B syt s pisk contratier S Graphics card and Moniter
YaST -

P Network Devices 16 Hardware Information =] 1o omA Moge
Control 9 network services -

H . Infrared Device o Joystick

Centeris Q ] &
1 security and Users
. 7Y .
your sta rtmg R (2| 4 Keyboard Layout I:) Mouse Model
point for . o =
| Printer ™ scanner
— Y
many -

i Sound TV Card
sysadmin b soun e
tasks in

Configure the graphics card and monitar

The left side of the YaST Control Center shows icons for the categories of
tasks you can perform. The right side shows icons for specific tasks in the
currently selected category. When you click an icon on the right side of the
YaST Control Center, a new YaST window appears and enables you to per-
form that task.

Table 1-4 summarizes the tasks for each of the category icons on the left side
of the YaST Control Center. As you can see from the entries in the second
column of Table 14, YaST Control Center is truly one-stop shopping for all of
your sysadmin chores.
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Table 1-4 Tasks by Category in the YaST Control Center

This Category Enables You to Configure or Manage the Following

Software Online Update, Installation Source, Installation in Xen
Environment, Installation into Directory, Media Check,
Patch CD Update, Software Management, System
Update

Hardware Bluetooth, CD-ROM Drives, Disk Controller, Graphics
Card and Monitor, Hardware Information, IDE DMA
Mode, Infrared Device, Joystick, Keyboard Layout,
Mouse Model, Printer, Scanner, Sound, TV Card

System /etc/sysconfig Editor, Boot Loader Configuration,

Boot or Rescue Floppy, Date and Time, LVM, Language,
PCI Device Drivers, Partitioner, Power Management,
Powertweak, Profile Manager, System Backup, System
Restoration, System Services (run level)

Network Devices

DSL, Fax, ISDN, Modem, Network Card, Phone
Answering Machine

Network Services

DHCP Server, DNS Server, DNS Host and Name, HTTP
Server, Host Names, Kerberos Client, LDAP Client, Mail
Transfer Agent, NFS Client, NFS Server, NIS Client, NIS
Server, NTP Client, Network Services (xinetd), Proxy,
Remote Administration, Routing, SLP Browser, Samba
Client, Samba Server, TFTP Server

Security and Users

Firewall, Group Management, Local Security, User
Management

Miscellaneous

Autoinstallation, Post a Support Query, Vendor Driver
CD, View Start-up Log, View System Log

GUI sysadmin tools in Ubuntu

Ubuntu uses the GNOME desktop, and its menu organization is similar

to that of Fedora’s GNOME desktop. You can find Ubuntu’s GUI system
administration tools in the following menus: Applications=>System Tools,
System=>Administration, and System=>Preferences. Table 1-5 lists the menu
choices for starting some of the GUI tools.

Table 1-5

Starting GUI Sysadmin Tools in Ubuntu

To Configure or Manage This Start GUI Tool by Choosing This

Date and time

System=>Administration=>Time and Date

Display settings

System=>Preferences=>Display
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To Configure or Manage This

Start GUI Tool by Choosing This

Hardware

System=>Administrationc>Hardware Drivers

Internet connection

System=>Administrationc>Network Tools

Network

System=>Administrationc>Network Tools

Preferences such as desk-
top and default applications

System=>Preferences

Printer Systemc>Administration=>Printing

Software System=>Administrationc>Software Sources
Manager

System logs Applicationst>System Tools=>System Log

System performance

Systemc>Administration=>System Monitor

Updates

System=>Administration>Ubuntu Update
Manager

User accounts

Systemc>Administration=>Users and Groups

GUI sysadmin tools in Xandros

Xandros is designed to be a desktop operating system, and as such, you can
access everything easily from the desktop. For most sysadmin tasks, you
start at the Xandros Control Center — choose Main Menu~>Control Center to
get there. (Figure 1-2 shows you what you find when you do get there.)

A Control Center.
Eile View Settings Help
Index | Search | Help

{E Display

= File Manager

i¢ General Settings

¥ Hardware Information

& Network

<3 Peripheral Devices

|2, Power Management

& sound & Multimedia

= Gy System Administration
B Boot Manager

Xandros Control Center

Configure r desktop environment.

’

KDE version:
User:
Hostname:
System.
Release:
Machine:

=5 Change Password

L Login Manager

«# Remote Desktop Sharing
¥ Ssenices

User Manager

Click on the "Help" tab on the left to view help for the active control module. Use
the "Search” tab if you are unsure where to look for a particular configuration
option
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The left side of the window shows a tree menu of task categories. Click the
plus sign next to a category to view the subcategories. When you click a spe-
cific task, the right side of the window displays the GUI through which you
can perform that task.

For some tasks, such as mounting file systems or adding printers, you can
open the Xandros File Manager as a system administrator by choosing Main
Menur>Applications>Systemr>Administrator Toolsm>Xandros File Manager
(Administrator). You're prompted for the root password. Figure 1-3 shows
the Xandros File Manager window from which you can perform some sys-
admin tasks.

IEl| My Linux - Xandros File Manager (Administrator)

File Edit View Go Bookmarks Windew Tools Help

Address € [ My Linux

<3 - o
) Qo5 LE|® #THE
| Al Folders ] 9. L] W
£} My Linux A 54 Ul p== -
{ My Home E My Home All File Printers
1% All File Systems My Linux Systems
(i Printers T ;g '-J}
- Windows Network N Tt (]
@} NFS MNetwork windows NFS Network [
aEG Metwork
= a a &
=E
5D Writer D E: CD Writer

{72 CD-RW/DVD-ROM
Figure 1-3: = mlFiovpy CD-RWDVD-R  Floppy
For some o
sysadmin
tasks,

use the
Xandros File
Manager.

o,

11 object(s) H My Linux

How to Become root

You have to log in as root to perform system administration tasks. The
root user is the superuser and the only account with all the privileges
needed to do anything in the system.

Common wisdom says you should not normally log in as root. When you’re
root, you can easily delete all the files with one misstep — especially when
you're typing commands. For example, you type the command rm *.html
to delete all files that have the .html extension. But what if you accidentally
press the spacebar after the asterisk (*)? The shell takes the command to be
rm * .html and — because * matches any filename — deletes everything
in the current directory. Seems implausible until it happens to you!
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Using the su - command

If you're logged in as a normal user, how do you do any system administra-
tion chores? Well, you become root for the time being. If you're working at a
terminal window or console, type

su -

Then enter the root password in response to the prompt. From this point,
you'’re root. Do whatever you have to do. To return to your usual self, type

exit
That’s it! It’s that easy.

By the way, Knoppix has a root user but doesn’t have a root password, so
you can become root by simply typing su - at the shell prompt in a ter-
minal window. Also, Ubuntu doesn’t have a root user. To perform any task
that requires root privileges in Ubuntu, you must type sudo followed by the
command and then provide your normal user password when prompted.

Becoming root for the GUI utilities

Most Linux distributions include GUI utilities to perform system administra-
tion chores. If you use any of these GUI utilities to perform a task that requires
you to be root, the utility typically pops up a dialog box that prompts you for
the root password, as shown in Figure 1-4 (except in Ubuntu, where the GUI
tools prompt for your normal user password). Just type the password and
press Enter. If you don’t want to use the utility, click Cancel.

Bl  FnerPasswod
D] To run this tool, you need administrator privileges

J To acguire such privileges, enter your root password
below. If you don't specify a password, you will be
unable to modify your system configuration.

Password: wwﬁ

r
X Cancel 4:9@(

Recovering from a forgotten root password

To perform system administration tasks, you have to know the root pass-
word. What happens if you forget the root password? Not to worry. You can
reset the root password by following these steps:
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Reboot the PC (select Reboot as you log out of the GUI screen) or
power up as usual.

As soon you see the graphical GRUB boot loader screen that shows

the names of the operating systems, you can boot. If your system runs
the LILO boot loader, press Ctrl+X, type 1linux single at the boot:
prompt, and press Enter. Then proceed to Step 4. If you don’t see the
graphical loader screen on reboot, it might not be installed (which can
occasionally occur when choosing to install from a Live CD). If this is the
case, it is recommended that you reinstall from the CD.

If you have more than one operating system installed, use the arrow
key to select Linux as your operating system and then press the A key.

GRUB prompts you for commands to add to its default boot command.
Press the spacebar, and then type single and press Enter.

Linux starts as usual but runs in a single-user mode that doesn’t require
you to log in. After Linux starts, you see the following command-line
prompt similar to the following:

sh-3.00#
Type the passwd command to change the root password as follows:

sh-3.00# passwd
Changing password for user root.
New password:

Type the new root password that you want to use (it doesn’t appear
on-screen) and then press Enter.

Linux asks for the password again, like this:
Retype new password:
Type the password again and press Enter.

If you enter the same password both times, the passwd command
changes the root password.

Now type reboot to reboot the PC.

After Linux starts, it displays the familiar login screen. Now you can log
in as root with the new password.

In SUSE Linux, in Step 3, type single init=/bin/sh (instead of single)
and before proceeding to Step 4, at the command-line prompt, type mount

/ -n -0 remount,rw. Then perform Steps 4 through 6 to change the
root password. After changing the password, type mount / -n -o
remount, ro. Then continue to Step 7 and reboot the PC.
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Make sure that your Linux PC is physically secure. As these steps show,
anyone who can physically access your Linux PC can simply reboot, set a
new root password, and do whatever he or she wants with the system.
Another way to protect against resetting the password is to set a GRUB pass-
word, which causes GRUB to require a valid password before it boots Linux.
Of course, you must then remember to enter the GRUB password every time
you boot your system!

Understanding How Linux Boots

Knowing the sequence in which Linux starts processes as it boots is impor-
tant. You can use this knowledge to start and stop services, such as the Web
server and Network File System (NFS). The next few sections provide you
with an overview of how Linux boots and starts the initial set of processes.
These sections also familiarize you with the shell scripts that start various
services on a Linux system.

Understanding the init process

When Linux boots, it loads and runs the core operating system program
from the hard drive. The core operating system is designed to run other
programs. A process named init starts the initial set of processes on your
Linux system.

To see the processes currently running on the system, type
ps ax | more
You get an output listing that starts like this:

PID TTY STAT TIME COMMAND
1 ? S 0:22 init [2]

The first column, with the heading PID, shows a number for each process.
PID stands for process ID (identification) — a sequential number assigned
by the Linux kernel. The first entry in the process list, with a PID of 1, is the
init process. It’s the first process, and it starts all other processes in your
Linux system. That’s why init is sometimes referred to as the mother of all
processes.

What the init process starts depends on

4+ The run level, an identifier that identifies a system configuration in
which only a selected group of processes can exist.
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4+ The contents of the /etc/inittab file, a text file that specifies which
processes to start at different run levels.

4 A number of shell scripts that are executed at specific run levels. (The
scripts are located in the /etc/init.d directory and a number of subdi-
rectories in /etc — these subdirectories have names that begin with rc.)

Most Linux distributions use seven run levels — 0 through 6. The meaning
of the run levels differs from one distribution to another. Table 1-6 shows
the meanings of the run levels and points out some of the actions specific to
Fedora, Debian, SUSE, Ubuntu, and Xandros.

Table 1-6 Run Levels in Linux

Run Level Meaning

0 Shut down the system

1 Run in single-user standalone mode (no one else can log in; you
work at the text console)

2 Run in multiuser mode (Debian, Ubuntu, and Xandros use run level
2 as the default run level)

3 Run in full multiuser mode (used for text mode login in Fedora and
SUSE)

4 Run in full multiuser mode (unused in Fedora and SUSE)

Run in full multiuser mode (used as the default run level with graph-
ical login in Fedora and SUSE)

6 Reboot the system

The current run level together with the contents of the /etc/inittab file
control which processes init starts in Linux. The default run level is 2 in
Debian, Ubuntu, and Xandros. In Fedora and SUSE, run level 3 is used for text
mode login screens and 5 for the graphical login screen. You can change the
default run level by editing a line in the /etc/inittab file.

To check the current run level, type the following command in a terminal
window:

/sbin/runlevel
In Debian, the runlevel command prints an output like this:

N 2
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The first character of the output shows the previous run level (N means no
previous run level), and the second character shows the current run level

(2). In this case, the system started at run level 2. If you're in a GUI desktop
in Fedora, the runlevel command should show 5 as the current run level.

Examining the /etc/inittab file

The /etc/inittabfile is the key to understanding the processes that init
starts at various run levels. You can look at the contents of the file by using
the more command, as follows:

more /etc/inittab

To see the contents of the /etc/inittab file with the more command, you
don’t have to log in as root.

To interpret the contents of the /etc/inittab file, follow these steps:

1. Look for the line that contains the phrase initdefault.
Here’s that line from the /etc/inittab file from a Debian system:
id:2:initdefault:
That line shows the default run level. In this case, it’s 2.
2. Find all the lines that specify what init runs at run level 2.

Look for a line that has a 2 between the first two colons (%). Here’s a rel-
evant line in Debian:

12:2:wait:/etc/init.d/rc 2

This line specifies that init executes the file /etc/init.d/rc with 2
as an argument.

If you look at the file /etc/init.d/rc in a Debian system, you find it’s a
shell script. You can study this file to see how it starts various processes for
run levels 1 through 5.

Each entry in the /etc/inittab file tells init what to do at one or more
run levels — you simply list all run levels at which the process runs. Each
inittab entry has four fields — separated by colons — in the following
format:

id:runlevels:action:process

Table 1-7 shows what each field means.
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Table 1-7 Fields in Each inittab Entry
Field Meaning
id A unique one- or two-character identifier. The init process

uses this field internally. You can use any identifier you want, as
long as you don't use the same identifier on more than one line.

runlevels A sequence of zero or more characters, each denoting a run
level. For example, if the runlevels field is 12345, that entry
applies to each of the run levels 1 through 5. This field is ignored
if the action field is setto sysinit, boot, or bootwait.

action What the init process will do with this entry. If this field is
initdefault, for example, init interprets the run
levels field as the default run level. If this field is set to
wait, init starts the program or script specified in the
process field and waits until that process exits.

process Name of the script or program that init starts. Some settings
of the action field require no process field. For example,
when the action field is initdefault, there's no need for a
process field.

Trying a new run level with the init command

To try a new run level, you don’t have to change the default run level in the
/etc/inittab file. If you log in as root, you can change the run level (and,
consequently, the processes that run in Linux) by typing init followed by
the run level.

For example, to put the system in single-user mode, type the following:
init 1

Thus, if you want to try run level 3 without changing the default run level in
/etc/inittab file, enter the following command at the shell prompt:
init 3

The system ends all current processes and enters run level 3. By default, the
init command waits 20 seconds before stopping all current processes and
starting the new processes for run level 3.
N To switch to run level 3 immediately, type the command init -t0 3.
The number after the -t option indicates the number of seconds init waits
before changing the run level.
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You can also use the telinit command, which is simply a symbolic link (a
shortcut) to init. If you make changes to the /etc/inittab file and want
init to reload its configuration file, use the command telinit q.

Understanding the Linux startup scripts

The init process runs a number of scripts at system startup. In the fol-
lowing discussions, a Debian system is used as an example, but the basic
sequence is similar in other distributions — only the names and locations of
the scripts may vary.

If you look at the /etc/inittab file in a Debian system, you find the follow-
ing lines near the beginning of the file:

# Boot-time system configuration/initialization script.
si::sysinit:/etc/init.d/rcS

The first line is a comment line. The second line causes init to run the
/etc/init.d/rcS script — the first Linux startup script that init runs
in a Debian system. The rcsS script performs many initialization tasks, such
as mounting the file systems, setting the clock, configuring the keyboard
layout, starting the network, and loading many other driver modules. The
rcsS script performs these initialization tasks by calling many other scripts
and reading configuration files located in the /etc/rcS.d directory.

After executing the /etc/init.d/rcS script, the init process runs the
/etc/init.d/rc script with the run level as an argument. For example,
for run level 2, the following line in /etc/inittab specifies what init
executes:

12:2:wait:/etc/init.d/rc 2

This example says init executes the command /etc/init.d/rc 2 and
waits until that command completes.

The /etc/init.d/rc script is somewhat complicated. Here’s how it works:

4+ It executes scripts in a directory corresponding to the run level. For
example, for run level 2, the /etc/init.d/rc script runs the scripts in
the /etc/rc2.d directory.

4 In the directory that corresponds with the run level, /etc/init.d/rc
looks for all files that begin with X and executes each of them with the
stop argument. This argument kills any currently running processes.
Then it locates all files that begin with S and executes each file with a
start argument. This argument starts the processes needed for the
specified run level.
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To see it executed at run level 2, type the following command:
ls -1 /etc/rc2.d

In the resulting listing, the K scripts — the files whose names begin with

K — stop (or kill) servers, whereas the S scripts start servers. The /etc/
init.d/rc script executes these files in the order in which they appear in
the directory listing.

Manually starting and stopping servers

In Linux, the server startup scripts reside in the /etc/init.d directory.
You can manually invoke scripts in this directory to start, stop, or restart
specific processes — usually servers. For example, to stop the FTP server
(the server program is vsftpd), type the following command:

/etc/init.d/vsftpd stop

If vsftpd is already running and you want to restart it, type the following
command:

/etc/init.d/vsftpd restart

You can enhance your system administration skills by familiarizing yourself
with the scripts in the /etc/init.d directory. To see its listing, type the
following command:

ls /etc/init.d

The script names give you some clue about which server the script can start
and stop. For example, the samba script starts and stops the processes
required for Samba Windows networking services. At your leisure, you may
want to study some of these scripts to see what each one does. You don’t
have to understand all the shell programming; the comments help you dis-
cover the purpose of each script.

Automatically starting servers at system startup

You want some servers to start automatically every time you boot the
system. The exact commands to configure the servers vary from one distri-
bution to another.

In Fedora and SUSE, use the chkconfig command to set up a server to start
whenever the system boots into a specific run level. For example, if you
start the SSH server, you want the sshd server to start whenever the system
starts. You can make that happen by using the chkconfig command. To set
sshd to start whenever the system boots into run level 3, 4, or 5, type the
following command (while logged in as root):
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chkconfig --level 345 sshd on

In Fedora and SUSE, you can also use the chkconfig command to check
which servers are turned on or off. For example, to see the complete list of
all servers for all run levels, type the following command:

chkconfig --list

In Debian, Ubuntu, and Xandros, you can use the update-rc.d command
to enable a server to start automatically at system startup. For example, to
set sshd to start automatically at the default run levels, type update-rc.d
sshd defaults in a terminal window while logged in as root. You can also
specify the exact run levels and the sequence number (the order in which
each server starts). To find out more about the update-rc.d command,
type man update-rc.d in a terminal window.

Taking Stock of Linux System Configuration Files

Linux includes a host of configuration files. All these files share text files that
you can edit with any text editor. To edit these configuration files, you must
log in as root. A selection of the most popular configuration files appears in
Table 1-8, along with a brief description of each. This table gives you an idea
of what types of configuration files a system administrator has to work with.
In many cases, Linux includes GUI utility programs to set up many of these
configuration files.

Table 1-8 Some Linux Configuration Files
Configuration File Description
/boot/grub Location of files for the GRUB boot loader.

/boot/grub/menu.lst Configuration file for the boot menu that GRUB
displays before it boots your system.

Map of the Linux kernel (maps kernel addresses
into names of functions and variables).

/boot/System.map

/boot/vmlinuz The Linux kernel (the operating system’s core).
/etc/apache2/httpd. Configuration file for the Apache Web server
conf (Debian).

/etc/apt/sources. Configuration file that lists the sources — FTP

list or Web sites or CD-ROM — from which the
Advanced Packaging Tool (APT) obtains pack-
ages (Debian, Ubuntu, and Xandros).

(continued)
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Table 1-8 (continued)

Configuration File

Description

/etc/at.allow

Usernames of users allowed to use the at com-
mand to schedule jobs for later execution.

/etc/at.deny

Usernames of users forbidden to use the at
command.

/etc/bashrc

System-wide functions and aliases for the bash
shell (Fedora).

/etc/bash.bashrc

System-wide functions and aliases for the bash
shell (Debian, SUSE, Ubuntu, and Xandros).

/etc/cups/cupsd. Printer configuration file for the Common UNIX
conf Printing System (CUPS) scheduler.
/etc/fonts Directory with font configuration files. (In partic-
ular, you can put local font configuration settings
inthefile /etc/fonts/local.conf.)
/etc/fstab Information about file systems available for mount-
ing and where each file system is to be mounted.
/etc/group Information about groups.

/etc/grub.conf

The configuration for the GRUB boot loader in
Fedora and SUSE.

/etc/hosts

List of IP numbers and their corresponding
hostnames.

/etc/hosts.allow

Hosts allowed to access Internet services on this
system.

/etc/hosts.deny

Hosts forbidden to access Internet services on
this system.

/etc/httpd/conf/
httpd.conf

Configuration file for the Apache Web server
(Fedora).

/etc/init.d

Directory with scripts to start and stop various
SEervers.

/etc/inittab Configuration file used by the init process that
starts all the other processes.
/etc/issue File containing a message to be printed before

displaying the text mode login prompt (usually
the distribution name and the version number).

/etc/lilo.conf

The configuration for the Linux Loader (LILO) —
one of the boot loaders that can load the operat-
ing system from disk (present only if you use the
LILO boot loader).
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Configuration File

Description

/etc/login.defs

Default information for creating user accounts,
used by the useradd command.

/etc/modprobe.conf

Configuration file for loadable kernel modules,
used by the modprobe command (Fedora and
SUSE).

/etc/modules.conf

Configuration file for loadable modules (Debian
and Xandros).

/etc/mtab Information about currently mounted file
systems.

/etc/passwd Information about all user accounts. (Actual
passwords are stored in /etc/shadow.)

/etc/profile System-wide environment and startup file for the

bash shell.

/etc/profile.d

Directory containing script files (with names that
endin . sh)thatthe /etc/profile script
executes.

/etc/init.d/rcS

Linux initialization script in Debian, SUSE,
Ubuntu, and Xandros.

/etc/rc.d/
rc.sysinit

Linux initialization script in Fedora.

/etc/shadow Secure file with encrypted passwords for all user
accounts (can be read by only root).

/etc/shells List of all the shells on the system that the user
can use.

/etc/skel Directory that holds initial versions of files such
as .bash_profile thatcopyto anew user's
home directory.

/etc/sysconfig Linux configuration files (Fedora and SUSE).

/etc/sysctl.conf

Configuration file with kernel parameters that are
read in and set by sysct1 at system startup.

/etc/termcap

Database of terminal capabilities and options
(Fedora and SUSE).

/etc/udev

Directory containing configuration files for
udev — the program that provides the ability
to dynamically name hot-pluggable devices and
create device files in the /dev directory.

/etc/X11

Directory with configuration files for the X
Window System (X11) and various display man-
agers such as gdm and xdm.

(continued)
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Table 1-8 (continued)

Configuration File

Description

/etc/X11l/xorg.conf

Configuration file for X.org X11 — the X Window
System (Fedora, Ubuntu, and SUSE).

/etc/xinetd.conf

Configuration for the xinetd daemon that
starts a number of Internet services on demand.

/etc/yum.conf

Configuration for the yum package updater and
installer (Fedora).

/var/log/apache?2

Web server access and error logs (Debian).

/var/log/cron

Log file with messages from the cron process
that runs scheduled jobs.

/var/log/boot.msg

File with boot messages (SUSE).

/var/log/dmesg File with boot messages (Debian, Fedora, Ubuntu,
and Xandros).
/var/log/httpd Web server access and error logs (Fedora).

/var/log/messages

System log.

Monitoring System Performance

When you’re the system administrator, you must keep an eye on how well
your Linux system is performing. You can monitor the overall performance
of your system by looking at information such as

4+ Central processing unit (CPU) usage

4 Physical memory usage

4 Virtual memory (swap-space) usage

4+ Hard drive usage

Linux comes with a number of utilities that you can use to monitor one or

more of these performance parameters. The following sections introduce a
few of these utilities and show you how to understand the information pre-
sented by said utilities.

Using the top utility
To view the top CPU processes — the ones that use most of the CPU time —

you can use the text mode top utility. To start that utility, type top in a ter-
minal window (or text console). The top utility then displays a text screen
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listing the current processes, arranged in the order of CPU usage, along with
various other information, such as memory and swap-space usage. Figure 1-5
shows a typical output from the top utility.

naba@linux:~ - Shell - Konsole <3

Session Edit View Bookmarks Settings Help
top - 21:54:33 up 2 min, 3 users, load average: 1.44, ©.81, 0.31 <]
Tasks: 76 total, 2 running, 74 sleeping, 0 stopped, © zombie
Cpuls): 0.0x us, 0.3% sy, 0.0« ni, 99.7x id, 0.0 wa, 0.0z hi, 0.0z si
Men : 767692k total, 381276k used, 386416k free, 37984k buffers
Swap: 1543104k total, Ok used, 1543104k free, 219760k cached
PID USER PR NI VIRT RES SHR S »CPU xMEW TIME+ COMMAND
4479 raot 15 © 153m 20m 309 S 0.3 2.8 0:05.93 X
1 root 16 © 688 264 2248 0.0 0.0 0:01.30 init
2 root 4 19 ® 06 085 0.0 0.0 0:00.00 ksoftirgd®
— 3 root 10 -5 9 O ©S 0.0 0.0 0:00.06 cuents/D
1 root 10 -5 0 06 035 0.0 0.0 0:00.00 khelper
- . 5 root 16 -5 0 ] 03 0.6 0.0 0:00.00 kthread
Flgure 1-5: ? root 0 -5 0 @ 905 0.0 0.0 0:00.00 kblockd0
39 root 15 o 0 ] 03 0.6 0.0 0:00.00 kapmd
You can see 60 root 20 0 0 © 05 0.0 0.0 0:00.00 pdflush
61 root 15 o 0 ] 03 0.6 0.0 0:00.01 pdflush
the top CPU 63 root 20 5 0 06 0S5 0.0 0.0 0:00.00 aios0
62 root 25 0 0 ] 03 0.6 0.0 0:00.00 ksuwapd®
r 653 root 10 -5 0 6 03 0.0 0.0 0:00.03 kseriod
p ocesses 959 root 16 -5 0 ] 03 0.6 0.0 0:00.01 reiserfs/0
i 1893 root 13 -4 1640 904 600 S 0.0 0.1 0:00.95 udeud
by USIng the 2225 root 10 - 0 03 0.0 0.0 0:00.00 khubd -
top ut|I|ty. 2433 nessageb 16 @ 3520 1544 1312 § 0.0 0.2  0:00.06 dbus-daenon <
(s | W shen [
\\3

The top utility updates the display every five seconds. If you keep top
running in a window, you can continually monitor the status of your Linux
system. To quit top, press Q or Ctrl+C or close the terminal window.

The first five lines of the output screen (see Figure 1-5) provide summary
information about the system, as follows:

4+ The first line shows the current time, how long the system has been up,
how many users are logged in, and three load averages — the average
number of processes ready to run during the last 1, 5, and 15 minutes.

4 The second line lists the total number of processes and the status of
these processes.

4 The third line shows CPU usage — what percentage of CPU time is used
by user processes, what percentage by system (kernel) processes, and
during what percentage of time the CPU is idle.

4 The fourth line shows how the physical memory is being used — the
total amount, how much is used, how much is free, and how much is
allocated to buffers (for reading from the hard drive, for example).

4 The fifth line shows how the virtual memory (or swap space) is being
used — the total amount of swap space, how much is used, how much is
free, and how much is being cached.
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The table that appears below the summary information (refer to Figure 1-5)
lists information about the current processes, arranged in decreasing order
by amount of CPU time used. Table 1-9 summarizes the meanings of the
column headings in the table that top displays.

Table 1-9 Column Headings in top Utility’s Output
Heading Meaning

PID Process ID of the process.

USER Username under which the process is running.

PR Priority of the process.

NI Nice value of the process — the value ranges from —20 (highest

priority) to 19 (lowest priority) and the default is 0. (The nice value
represents the relative priority of the process: The higher the
value, the lower the priority and the nicer the process because it
yields to other processes.)

VIRT Total amount of virtual memory used by the process, in kilobytes.

RES Total physical memory used by a task (typically shown in kilo-
bytes, but an m suffix indicates megabytes).

SHR Amount of shared memory used by process.

S State of the process (S for sleeping, D for uninterruptible sleep, R

for running, z for zombies — processes that should be dead but
are still running — or T for stopped).

%CPU Percentage of CPU time used since last screen update.
$MEM Percentage of physical memory used by the process.
TIME+ Total CPU time the process has used since it started.
COMMAND Shortened form of the command that started the process.

Using the uptime command

You can use the uptime command to get a summary of the system’s state.
Just type the command like this:

uptime

It displays output similar to the following:

15:03:21 up 32 days, 57 min, 3 users, load average: 0.13, 0.23, 0.27

This output shows the current time, how long the system has been up,

the number of users, and (finally) the three load averages — the average
number of processes that were ready to run in the past 1, 5, and 15 minutes.
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Load averages greater than 1 imply that many processes are competing for Book V
CPU time simultaneously. Chapter 1

The load averages give you an indication of how busy the system is.

Using the vmstat utility

You can get summary information about the overall system usage with the
vmstat utility. To view system usage information averaged over 5-second
intervals, type the following command (the second argument indicates the
total number of lines of output vmstat displays):
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vmstat 5 8

You see output similar to the following listing:

procs ----------- MeMOry---------- --- swap-- ----- io---- -- system-- ---- cpu----
r b swpd free buff cache si so bi bo in cs us sy id wa

0 0 31324 4016 18568 136004 1 1 17 16 8 110 33 4 61 1

0 1 31324 2520 15348 139692 0 0 7798 199 1157 377 8 8 6 78

1 0 31324 1584 12936 141480 0 19 5784 105 1099 437 12 5 0 82

2 0 31324 1928 13004 137136 7 0 1586 138 1104 561 43 6 0 51

3 1 31324 1484 13148 132064 0 0 1260 51 1080 427 50 5 0 46

0 0 31324 1804 13240 127976 0 0 1126 46 1082 782 19 5 47 30

0 0 31324 1900 13240 127976 0 0 0 0 1010 211 3 1 96 0

0 0 31324 1916 13248 127976 0 0 0 10 1015 224 3 2 95 0

The first line of output shows the averages since the last reboot. After that,
vmstat displays the 5-second average data seven more times, covering the
next 35 seconds. The tabular output is grouped as six categories of informa-
tion, indicated by the fields in the first line of output. The second line shows
further details for each of the six major fields. You can interpret these fields
by using Table 1-10.

Table 1-10 Meaning of Fields in the vmstat Utility’s Qutput

Field Name Description

procs Number of processes and their types: r = processes waiting
to run, b = processes in uninterruptible sleep, w = processes
swapped out but ready to run.

memory Information about physical memory and swap-space usage (all
numbers in kilobytes): swpd = virtual memory used, free = free
physical memory, buf £ = memory used as buffers, cache =
virtual memory that's cached.

swap Amount of swapping (the numbers are in kilobytes per second):
si = amount of memory swapped in from disk, so = amount of
memory swapped to disk.

(continued)
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Table 1-10 (continued)

Field Name Description

io Information about input and output. (The numbers are in blocks per
second, where the block size depends on the disk device.) bi =
rate of blocks sent to disk, bo = rate of blocks received from disk.

system Information about the system: in = number of interrupts per
second (including clock interrupts), cs = number of context
switches per second — how many times the kernel changed
which process was running.

cpu Percentages of CPU time used: us = percentage of CPU time
used by user processes, sy = percentage of CPU time used by
system processes, id = percentage of time CPU is idle, wa =
time spent waiting for input or output (1/0).

In the vmstat utility’s output, high values in the si and so fields indicate
too much swapping. (Swapping refers to the copying of information between
physical memory and the virtual memory on the hard drive.) High numbers
in the bi and bo fields indicate too much disk activity.

Checking disk performance and disk usage

Linux comes with the /sbin/hdparm program to control IDE or ATAPI hard
drives, which are common on most PCs. One feature of the hdparm program
is that you can use the -t option to determine the rate at which data is

read from the disk into a buffer in memory. For example, here’s the result of
typing /sbin/hdparm -t /dev/hda on one system:

/dev/hda:
Timing buffered disk reads: 178 MB in 3.03 seconds = 58.81 MB/sec

The command requires the IDE drive’s device name (/dev/hda for the first
hard drive and /dev/hdb for the second hard drive) as an argument. If you
have an IDE hard drive, you can try this command to see how fast data is
read from your system'’s disk drive.

To display the space available in the currently mounted file systems, use the
df command. If you want a more readable output from df, type the follow-
ing command:

df -h

Here’s a typical output from this command:
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Filesystem Size Used Avail Use% Mounted on Book V
/dev/hda5 7.1G 3.9G 2.9G 59% / Chapter 1
/dev/hda3 99M 18M 77M 19% /boot

none 125M 0 125M 0% /dev/shm

/dev/scd0 2.6G 2.6G 0 100% /media/cdrecorder

As this example shows, the -h option causes the df command to display the
sizes in gigabytes (G) and megabytes (M).
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To check the disk space being used by a specific directory, use the du com-
mand — you can specify the -h option to view the output in kilobytes (K)
and megabytes (M), as shown in the following example:

du -h /var/log
Here’s a typical output of that command:

152K /var/log/cups
4.0K /var/log/vbox
4.0K /var/log/httpd
508K /var/log/gdm

4.0K /var/log/samba
.0K /var/log/mail

.0K /var/log/news/OLD
.0K /var/log/news

.0K /var/log/squid
.2M /var/log

N > 00 0

The du command displays the disk space used by each directory, and the
last line shows the total disk space used by that directory. If you want to
see only the total space used by a directory, use the -s option. For example,
type du -sh /home to see the space used by the /home directory. The
command produces output that looks like this:

89M /home

Viewing System Information with
the /proc File System

Your Linux system has a special /proc file system. You can find out many
things about your system from this file system. In fact, you can even change
kernel parameters through the /proc file system (just by writing to a file in
that file system), thereby modifying the system’s behavior.

The /proc file system isn’t a real directory on the hard drive but a col-
lection of data structures in memory, managed by the Linux kernel, that
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appears to you as a set of directories and files. The purpose of /proc (also
called the process file system) is to give you access to information about the
Linux kernel as well as to help you find out about all processes currently
running on your system.

You can access the /proc file system just as you access any other directory,
but you have to know the meaning of various files to interpret the informa-
tion. Typically, you can use the cat or more commands to view the contents
of afile in /proc. The file’s contents provide information about some aspect
of the system.

As with any directory, start by looking at a detailed directory listing of /
proc. To do so, log in as root and type 1s -1 /proc in a terminal window.
In the output, the first set of directories (indicated by the letter d at the
beginning of the line) represents the processes currently running on your
system. Each directory that corresponds to a process has the process ID (a
number) as its name.

Notice also a very large file named /proc/kcore; that file represents the
entire physical memory of your system. Although /proc/kcore appears in
the listing as a huge file, no single physical file occupies that much space on
your hard drive — so don’t try to remove the file to reclaim disk space.

Several files and directories in /proc contain interesting information about
your Linux PC. The /proc/cpuinfo file, for example, lists the key charac-
teristics of your system, such as processor type and floating-point processor
information. You can view the processor information by typing cat /proc/
cpuinfo. For example, here’s what appears when cat /proc/cpuinfo is
run on a sample system:

processor : 0

vendor_id : GenuinelIntel

cpu family : 15

model : 3

model name : Intel(R) Celeron(R) CPU 2.53GHz

stepping : 3

cpu MHz : 2533.129

cache size : 256 KB

fdiv_bug : no

hlt_bug : no

f00f_bug : no

coma_bug : no

fpu : yes

fpu_exception : yes

cpuid level : 5

wp : yes

flags : fpu vme de pse tsc msr pae mce cx8 apic sep mtrr pge
mca cmov pat pse36 clflush dts acpi mmx fxsr sse sse2 ss
ht tm pbe pni monitor ds_cpl cid

bogomips : 4997.12
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This output is from a 2.5 GHz Celeron system. The listing shows many inter-
esting characteristics of the processor. Note the line that starts with fdiv_
bug. Remember the infamous Pentium floating-point division bug? The bug
is in an instruction called £div (for floating-point division). Thus, the £div_
bug line indicates whether this particular Pentium has the bug.

The last line in the /proc/cpuinfo file shows the BogoMIPS for the proces-
sor, as computed by the Linux kernel when it boots. BogoMIPS is something
that Linux uses internally to time-delay loops.

Table 1-11 summarizes some of the files in the /proc file system that pro-
vide information about your Linux system. You can view some of these files
on your system to see what they contain, but note that not all files shown in
Table 1-11 are present on your system. The specific contents of the /proc
file system depend on the kernel configuration and the driver modules that
are loaded (which, in turn, depend on your PC’s hardware configuration).

Table 1-11 Some Files and Directories in /proc
File Name Content
/proc/acpi Information about Advanced Configuration and

Power Interface (ACPI) — an industry-standard
interface for configuration and power manage-
ment on laptops, desktops, and servers.

/proc/bus Directory with bus-specific information for each
bus type, such as PCI.

/proc/cmdline The command line used to start the Linux kernel
(for example, ro root=LABEL=/ rhgb).

/proc/cpuinfo Information about the CPU (the microprocessor).

/proc/devices Available block and character devices in your
system.

/proc/dma Information about DMA (direct memory access)
channels that are used.

/proc/driver/rtc Information about the PC'’s real-time clock (RTC).

/proc/filesystems List of supported file systems.

/proc/ide Directory containing information about IDE
devices.

/proc/interrupts Information about interrupt request (IRQ) numbers

and how they are used.

/proc/ioports Information about input/output (I/0) port
addresses and how they're used.

(continued)
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Table 1-11 (continued)

File Name Content

/proc/kcore Image of the physical memory.

/proc/kmsg Kernel messages.

/proc/loadavyg Load average (average number of processes wait-
ing to run in the last 1, 5, and 15 minutes).

/proc/locks Current kernel locks (used to ensure that multiple
processes don't write to a file at the same time).

/proc/meminfo Information about physical memory and swap-
space usage.

/proc/misc Miscellaneous information.

/proc/modules List of loaded driver modules.

/proc/mounts List of mounted file systems.

/proc/net Directory with many subdirectories that contain
information about networking.

/proc/partitions List of partitions known to the Linux kernel.

/proc/pci Information about PCI devices found on the
system.

/proc/scsi Directory with information about SCSI devices
found on the system (present only if you have a
SCSl device).

/proc/stat Overall statistics about the system.

/proc/swaps Information about the swap space and how much
is used.

/proc/sys Directory with information about the system. You

can change kernel parameters by writing to files
in this directory. (Using this method to tune system
performance requires expertise to do properly.)

/proc/uptime Information about how long the system has
been up.
/proc/version Kernel version number.

\4
P You can navigate the /proc file system just as you’d work with any other

directories and files in Linux. Use the more or cat commands to view the
contents of a file.
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Understanding Linux Devices

Figure 1-6:
An
application
can access
a device
through

a special
file that, in
turn, uses
a device
driver.

Linux treats all devices as files and uses a device just as it uses a file —
opens it, writes data to it, reads data from it, and closes it when finished.
This ability to treat every device as a file is possible because of device driv-
ers, which are special programs that control a particular type of hardware.
When the kernel writes data to the device, the device driver does whatever
is appropriate for that device. For example, when the kernel writes data to
the floppy drive, the floppy device driver puts that data onto the physical
medium of the floppy disk. On the other hand, if the kernel writes data to
the parallel port device, the parallel port driver sends the data to the printer
connected to the parallel port.

Thus, the device driver isolates the device-specific code from the rest of
the kernel and makes a device look like a file. Any application can access a

device by opening the file specific to that device. Figure 1-6 illustrates this
concept of a Linux device driver.

({ ) Linux kernel

/dev/cdrom /dev/fd0 eth0
A A A
¥ ¥ ¥
CD-ROM Floppy Ethernet
Software driXer dri;/er driver
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Device files

As Figure 1-6 shows, applications can access a device as if it were a file.
These files, called device files, appear in the /dev directory in the Linux file
system.
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If you use the 1s command to look at the list of files in the /dev directory,
you see several thousand files. These files don’t mean that your system has
several thousand devices. The /dev directory has files for all possible types
of devices — that’s why the number of device files is so large.

So how does the kernel know which device driver to use when an application
opens a specific device file? The answer is in two numbers called the major
and minor device numbers. Each device file is mapped to a specific device
driver through these numbers.

To see an example of the major and minor device numbers, type the follow-
ing command in a terminal window:

ls -1 /dev/hda
You see a line of output similar to the following:
brw-rw---- 1 root disk 3, 0 Aug 16 14:50 /dev/hda

In this line, the major and minor device numbers appear just before the date.
In this case, the major device number is 3 and the minor device number is

0. The kernel selects the device driver for this device file by using the major
device number.

You don’t have to know much about device files and device numbers, except
to be aware of their existence.

In case you're curious, all the major and minor numbers for devices are
assigned according to device type. The Linux Assigned Names And Numbers
Authority (LANANA) assigns these numbers. You can see the current device
list at www.lanana.org/docs/device-list/devices. txt.

Block devices

The first letter in the listing of a device file also provides an important clue.
For the /dev/hda device, the first letter is b, which indicates that /dev/
hda is a block device — one that can accept or provide data in chunks (typi-
cally 512 bytes or 1K). By the way, /dev/hda refers to the first IDE hard
drive on your system (the C: drive in Windows). Hard drives, floppy drives,
and CD-ROM drives are all examples of block devices.

Character devices

If the first letter in the listing of a device file is ¢, the device is a character
device — one that can receive and send data one character (one byte) at a
time. For example, the serial port and parallel ports are character devices.
To see the specific listing of a character device, type the following command
in a terminal window:
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1ls -1 /dev/ttySO0 Book V
Chapter 1
The listing of this device is similar to the following:

crw-rw---- 1 root uucp 4, 64 Aug 16 14:50 /dev/ttySO

Note that the very first letter is c because /dev/ttyS0 — the first serial
port — is a character device.
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Network devices

Network devices that enable your system to interact with a network — for
example, Ethernet and dial-up Point-to-Point Protocol (PPP) connections —
are special because they need no file to correspond to the device. Instead,
the kernel uses a special name for the device. For example, Ethernet devices
are named etho for the first Ethernet card, ethl for the second one, and so
on. PPP connections are named ppp0, pppl, and so on.

Because network devices aren’t mapped to device files, no files correspond-
ing to these devices are in the /dev directory.

Persistent device naming with udev

Linux kernel 2.6 introduces a new approach for handling devices, based on
the following features:

4+ sysfs: Kernel 2.6 provides the sysfs file system, which is mounted on
the /sys directory of the file system. The sysfs file system displays
all the devices in the system as well as lots of information about each
device, including the location of the device on the bus, attributes such
as name and serial number, and the major and minor numbers of the
device.

4+ /sbin/hotplug: This program is called whenever a device is added or
removed. It can then do whatever is necessary to handle the device.

4 /sbin/udev: This program takes care of dynamically named devices
based on device characteristics such as serial number, device number
on a bus, or a user-assigned name based on a set of rules that are set
through the text file /etc/udev/udev.rules.

MBER The udev program’s configuration file is /etc/udev/udev.conf. Based
on settings in that configuration file, udev creates device nodes automati-
cally in the directory specified by the udev_root parameter. For example,
to manage the device nodes in the /dev directory, udev_root should be
defined in /etc/udev/udev.conf as follows:

udev_root="/dev/"
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Managing Loadable Driver Modules

To use any device, the Linux kernel must contain the driver. If the driver
code is linked into the kernel as a monolithic program (a program in the form
of a single, large file), adding a new driver means rebuilding the kernel with
the new driver code. Rebuilding the kernel means you have to reboot the PC
with the new kernel before you can use the new device driver. Luckily, the
Linux kernel uses a modular design that does away with rebooting hassles.
Linux device drivers can be created in the form of modules that the kernel
can load and unload without having to restart the PC.

‘x‘gN\BEI? Driver modules are one type of a broader category of software modules
& called loadable kernel modules. Other types of kernel modules include code
that can support new types of file systems, modules for network protocols,
and modules that interpret different formats of executable files.

Loading and unloading modules

You can manage the loadable device driver modules by using a set of com-
mands. You have to log in as root to use some of these commands. Table
1-12 summarizes a few commonly used module commands.

Table 1-12 Commands to Manage Kernel Modules

This Command Does the Following

insmod Inserts a module into the kernel.

rmmod Removes a module from the kernel.

depmod Determines interdependencies between modules.

ksyms Displays a list of symbols along with the name of the
module that defines the symbol.

lsmod Lists all currently loaded modules.

modinfo Displays information about a kernel module.

modprobe Inserts or removes a module or a set of modules intel-

ligently. (For example, if module A requires B, modprobe
automatically loads B when asked to load A.)

If you have to use any of these commands, log in as root or type su - in a
terminal window to become root.

To see what modules are currently loaded, type

1lsmod
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You see a long list of modules. The list that you see will depend on the types
of devices installed on your system.

The list displayed by 1smod includes all types of Linux kernel modules, not
just device drivers. For example, if you use the Ext3 file system, you typically
find two modules — jbd and ext3 — that are part of the Ext3 file system
(the latest file system for Linux).

Besides 1smod, one commonly used module command is modprobe. Use
modprobe when you need to manually load or remove one or more modules.
The best thing about modprobe is that you don’t need to worry if a module
requires other modules to work. The modprobe command automatically
loads any other module needed by a module. For example, to manually load
the sound driver, use the command

modprobe snd-card-0

This command causes modprobe to load everything needed to make sound
work.

You can use modprobe with the -r option to remove modules. For example,
to remove the sound modules, use the following command:

modprobe -r snd-card-0

This command gets rid of all the modules that the modprobe snd-card-0
command had loaded.

Using the /etc/modprobe.conf file

How does the modprobe command know that it needs to load the snd-
intel8x0 driver module? The answer’s in the /etc/modprobe.conf con-
figuration file. That file contains a line that tells modprobe what it should
load when it sees the module name snd-card-0.

To view the contents of /etc/modprobe. conf, type
cat /etc/modprobe.conf

For example, consider a /etc/modprobe. conf file that contains the follow-
ing lines:

alias eth0 3c¢c59x
alias snd-card-0 snd-intel8x0
alias usb-controller uhci-hcd

Each line that begins with the keyword alias defines a standard name for
an actual driver module. For example, the first line defines 3c59x as the
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actual driver name for the alias eth0, which stands for the first Ethernet
card. Similarly, the third line defines snd-intel8x0 as the module to load
when the user uses the name snd-card-0.

The modprobe command consults the /etc/modprobe. conf file to con-
vert an alias to the real name of a driver module. It also consults the /etc/
modprobe. conf file for other tasks, such as obtaining parameters for driver
modules. For example, you can insert lines that begin with the options key-
word to provide values of parameters that a driver may need.

For example, to set the debug level parameter for the Ethernet driver to 5
(this parameter generates lots of information in /var/log/messages), add
the following line to the /etc/modprobe. conf file:

options 3c¢c59x debug=5

This line specifies 5 as the value of the debug parameter in the 3c¢59x
module.

If you want to know the names of the parameters that a module accepts, use
the modinfo command. For example, to view information about the 3¢59x
driver module, type

modinfo 3c59x | more

From the resulting output, it’s possible to tell that debug is the name of the
parameter for setting the debug level.

Unfortunately, the information displayed by the modinfo command can be
cryptic. The only saving grace is that you may not have to do much more
than use a graphical utility to configure the device, and the utility takes
care of adding whatever is needed to configuration files, such as /etc/
modprobe.conf.

Scheduling Jobs in Linuyx

As a system administrator, you may have to run some programs automati-
cally at regular intervals or execute one or more commands at a specified
time in the future. Your Linux system includes the facilities to schedule jobs
to run at any future date or time you want. You can also set up the system to
perform a task periodically or just once. Here are some typical tasks you can
perform by scheduling jobs on your Linux system:

4+ Back up the files in the middle of the night

4+ Download large files in the early morning when the system isn’t busy
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4+ Send yourself messages as reminders of meetings

4+ Analyze system logs periodically and look for any abnormal activities

You can set up these jobs by using the at command or the crontab facility
of Linux. The next few sections introduce these job-scheduling features of
Linux.

Scheduling one-time jobs

If you want to run one or more commands at a later time, you can use the
at command. The atd daemon — a program designed to process jobs sub-
mitted using at — runs your commands at the specified time and mails the
output to you.

Before you try the at command, you need to know that the following config-
uration files control which users can schedule tasks using the at command:

4 /etc/at.allow contains the names of the users who may submit jobs
using the at command.

4 /etc/at.deny contains the names of users not allowed to submit jobs
using the at command.

If these files aren’t present or if you find an empty /etc/at .deny file, any
user can submit jobs by using the at command. The default in Linux is an
empty /etc/at.deny file; with this default in place, anyone can use the
at command. If you don’t want some users to use at, simply list their user-
names in the /etc/at.deny file.

To use at to schedule a one-time job for execution at a later time, follow
these steps:

1. Run the at command with the date or time when you want your com-
mands executed.

When you press Enter, the at> prompt appears, as follows:

at 21:30
at>

This method is the simplest way to indicate the time when you want to
execute one or more commands — simply specify the time in a 24-hour
format. In this case, you want to execute the commands at 9:30 p.m.
tonight (or tomorrow, if it’s already past 9:30 p.m.). You can, however,
specify the execution time in many different ways. (See Table 1-13 for
examples.)

2. At the at> prompt, type the commands you want to execute as if you
were typing at the shell prompt. After each command, press Enter and
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continue with the next command. When you finish entering the com-
mands you want to execute, press Ctrl+D to indicate the end.

Here’s an example that shows how to execute the ps command at a
future time:

at> ps
at> <EOT>
job 1 at 2006-12-28 21:30

After you press Ctrl+D, the at command responds with the <EOT> mes-
sage, a job number, and the date and time when the job will execute.

Table 1-13 Formats for the at Command for the Time of Execution

Command When the Job Will Run

at now Immediately

at now + 15 minutes 15 minutes from the current time

at now + 4 hours 4 hours from the current time

at now + 7 days 7 days from the current time

at noon At noontime today (or tomorrow, if already
past noon)

at now next hour Exactly 60 minutes from now

at now next day At the same time tomorrow

at 17:00 tomorrow At 5 p.m. tomorrow

at 4:45pm At 4:45 p.m. today (or tomorrow, if it's already
past 4:45 p.m.)

at 3:00 Dec 28, 2011 At 3:00 a.m. on December 28, 2011

After you enter one or more jobs, you can view the current list of scheduled
jobs with the atg command:

atg
The output looks similar to the following:

4 2010-12-28 03:00 a root
5 2010-10-26 21:57 a root
6 2011-10-26 16:45 a root

The first field on each line shows the job number — the same number that
the at command displays when you submit the job. The next field shows the
year, month, day, and time of execution. The last field shows the jobs pend-
ing in the a queue.



\\J

Scheduling Jobs in Linux 3 27

If you want to cancel a job, use the atrm command to remove that job from
the queue. When removing a job with the atrm command, refer to the job by
its number, as follows:

atrm 4
This command deletes job 4 scheduled for 3:00 a.m. December 28, 2010.

When a job executes, the output is mailed to you. Type mail at a terminal
window to read your mail and to view the output from your jobs.

Scheduling recurring jobs

Although at is good for running commands at a specific time, it’s not useful
for running a program automatically at repeated intervals. You have to use
crontab to schedule such recurring jobs — for example, if you want to back
up your files to tape at midnight every evening.

You schedule recurring jobs by placing job information in a file with a spe-
cific format and submitting this file with the crontab command. The cron
daemon — crond — checks the job information every minute and executes
the recurring jobs at the specified times. Because the cron daemon pro-
cesses recurring jobs, such jobs are also referred to as cron jobs.

Any output from a cron job is mailed to the user who submits the job. (In
the submitted job-information file, you can specify a different recipient for
the mailed output.)

Two configuration files control who can schedule cron jobs using crontab:
4 /etc/cron.allow contains the names of the users who may submit
jobs using the crontab command.
4 /etc/cron.deny contains the names of users not allowed to submit

jobs using the crontab command.

If the /etc/cron.allow file exists, only users listed in this file can sched-
ule cron jobs. If only the /etc/cron. deny file exists, users listed in this
file can’t schedule cron jobs. If neither file exists, the default Linux setup
enables any user to submit cron jobs.

To submit a cron job, follow these steps:

1. Prepare a shell script (or an executable program in any programming
language) that can perform the recurring task you want to perform.

You can skip this step if you want to execute an existing program
periodically.
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2.

Prepare a text file with information about the times when you want
the shell script or program (from Step 1) to execute and then submit
this file by using crontab.

You can submit several recurring jobs with a single file. Each line with
timing information about a job has a standard format, with six fields —
the first five specify when the job runs, and the sixth and subsequent
fields constitute the command that runs. For example, here’s a line that
executes the myjob shell script in a user’s home directory at five min-
utes past midnight each day:

5 0 * * * SHOME/myjob

Table 1-14 shows the meaning of the first five fields. Note: An asterisk
(*) means all possible values for that field. Also, an entry in any of the
first five fields can be a single number, a comma-separated list of num-
bers, a pair of numbers separated by a hyphen (indicating a range of
numbers), or an asterisk.

Suppose the text file jobinfo (in the current directory) contains the
job information. Submit this information to crontab with the follow-
ing command:

crontab jobinfo

That’s it! You're set with the cron job. From now on, the cron job runs at
regular intervals (as specified in the job information file), and you receive
mail messages with the output from the job.

To verify that the job is indeed scheduled, type the following command:

crontab -1

The output of the crontab -1 command shows the cron jobs currently
installed in your name. To remove your cron jobs, type crontab -r.

Table1-14  Format for the Time of Execution in crontab Files

Field Meaning of Field Acceptable Range of Values™
Number

1 Minute 0-59

2 Hour of the day 0-23

3 Day of the month 0-31
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Field Meaning of Field Acceptable Range of Values* Book V
Number Chapter 1
4 Month 1-12 (1 means January, 2 means February,

and so on) or the names of months using
the first three letters — Jan, Feb, Mar, Apr,
May, Jun, Jul, Aug, Sep, Oct, Nov, Dec

5 Day of the week 0-6 (0 means Sunday, 1 means Monday,
and so on) or the three-letter abbreviations
of weekdays — Sun, Mon, Tue, Wed, Thu,
Fri, Sat

*An asterisk in a field means all possible values for that field. For example, if an asterisk is in the
third field, the job is executed every day.
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If you log in as root, you can also set up, examine, and remove cron jobs
for any user. To set up cron jobs for a user, use this command:

crontab -u username filename

Here, username is the user for whom you install the cron jobs, and file
name is the file that contains information about the jobs.

Use the following form of crontab command to view the cron jobs for a
user:

crontab -u username -1
To remove a user’s cron jobs, use the following command:

crontab -u username -r

Note: The cron daemon also executes the cron jobs listed in the system-
wide cron job file /etc/crontab. Here’s a typical /etc/crontab file from
a Linux system (type cat /etc/crontab to view the file):

SHELL=/bin/bash

PATH=/sbin: /bin:/usr/sbin:/usr/bin
MAILTO=root

HOME=/

# run-parts

01 * * * * root run-parts /etc/cron.hourly

02 4 * * * root run-parts /etc/cron.daily
22 4 * * 0 root run-parts /etc/cron.weekly
42 4 1 * * root run-parts /etc/cron.monthly
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The first four lines set up several environment variables for the jobs listed in
this file. The MATL.TO environment variable specifies the user who receives
the mail message with the output from the cron jobs in this file.

The line that begins with # is a comment line. The four lines following the
run-parts comment execute the run-parts shell script (located in the
/usr/bin directory) at various times with the name of a specific directory
as argument. Each of the arguments to run-parts — /etc/cron.hourly,
/etc/cron.daily, /etc/cron.weekly, and /etc/cron.monthly — are
directories. Essentially, run-parts executes all scripts located in the direc-
tory that you provide as an argument.

Table 1-15 lists the directories where you can find these scripts and when
they execute. You have to look at the scripts in these directories to know
what executes at these periodic intervals.

Table 1-15 Script Directories for cron Jobs
Directory Name Script Executes
/etc/cron.hourly Every hour
/etc/cron.daily Each day
/etc/cron.weekly Weekly

/etc/cron.monthly Once each month




Chapter 2: Managing Users
and Groups

In This Chapter

» Managing a user account with a GUI user manager and commands
+ Understanding the password file

v Managing your groups

v Working in the user environment

+ Changing user and group ownerships of files and directories

Linux is a multiuser system, so it has many user accounts. Even if you're
the only user on your system, many servers require a unique username
and group name. For example, the FTP server runs under the username ftp.
A whole host of system user accounts aren’t for people but just for running
specific programs.

Also, user accounts can belong to one or more groups. Typically, each
username has a corresponding private group name. By default, each user
belongs to that corresponding private group. However, you can define other
groups for the purpose of providing access to specific files and directories
based on group membership.

User and group ownerships of files are a way to make sure that only the
right people (or the right process) can access the right files and directories.
Managing the user and group accounts is a typical system administration
job. It’s not hard to do this part of the job, given the tools that come with
Linux, as you discover in this chapter.

Adding User Accounts

You get the chance to add user accounts when you boot your system for the
first time after installing Linux. The root account is the only one that you
must set up during installation. If you don’t add other user accounts when
you start the system for the first time, you can add new users later on, using
a GUI user account manager or the useradd command.
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\‘&N\BEI; Creating other user accounts besides root is a good idea. Even if you're the
& only user of the system, logging in as a less privileged user is good practice
because that way you can’t damage any important system files inadver-
tently. If necessary, you can type su - to log in as root and then perform
any system administration tasks.

Managing user accounts by using a GUI
user manager

Most Linux distributions come with a GUI tool to manage user accounts.
You can use that GUI tool to add new user accounts. The tool displays a list
of current user accounts and has an Add button for adding new users, as
shown in Figure 2-1.

Users Settings [=]=]x]
Figure 2-1: ‘ Knistiid  kristind Change...
e I— e
In UbUntU, Create New User
Account type: Desktop user Change...
you can Create a new user
manage Password: Asked on login Change...
user and Name: ‘Evan Dulaney| |
group short Name: ‘evand ‘ v|
accounts @  shortname must consist of:
~ lower case letters from the English alphabet
from the = digits
UserS and > any of the characters ".", "-"and "_"
"] Encrypt home folder to protect sensitive data =
G rou ps Manage Groups | ‘ Advanced Settings |
interface. Cancel | | Close |

The basic steps, regardless of the specific GUI tool, are as follows:

1. Click the Add User button.

A dialog box prompts you for information about the password for the
new user account, as shown in Figure 2-2.

2. Enter the requested information.
The GUI tool takes care of adding the new user account.
3. (Optional) Click Advanced Settings for the user (refer to Figure 2-1) to

configure additional information.

The Advanced tab (shown in Figure 2-3) allows you to override the
defaults for the home directory, shell, and ID information.
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NSPEC,,  For example, in SUSE, select the Security and Users category from the

€ left side of the YaST Control Center, and then click the User Management
icon in the right side of the window. YaST displays the User and Group
Administration pane, where you can define new user accounts.

(9
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Note that the pane has two types of accounts it can configure: Users and
Groups. Selecting Manage Groups displays the names of groups from the /
etc/group, as shown in Figure 2-4.
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Figure 2-4:
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Initially, the User and Group Administration tool filters out any system
users and groups. However, you can view the system users by choosing
Edit->Preferences and setting the filter to System Users from the drop-down
list or check box, depending on your distribution. (System Users refers

to user accounts that aren’t assigned to human users; rather, these user
accounts are used to run various services.) You need to be the root user to
access the features of this utility.

To add a new user account, click the Add button and enter the information
requested in the New Local User window.

Fill in the requested information in the window and then click the Accept
button. The new user now appears in the list of users in the User and Group
Administration pane.

You can add more user accounts, if you like. When you finish, click the
Finish button in the User and Group Administration pane to create the new
user accounts.

By default, YaST places all local users in a group named users. Sometimes
you want a user to be in another group as well so that the user can access
the files owned by that group. Adding a user to another group is easy. For
example, to add the username kdulaney to the group called wheel, type
the following command in a terminal window:

usermod -G wheel kdulaney

To remove a user account, click the username in the list of user accounts
and then click the Delete button.

Managing user accounts by using commands

If you're working from a text console, you can create a new user account by
using the useradd command. Follow these steps to add an account for a
new user:



Understanding the /etc/passwd File 335

1. Log in as root. Book V
R . Chapter 2
If you're not already logged in as root, type su - to become root.

2. Type the following useradd command with the -c option to create
the account:

/usr/sbin/useradd -c “Kristin Dulaney” kdulaney

3. Set the password by using the passwd command, as follows:

sdnoig pue
s19s) Huibeuepy

passwd kdulaney

You're prompted for the password twice. If you type a password that
someone can easily guess, the passwd program will scold you and sug-
gest that you use a more difficult password.

The useradd command consults the following configuration files to obtain
default information about various parameters for the new user account:

4 /etc/default/useradd: Specifies the default shell (/bin/bash) and
the default home directory location (/home)

4 /etc/login.defs: Provides system-wide defaults for automatic group
and user IDs, as well as password-expiration parameters

4 /etc/skel: Contains the default files that useradd creates in the
user’s home directory

Examine these files with the cat or more commands to see what they contain.
/usr/sbin/userdel username at the command prompt where username

is the name of the user you want to remove. To wipe out that user’s home
directory as well, type /usr/sbin/userdel -r username.

\‘&N\BEB You can delete a user account by using the userdel command. Simply type
<
&

To modify any information in a user account, use the usermod command.
For example, for user kdulaney to have root as the primary group, type
the following:

usermod -g root kdulaney

\4
<~ To find out more about the useradd, userdel, and usermod commands,
type man useradd, man userdel, or man usermod, respectively, in a ter-

minal window.

Understanding the /etc/passwd File

The /etc/passwd file is a list of all user accounts. It’s a text file and any
user can read it — no special privileges needed. Each line in /etc/passwd
has seven fields, separated by colons (:).
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Here’s a typical entry from the /etc/passwd file:

kdulaney:x:1000:1000:Kristin Dulaney,,,, :/home/kdulaney:/bin/bash

As the example shows, the format of each line in /etc/passwd looks

like this:

username:password: UID: GID: GECOS: homedir: shell

Table 2-1 explains the meaning of the seven fields in each /etc/passwd

entry.

Table 2-1

Fields in the /etc/passwd File

This Field

Contains

username

An alphanumeric username, usually 8 characters long
and unique. (Linux allows usernames to be longer
than 8 characters, but some other operating systems
do not.)

password

When present, a 13-character encrypted password.
(An empty field means that no password is required
to access the account. An x means the password
is stored in the /etc/shadow file, which is more
secure.)

UID

A unigue number that serves as the user identifier.
(root hasa UID of 0, and usually UTDs from 1 to
100 are reserved for nonhuman users such as serv-
ers; keeping the UID less than 32, 767 is best.)

GID

The default group ID of the group to which the user
belongs (1D 0 s for group root, other groups are
defined in /etc/group, and users can be, and
usually are, in more than one group at a time).

GECOS

Optional personal information about the user. (The
finger command uses this field and GECOS stands
for General Electric Comprehensive Operating
System, a long-forgotten operating system that's
immortalized by the name of this field in /etc/
passwd.)

homedir

The name of the user’s home directory.

shell

The command interpreter (shell), such as bash
(/bin/bash), which executes when this user logs in.
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A group is something to which users belong. A group has a name and an
identification number (ID). After a group is defined, users can belong to one
or more of these groups.

You can find all the existing groups listed in /etc/group. For example,
here’s the line that defines the group named wheel:
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wheel:x:10:root, kdulaney

As this example shows, each line in /etc/group has the following format,
with four fields separated by colons:

groupname: password: GID: membership

Table 2-2 explains the meaning of the four fields in a group definition.

Table 2-2 Meaning of Fields in /etc/group File

Field Name Meaning

groupname The name of the group (for example, wheel)

password The group password (an x means that the password is
stored in the /etc/shadow file)

GID The numerical group ID (for example, 10)

membership A comma-separated list of usernames that belong to

this group (for example, root , kdulaney)

If you want to create a new group, you can simply use the groupadd com-
mand. For example, to add a new group called class with an automatically
selected group ID, type the following command in a terminal window (you
have to be logged in as root):

groupadd class

Then you can add users to this group with the usermod command. For
example, to add the user kdulaney to the group named class, type the fol-
lowing commands:

usermod -G class kdulaney
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If you want to remove a group, use the groupdel command. For example, to
remove a group named class, type

groupdel class

Exploring the User Environment

When you log in as a user, you get a set of environment variables that con-
trol many aspects of what you see and do on your Linux system. If you want
to see your current environment, type the following command in a terminal
window:

env

(By the way, the printenv command also displays the environment, but
env is shorter.)

The env command prints a long list of lines. The collection of lines is the
current environment, and each line defines an environment variable. For
example, the env command displays this typical line:

HOSTNAME=localhost.localdomain

This line defines the environment variable HOSTNAME as localhost.
localdomain.

An environment variable is nothing more than a name associated with a
string. For example, the environment variable named PATH is typically
defined as follows for a normal user:

PATH=/usr/local/bin:/bin:/usr/bin:/usr/local/sbin: /usr/
sbin:/sbin

The string to the right of the equal sign (=) is the value of the PATH environ-
ment variable. By convention, the PATH environment variable is a sequence
of directory names, each name separated by a colon (:).

Each environment variable has a specific purpose. For example, when the
shell has to search for a file, it simply searches the directories listed in the
PATH environment variable in the order of their appearance. Therefore, if
two programs have the same name, the shell executes the one it finds first.

In a fashion similar to the shell’s use of the PATH environment variable, an
editor such as vi uses the value of the TERM environment variable to figure
out how to display the file you edit with vi. To see the current setting of
TERM, type the following command at the shell prompt:
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echo S$STERM

If you type this command in a terminal window, the output is as follows:
Xterm

To define an environment variable in bash, use the following syntax:
export NAME=Value

Here, NAME denotes the name of the environment variable, and value is the
string representing its value. Therefore, you set TERM to the value xterm by
using the following command:

export TERM=xterm

After you define an environment variable, you can change its value by simply
specifying the new value with the syntax NAME=new-value. For example,

to change the definition of TERM to vt100, type TERM=vt100 at the shell
prompt.

With an environment variable, such as PATH, you typically want to append a
new directory name to the existing definition rather than define the PATH from
scratch. For example, if you download and install the Java 5 Development

Kit (available from http://java.sun.com/javase/downloads/index_
jdk5. jsp), you have to add the location of the Java binaries to PATH. Here’s
how you accomplish that task:

export PATH=$PATH:/usr/java/jdkl.5.0/bin

This command appends the string : /usr/java/jdkl.5.0/bin to the cur-
rent definition of the PATH environment variable. The net effect is to add /
usr/java/jdkl.5.0/bin to the list of directories in PATH.

Note: You also can write this export command as follows:

export PATH=${PATH}:/usr/java/jdkl.5.0/bin

After you type that command, you can access programs in the /usr/java/
jdk1l.5.0/bin directory, such as javac, the Java compiler that converts

Java source code into a form that the Java interpreter can execute.

PATH and TERM are only two of a handful of common environment variables.
Table 2-3 lists some of the environment variables for a typical Linux user.

Book V
Chapter 2
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Table 2-3 Typical Environment Variables in Linux

Environment Variable Contents

DISPLAY The name of the display on which the X Window
System displays output (typically setto : 0. 0)

HOME Your home directory

HOSTNAME The host name of your system

LOGNAME Your login name

MAIL The location of your mail directory

PATH The list of directories in which the shell looks for
programs

SHELL Your shell (SHELL=/bin/bash for bash)

TERM The type of terminal

Changing User and Group Ownership of Files

In Linux, each file or directory has two types of owners: a user and a group.
In other words, a user and group own each file and directory. The user and
group ownerships can control who can access a file or directory.

To view the owner of a file or directory, use the 1s -1 command to see the
detailed listing of a directory. For example, here’s a typical file’s information:

-rw-rw-r-- 1 kdulaney kdulaney 40909 Aug 16 20:37 composer.
txt

In this example, the first set of characters shows the file’s permission
setting — who can read, write, or execute the file. The third and fourth
fields (in this example, kdulaney kdulaney) indicate the user and group
owner of the file. Each user has a private group that has the same name as
the username. So most files’ user and group ownership appear to show the
username twice.

As a system administrator, you may decide to change the group ownership
of a file to a common group. For example, suppose you want to change the
group ownership of the composer. txt file to the class group. To do that,
log in as root and type the following command:

chgrp class composer.txt
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This chgrp command changes the group ownership of composer. txt to
class.

You can use the chown command to change the user owner. The command
has the following format:

chown username filename

For example, to change the user ownership of a file named sample. jpg to
kdulaney, type

chown kdulaney sample.jpg

The chown command can change both the user and group owner at the
same time. For example, to change the user owner to kdulaney and the
group owner to class, type

chown kdulaney.class composer.txt

In other words, you simply append the group name to the username with a
period in between and then use that as the name of the owner.

Book V
Chapter 2
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Chapter 3: Managing File Systems

In This Chapter

+ Navigating the Linux file system
v~ Sharing files with NFS

v+~ Backing up and restoring files
+» Mounting the NTFS file system
v Accessing MS-DOS files

A file system refers to the organization of files and directories. As a
system administrator, you have to perform certain operations to
manage file systems on various storage media. For example, you have to
know how to mount — add a file system on a storage medium by attaching
it to the overall Linux file system. You also have to back up important data
and restore files from a backup. Other file-system operations include shar-
ing files with the Network File System (NFS) and accessing MS-DOS files.
This chapter shows you how to perform all file-system management tasks.

Exploving the Linux File System

The files and directories in your PC store information in an organized
manner, just like paper filing systems. When you store information on
paper, you typically put several pages in a folder and then store the folder
in a file cabinet. If you have many folders, you probably have some sort of
filing system. For example, you may label each folder’s tab and then arrange
them alphabetically in the file cabinet. You might have several file cabinets,
each with lots of drawers, which, in turn, contain folders full of pages.

Operating systems, such as Linux, organize information in your computer
in a manner similar to your paper filing system. Linux uses a file system to
organize all information in your computer. Of course, the storage medium
isn’t a metal file cabinet and paper. Instead, Linux stores information on
devices such as hard drives, USB drives, and DVD drives.

To draw an analogy between your computer’s file system and a paper filing
system, think of a disk drive as the file cabinet. The drawers in the file cabi-
net correspond to the directories in the file system. The folders in each
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Figure 3-1:
It's a bit of
a stretch,
but you
can think
of the Linux
file system
as similar
to a filing
cabinet.

drawer are also directories — because a directory in a computer file system
can contain other directories. You can think of files as the pages inside the
folder — and that’s where the actual information is stored. Figure 3-1 illus-
trates the analogy between a file cabinet and the Linux file system.
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The Linux file system has a hierarchical structure — directories can contain
other directories, which in turn contain individual files.

Everything in your Linux system is organized in files and directories. To
access and use documents and programs on your system, you have to be
familiar with the file system.

Understanding the file-system hierarchy

The Linux file system is organized like a tree, with a root directory from
which all other directories branch out. When you write a complete path-
name, the root directory is represented by a single slash (/). Then there’s a
hierarchy of files and directories. Parts of the file system can be in different
physical drives or different hard drive partitions.

Linux uses a standard directory hierarchy. Figure 3-2 shows some of the
standard parts of the Linux file system. You can create new directories any-
where in this structure.
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Write the name of any file or directory by concatenating the names of direc-
tories that identify where that file or directory is and by using the forward
slash (/) as a separator. For example, in Figure 3-2, the usr directory at the
top level is written as /usr because the root directory (/) contains usr.
On the other hand, the X11R6 directory is inside the usr directory, which
is inside the root directory (/). Therefore, the X11R6 directory is uniquely
identified by the name /usr/X11R6. This type of full name is a pathname
because the name identifies the path you take from the root directory to
reach a file. Thus, /usr/X11R6 is a pathname.

The Filesystem Hierarchy Standard (FHS) specifies the organization of files
and directories in UNIX-like operating systems, such as Linux. FHS defines

a standard set of directories and their intended use. The FHS, if faithfully
adopted by all Linux distributions, should help improve the interoperability
of applications, system administration tools, development tools, and scripts
across all Linux distributions. FHS even helps the system documentation as
well as books like this one because the same description of the file system
applies to all Linux distributions. Version 2.3 of FHS was announced on
January 29, 2004. FHS 2.3 is part of the Linux Standard Base version 3.x (LSB
3.0), which was released on July 1, 2005. The standard was updated with 3.1
on October 25, 2005, and 3.2 on January 28, 2008. LSB 3.x (see www. 1inux
base.org) is a set of binary standards aimed at reducing variations among
the Linux distributions and promoting portability of applications. As of this
writing, the most current Base is 4.0.3 (April 2010). To find out more about
FHS, check out the FHS home page at www.pathname. com/ths.

Each of the standard directories in the Linux file system has a specific pur-
pose. Table 3-1, Table 3-2, and Table 3-3 summarize these directories.



3 46 Exploring the Linux File System

Table 3-1 Standard Directories in Linux File System

Directory Used to Store

/bin Executable files for user commands (for use by all users)

/boot Files needed by the boot loader to load the Linux kernel

/dev Device files

/etc Host-specific system configuration files

/home User home directories

/1ib Shared libraries and kernel modules

/media Mount point for removable media

/mnt Mount point for a temporarily mounted file system

/opt Add-on application software packages

/root Home directory for the root user

/sbin Utilities for system administration

/sTv Data for services (such as Web and FTP) offered by this system

/ tmp Temporary files

Table 3-2 The /usr Directory Hierarchy

Directory Secondary Divectory Hierarchy

/usr/bin Most user commands

/usr/include Directory for include files—files that are inserted into
source code of applications by using various directives —
used in developing Linux applications

/usr/1lib Libraries used by software packages and for programming

/usr/libexec Libraries for applications

/usr/local Any local software

/usr/sbin Nonessential system administrator utilities

/usr/share Shared data that doesn’t depend on the system architec-

ture (whether the system is an Intel PC or a Sun SPARC
workstation)

/usr/src

Source code
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Table 3-3 The /var Directory Hierarchy

Directory Variable Data

/var/cache Cached data for applications

/var/lib Information relating to the current state of applications

/var/lock Lock files to ensure that a resource is used by one applica-
tion only

/var/log Log files organized into subdirectories

/var/mail User mailbox files

/var/opt Variable data for packages stored in the /opt directory

/var/run Data describing the system since it was booted

/var/spool Data that’s waiting for some kind of processing

/var/tmp Temporary files preserved between system reboots

/var/yp Network Information Service (NIS) database files

Mounting a device on the file system

The storage devices that you use in Linux contain Linux file systems. Each
device has its own local file system consisting of a hierarchy of directories.
Before you can access the files on a device, you have to attach the device’s
directory hierarchy to the tree that represents the overall Linux file system.

Mounting is the operation you perform to cause the file system on a physical
storage device (a hard drive partition or a CD-ROM) to appear as part of the
Linux file system. Figure 3-3 illustrates the concept of mounting.

Figure 3-3 shows each device with a name that begins with /dev. For
example, /dev/cdromn is the first DVD/CD-ROM drive. Physical devices are
mounted at specific mount points on the Linux file system. For example, the
DVD/CD-ROM drive, /dev/cdrom, is mounted on /media/cdrom in the file
system. After mounting the CD-ROM in this way, the Fedora directory on a
CD-ROM or DVD-ROM appears as /media/cdrom/Fedora in the Linux file
system.

You can use the mount command to manually mount a device on the Linux
file system at a specified directory. That directory is the mount point. For
example, to mount the DVD/CD-ROM drive at the /media/cdrom directory,
type the following command (after logging in as root):

mount /dev/cdrom /media/cdrom
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Figure 3-3:

You have

to mount a
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the Linux

file system

before

accessing it.

— /dev/cdrom
The mount command reports an error if the DVD/CD-ROM device is mounted
already or if no CD or DVD media is in the drive. Otherwise, the mount oper-
ation succeeds, and you can access the contents of the DVD or CD through
the /media/cdrom directory.

Q&N‘BEH You can use any directory as the mount point. If you mount a device on a

& nonempty directory, however, you can’t access the files in that directory

until you unmount the device by using the umount command. Therefore,
always use an empty directory as the mount point.

A\

To unmount a device when you no longer need it, use the umount command.
For example, for a DVD/CD-ROM device with the device name /dev/cdrom,
type the following command to unmount the device:

umount /dev/cdrom

The umount command succeeds as long as no one is using the DVD/
CD-ROM. If you get an error when trying to unmount the DVD/CD-ROM,
check to see if the current working directory is on the DVD or CD. If you're
currently working in one of the DVD/CD-ROM'’s directories, that also quali-
fies as a use of the DVD/CD-ROM.
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Examining the /etc/(stab file

The mount command has the following general format:
mount device-name mount-point

However, you can mount by specifying only the CD-ROM device name or the
mount-point name, provided there’s an entry in the /etc/fstab file for
the CD-ROM mount point. That entry specifies the CD-ROM device name and
the file-system type. That’s why you can mount the CD-ROM with a shorter
mount command.

For example, in Debian, you can mount the CD-ROM by typing one of the
following commands:

mount /dev/cdrom
mount /media/cdrom

The /etc/fstab file is a configuration file — a text file containing informa-
tion that the mount and umount commands use. Each line in the /etc/
fstab file provides information about a device and its mount point in the
Linux file system. Essentially, the /etc/fstab file associates various mount
points within the file system with specific devices, which enables the mount
command to work from the command line with only the mount point or the
device as argument.

Here’s a /etc/fstab file from a SUSE system. (The file has a similar format
in other Linux distributions.)

/dev/hdall / reiserfs acl,user_xattr 1 1

/dev/hda7 /boot ext3 acl,user_xattr 1 2

/dev/hda6 /datal auto noauto,user 0 0

/dev/hda9 /data2 auto noauto,user 0 0

/dev/hdal0 /data3 auto noauto,user 0 0

/dev/hda5 /data4 auto noauto,user 0 0

/dev/hda2 /windows/C ntfs ro,users,gid=users,umask=0002,nls=utf8 0 0

/dev/hda8 swap swap pri=42 0 0

devpts /dev/pts devpts mode=0620,gid=5 0 0

proc /proc proc defaults 0 0

usbfs /proc/bus/usb usbfs noauto 0 0

sysfs /sys sysfs noauto 0 0

/dev/cdrecorder /media/cdrecorder subfs fs=cdfss,ro,procuid,nosuid, nodev, exec, ioc
harset=utf8 0 0

The first field on each line shows a device name, such as a hard drive parti-
tion. The second field is the mount point, and the third field indicates the type
of file system on the device. You can ignore the last three fields for now.

This /etc/fstab file shows that the /dev/hda8 device functions as a swap
device for virtual memory, which is why both the mount point and the file-
system type are set to swap.

Book

v

Chapter 3

swajsig
a4 huibeuepy



35 0 Sharing Files with NFS

SPEC,
N\ /,e,o

(9

Q\S‘ RIB(/I)

The Linux operating system uses the contents of the /etc/fstab file to
mount various file systems automatically. During Linux startup, the init
process executes a shell script that runs the mount -a command. That
command reads the /etc/fstab file and mounts all listed file systems
(except those with the noauto option). The third field on each line of /etc/
fstab specifies the type of file system on that device, and the fourth field
shows a comma-separated list of options that the mount command uses
when mounting that device on the file system. Typically, you find the
defaults option in this field. The defaults option implies — among other
things — that the device mounts at boot time, that only the root user can
mount the device, and that the device mounts for both reading and writing.
If the options include noauto, the device doesn’t mount automatically when
the system boots.

In Fedora, you often find the managed option in the fourth field of /etc/
fstab entries. The managed option indicates that the line was added to the
fstab file by the HAL (hardware abstraction layer) daemon, which runs
the fstab-sync command to add entries in the /etc/£fstab file for each
removable drive that it detects. You typically find that the entries for DVD/
CD-ROM drive(s) (/dev/hdc in most systems) have the managed option in
the fourth field.

Sharing Files with NFS
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Sharing files through the NFS is simple and involves two basic steps:

4 On the NFS server, export one or more directories by listing them in the
/etc/exports file and by running the /usr/sbin/exportfs com-
mand. In addition, you must run the NFS server.

4 On each client system, use the mount command to mount the directo-
ries the server has exported.

How you start the NFS server depends on the Linux distribution. If a GUI
sysadmin tool is available, you can start the NFS server from the GUI tool.
Otherwise, you can type a command in a terminal window to start the NFS
server. For example, in Debian, you can type invoke-rc.d nfs-kernel-
server start and invoke-rc.d nfs-common start to start the NFS
server. In Fedora, type service nfs start. To start the NFS server in SUSE,
you can use the YaST Control Center: From the main menu, choose Systemr>
YaST=Systemr>System Services (Runlevel). In Xandros, you can start the NFS
server from the Xandros Control Center (Main Menu=>Control Center) or by
typing invoke-rc.d nfs-user-server start in aterminal window.

The only problem in using NFS is that each client system must support it.
Most PCs don’t come with NFS — that means you have to buy NFS software
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separately if you want to share files by using NFS. If, however, all systems
on your LAN run Linux (or other variants of UNIX with built-in NFS support),
using NFS makes sense.

NFS has security vulnerabilities. Therefore, don’t set up NFS on systems
directly connected to the Internet.

The upcoming section walks you through an NFS setup, using an example of
two Linux PCs on a LAN.

Exporting a file system with NFS

To export a file system with NFS, start with the server system that exports —
makes available to the client systems — the contents of a directory. On the
server, you must run the NFS service and also designate one or more file sys-
tems to be exported to the client systems.

You have to add an appropriate entry to the /etc/exports file. For exam-
ple, suppose you want to export the /home directory and you want to enable
the hostname LNBP75 to mount this file system for read and write opera-
tions. (You can use a host’s IP address in place of the hostname.) You can
do so by adding the following entry to the /etc/exports file:

/home LNBP75 (rw)
If you use the IP address of a host, the entry might look like this:
/home 192.168.1.200 (rw)

This specifies that 192.168.1.200 is the IP address of the host that’s allowed
full access to the /home directory.

After adding the entry in the /etc/exports file, start the NFS server using a
method appropriate for your Linux distribution. For example, in Fedora, log
in as root and type the following command in a terminal window:

service nfs start

When the NFS service is up, the server side of NFS is ready. Now you can
try to mount the exported file system from a client system and access the
exported file system.

If you ever make any changes to the exported file systems listed in the
/etc/exports file, remember to restart the NFS service. For example, in
Fedora, type service nfs restart in a terminal window. In Xandros, type
invoke-rc.d nfs-user-server restart.
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Mounting an NFS file system

To access an exported NFS file system on a client system, you have to mount
that file system on a mount point — which is, in practical terms, nothing
more than a local directory. For example, suppose you want to access the
/home /public directory exported from the server named LNBP200 at the
local directory /mnt/1nbp200 on the client system. To do so, follow these
steps:

1. Log in as root and create the directory with the following command:
mkdir /mnt/lnbp200

2. Type the following command to perform the mount operation:
mount 1nbp200:/home/public /mnt/lnbp200

If you know only the IP address of the server, replace the hostname (in
this case, 1nbp200) with the IP address.

3. Change the directory to /mnt /1nbp200 with the command cd /mnt/
1nbp200.

Now you can view and access exported files from this directory.

To confirm that the NFS file system is indeed mounted, log in as root on the
client system and type mount in a terminal window. You see a line similar to
the following about the NFS file system:

1nbp200: /home/public on /mnt/lnbp200 type nfs (rw,addr=192.168.1.200)

Backing Up and Restoring Files
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Backing up and restoring files is a crucial system administration task. If
something happens to your system’s hard drive, you have to rely on the
backups to recover important files. The following discussion presents
some backup strategies, describes several backup media, and explains how
to back up and restore files by using the tape archiver (tar) program that
comes with Linux. Also, you find out how to perform incremental and auto-
matic backups on tapes.

If you have a CD burner, you can back up files also by recording them on a
CD-R. Consult Book II, Chapter 4, for information on what application you
can use to burn a data CD.
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Selecting a backup strategy and media

Your Linux system’s hard drive contains everything you need to keep the
system running — as well as other files (such as documents and databases)
that keep your business running. You have to back up these files so you can
recover quickly and bring the system back to normal in case the hard drive
crashes. Typically, you have to follow a strict regimen of regular backups
because you can never tell when the hard drive may fail or the file system
may get corrupted. To implement such a regimen, first decide which files
you want to back up, how often, and what backup storage media to use. This
process is what is meant by selecting a backup strategy and backup media.

Your choice of backup strategy and backup media depends on your assess-
ment of the risk of business disruption due to hard drive failure. Depending
on how you use your Linux system, a disk failure may or may not have much
effect on you.

For example, if you use your Linux system as a learning tool (to find out
more about Linux or programming), all you may need are backup copies

of some system files required to configure Linux. In this case, your backup
strategy can be to save important system configuration files on one or more
floppies every time you change any system configuration.

On the other hand, if you use your Linux system as an office server that
provides shared file storage for many users, the risk of business disruption
due to disk failure is much higher. In this case, you have to back up all the
files every week and back up any new or changed files every day. You can
perform these backups in an automated manner (with the job-scheduling
features described in Chapter 1 of this minibook). Also, you probably need
a backup storage medium that can store many gigabytes of data. In other
words, for high-risk situations, your backup strategy is more elaborate and
requires additional equipment (such as a tape drive).

Your choice of backup media depends on the amount of data you have to
back up. For a small amount of data (such as system configuration files), you
can use USB flash drives as the backup media. If your PC has a Zip drive, you
can use Zip disks as backup media; these are good for backing up a single-
user directory. To back up entire servers, use an external hard drive (which
could be attached to the computer or the network) or a tape drive (typically
a 4mm or 8mm tape drive that connects to a SCSI controller). Such tape
drives can store several gigabytes of data per tape, and you can use them to
back up an entire file system on a single tape.

When backing up files to these media, you have to refer to the backup device
by name. Table 3-4 lists device names for some common backup devices.
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Table 3-4 Device Names for Common Backup Devices

Backup Device Linux Device Name

Floppy disk (where /dev/£d0
they still exist)

IDE Zip drive /dev/hdc4 or /dev/hdd4

SCSI Zip drive /dev/sda (assuming it's the first SCSI drive — otherwise,
the device name depends on the SCSI ID)

SCSI tape drive /dev/st0 or /dev/nst0 (the n prefix means that the

tape isn't rewound after files are copied to the tape)

Commercial backup utilities for Linux

The next section explains how to back up and restore files using the tape
archiver (tar) program that comes with Linux. Although you can manage
backups with tar, a number of commercial backup utilities come with
graphical user interfaces and other features to simplify backups. Here are
some well-known commercial backup utilities for Linux:

4+ BRU: A backup and restore utility from the TOLIS Group, Inc.
(www . tolisgroup.com)

4+ LONE-TAR: Tape backup software package from Lone Star Software
Corp. (www.cactus.com)

4+ Arkeia: Backup and recovery software for heterogeneous networks from
Arkeia (www.arkeia.com)

4+ CA ARCserve Backup for Linux: Data-protection technology for Linux
systems from Computer Associates (http://www.arcserve.com/us/
products/product.aspx?i1d=5282)

Using the tape archiver — tar

You can use the tar command to archive files to a device, such as a floppy
disk or tape. The tar program creates an archive file that can contain other
directories and files and (optionally) compress the archive for efficient stor-
age. The archive is then written to a specified device or another file. Many
software packages are distributed in the form of a compressed tar file.

The command syntax of the tar program is as follows:

tar options destination source
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Here, options are usually specified by a sequence of single letters, with
each letter specifying what tar does. The destinationis the device name
of the backup device. And source is a list of file or directory names denot-
ing the files to back up.

Backing up and restoring a single-volume archive

Suppose you want to back up the contents of the /etc/X11 directory on a
floppy disk. Log in as root, place a disk in the floppy drive, and type the fol-
lowing command:

tar zcvf /dev/£fd0 /etc/X11l

The tar program displays a list of filenames as each file is copied to the
compressed tar archive on the floppy disk. In this case, the options are
zcvE, the destination is /dev/£d0 (the floppy disk), and the source is the
/etc/X11 directory (which implies all its subdirectories and their con-
tents). You can use a similar tar command to back up files to a tape —
simply replace /dev/£d0 with the tape device — such as /dev/st0 for a
SCSI tape drive.

Table 3-5 defines a few common tar options.

Table 3-5 Common tar Options
Option Does the Following
c Creates a new archive.

Specifies the name of the archive file or device on the next field in
the command line.

M Specifies a multivolume archive. (The next section describes multi-
volume archives.)

t Lists the contents of the archive.

v Displays verbose messages.

x Extracts files from the archive.

z Compresses the tar archive using gzip.

To view the contents of the tar archive you create on the floppy disk, type
the following command:

tar ztf /dev/£d0
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You see a list of filenames (each begins with /etc/X11) indicating what’s in
the backup. In this tar command, the t option lists the contents of the tar
archive.

To extract the files from a tar backup, follow these steps while logged in as
root:

1. Change the directory to /tmp by typing this command:
cd /tmp

This step is where you can practice extracting the files from the tar
backup. For a real backup, change the directory to an appropriate loca-
tion (typically, you type cd /).

2. Type the following command:
tar zxvf /dev/£d0

This tar command uses the x option to extract the files from the
archive stored on /dev/£do0 (the floppy disk).

Now if you check the contents of the /tmp directory, you notice that the
tar command creates an etc/X11 directory tree in /tmp and restores all
the files from the tar archive into that directory. The tar command strips
the leading / from the filenames in the archive and restores the files in the
current directory. If you want to restore the /etc/X11 directory from the
archive on the floppy, use this command:

tar zxvf /dev/fd0 -C /

The -C does a cd to the directory specified (in this case, the root directory
of /) before doing the tar; the / at the end of the command denotes the
directory where you want to restore the backup files.

You can use the tar command to create, view, and restore an archive. You
can store the archive in a file or in any device you specify with a device name.

Backing up and restoring a multivolume archive

Sometimes the capacity of a single storage medium is less than the total
storage space needed to store the archive. In this case, you can use the M
option for a multivolume archive — meaning the archive can span multiple
tapes or floppies (if you happen to be using an older machine that still has
them). Note, however, that you can’t create a compressed, multivolume
archive. That means you have to drop the z option. To see how multivolume
archives work, log in as root, place one disk in the floppy drive, and type
the following tar command:

tar cviM /dev/£fd0 /usr/share/doc/ghostscript*
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Note: The M tells tar to create a multivolume archive. The tar command
prompts you for a second floppy when the first one is filled. Take out the
first floppy and insert another floppy when you see the following prompt:

Prepare volume #2 for '/dev/£fd0' and hit return:

When you press Enter, the tar program continues with the second floppy.
In this example, you need only two floppies to store the archive; for larger
archives, the tar program continues to prompt for floppies as needed.

To restore from this multivolume archive, type ed /tmp to change the direc-
tory to /tmp. (I use the /tmp directory for illustrative purposes, but you have
to use a real directory when you restore files from archive.) Then type

tar xviM /dev/£d0
The tar program prompts you to feed the floppies as necessary.

Use the du -s command to determine the amount of storage you need for
archiving a directory. For example, type du -s /etc to see the total size of
the /etc directory in kilobytes. Here’s a typical output of that command:

35724 /etc

The resulting output shows that the /etc directory requires at least 35,724K
of storage space to back up.

Backing up on tapes

Although backing up on tapes is as simple as using the right device name in
the tar command, you do have to know some nuances of the tape device to
use it well. When you use tar to back up to the device named /dev/st0 (the
first SCSI tape drive), the tape device automatically rewinds the tape after the
tar program finishes copying the archive to the tape. The /dev/st0 device
is called a rewinding tape device because it rewinds tapes by default.

If your tape can hold several gigabytes of data, you may want to write sev-
eral tar archives — one after another — to the same tape (otherwise much
of the tape may be left empty). If you plan to do so, your tape device can’t
rewind the tape after the tar program finishes. To help you with scenarios
like this one, several Linux tape devices are nonrewinding. The nonrewind-
ing SCSI tape device is called /dev/nst0. Use this device name if you want
to write one archive after another on a tape.

After each archive, the nonrewinding tape device writes an end-of-file (EOF)
marker to separate one archive from the next. Use the mt command to control
the tape — you can move from one marker to the next or rewind the tape. For
example, after you finish writing several archives to a tape using the /dev/nst0
device name, you can force the tape to rewind with the following command:
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mt -f /dev/nst0 rewind

After rewinding the tape, you can use the following command to extract files
from the first archive to the current disk directory:

tar xvi /dev/nst0

After that, you must move past the EOF marker to the next archive. To do so,
use the following mt command:

mt —-f /dev/nst0 fsf 1

This positions the tape at the beginning of the next archive. Now use the tar
xvf command again to read this archive.
CMBER . :
If you save multiple archives on a tape, you have to keep track of the
archives yourself. The order of the archives can be hard to remember, so
you may be better off simply saving one archive per tape.

Performing incremental backups

Suppose you use tar to back up your system’s hard drive on a tape. Because
such a full backup can take quite some time, you don’t want to repeat this task
every night. (Besides, only a small number of files may have changed during
the day.) To locate the files that need backing up, you can use the £ind com-
mand to list all files that have changed in the past 24 hours:

find / -mtime -1 -type f -print

This command prints a list of files that have changed within the last day.
The -mtime -1 option means you want the files that were last modified less
than one day ago. You can now combine this £ind command with the tar
command to back up only those files that have changed within the last day:

tar cvf /dev/st0 “find / -mtime -1 -type f -print’

When you place a command between single back quotes, the shell executes
that command and places the output at that point in the command line. The
result is that the tar program saves only the changed files in the archive.
This process gives you an incremental backup of only the files that have
changed since the previous day.

Performing automated backups

Chapter 1 of this minibook shows how to use crontab to set up recurring
jobs (called cron jobs). The Linux system performs these tasks at regular
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intervals. Backing up your system is a good use of the crontab facility. Book V
Suppose your backup strategy is as follows: Chapter 3

4+ Every Sunday at 1:15 a.m., your system backs up the entire hard drive
on the tape.

4 Monday through Saturday, your system performs an incremental backup
at 3:10 a.m. by saving only those files that have changed during the past
24 hours.

swajsig
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To set up this automated backup schedule, log in as root and type the fol-
lowing lines in a file named backups (this example assumes that you are
using a SCSI tape drive):

15 1 * * 0 tar zcvf /dev/st0 /
10 3 * * 1-6 tar zcvf /dev/st0 “find / -mtime -1 -type f -print’

Next, submit this job schedule by using the following crontab command:
crontab backups

Now you're set for an automated backup. All you need to do is to place a
new tape in the tape drive every day. Remember also to give each tape an
appropriate label.

Accessing a DOS or Windows File System

If you're using a legacy machine that you just don’t want to throw out and
have Microsoft Windows 95, 98, or Me installed on your hard drive, you've
probably already mounted the DOS or Windows partition under Linux. If not,
you can easily mount DOS or Windows partitions in Linux. Mounting makes
the DOS or Windows directory hierarchy appear as part of the Linux file
system.

Mounting a DOS or Windows disk partition

To mount a DOS or Windows hard drive partition or floppy in Linux, use the
mount command but include the option -t vfat to indicate the file-system
type as DOS. For example, if your DOS partition happens to be the first parti-
tion on your IDE (Integrated Drive Electronics) drive and you want to mount
it on /dosc, use the following mount command:

mount -t vfat /dev/hdal /dosc
The -t vfat part of the mount command specifies that the device you

mount — /dev/hdal — has an MS-DOS file system. Figure 3-4 illustrates the
effect of this mount command.
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Figure 3-4:
Here's how
you mount
aDOS
partition on
the /dosc
directory.

i Linux File System

/bin /boot /dev /dosc /etc  /media ... /shin Jusr

/dosc/dos  /dosc/windows ...

DOS Partition
/dev/hda1l

/DOS  /WINDOWS

Figure 3-4 shows how directories in your DOS partition map to the Linux file
system. What was the C: \D0OS directory under DOS becomes /dosc/dos
under Linux. Similarly, C: \WINDOWS now is /dosc/windows. You probably
can see the pattern. To convert a DOS filename to Linux (when you mount
the DOS partition on /dosc), perform the following steps:

1. Change the DOS names to lowercase.
2. Change C:\ to /dosc/.
3. Change all backslashes (\) to slashes (/).

Mounting those old DOS floppy disks

Just as you mount a DOS hard drive partition on the Linux file system, you
can also mount a DOS floppy disk on a legacy machine. You must log in as
root to mount a floppy, but you can set up your system so that any user
can mount a DOS floppy disk. You also have to know the device name for
the floppy drive. By default, Linux defines the following two generic floppy
device names:
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4 /dev/£do0 is the A drive (the first floppy drive)
4+ /dev/£dl is the B drive (the second floppy drive, if you have one)
You can use any empty directory in the file system as the mount point, but

the Linux system comes with a directory, /media/f1loppy, specifically for
mounting a floppy disk.

To mount a DOS floppy disk on the /media/floppy directory, put the
floppy in the drive and type the following command:

mount -t vfat /dev/fd0 /media/floppy

After you mount the floppy, you can copy files to and from the floppy by
using the Linux copy command (cp). To copy the file gnomel . pcx from the
current directory to the floppy, type the following:

cp gnomel.pcx /media/floppy
Similarly, to see the contents of the floppy disk, type the following:
1ls /media/floppy

If you want to remove the floppy disk from the drive, first unmount the
floppy drive. Unmounting removes the association between the floppy disk’s
file system and the mount point on the Linux file system. Use the umount
command to unmount the floppy disk like this:

umount /dev/£d0

You can set up your Linux system so that any user can mount a DOS floppy.
To enable any user to mount a DOS floppy in the A drive on the /a directory,
for example, perform the following steps:

1. Log in as root.

2. Create the /a directory (the mount point) by typing the following com-
mand in a terminal window:

mkdir /a

3. Edit the /etc/£stab file in a text editor (such as vi or emacs) by
inserting the following line, and then save the file and quit the editor:

/dev/£d0 /a vfat noauto,user 0 0

The first field in that line is the device name of the floppy drive (/dev/
£40); the second field is the mount directory (/a); the third field shows
the type of file system (vfat). The user option (which appears next to
noauto) enables all users to mount DOS floppy disks.
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4. Log out and then log back in as a normal user.

5. To confirm that you can mount a DOS floppy as a normal user and not
just as root, insert a DOS floppy in the A drive and type the following
command:

mount /a

The mount operation succeeds, and you see a listing of the DOS floppy
when you type the command 1s /a.

6. To unmount the DOS floppy, type umount /a.

Mounting an NTFS partition

Nowadays, most PCs come with Windows Vista or Windows 7 pre-installed
on the hard drive. Both Windows Vista and Windows 7, as well as Windows
XP, typically use the NT File System (NTFS). Linux supports read-only access
to NTFS partitions, and many distributions come with the ntfs.ko kernel
module, which is needed to access an NTFS partition.

If you've installed Linux on a Windows XP system and want to access files
on the NTFS partition but your distribution doesn’t include the ntfs.ko
module, you can build the kernel after enabling an NTFS module during the
kernel configuration step.

After rebuilding and booting from the new kernel, log in as root and type
the following command to create a mount point for the NTFS partition. (In
this case, I'm creating a mount point in the /mnt directory.)

mkdir /mnt/xp

Now, you can mount the NTFS partition with the following command:

mount /dev/hda2 /mnt/xp -t ntfs -r -o umask=0222

If necessary, replace /dev/hda2 with the device name for the NTFS parti-
tion on your system. On most PCs that come with Windows XP pre-installed,
the NTFS partition is the second one (/dev/hda2) — the first partition

(/dev/hdal) is usually a hidden partition used to hold files used for
Windows XP installation.

Using mtools

One way to access the MS-DOS file system is to first mount the DOS hard
drive or floppy disk by using the mount command and then use regular
Linux commands, such as 1s and cp, to work with the mounted DOS file
system. This approach of mounting a DOS file system is fine for hard drives.
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Linux can mount the DOS partition automatically at startup, and you can
access the DOS directories on the hard drive at any time.

If you want a quick directory listing of a DOS floppy disk, however, mounting
can soon become tedious. First, you have to mount the floppy drive. Then
you must use the 1s command. Finally, you must use the umount command
before ejecting the floppy out of the drive.

This situation is where the mtools package comes to the rescue. The
mtools package implements most common DOS commands; the commands
use the same names as in DOS except you add an m prefix to each command.
Thus, the mdir command lists the directory listing and mcopy copies files.
The best part of mtools is the fact that you don’t have to mount the floppy
disk to use the mtools commands.

Because the mtools commands write to and read from the physical device
(floppy disk), you must log in as root to perform these commands. If you
want any user to access the mtools commands, you must alter the permis-
sion settings for the floppy drive devices. Use the following command to
permit anyone to read from and write to the first floppy drive:

chmod o+rw /dev/£fd0

Trying mtools

To try out mtools, follow these steps:

1. Place an MS-DOS floppy disk in your system’s A drive.
2. Type mdir.

You see the directory of the floppy disk (in the standard DOS directory
listing format).

Typically, you use the mtools utilities to access floppy disks. The default
configuration file, /etc/mtools. cont, is set up to access the floppy drive
as the A drive. Although you can edit that file to define C and D drives for
your DOS hard drive partitions, you can access the hard drive partitions also
by using the Linux mount command to mount them. Because you can mount
the hard drive partitions automatically at startup, accessing them through
the Linux commands is normally just as easy.

Understanding the /etc/mtools.conf file

The mtools package works with the default setup, but if you get any errors,
check the /etc/mtools. conf file. That file contains the definitions of the
drives (such as A, B, and C) that the mtools utilities see. Following are a few
lines from a typical /etc/mtools. conf file:
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drive a: file="/dev/fd0" exclusive mformat_only
drive b: file="/dev/fdl" exclusive mformat_only

# First SCSI hard disk partition

#drive c: file="/dev/sdal"

# First IDE hard disk partition on a Windows 98 PC
drive c: file="/dev/hdal"

# Internal IDE Zip drive

drive e: file="/dev/hdd4" exclusive

The pound sign (#) indicates the start of a comment. Each line defines a
drive letter, the associated Linux device name, and some keywords that
indicate how to access the device. In this example, the first two lines define
drives A and B. The third noncomment line defines drive C as the first parti-
tion on the first IDE drive (/dev/hdal). If you have other DOS drives (D, for
example), you can add another line that defines drive D as the appropriate
disk partition.

If your system’s A drive is a high-density, 3.5-inch drive, you don’t need to
change anything in the default /etc/mtools. conf file to access the floppy
drive. If you also want to access any DOS partition in the hard drive, uncom-
ment and edit an appropriate line for the C drive.

You also can access lomega Zip drives through mtools. Simply specify a
drive letter and the appropriate device’s filename. For built-in IDE (ATAPI)
Zip drives, try /dev/hdd4 as the device file and add the following line in the
/etc/mtools.conf file:

drive e: file="/dev/hdd4"

After you have made this change, you can use mtools commands to access
the Zip drive (refer to it as the E drive). For example, to see the directory
listing, place the Zip disk in the Zip drive and type:

mdir e:

Understanding the mtools commands

The mtools package is a collection of utilities. The discussion so far has
included mdir — the mtools counterpart of the DIR command in DOS. The
other mtools commands are fairly easy to use.

If you know MS-DOS commands, using the mtools commands is simple.

Type the DOS command in lowercase letters and remember to add m in front
of each command. Because the Linux commands and filenames are case-sen-
sitive, you must use all lowercase letters when you type mtools commands.

Table 3-6 summarizes the commands available in mtools.
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Table 3-6 The mtools Commands
mtools Utility MS-DOS The mtools Utility Does the Following
Command (1f Any)
mattrib ATTRIB Changes MS-DQOS file-attribute flags
mbadblocks Tests a floppy disk and marks the bad
blocks in the file allocation table (FAT)
mcd CD Changes an MS-DOS directory
mcopy COPY Copies files between MS-DOS and Linux
mdel DEL or Deletes an MS-DOS file
ERASE
mdeltree DELTREE Recursively deletes an MS-DOS directory
mdir DIR Displays an MS-DOS directory listing
mdu Lists space that a directory and its con-
tents occupy
mformat FORMAT Places an MS-DOS file system on a low-
level-formatted floppy disk (use fdformat
to low-level-format a floppy disk in Linux).
minfo Gets information about an MS-DOS file
system
mkmanifest Makes a list of short name equivalents
mlabel LABEL Initializes an MS-DOS volume label
mmd MD or MKDIR Creates an MS-DOS directory
mmove Moves or renames an MS-DOS file or
subdirectory
mmount Mounts an MS-DOS disk
mpartition Creates an MS-DOS file system as a
partition
mrd RD or RMDIR Deletes an MS-DOS directory
mren REN or Renames an existing MS-DOS file
RENAME
mshowfat Shows FAT entries for an MS-DOS file
mtoolstest Tests and displays the currentmtools
configuration
mtype TYPE Displays the contents of an MS-DOS file
mwrite COPY Copies a Linux file to MS-DOS
mzip Performs certain operations on SCSI Zip

disks
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You can use the mtools commands just as you use the corresponding DOS
commands. The mdir command, for example, works the same as the DIR
command in DOS. The same goes for all the other mtools commands shown
in Table 3-6.

You can use wildcard characters (such as *) with mtools commands, but
you must remember that the Linux shell is the first program to see your
command. If you don’t want the shell to expand the wildcard character all
over the place, use quotation marks around filenames that contain any wild-
card characters. For example, to copy all * . txt files from the A drive to
your current directory, use the following command:

mcopy "a:*.txt"

If you omit the quotation marks, the shell tries to expand the string a: * . txt
with filenames from the current Linux directory. It also tries to copy those
files (if any) from the DOS floppy disk.

On the other hand, if you want to copy files from the Linux directory to the
DOS floppy disk, you do want the shell to expand any wildcard characters.
To copy all *. jpg files from the current Linux directory to the DOS floppy
disk, for example, use mcopy like this:

mcopy *.Jjpg a:

With the mtools utilities, you can use the backslash character (\) as the
directory separator, just as you do in DOS. However, when you type a file-
name that contains the backslash character, you must enclose the name in
double quotation marks (" "). For example, here’s a command that copies a
file from a subdirectory on the A drive to the current Linux directory:

mcopy "a:\test\sample.dat"
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Chapter 4: Installing and Updating
Applications

In This Chapter

+» Working with RPM files with the rpm command
v Working with DEB files with dpkg, dselect, and APT
v Building applications from source files

v+ Online updating of Linux applications

M ost software packages for Linux are distributed in one of two special
file formats: Red Hat Package Manager (RPM) files or Debian (DEB)
files. That’s why you have to know how to install or remove software pack-
ages that come in the form of RPM or DEB files. This chapter illustrates how
to work with both types of files.

You can install RPM and DEB files in all Linux distributions, but each distri-
bution has its favored distribution format. Fedora, with its Red Hat Linux
heritage, favors RPM files, whereas most Debian-based distributions, such
as Knoppix, Ubuntu, and Xandros, use DEB files for distributing software.
SUSE Linux uses RPM format.

Many other open source software packages come in source-code form, usu-

ally in compressed archives. You have to unpack, build, and install the soft-

ware to use it. The following sections describe the steps you typically follow
when downloading, building, and installing source-based software packages.
There is also a brief description of how to update your Linux system online.

As you'll find out, each distribution has its own tools for online updates.

Working with RPM Files

RPM is a system for packaging all the necessary files for a software product
in a single file — called an RPM file, or simply, an RPM. In fact, the Fedora
and SUSE distributions are a whole lot of RPMs. The best way to work with
RPMs is through the RPM commands. You have to type these commands at
the shell prompt in a terminal window or a text console.
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In Fedora, the RPM commands are suitable only if you have to install just a
handful of RPM files. To install a large number of RPM files, you should
choose Applicationst>Add/Remove Software from the desktop. If you install
RPM files from a CD or DVD, first mount the CD/DVD and then type system-
cdinstall-helper /media/cdrom. (If your CD/DVD is mounted at some
other directory, replace /media/cdrom with that directory name.) You'll
see a Package Management window from which you can select and install
groups of packages.

Using the RPM command

When you install an RPM-based distribution such as Fedora, the installer
uses the rpm command to unpack the packages (RPM files) and to copy the
contents to your hard drive.

You don’t have to understand the internal structure of an RPM file, but you
need to know how to use the rpm command to work with RPM files. Here are
some of the things you can do with the rpm command:

4+ Find out the version numbers and other information about the RPMs
installed on your system.

4+ Install a new software package from an RPM. For example, you may
install a package you skipped during the initial installation.

4+ Remove (uninstall) unneeded software you previously installed from an
RPM. You may uninstall a package to reclaim the disk space, if you find
that you rarely (or never) use the package.

4+ Upgrade an older version of an RPM with a new one. For example, in
Fedora, you may upgrade after you download a new version of a package
from Fedora download sites (listed online at http://mirrors. fedora
project.org). You must upgrade an RPM to benefit from the fixes in
the new version.

4+ Verify that an RPM is in working order. You can verify a package to
check that all necessary files are in the correct locations.

As you can see, the rpm command is versatile — it can do a lot of different
things, depending on the options you use.

If you ever forget the rpm options, type the following command to see a list:
rpm --help | more

The number of rpm options will amaze you!
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Understanding RPM filenames

An RPM contains a number of files, but it appears as a single file on your
Fedora system. By convention, the RPM filenames have a specific format.
A typical RPM filename looks like this:

openoffice.org-writer-1.9.104-2.1386.rpm

This filename has the following parts, the first three of which are separated
by hyphens (-):

4+ Package name: openoffice.org-writer
4 Version number: 1.9.104
4 Release number: 2

4+ Architecture: i386 (this package is for Intel 80x86 or Pentium-compatible
processors)

Usually, the package name is descriptive enough for you to guess what the
RPM may contain. The version number is the same as that of the software
package’s current version number (even when it’s distributed in some other
form, such as a tar file). Developers assign the release number to keep
track of changes. The architecture is i386, or noarch, for the RPMs you want
to install on a PC with an Intel x86-compatible processor.

QOuerying RPMs
As the rpm command installs packages, it builds a database of installed

RPMs. You can use the rpm -g command to query this database to find
information about packages installed on your system.

For example, to find out the version number of the Linux kernel installed on
your system, type the following rpm -g command:

rpm -g cups
You see a response similar to the following:
cups-1.4.1-15

The response is the name of the RPM for the kernel. (This version is the
executable version of the kernel, not the source files.) The name is the same
as the RPM filename, except that the last part — . 1386 . rpm — isn’t shown.
In this case, the version part of the RPM tells you that you have CUPS (the
Common UNIX Printing System) version 1.4.1 installed.
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You can see a list of all installed RPMs by using the following command:
rpm -ga

You see a long list of RPMs scroll by your screen. To view the list one screen
at a time, type

rpm -ga | more

If you want to search for a specific package, feed the output of rpm -ga to
the grep command. For example, to see all packages with kernel in their
names, type

rpm -dga | grep kernel

The result depends on what parts of the kernel RPMs are installed on a
system.

You can query much more than a package’s version number with the rpm
-g command. By adding single-letter options, you can find out other useful
information. For example, try the following command to see the files in the
CUPS package:

rpm -gl cups

Here are a few more useful forms of the rpm -g commands to query infor-
mation about a package. (To use any of these rpm -g commands, type the
command, followed by the package name.)

4+ rpm -gc: Lists all configuration files in a package.

4+ rpm -gd: Lists all documentation files in a package. These are usually
the online manual pages (also known as man pages).

4+ rpm -gf: Displays the name of the package (if any) to which a specified
file belongs.

4+ rpm -gi: Displays detailed information about a package ( version
number, size, installation date, and a brief description).

4+ rpm -gl: Lists all the files in a package. For some packages, you see a
very long list.

4+ rpm -gs: Lists the state of all files in a package. (The state of a file can
be one of the following: normal, not installed, or replaced.)

These rpm commands provide information about installed packages only.

If you want to find information about an uninstalled RPM file, add p to the
command-line option of each command. For example, to view the list of files
in the RPM file named rdist-6.1.5-792.1586.rpm, go to the directory
where that file is located and type the following command:
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rpm -gpl rdist-*.rpm

This command works only if the current directory contains that RPM file.
Two handy rpm -g commands enable you to find out which RPM file pro-
vides a specific file and which RPMs need a specified package. To find out
the name of the RPM that provides a file, use the following command:

rpm -g --whatprovides filename

For example, to see which RPM provides the file /etc/vsftpd.conf, type
rpm -g --whatprovides /etc/vsftpd.conf

RPM then prints the name of the package that provides the file, like this:
vsftpd-2.0.3-1

If you provide the name of a package instead of a filename, RPM displays the
name of the RPM package that contains the specified package. On the other
hand, to find the names of RPMs that need a specific package, use the follow-
ing command:

rpm -q --whatrequires packagename

For example, to see which packages need the openss1 package, type

rpm -g --whatrequires openssl

The output from this command shows all the RPM packages that need the
openssl package.

Installing an RPM

To install an RPM, use the rpm -i command. You have to provide the name
of the RPM file as the argument. If you want to view the progress of the RPM
installation, use rpm -ivh. A series of pound signs (#) displays as the pack-
age is unpacked.

For example, to install the kernel-devel RPM (which contains the header
files for the Linux operating system) for Fedora from the companion DVD-
ROM, insert the DVD, and after it’s mounted, type the following commands:

cd /media/cdrom/Fedora/RPMS
rpm -ivh kernel-devel*

You don’t have to type the full RPM filename — you can use a few characters
from the beginning of the name followed by an asterisk (*). Make sure you
type enough of the name to identify the RPM file uniquely.
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If you try to install an RPM that’s already installed, the rpm -i command
displays an error message. To force the rpm command to install a package
even if errors are present, add --force to the rpm -i command, like this:

rpm -1 --force man-2%*

Removing an RPM

You may want to remove — uninstall — a package if you realize that you
don’t need the software. For example, if you have installed the X Window
System development package but discover you're not interested in writing
X applications, you can easily remove the package by using the rpm -e
command.

For example, to remove the package named gt3-devel, type
rpm -e gt3-devel

You have to know the name of the package before you can remove it. One
good way to find the name is to use rpm -ga with grep to search for the
appropriate RPM file.

To remove an RPM, you don’t need the full RPM filename; all you need is the
package name — the first part of the filename up to the hyphen (-) before
the version number.

The rpm -e command does not remove a package that other packages
need.

Upgrading an RPM

Use the rpm -U command to upgrade an RPM. You must provide the name
of the RPM file that contains the new software. For example, if you have
version 1.1.20 of CUPS (printing system) installed but want to upgrade to
version 1.1.23, download the RPM file cups-1.1.23-15.1386.rpm from a
repository and use the following command:

rpm -U cups-1.1.23-15.1386.rpm

The rpm command performs the upgrade by removing the old version of the
CUPS package and installing the new RPM.

Whenever possible, upgrade rather than remove the old package and install
a new one. Upgrading automatically saves your old configuration files, so
you don’t have to reconfigure the software after a fresh installation.
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When you’re upgrading the kernel packages that contain a ready-to-run
Linux kernel, install it by using the rpm -i command (instead of the rpm -U
command). That way, you won’t overwrite the current kernel.

Verifying an RPM

If you suspect that a software package isn’t properly installed, use the rpm
-V command to verify it. For example, to verify the kernel package, type the
following:

rpm -V kernel

rpm compares the size and other attributes of each file in the package against
those of the original files. If everything verifies correctly, the rpm -V com-
mand does not print anything. If it finds any discrepancies, you see a report of
them. For example, the command to type to verify the ht tpd package is

rpm -V httpd
The result may resemble the following:
S.5. . . . T c /etc/httpd/conf/httpd.conf

In this case, the output from rpm -V shows that a configuration file has
changed. Each line of this command’s output has three parts:

4+ The line starts with eight characters: Each character indicates the type
of discrepancy found. For example, S means the size is different, and T
means the time of last modification is different. Table 4-1 shows each
character and its meaning. A period means that that specific attribute
matches the original.

4+ For configuration files, a c appears next; otherwise, this field is blank.
That’s how you can tell whether a file is a configuration file. Typically,
you don’t worry if a configuration file has changed; you probably made
the changes yourself.

4 The last part of the line is the full pathname of the file. From this part,
you can tell exactly where the file is located.

Table 4-1 Characters Used in RPM Verification Reports
Character Meaning

S Size has changed

M Permissions and file type are different

5 Checksum computed with the MD5 algorithm is different

(continued)
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Table 4-1 (continued)

Character Meaning

D Device type is different

Symbolic link is different

File's user is different

File's group is different

HlQ|c |

File’s modification time is different

Working with DEB Files

\\3

Debian packages with . deb file extensions store executable files together
with configuration files, online documentation, and other information. You
can unpack and manipulate these DEB files using the Debian utility dpkg,
which is a command-line program that takes many options. A text mode,
menu-driven program called dselect is also available for you to manage the
packages without having to type dpkg commands.

You typically use a higher-level utility called APT (Advanced Packaging Tool)
to work with packages in Debian. For example, instead of downloading a DEB
file and installing it with the dpkg command, you can simply use the apt-get
command to install the package. The apt-get command can even download
the package from an online Debian repository and install it on your system.
The dpkg command is still useful when you want to look at the contents of a
DEB file that you have manually downloaded from a repository or that might
be in the apt cache directory (/var/cache/apt/archives in Debian).

dpkg, dselect, and apt are described in the following sections.
Understanding DEB filenames

A typical DEB package has a filename like the following:
mozilla-firefox_1.0.4-2_1386.deb

The filename has three parts separated by underscores (_):

4+ Package name: mozilla-firefox

4+ Version and revision: 1.0.4-2 (the first part is the package maintainer’s
version number; the second part is the Debian revision number)

4+ Architecture: i386 (the package is for Intel x86-compatible systems)

The filename has a . deb extension, which indicates that this is a DEB file.
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Using the dpkg command

To get a feel for the dpkg command, type dpkg --help | more. The
output shows the large number of options that dpkg accepts. You can also
type man dpkg to read the online man page for dpkg.

You can use dpkg to perform many operations on packages, but you have to
work at a shell prompt in a terminal window or a text console. The format of
a dpkg command is

dpkg [options] action package

The command has zero or more options, an action indicating what dpkg
has to do, and the name of a package, a DEB file, or a directory (depending
on the action argument). Sometimes the dpkg command does not need any
name of package or file, just an action.

Here are some examples of actions you can perform with dpkg:

4+ Install a package from a DEB file with the command dpkg -1 package
file, where packagefile is the name of the DEB file (for example,
vsftpd-*.deb).

4+ Remove a package but retain the configuration files with the command
dpkg -r packagename, where packagename is the name of the pack-
age (for example, vsftpd)

4+ Configure a package with the command dpkg --configure package
name, where packagename is the name of a package (for example,
vsftpd)

4+ Purge — remove everything including the configuration files — with the
command dpkg -P packagename, where packagename is the name of
a package (for example, vsftpd)

4+ Audit packages (and find the ones that are partially installed on your
system) with the command dpkg -C (does not need a file or package
name)

4 List contents of a DEB file with the command dpkg -c¢ package
file, where packagefile is the name of the DEB file (for example,
vsftpd-*.deb)

4 View information about a DEB file with the command dpkg -I package
file, where packagefileis the name of the DEB file (for example,
vsftpd-*.deb)

4+ List packages matching pattern with the command dpkg -1 pattern,
where pattern is the package name pattern — usually with wildcard
characters — that you want to match (for example, kernel*)
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4+ Find packages that contain files with the command dpkg -S pattern,
where pattern is the filename pattern — usually with wildcard
characters — that the package contains (for example, stdio*)

4+ List files installed from a package with the command dpkg -L package
name, where packagename is the name of a package (for example,
vsftpd)

You can try these commands on a Debian system or any system that uses
DEB packages. For example, to look for all packages matching names that
begin with mozilla, type dpkg -1 mozilla* in a terminal window. Here is
the relevant portion of this command’s output on a Debian system:

||/ Name Version Description

+4+4- =====- —===== ====== —============
un mozilla <none> (no description available)

un mozilla-bonobo <none> (no description available)

ii mozilla-browse 1.7.8-1 The Mozilla Internet application suite - cor

ii mozilla-firefox 1.0.4-2 lightweight web browser based on Mozilla

The 1ii in the first column indicates that the package is installed; un means
the package is not installed.

Another common use of dpkg -1 is to list all packages and use grep to
find lines that match a search string. For example, to find anything contain-
ing kernel, type dpkg -1 | grep kernel. If the package names (in the
second column of the dpkg -1 output) are truncated, adjust the width of
the output lines with a command like this:

COLUMNS=132 dpkg -1 | grep kernel

The dpkg -S command is a handy way to locate which package provided a
specific file in the system. For example, if you want to figure out what package
includes the /etc/host.conf file, type dpkg -S /etc/host.conf and the
output shows that the base-files package contains /etc/host.conf:

base-files: /etc/host.conf

Introducing dselect

The dselect is meant to be a front-end to the dpkg utility. To try out
dselect,loginas root and type dselect in aterminal window (or a
text console). When dselect starts, you get dselect’s text mode menu.

dselect is not described in detail, but here are some of the tasks you can
perform from the dselect main menu:

4+ Specify an access method — how to find the DEB packages
4+ Update the list of available packages
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4+ View the status of installed and available packages

4+ Select packages and manage dependencies among packages

4+ Install new packages or upgrade existing ones to newer versions
4+ Configure packages that are not yet configured

4+ Remove packages

One common sequence in dselect is to update the list of available pack-
ages and then upgrade all packages for which updates are available. You
can, of course, perform that same task with a simple apt command as well.

Using APT to manage DEB packages

APT is truly an advanced utility for keeping your Debian system up-to-date.
You can use a number of APT utilities to manage DEB packages. The two
commonly used commands are apt-get and apt-cache.

To install a package with apt-get, simply type apt-get install package
name, where packagename is the name of the package that you want to
install. For example, to install the vsftpd package, type apt-get install
vsftpd.

Removing a package is equally simple. Type apt-get remove package
name, where packagename is the name of the package you want to remove.

If you want to find the name of a package and you know some terms associ-
ated with the package, you can look for it with the apt-cache utility. For
example, to look for a CD/DVD burner package, type apt-cache search
burn | more to search through the APT’s package cache (which is the list
of Debian packages that APT downloads from the servers listed in the
/etc/apt/sources.list file). Here are some lines of output from that
command:

arson - KDE frontend for burning CDs
burn - Command line Data-CD, Audio-CD, ISO-CD, Copy-CD writing tool
caca-utils - text mode graphics utilities
cdcontrol - A parallel burner that allow you to write to one or more CD-Writers
at once
cdlabelgen - generates front cards and tray cards for CDs and DVDs
cdrtoaster - Tcl/Tk front-end for burning cdrom
cdw - Tool for burning CD's - console version
cdw-common - Tool for burning CD's - common files
cpuburn - a collection of programs to put heavy load on CPU
cwedr - Chez Wam CD Ripper
dvd+rw-tools - DVD+-RW/R tools
dvdbackup - tool to rip DVD's from the command line
edenmath.app - Scientific calculator for GNUstep
gcdw - Tool for burning CD's - graphical version
gcombust - GTK+ based CD mastering and burning program
. lines deleted .

Book V
Chapter 4

suonesijddy
Bunepdqn pue
Buijjeisuj



3 78 Building Software Packages from Source Files

3

\\3

The output shows several potential CD/DVD burning programs that could
be installed. To discover more about any of the packages, type apt-cache
show packagename, where packagename is the name of the package

for which you want information. For example, to find out more about the
dvd+rw-tools package, type apt-cache show dvd+rw-tools and the
output shows a description of the package. You can then install the package
with apt-get install.

To search for a keyword that appears in the package’s name only, use the
--names-only option like this: apt-cache search - -names-only
keyword, where keyword is something that appears in the package’s name.
For example, if you want to find packages that contain selinux in their
names, type apt-cache search - -names-only selinux.

Run apt-get clean periodically to clean out the local repository (in the
/var/cache/apt/archives directory) of DEB files that have already been
installed. You can free up some disk space by removing these DEB files.

Building Software Packages from Source Files

Many open source software packages are distributed in source-code form,
without executable binaries. Before you can use such software, you have to
compile the source files to build the executable binary files and then follow
some instructions to install the package. This section shows you how to
build software packages from source files.

Downloading and unpacking the software

Typically, open source software source files are distributed in compressed
tar archives. These archives are created by the tar program and com-
pressed with the gzip program. The distribution is in the form of a single
large file with the . tar.gz or . tar.z extension — often referred to as a
compressed tarball. If you want the software, you have to download the com-
pressed tarball and unpack it.

Download the compressed tar file by using anonymous FTP or going
through your Web browser. Typically, this process involves no effort on
your part beyond clicking a link and saving the file in an appropriate direc-
tory on your system.

To try your hand at downloading and building a software package, you can
practice on the X Multimedia System (XMMS) — a graphical X application for
playing MP3 and other multimedia files. XMMS is bundled with Fedora and
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already installed on your system. However, you do no harm in downloading
and rebuilding the XMMS package again.

Download the source files for XMMS from www . xmms . org/download.php.
The files are packed in the form of a compressed tar archive. Click the http
link for the source files and save them in the /usr/local/src directory in
your Linux system. (Be sure to log in as root; otherwise you cannot save in
the /usr/local/src directory.)

After downloading the compressed tar file, examine the contents with the
following tar command:

tar ztf xmms*.gz | more

You see a listing similar to the following:

xmms-1.2.10/
xmms-1.2.10/intl/
xmms-1.2.10/intl/ChangeLog
xmms-1.2.10/intl/Makefile.in
xmms-1.2.10/intl/config.charset
xmms-1.2.10/intl/locale.alias
xmms-1.2.10/intl/ref-add.sin
xmms-1.2.10/intl/ref-del.sin
xmms-1.2.10/intl/gmo.h
xmms-1.2.10/intl/gettextP.h
xmms-1.2.10/intl/hash-string.h
xmms-1.2.10/intl/loadinfo.h

i

lines deleted .

The output of this tar command shows you what’s in the archive and gives
you an idea of the directories that are created after you unpack the archive.
In this case, a directory named xmms-1.2.10 is created in the current
directory, which, in this case, is /usr/local/src. From the listing, you
also figure out the programming language used to write the package. If you
see .c and .h files, the source files are in the C programming language,
which is used to write many open source software packages.

To extract the contents of the compressed tar archive, type the following
tar command:

tar zxvf xmms*.gz

You again see a long list of files as they are extracted from the archive and
copied to the appropriate directories on your hard drive.

Now you’re ready to build the software.
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Building the software from source files

After you unpack the compressed tar archive, all source files are in a direc-
tory whose name is usually that of the software package with a version
number suffix. For example, the XMMS version 1.2.10 source files extract to
the xmms-1.2.10 directory. To start building the software, change directo-
ries with the following command:

cd xmms*

You don’t have to type the entire name — the shell can expand the directory
name and change to the xmms-1.2.10 directory.

Nearly all software packages come with a README or INSTALL file — a text
file that tells you how to build and install the package. XMMS is no excep-
tion; it comes with a README file you can peruse by typing more README. An
INSTALL file contains instructions for building and installing XMMS.

Q‘\gN\BEB Most open source software packages, including XMMS, also come with a file
& named COPYING. This file contains the full text of the GNU General Public
License (GPL), which spells out the conditions under which you can use and
redistribute the software. If you're not familiar with the GNU GPL, read this
file and show the license to your legal counsel for a full interpretation and an
assessment of applicability to your business.

To build the software package, follow the instructions in the README or
INSTALL file. For the XMMS package, the README file lists some of the pre-
requisites (such as libraries) and tells you what commands to type to build
and install the package. In the case of XMMS, the instructions tell you to use
the following steps:

1. Type ./configure to check your system’s configuration.

This command also runs a shell script that creates a file named Makefile —
a file the make command uses to build and install the package. (You
can type . /configure --help to see a list of options that configure
accepts.)

If you get any errors about missing packages, you have to install those
missing packages. Use your distribution’s software installation tools
to add the missing packages. For example, in Debian use the apt-get
install command. In Fedora, choose Applications=>Add/Remove
Software. In SUSE, use the YaST GUI tool.

2. Type make to build the software.

This step compiles the source files in all the subdirectories. (Compiling
source code converts each source file into an object file — a file contain-
ing binary instructions that your PC’s processor can understand.)
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3. Type make install to install the software.

This step copies libraries and executable binary files to appropriate
directories on your system.

Although the preceding list is specific to XMMS, most other packages follow
these steps: configure, make, and make install.The configure shell
script guesses system-dependent variables and creates a Makefile with
commands needed to build and install the software.

To use these simple commands to build software packages, you must first
install the software-development tools on your system. In Fedora, you must
install the Development Tools and the GNOME Software Development pack-
ages. In Debian, to build and run XMMS, you must also install the X Software
Development package because XMMS is an X application.

After you’ve installed XMMS, try running it from the GNOME or KDE desktop
by typing samms in a terminal window. From the XMMS window, press L to
get the Load File dialog box. Select an MP3 file to play. Your PC must have

a sound card, and the sound card must be configured correctly for XMMS
to work.

To summarize, here’s an overview of the steps you follow to download,
unpack, build, and install a typical software package:

1. Use a Web browser to download the source code, usually in the form of
a .tar.gz file, from the anonymous FTP site or Web site.

2. Unpack the file with a tar zxvf filename command. (If the com-
pressed tar file has a .bz2 extension, that means the file is compressed
with bzip2 and you can unpack that file with a tar jxvf filename
command.)

3. Change the directory to the new subdirectory where the software is
unpacked, with a command such as cd software_dir.

4. Read any README or INSTALL files to get a handle on any specific
instructions you must follow to build and install the software.

5. The details of building the software may differ slightly from one software
package to another, but typically you type the following commands to
build and install the software:

./configure
make
make install

6. Read any other documentation that comes with the software to find out
how to use the software and whether you must configure the software
further before using it.
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Installing SRPMs

If you have the source CDs for Fedora (you can download the source CD
images from one of the sites listed at http: //mirrors. fedoraproject.
org), you can install the source files and build various applications directly
from the source files. Fedora source-code files, like the executable binary
files, also come in RPMs, and these source-code RPM files are generally
known as SRPMs (source RPMs).

To install a specific source RPM and build the application, follow these steps:

1. Mount the DVD-ROM by typing mount /media/cdrom or wait for the
GNOME desktop to mount the DVD.

2. Typically, source RPMs are in the SRPMs directory. Change to that
directory by typing the following command:

cd /media/cdrom/SRPMS

3. Install the source RPM file by using the rpm -i command. For exam-
ple, to install the Web server (httpd) source, type

rpm -ivh httpd*.src.rpm

The files are installed in the /usr/src/packages/SOURCES directory.
A spec file with the . spec extension is placed in the /usr/src/
packages/SPECS directory. The spec file describes the software and
contains information used to build and install the software.

4. Use the rpmbuild command with the spec file to build the software
and install the binary files.

You perform different tasks, from unpacking the source files to building
and installing the binaries by using different options with the rpmbuild
command. For example, to process the entire spec file, type:

rpmbuild -ba packagename.spec

where packagename is the name of the SRPM. This command builds the
software and installs the binary files.

Updating Linux Applications Online

A
gg‘

NG/

Each Linux distribution comes with utilities that enable you to update the
software online. The following sections provide an overview of the update
methods in Debian, Fedora, SUSE, Ubuntu, and Xandros.

You need a fast Internet connection (such as a DSL or cable modem) to
easily update your Linux applications or download new software pack-
ages. Make sure that your Internet connection is up and running before you
attempt to update your Linux system online.
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Keeping Debian and Ubuntu updated with APT

The best way to keep your Debian system updated is to use APT. More
specifically, you use the apt-get command-line utility with appropri-
ate options. Because Ubuntu is Debian-based, you can use APT to update
Ubuntu as well.

In a nutshell, assuming the APT sources were configured during Debian
installation, you can keep the current collection of software updated with
the following two commands, typed in this order:

apt-get update
apt-get upgrade

The apt-get update command checks the current list of packages against
the ones available from the locations specified in /etc/apt/sources.
list file and gathers information about new versions of installed packages.

The apt-get upgrade command installs any available new versions of
the packages installed in your Debian system. You must perform apt-get
upgrade to install any available upgrades.

To install a new package in Debian, use apt-cache search to find the
package name in APT’s package cache and then use apt-get install to
install the package.

Updating Fedora Applications

Fedora comes with a graphical Update Agent that can download any new
RPM files your system requires and install those files for you.

To update Fedora software packages using the Software Update agent, follow
these steps:

1. Log in as root, and choose System->Administration->Software Update.

The Update Agent starts and displays a list of updates that are available
(see Figure 4-1).

2. Click Install Updates to continue.

The updater resolves dependencies for the updates. You may be asked
to confirm the downloading of additional software needed to resolve
these dependencies. If so, Software Update downloads the packages.
Then Software Update updates the software. A progress bar is displayed
during all steps of the operation.

Finally, Software Update displays a message about the package(s) it
installs successfully (see Figure 4-2).
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Figure 4-1:
Software
Update
displays the
available
updates.

5 Software Update Q@@

%‘ There are 475 updates available

Software updates correct errors, eliminate
security vulnerabilities and provide new features.

Install Software v | Status Size o
‘L,} ::r?;“ﬂagczl::lgz q:li:;esc)tion and reporting tool 205.7 KB j
::::u:;i::p;g'.’:f;-z.fuz (i686) soska
B D i mcdon kerneame 1 0.8-2.1c12 (i886) L3Ke
B9 ionpytnon 052103 lsser o

Virtual package to install all necessa ackages f...

(<]

This notification was issued on 2010-04-10.

The list of bugs that are fixed in this release can be found at: http://abisource. com/
changelogs/2.8.3.phtml

For more information about this update please visit this website:
« https://admin.fedoraproject.org/updates/F12/FEDORA-2010-6328.

For more information about bugs fixed by this update please visit this website:
« https://bugzilla.redhat.com/show_bug.cqi?id=554899.

@ A restart will be required. 475 updates selected (379.4 MB)

Quit ] [ Install Updates

Figure 4-2:
Software
Update tells
you the
update was
successful.

Figure 4-3:
Software
Update
informs
you that all
packages
are up-to-
date.

All selected updates installed

= All selected updates were successfully installed.

3. Click the OK button to exit Software Update.

Ideally, you want to keep your system up-to-date and receive messages when
you open Software Update like those shown in Figure 4-3.

All software is up to date

- There are no software updates available
for your computer at this time.
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In Fedora, you can also use Yum (which, by the way, stands for Yellow dog
Updater, Modified) to keep your packages up-to-date. Yum is a command-
line utility for updating as well as installing and removing RPM packages.
Yum downloads RPM package headers from a specified Web site and uses
the rpm utility to figure out any interdependencies among packages and
what needs to be installed on your system. Then it downloads and uses rpm
to install the necessary packages. Because Yum downloads just the headers,
which are much smaller than the complete RPM packages, Yum is much
faster than the alternative, where you manually download the complete RPM
packages using the rpm command.

Typically, you keep your system up-to-date with the graphical Package
Updater because it’s easy to use. However, knowing how to run Yum from
the command line is good, just in case you have problems with the GUIL

You can read more about Yum and keep up with Yum news by visiting the
Yum Web page at http://yum.baseurl.org.

The command line for Yum has the following syntax:
yvum [options] command [packagenames]

optionsis alist of Yum options, command specifies what you want Yum

to do, and packagenames are the names of a packages on which Yum per-
forms that action. You must provide command, but options and package
names are optional (which is why they are shown in square brackets in the
syntax). Table 4-2 summarizes the Yum commands and Table 4-3 lists some
common Yum options.

Table 4-2 Yum Commands

Command Yum Wilt

check- Check for available updates for your system

update

clean Clean up the cache directory

info Display summary information about the specified packages

install Install latest versions of specified packages, making sure that
all dependencies are satisfied

list Listinformation about available packages

list List packages already installed on your machine

installed

(continued)
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Table 4-2 (continued)

Command Yum Wilt

list List installed packages that have updates available
updates

provides Provide information on which package provides a file
remove Remove specified packages as well as any packages that

depend on the packages being removed

search Find packages whose header contains what you specify as the
package name

update Update specified packages, making sure that all dependencies
are satisfied

Table 4-3 Some Common Yum Options

Option Yum Witt

--download-only Download but not install the packages.

--exclude=pkgname Exclude the specified package. (You can use this
option more than once on the command line.)

--help Display a help message and quit

--installroot=path Use the specified pathname as the directory

under which all packages are installed.

-y Assume that your answer to any question is yes.

If you simply want Yum to update your system, type the following. (You
have to be logged in as root.)

yum update

Yum consults its configuration file, /etc/yum.conf, and does everything
needed to update the packages installed on your system.

If you want to update only certain packages, you can specify the package
names. For example, to update the kernel and xorg-x11 packages, use
the following Yum command:

yum update kernel* xorg-xl11*

This command updates all packages whose names begin with kernel and
xorg-x11.
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You may use the options to further instruct Yum what to do. For example, if
you want to download but not install the updated packages, type

yum --download-only update

Another typical option is --exclude, which enables you to exclude one or
more packages from the update process. Suppose you want to update every-
thing except the GNOME packages (whose names begin with gnome) and the
rhythmbox package. You would type the following Yum command:

yum --exclude=gnome* --exclude=rhythmbox update

Updating SUSE online

SUSE comes with YOU — YaST Online Update — for online software updates.
To access YOU, choose System=>YaST from the main menu. Then, from the
YaST Control Center’s Software category, click Online Update. This brings
up the YaST Online Update window.

To set up YOU automatic updates, click the Configure Fully Automatic
Update button. You can then specify a time of the day when you want YOU
to download any available patches and install them. You can instead specify
that YOU download but not install the patches.

To update your SUSE system online, select the installation source and click
Next. YOU then downloads the list of patches and displays them.

Select the patches (some are recommended and preselected for you) and
then click Accept. YOU then downloads the required packages and installs
them on your SUSE system.

Using Xandros Networks

In Xandros, use Xandros Networks to update applications or install new
ones. From the main menu, choose Xandros Networks (or double-click the
Xandros Networks icon on the desktop) to open the Xandros Networks
window.

To install the latest updates from Xandros, choose File>Install All Latest
Updates from Xandros or click the Update button. Xandros Networks then
downloads information about the available updates and shows a summary of
the packages to be downloaded and the disk space needed to install them.

Click OK. Xandros Networks prompts you for the root password. After you
enter the root password, it downloads and installs the software updates.

Book V
Chapter 4

suonesijddy
Bunepdqn pue
Buijjeisuj



388 Updating Linux Applications Online

Behind the scenes, Xandros Networks uses Debian’s apt-get command to
download and install the software updates.

The Xandros Networks window also offers options to install new software.
You can even shop for new applications through Xandros Networks. If you
have to install RPM or DEB files, you can do so in Xandros Networks by
choosing File=>Install RPM File or Filer>Install DEB File.
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Security

Firewall Configuration

File Options Help

RN L B )

Wizard Apply Reload Disable
Here you can define which services are trusted. Trusted services are
Other Ports accessible from all hosts and networks.
Trusted Interfaces Service ~ | Port/Protocol :
Masquerading ‘DNS :53/tcp, 53/udp
Custom Rules FTP 21/tcp

“IMAP over SSL ' 993ftcp

IPsec Efah, fesp

“Mail (SMTP) “25/tep

Multicast DNS ImDNS}ESBSBIudp
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‘NFS4 : 2049/tcp, 2049/udp
- OpenvPN 11194/udp

-POP-3 over S5L | 995/tcp

FALY Allow access to necessary services, only.

The firewall is enabled. [modified)

Set up packet filtering with the Firewall Configuration tool
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Chapter 1: Introducing Linux
Security

In This Chapter

v~ Establishing a security policy and framework
v~ Understanding host security issues

+ Understanding network security issues

v Translating computer security terminology

+ Keeping up with security news and updates

Fis chapter explains why you need to worry about security and offers a
high-level view of how to get a handle on security. The idea of an overall
security framework is explained and the two key aspects of security — host
security and network security — are discussed. This chapter ends by intro-
ducing you to the terminology used in discussing computer security.

Why Worry about Security?

In today’s networked world, you have to worry about your Linux system’s
security. For a standalone system or a system used in an isolated local area
network (LAN), you have to focus on protecting the system from the users
and the users from one another. In other words, you don’t want a user to
modify or delete system files, whether intentionally or unintentionally, and
you don’t want a user destroying another user’s files.

If your Linux system is connected to the Internet, you have to secure the
system from unwanted accesses over the Internet. These intruders — or
crackers, as they’re commonly known — typically impersonate a user, steal
or destroy information, and even deny you access to your own system
(known as a Denial of Service, or DoS, attack).

By its very nature, an Internet connection makes your system accessible

to any other system on the Internet. After all, the Internet connects a huge
number of networks across the globe. In fact, the client/server architecture
of Internet services, such as HTTP (Web) and FTP, rely on the wide-open
network access the Internet provides. Unfortunately, the easy accessibility
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to Internet services running on your system also means that anyone on the
Net can easily access your system.

If you operate an Internet host that provides information to others, you
certainly want everyone to access your system’s Internet services, such

as FTP and Web servers. However, these servers often have vulnerabilities
that crackers may exploit to harm your system. You need to know about the
potential security risks of Internet services — and the precautions you can
take to minimize the risk of someone exploiting the weaknesses of your FTP
or Web server.

You also want to protect your company’s internal network from outsid-

ers, even though your goal is to provide information to the outside world
through your Web or FTP server. You can protect your internal network by
setting up an Internet firewall — a controlled access point to the internal net-
work — and placing the Web